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Preface

This ASG-Insight Reference Guide provides instruction for using ASG-Insight (herein
called Insight). Insight is a powerful interactive system automating the analysis process
of COBOL programs.

Allen Systems Group, Inc. (ASG) provides professional support to resolve any questions
or concerns regarding the installation or use of any ASG product. Telephone technical
support is available around the world, 24 hours a day, 7 days aweek.

ASG welcomes your comments, as a preferred or prospective customer, on this
publication or on any ASG product.

About this Publication

This publication consists of these chapters:

<  Chapter 1, "Introduction,” provides an overview of Insight.

=  Chapter 2, "File," describes commands available on Insight’s File menu.

- Chapter 3, "View," describes commands available on Insight’s View menu.

=  Chapter 4, "Search,” describes commands available on Insight’ s Search menu.

=  Chapter 5, "Logic," describes commands available on Insight’s Logic menu.

- Chapter 6, "Task," describes commands available on Insight’s Task menu.

<  Chapter 7, "List," describes commands available on Insight’s List menu.

=  Chapter 8, "Options," describes commands available on Insight’s Options menu.

- Chapter 9, "Help," describes commands available on Insight’s Help menu.

<  Chapter 10, "Commands," describes commands available in Insight.

e  Chapter 11, "Analyze," describes the analyze process.
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Chapter 12, "AKR Utilities," describes how to use AKR utilities.

Chapter 13, "Paragraph Control Transfer Methods," describes how control is passed
to and from target paragraphs.

Chapter 14, "Help Facility," describes how to use the comprehensive online help
facility.

Related Publications

The documentation library for ASG-Insight consists of these publications (where nn
represents the product version number):

Note:

ASG-Center Installation Guide (CNX0300-nn) contains installation and
maintenance information for ASG-Center, the common set of libraries shared by the
ASG-Existing Systems Workbench (ESW) suite of products.

ASG-ESW Enhancement Summary (ESW1000-nn) highlights the new functionality
for this release.

ASG-Insight Installation Guide (INX0300-nn) provides instruction about the
installation and maintenance of ASG-Insight.

ASG-Insight Quick Reference Card (INX0900-nn) provides a summary of the
commands and functions within ASG-Insight.

ASG-Insight Quick Reference Guide (INX0600-nn) summarizes the syntax and use
of ASG-Insight commands.

ASG-Insight Reference Guide (INX0400-nn) provides detailed information about
the pop-ups, screens, and commands used in ASG-Insight, including field
descriptions, usage notes, and command syntax.

ASG-Insight User’s Guide (INX0200-nn) provides user information for
ASG-Insight.

To obtain a specific version of a publication, contact ASG Customer Support.
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ASG-Existing Systems Workbench (ASG-ESW)

ASG-ESW (herein called ESW) is an integrated suite of components designed to assist
organizations in enhancing, redeveloping, or re-engineering their existing systems. ESW
products use the Application Knowledge Repository (AKR) to store source program
analysis information generated by the Analytical Engine. Figure 1 represents the
components of ESW.

Figurele+ ASG Existing Systems Workbench

Existing Systems Workbench I

ASG-Alliance for Application Understanding

ASG-AutoChange for Mass Change Projects
ASG-Bridge for Conversion Projects
ASG-Encore for Evolving COBOL Programs
ASG-Center ASG-Estimate for Resource Estimation
ASG-Insight for Program Understanding
ASG-Recap for Portfolio Analysis

. . ASG-SmartDoc for Program Documentation
Analytical Engine |«

Y

ASG-SmartEdit for COBOL Intelligent Editing

ASG-SmartQuest for Analyzing Abends

Application
Knowledge

Repository (AKR) - TS0
- CICs

- IMS

- ASM

- APS

- PLI

- TCA for Test Coverage Analysis
- DB2 Stored Procedure

ASG-SmartTest for Testing/Debugging

xi
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Xii

This table contains the name and description of each ESW component:

ASG-Alliance

Alliance

The application understanding component that is
used by I T professionalsto conduct an analysis of
every application in their environment. Alliance
supports the analysis and assessment of the
impact of change requests upon an entire
application. Alliance alows the programmer/
analyst to accurately perform application analysis
tasks in afraction of the time it would take to
perform these tasks without an automated
analysistool. Theimpact analysis from Alliance
provides application management with additional
information for use in determining the resources
required for application changes.

ASG-AutoChange AutoChange

The COBOL code change tool that makes
conversion teams more productive by enabling
quick and safe changes to be made to large
quantities of code. AutoChange is an interactive
tool that guides the user through the process of
making source code changes.

ASG-Bridge

Bridge

Thebridging product that enablesfield expansion
for program source code, without being required
to simultaneously expand the fieldsin files or
databases. Because programs are converted in
smaller groups, or on a one-by-one basis, and do
not require file conversion, testing during the
conversion process is simpler and more thorough.

ASG-Center

Center

The common platform for al ESW products.
Center providesthecommon Analytical Engineto
analyze the source program and store this
information in the AKR. This common platform
provides a homogeneous environment for all
ESW products to work synergisticaly.
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ASG-Encore Encore The program re-engineering component for
COBOL programs. Encore includes analysis
facilities and allows you to extract code based on
the most frequently used re-engineering criteria.
Thecode generation facilitiesallow you to usethe
results of the extract to generate a standalone
program, a callable module, a complement
module, and a CICS server. Prior to code
generation, you can view and modify the
extracted Logic Segment using the COBOL
editor.

ASG-Estimate Estimate The resource estimation tool that enablesthe user
to define the scope, determine the impact, and
estimate the cost of code conversion for COBOL,
Assembler, and PL/I programs. Estimate locates
selected data items across an application and
determines how they are used (moves, arithmetic
operations, and compares). Time and cost factors
are applied to these counts, generating cost and
personnel resource estimates.

ASG-Insight Insight The program understanding component for
COBOL programs. Insight allows programmers
to expose program structure, identify dataflow,
find program anomalies, and trace logic paths. It
also has automated proceduresto assist in
debugging program abends, changing a
computation, and resolving incorrect program
output values.

ASG-Recap Recap The portfolio analysis component that evaluates
COBOL applications. Recap reports provide
function point analysis and metrics information,
program quality assessments, intra-application
and inter-application comparisons and
summaries, and historical reporting of function
point and metrics information. The portfolio
analysisinformation can also be viewed
interactively or exported to a database,
Spreadsheet, or graphics package.

ASG-SmartDoc SmartDoc The program documentation component for
COBOL programs. SmartDoc reports contain
control and data flow information, an annotated
sourcelisting, structure charts, program summary
reports, exception reportsfor program anomalies,
and software metrics.

Xiii



ASG-Insight Reference Guide

ASG-SmartEdit SmartEdit The COBOL editing component that can be
activated automatically when the | SPF/PDF
Editor isinvoked. SmartEdit provides
comprehensive searching, inline copybook
display, and syntax checking. SmartEdit allows
you to include an additional preprocessor (for
example, the APS generator) during syntax
checking. SmartEdit supportsall versions of IBM
COBOL, CICS, SQL, and CA-IDMS.

ASG-SmartQuest  SmartQuest Thediagnostic tool for analyzing batch and CICS
transaction abends. SmartQuest has been
designed to make the maximum use of simple
point-and-shoot techniques to enable fast and
easy navigation through any data dump.

ASG-SmartTest SmartTest The testing/debugging component for COBOL,
PL/I, Assembler, and APS programsin the TSO,
MV S Batch, CICS (including file services), and
IMS environments. SmartTest features include
program analysis commands, execution control,
intelligent breakpoints, test coverage, pseudo
code with COBOL source update, batch connect,
disassembl ed object code support, and full screen
memory display.

Invoking ESW Products

The method you use to invoke an ESW product depends on your system setup. If you
need assistance to activate a product, see your systems administrator. If your site startsa
product directly, use the I SPF selection or CLIST asindicated by your systems
administrator. If your site uses the ESW screen to start a product, initiate the ESW screen
using the I SPF selection or CLIST asindicated by your systems administrator and then
typing in the product command on the command line.

The product names can a so vary depending on whether you access a product directly or
through ESW. See "ESW Product Integration” on page xv for more information about
using ESW.

Xiv
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To initialize ESW products from the main ESW screen, select the appropriate option on
the action bar pull-downs or type the product shortcut on the command line.

Alliance (Application Understanding) AL Understand » Application
AutoChange (Conversion Set) CcC Change » Conversion Set
Bridge BR Change » ASG-Bridge
Encore (Program Re-engineering) EN Re-engineer » Program
Estimate ES Measure » ASG-Estimate
Insight (Program Understanding) IN Understand » Program
Recap (Portfolio Analysis) RC Measure P Portfolio
SmartDoc (Program Documentation) DC Document » Program
SmartEdit SE Change » Program

Or

Change » Program with Options

SmartQuest SQV Understand » Abend/Dump

SmartTest (Testing/Debugging) ST Test » Module/Transaction

ESW Product Integration

Because ESW is an integrated suite of products, you are able to access individual ESW
products directly, or through the main ESW screen. As aresult, different fields, values,
action bar options, and pull-down options display on a screen or pop-up depending on
how you accessed the screen or pop-up.

Certain ESW products also contain functionality that interfaces with other ESW products.
Using SmartTest as an example, if Allianceisinstalled, SmartTest provides a dynamic
link to Alliance that can be used to display program analysisinformation. If Insight is
installed and specified during the analyze, the Insight program analysis functions are
automatically available for viewing logic/data rel ationships and execution path. For
example, the Scratchpad option is available on the Options pull-down if you have Insight
installed.

XV
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Accessto these integrated products requires only that they be installed and executed in
the same libraries.

Example 1

Figure 2 shows the Encore Primary screen that displays when you access Encore directly.

The Encore Primary screen contains these eight action bar menu items: File, View,
Extract, Generate, Search, List, Options, and Help.

Figure2+« EncorePrimary Screen

File Uiew Edtract Generate 3Zearch List Odptions Help

AEE-Encore
CoHHand ===
Aotttk Hetebbek bbbl Stk
Atk Hbtebk bbbkl ettt
Atttk Atttk Hhtebkbt kekR Atk
Aetetoick Aetetoick Atttk etk Atk
Atttk
Aotttk

Copyright ALLen $ystens Group, IncC., an unpublished work.
A proprietary product of ASG, Inc. Use pestricted to authorized licensees.
Visit the ASGE Support Web Site at www.asg.cod

XVi
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Figure 3 shows the Encore Primary screen that displays when you access Encore through
ESW by selecting Re-engineer » Program from the ESW action bar menu. Notice that the
Primary screen name changes to ASG-ESW - Program Re-engineering when you enter
Encore through ESW. Also, the Logic menu item displaysif Insight isinstalled.

Figure 3+« ESW Encore Primary Screen

File Uiew Edtract Generate fearch Logic List Options Help

AZG-EZN — Prograd Re-engineering

CorAdand ===
Atttk Eoos 2 I S s 2 Atk
Aotttk Aebbt bbbk Aotk
Atttk Atttk Atttk stk Atk
Atttk Atttk debittck deboiolk Aok
Aotk
ettt

Copwright Allen Systens Group, INC.. an unpubliszhed vork.
A proprietary product of ASG, InC. Use restricted to authorized licensess.
Wigit the AZG Support Web Zite at wuw,asg.coH

Figure 4 shows the File - Analyze Submit pop-up that displays when you access
SmartTest directly. Figure 5 on page xviii showsthe File - Analyze Submit pop-up that
displays when you access SmartTest through ESW.

Figured« File- Analyze Submit Screen

File - Analyze SUbHiT
ConAand ===

E - Edit JCL % = EubMiT JCL

CoHpile and link JCL [PDE or sequentiall:
Data set nane

Analyze features [T-M]:
ASG-3HartTests ¥ Extended Analysis:s M

AKR data set nawe
AKR proghad nade  NEWDEHO [if overriding PROGRAA-IO0)

Analyze options:

CoHpile? [Y«H] « o o o o o« o T [¥ if needad by features)
Link 1oad Hodule reusable® [Y-M] T

XVvii
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The actions shown on these screens can also vary. For example, the D - Doc Options
action is only available on the File Prepare Program screen (or File - Analyze Submit
screen) if SmartDoc isinstalled on your system. In Figure 4 on page xvii, the
ASG-SmartDoc Options action is not displayed.

Figure5e« ASG-ESW - Prepare Program Screen (accessed through ESW)

CoHHand ===

AZE-EIN - Prepare Prograd

E - Edit TCL % - Eubmit TCL

CoHpile and link JCL [PDE oF sequentiall:
Data =&t nane

0 - Doc options

Analyze features [T-M]:
Understand: M Testl T
Re-&ngineetl N Abend<DuMpl N

AKR data set nane

Extended Analysiss M

Docurent: M

AKR prograd nane  MEWMDEHO

Analyze options:

[if overriding PROGRAR-IO)

CoHpile? [¥«<H] « « o« @ & o & o T
Link l1oad Hodule reusable® (v-M] T

[¥ if needad by features)
[Test and Abend-Ounp onlyl

Notice that the Analyze featuresfield in Figure 5 lists additional ESW products than
shown on Figure 4 on page xvii. Thisfield is automatically customized to contain the
ESW products you have installed on your system. These are the names of the analyze

types:
ASG-Encore Re-engineer
ASG-Insight Understand
ASG-SmartDoc Document
ASG-SmartQuest Abend/Dump
ASG-SmartTest Test
Extended Analysis (ASG-SmartTest with  Extended Analysis

Insight installed)

XViii
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Publication Conventions
ASG uses these conventions in technical publications:

Convention Represents

ALL CAPITALS Directory, path, file, dataset, member, database,
program, command, and parameter names.

Initial Capitals on Each Word Window, field, field group, check box, button, panel (or
screen), option names, and names of keys. A plussign
(+) isinserted for key combinations (e.g., Alt+Tab).

lowercase italic Information that you provide according to your
monospace particular situation. For example, you would replace
T1lename with the actual name of thefile.

Monospace Characters you must type exactly as they are shown.
Code, JCL, file listings, or command/statement syntax.

Also used for denoting brief examplesin a paragraph.

Vertical Separator Bar (|) Optionsavailablewith thedefault valueunderlined (e.q.,
with underline Y|N).

Underline Denotes a cursor-selectable field or line.

ASG Customer Support

ASG provides support throughout the world to resolve questions or problems regarding
installation, operation, or use of our products. We provide all levels of support during
normal business hours and emergency support during non-business hours.

ASG Third-party Support. ASG provides software products that run in a number of
third-party vendor environments. Support for all non-ASG productsis the responsibility
of the respective vendor. In the event avendor discontinues support for a hardware and/or
software product, ASG cannot be held responsible for problems arising from the use of
that unsupported version.

XiX



ASG-Insight Reference Guide

Intelligent Support Portal (ISP)

Online product support is available at: http://www.asg.com/support/support.asp via the
ASG Intelligent Support Portal (1SP). Y our logon information for | SP online support is:

Customer ID = NNNNNNNNN
Password = XXXXXXXXXX

where;

NNNNNNNNNN is your customer 1D supplied by ASG Product Distribution.
XXXXXXXXXX isyour unique password supplied by ASG Product Distribution.

The ASG-Intelligent Support Portal User's Guide providesinstructions on how to usethe
ISP and islocated on the ASG Support web page.

Telephone Support

To expedite response time, please have this information ready:

- Product name, version number, and rel ease number

- List of any fixes currently applied

- Any alphanumeric error codes or messages written precisely as displayed
- A description of the specific steps that immediately preceded the problem

- Verify whether you received an ASG Service Pack or cumulative service tape for this
product. It may include information to help you resolve questions regarding installation of
this ASG product. The Service Pack instructions are in atext file on the distribution media
included with the Service Pack. Y ou can access the latest software corrections and Service
Packs viathe | SP.

- The severity code (ASG Customer Support uses an escalated severity system to prioritize
serviceto our clients. The severity codes and their meanings are listed below.)

Severity Codes and Expected Support Response Times

Severity Meaning Expected Support Response Time
1 Production down, critical situation Within 30 minutes
2 Major component of product disabled Within 2 hours
3 Problem with the product, but customer has ~ Within 4 hours
work-around solution
4 "How-to" questions and enhancement Within 4 hours
requests

XX
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The Americas

Phone

Fax

Preface

E-mail

United States and
Canada

Europe, Middle East, and Africa (EMEA)

800.354.3578

1.703.464.4901

support@asg.com

During normal business hours, we recommend that you call the Central Support number

first (except in South Africa).

Phone Fax E-mail
Central Support 00.800.3544.3578 44.1727.812018 support.emea@asg.com
English 44.1727.736305 44.1727.812018 support.uk@asg.com
French 33.141.028590 33.141.028589 support.fr@asg.com
German 49.89.45716.200 49.89.45716.400 support.de@asg.com
Italian 39.0290450025 support.it@asg.com
Dutch 31.30.241.6133 support.nl @asg.com
Spanish 34.913.523.800 34.917.156.961 support.es@asg.com
South Africa 800.201.423 support.sa@asg.com
Asia Pacific (APAC)

Phone Fax E-mail
Central Support 61.3.9645.8500 61.3.9645.8077 support.au@asg.com
Australia 800.637.947 61.3.9645.8077 support.au@asg.com
Hong Kong 800.96.2800 support.hk@asg.com
Japan 81.3.5326.3684 81.3.5326.3001 support.au@asg.com
Singapore 65.224.3080 65.224.8516 support.sg@asg.com
All Other Countries (Also for any non-working numbers)

Phone Fax E-mail
All other countries  1.239.435.2201 support@asg.com

If you receive a voice mail message, follow the instructions to report a production-down
or critical problem. Leave a detailed message including your name and phone number.
An ASG Customer Support representative will be paged and will return your call as soon
as possible. Please have available the information described previously when the ASG
Customer Support representative contacts you.
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XXii

Submit all product and documentation suggestions to ASG’ s product management team
at http://www.asg.com/asp/email productsuggestions.asp.

If you do not have access to the web, FAX your suggestions to product management at
(239) 263-3692. Please include your name, company, work phone, e-mail ID, and the
name of the ASG product you are using. For documentation suggestions include the
publication number located on the publication’ s front cover.


http://www.asg.com/asp/emailproductsuggestions.asp

1 Introduction

Insight isthe ESW component that is designed to help you understand COBOL programs.
Insight exposes program structure, identifies data flow, finds program anomalies, and
traces logic paths. It also has automated procedures for debugging program abends,
changing computations, and resolving incorrect program output val ues.

Insight Overview

Insight analyzes COBOL programs using IBM's TSO/I SPF interface, and is an electronic
window that lets you see the internal workings of a COBOL program.

Insight features Common User Access (CUA) screens, pull-downs, and pop-ups designed
to give you easy accessto all product features.

An action bar isthe line of keywords displayed at the top of a screen. Each keyword
represents an action category performed on that screen. To view the action list on a
pull-down, move the cursor to the desired keyword and press Enter. To make a selection,
type the number that corresponds to the desired action and press Enter. Theresult is either
agenerated command or a pop-up.

A pop-up isawindow that displays on your screen that allows you to enter information
for the requested action.

Note:
See the ASG-Insight User’s Guide for more information.

Powerful Insight facilities provide a precise, consistent, and thorough analysis of COBOL
source code. Y ou no longer need to summarize information from source listings, cross-
references, and primitive online browse facilities. Each task is automated, yet blends with
your current maintenance practices. Y ou can determine what information you want and
when you want it. Y ou can aso direct whether an overview or the details of a program

display.
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Benefits

Insight analyzes COBOL source code rapidly and accurately.

Use Insight's flexible options to get an overview of both structured and unstructured
programs. Insight gives you online access to complete data cross-referencing. These
references include automatic checksfor group level and redefined datanames. In addition,
Insight retains the results so you can further evaluate them with other commands.

These Insight features reduce effort, eliminate oversights, and save time:

Efficiency. Collectsinformation automatically from limited listings and browse
facilities. Use an Insight action bar selection or acommand to evaluate your program and
to receive concise results.

Accuracy. Evaluates COBOL source code consistently and precisely.

Usability. Features easy-to-use CUA screens, pull-downs, and pop-ups eliminating the
need to search and summarize program listings. Results are summarized in screen
formats that prepare you for your next query.

Accessibility. Integrates accessibility into your daily TSO/I SPF work environment and
supplies useful help facilities.

Focus. Manages technica details so that you can focus on understanding programs and
assessing your changes.

Understandability. Provides pull-downs, pop-ups, and commands to automate each
task needed to learn a program. Pop-ups or Insight commands easily reveal any COBOL
program characteristic, and the resulting analysisis presented clearly.

Insight offers these five features that help you through the understanding process:
- Determining program structure

- | dentifying data usage and relationships

- Tracing datausagein logic

=  Tracinglogic flow

-  Saving, reusing, and printing information



File

This chapter describes items on the Insight File menu and contains these sections:

File Pull-down 4

File - Open Program Request Pop-Up 5

AKR Program Selection Pop-up 7

File - Close Program Request Pop-up 10
File - Save Program Reguest Pop-up 11
File - Analyze Submit Pop-up 12
File - AKR Utility Pop-up 15
File - AKR Directory Pop-up 17
File - AKR Allocate/Expand Pop-up 20
File - ASG-SmartEdit Request Pop-up 22
File - Execute Script Pop-up 23

w
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File Pull-down

To access, edit, and analyze programs, manage the AKR, execute script files, and exit

Insight, follow this step:

» Select File on the action bar and press Enter. The File pull-down, shown in Figure 6,
displays.

Figure 6+« FilePull-down

Actions

File Wiew Search Logic Task List o0Options Help
_ 1. open... W = Progran Understanding
2. Close...
3. Fave...
d. Analyze...
5. AKR utility...
6. AFG-EHArtEdit.u. Hebstebk chedobtebck Hefoketok
Ta EHECUTE SCRipTee. | doeek debideek Atttk
G. EMit Hedek
ok
ot ot defebetsdok eteoih Hefek
Hedetotah Hedetotah dedoketedok detebebek #edok
eddoth
oot

CopYright Allen Systeds Group, IncC., an unpublizhed vork.
A proprietary product of ASG, Inc. Use restricted to authorized 1icensess.
Visit the ASE Support Web Zite at wuw,asg.cod

1. Open Displaysthe File - Open Program pop-up used to typethe AKR and
program name to be opened.

2. Close Displays the File - Close pop-up used to exit the active program
without ending the Insight session.

3. Save Displays the File - Save pop-up used to save marks and/or equates
in the active program.

4. Analyze Displays the File - Analyze Submit pop-up used to submit an
Analyze job, and to specify the AKR to store the analyze
information.

5. AKR Utility DisplaystheFile- AKR Utility pop-up used to display the program

directory, allocate or expand an AKR, rename a program, and
delete a program.
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6. ASG-SmartEdit Displaysthe File - SmartEdit Request pop-up used to specify
whether you want to edit or browse the source code.

Thisaction only displays on the pull-down if SmartEditisinstalled.

7. Executescript  DisplaystheFile- Execute Script pop-up used to specify the dataset
name and script option.

8. Exit Closes the active program, ends the Insight session, and returns to
the screen that you used to access Insight.

Use the values specified on the Options - Product Parameters
pop-up to determine if equates and marks are to be saved when you
select this action.

File - Open Program Request Pop-Up
To open aprogram for examination in Insight, follow this step:

» Select File » Open and press Enter. The File - Open Program Request pop-up, shown
in Figure 7, displays.

Figure 7« File- Open Program Request Pop-up

File - Open Program Request
Type AKR information and program name. Then press Enter.

Application Knowledge Repository (AKR):

Data set name . . "VIAUSR.TEST.AKR"
Program name . . (blank for selection list)
Volume serial . . (if not cataloged)
Password . . . . (if password protected)

A program initialy displaysin Source View. Use the View pull-down to select other
views. See "Source View Screen” on page 29 and "View" on page 25 for more
information regarding views.
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Fields

Usage Notes

Dataset name  Required. Type the dataset name of the AKR where the program
resides.

Programname  Optional. Type the name of the program if not entered in the Data set
name field. If the program nameis not entered, the AKR Program
Selection pop-up displays to select the program name.

Volume serial Required if the dataset is not cataloged. Type the volume serial
number of the device where the AKR resides.

Password Required if the dataset is protected. Type the dataset password.

Note:

After you enter the AKR information on the File - Open Program Request pop-up, it is
saved and displays on the pop-up the next time it is opened.

When you open a new program while another program is open, the File - Open Program
Request pop-up (Figure 8) displays specifying the active program disposition and any
updates. After you select an option, the AKR Program Selection pop-up displays
allowing you to open a new program.

Figure 8+ File- Open Program Request Pop-up When Active Program Exists

File - Open Program Request

A program is currently open. Select an action to
be performed on the open program before opening
new program. Then press Enter.

1 1. Close the program, save any updates
2. Close the program, no updates saved
3. Do not close program

Note:

Y ou can aso open new programs with the CALL command, the PROGRAM command,
or the VIEW command. See "Commands' on page 177 for more information on these
commands.
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AKR Program Selection Pop-up

To list information about each program in the AKR and choose a program

1 L eave the program name on the File - Open Program pop-up blank and press Enter.
The AKR Program Selection pop-up, shown in Figure 9, displays.

Figure9+ AKR Program Selection Pop-up

AKR Program Selection

Command ===> Scroll ===> CSR
Application Knowledge Repository: USER.TEST.AKR

S Name Alias OF Type Lines Date Time Jobname
_ CALLDYN IN 116  DDMMYYYY  HH:MM:SS  SRENRAPA
_ CALLLAB IN 115  DDMMYYYY  HH:MM:SS  SRENRAPA
_ CHKACCT2 IN 310 DDMMYYYY  HH:MM:SS  VIADBDB
_ CTXpPO1 IN 12167  DDMMYYYY  HH:MM:SS  SRENLESD
_ DB2SAMP IN 556  DDMMYYYY  HH:MM:SS  SRENRAPD
_ DB2001 IN 185  DDMMYYYY  HH:MM:SS  SRENRAPD
_ DB2002 IN 267  DDMMYYYY  HH:MM:SS  SRENRAPD
_ DB2003 IN 200  DDMMYYYY  HH:MM:SS  SRENRAPD
_ DB2004 IN 99  DDMMYYYY  HH:MM:SS  SRENRAPD
_ DECLTEST IN 44  DDMMYYYY  HH:MM:SS  SRENRAPA
_ DECLTV IN 39  DDMMYYYY  HH:MM:SS  SRENRAPA
_ DLITCBL VIAPGM3 IN 248  DDMMYYYY  HH:MM:SS  SRENRAPA
_ EMPINQ IN 1151  DDMMYYYY  HH:MM:SS  SRENLESJ
_ IDMSTOO1 IN 596  DDMMYYYY  HH:MM:SS  SRENRAPI
_ IDMST002 IN 443  DDMMYYYY  HH:MM:SS  SRENRAPI

2  Sdlect aprogram using the line command area or type SELECT in the command
input area.

More than one Insight user can view a COBOL program at the same time. The first
person who enters a program has write access and can save marks and equates. All
subsequent users cannot save marks and equates and receive a message that the program
is currently being viewed.

Y ou can scroll the AKR Program Selection pop-up using either the scroll commands or
the LOCATE command. The LOCATE command scrolls directly to the specified name.
If the name does not exist, the scroll facility displays the nearest match.
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Fields

Application
Knowledge
Repository

Specifies the AKR dataset name specified on the File - Open
Program Request pop-up.

Line command area

Identifies the line command area, which accepts these line

commands:

S Selectsthe specified program. The Source View screen
displays.

! Locates the specified program. The screen is scrolled until
the specified program is at the top of the display.

Name

Specifies the name of the program in the AKR, from the
PROGRAM-ID statement.

If the analyzed program contains an ENTRY point, Name isthe
ENTRY point name.

If you overrode the namein the PROGRAM-ID statement when
you submitted the analyze job, Name is the name you entered in
the AKR program name field on the File - Analyze Submit

pop-up.See "File - Analyze Submit Pop-up" on page 12 or "File

- AKR Directory Pop-up" on page 17 for moreinformation about
AKR entries.

Alias Of

Specifiesthe name of the program containing the ENTRY point,
if the analyzed program contains an ENTRY point.

If you overrode the namein the PROGRAM-ID statement when
you submitted the analyze job, Alias of is the name that you
entered in the AKR program name field on the File - Analyze
Submit pop-up.See "File - AKR Directory Pop-up" on page 17
for more information about alias namesin the AKR.
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Type Indicates the analysis type(s) performed on the program. The
File - Analyze Submit pop-up shows the analysis type when the
analyzejob is submitted. Insight only uses programswith the IN
analysistype. These are the valid analysis types:

DA Indicates an Extended SmartDoc analysis with a
COBOL compile was performed.

DC Indicates a SmartDoc analysis with a COBOL
compile was performed.

DX Indicates an Extended SmartDoc analysis was
performed.

DS Indicates a SmartDoc analysis was performed.

EN Indicates an Encore analysis was performed.

IN Indicates an Insight analysis was performed.

SQ Indicates a SmartQuest analysis was performed.

ST Indicates a SmartTest analysis was performed.

ASM Indicates the program is an Assembler source
program.

PROFILE  Indicatesthat the member contains SmartTest
profile information.

METRICS Indicates that the member contains SmartDoc
metric information.

INTERNAL Thisisan Encore feature that indicates the
member contains logic segment information.

Lines Lists the number of program source lines.

Date/Time Lists the date and time the program was analyzed.

Jobname Specifies the job name that analyzed the program.
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File - Close Program Request Pop-up

To exit the active program without exiting Insight and to save marks and equates, follow
this step:

» Select File » Close and press Enter. The File - Close Program Reguest pop-up, shown
in Figure 10, displays.

Figure 10« File - Close Program Request Pop-up

File - Close Program Request

Select the desired disposition of any updates
for the program to be closed. Then press Enter.

2 1. Close the program, save any updates
2. Close the program, no updates saved

Use the File - Save Program Request pop-up or the SAVE command to save marks and
equates.

Field

Option Overrides the values set on the Options - Product Parameters pop-up. If
you select no option, Insight uses the values on the Options - Product
Parameters pop-up to determine if marks and equates are to be saved.
Choose one of these options:

Close the program, save updates

Exits the active program saving any marks and eguates that you
created or changed during the session. This overridesthe values set on
the Options - Product Parameters pop-up.

Close the program, no updates saved

Exits the active program without saving any marks and equates that
you created or changed during the session. This overrides the values
set on the Options - Product Parameters pop-up.

10
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File - Save Program Request Pop-up

To save the AKR marks and/or equates that were created or changed, without ending the
session, follow this step:

» Select File » Save and press Enter. The File - Save pop-up, shown in Figure 11,

displays.

Figure 1l e« File- Save Program Request Pop-up

1 1.
2.
3.

File - Save Program Request

Select the updates (if any) to be saved for the
current program. Then press Enter.

Save user MARKs and EQUATEs
Save user MARKs only
Save user EQUATEs only

To save marks and equates, use the File - Close pop-up or the SAVE command.

Field

Option

Overrides the values set on the Options - Product Parameters pop-up. If
you select no option, Insight uses the values set on the Options - Product
Parameters pop-up to determine if marks and equates are to be saved.

Choose one of these options:
Save User MARKs and EQUATES

Select 1 to save all marks and equates for the active program. This
overrides the values set on the Options - Product Parameters pop-up.

Save User MARKs only

Select 2 to save all marks created or changed for the active program.
Equates are not saved. This overrides the values set on the
Options - Product Parameters pop-up.

Save User EQUATES only

Select 3 to save all equates entered for the active program. Marks are
not saved. This overrides the values set on the Options - Product
Parameters pop-up.

Usage Notes

See "Options - Scratchpad Pop-up” on page 161 for information about creating user

marks and equates.

11
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File - Analyze Submit Pop-up

To edit and submit JCL, to specify the AKR information for the analyze job, and to store
the information on the AKR, follow this step:

» Select File» Analyze, or type ANALYZE in any command input area, and press Enter.
The File - Analyze Submit pop-up, shown in Figure 12, displays.

Note:

Y ou can aso analyze programs using other methods. See "Analyzing a COBOL
Program" on page 340 for more information.

Figure12« File- Analyze Submit Pop-up

ASG-ESW - Prepare Program
Command ===>

E - Edit JCL S - Submit JCL D - Doc Options

Compile and link JCL (PDS or sequential):
Data set name “USER.TEST.CNTL(YOURJCL)"

Analyze features (Y/N):
Understand: Y Test: Y Extended Analysis: Y Document: N
Re-engineer: N Abend/Dump: N

AKR data set name “USER.TEST.AKR"

AKR program name (if overriding PROGRAM-I1D)

Analyze options:

Compile? (Y/N) . . . . . . . . . Y (Y if needed by features)
Link load module reusable? (Y/N) Y (Test only)
Options
E - Edit JCL Enables you to review or change the compile/analyze JCL, if

required. To do this, type E and press Enter. The JCL member you
specified in the Data Set Namefield generates the JCL to be edited,
applying therulesoutlined inthe Analyze appendix. The Edit screen
displays the generated JCL .

Type SUBMIT to submit the edited JCL for execution when you
have compl eted editing. Optionally, you can save the edited JCL in
apartitioned dataset using the CREATE command. Otherwise, any
changes made at this time are not saved.

12



Fields

2 File

D - Doc Options

Displaysonly if SmartDaoc isinstalled. Type D to display the
File - SmartDoc Options screen used to request an Extended
SmartDoc analysis and to specify what reports (if any) are
generated.

S - Submit JCL

Submitsthe JCL to compile/analyzethe specified program. The JCL
submitted is generated from the JCL member specified in the Data
Set name field, using the rules outlined in the Analyze appendix.

Data set name

Required. The PDS member or sequential dataset containing the JCL
to compile and link the program. If the JCL residesin a source
manager such as Librarian or Panvalet, use the VIASUB edit macro
to submit the compile/analyze job.

Understand

Displaysonly if Insight isinstalled. This type of analysis provides
Insight logic and program execution flow capabilities. If Insight isthe
only product installed, thisfield contains Y ES and cannot be changed.
The defaultisY.

Test

Displaysonly if SmartTest isinstalled. Y indicates that a SmartTest
compile/analysiswill beperformed. Thistypeof analysisprovidesthe
testing and debugging information required by SmartTest. If
SmartTest isthe only product installed this field contains Y ES and
cannot be changed. The defaultisY.

Extended
Analysis

Displaysonly if SmartTest isinstalled. Thistype of analysis provides
comprehensive program analyzing capabilitiesin addition to the
testing and debugging capabilities of SmartTest. The defaultisY.

A SmartDoc extended analysisis specified on the File - SmartDoc
Options screen.

Document

Displaysonly if SmartDoc isinstalled. Thistype of analysis provides
the report information generated by SmartDoc. If SmartDoc isthe
only product installed thisfield contains Y ES and cannot be changed.
The defaultisY.

Re-engineer

Displaysonly if Encoreisinstalled. Thistype of analysisprovidesthe
logic and program execution flow capabilities of Encore. YES
specifies that an Encore compile/analysisisto be performed. The
default isN.

13
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Abend/Dump Displaysonly if SmartQuest isinstalled. Thistype of analysisletsyou
analyze the source code to be used when diagnosing dumps. The
default isN.

AKR data set Required. Type the name of the AKR that isto contain the

name information for the analyzed program.

AKR program  Optional. Typeanaliasnameto be used by theanalyze processto save

name itsresultsin the AKR.

If you do not enter avalue in thisfield, the analyze job saves the
resultsin the AKR using the PROGRAM-ID statement name in the
COBOL source.

If you enter a AKR program name, the analyzed job saves the results
using the entered name in the AKR, and also as an PROGRAM-ID
aias.

If aprogram contains ENTRY points, the analyze job also saves a
member for each ENTRY point in the AKR, with an alias of the
PROGRAM-ID.

Note:

Thisfield is only used for the AKR program name and does not
change the COBOL program name in the source.

Analyze options

Optional. Type the analyze options you want to override. Default
options for the analyze job are established at installation time.
Analyze options that can be entered in this field are described in the
Analyze appendix.

Compile?

Optional. You do not need to compile or link a program if Insight,
Encore, or SmartDoc are the only analyze features specified. TypeN
inthisfield to suppressthe JCL compile step and link steps. Thisfield
isforced to avalue of Y if SmartTest and/or Extended analysisis
selected.

Link load
module reusable

Optional. Usethisfield to test a program under SmartTest that is
dynamically loaded and is tested with RUN MONITOR. Y ou must
mark the load modul e as reusabl e to retain the Breakpoints across
calls. ThedefaultisY.

14
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2 File

To display the program directory, allocate or expand an AKR, rename a program, and
delete a program, follow this step:

» Select File» AKR Utility and press Enter. The File - AKR Utility pop-up, shown in

Figure 13, displays.

Figure 13« File- AKR Utility Pop-up

Command ===>

ASG-ESW - AKR Utility

Volume serial . .
Password

Blank - Display member list D - Delete member
A - Allocate/expand AKR R - Rename member

Application Knowledge Repository (AKR):

Data set name . . "VIAUSR.TEST.AKR"
Member . . . . . (if "R" or "D" selected)
New name (if "R" selected)

(if not cataloged)
(if password protected)

Options

Blank - Display member
list

Displaysthe File - AKR Directory pop-up that lists the
programs stored inthe AKR. Y ou can also delete or rename
programs on the File - AKR Directory pop-up.

A - Allocate/expand AKR

Select option A to alocate anew AKR or to expand an
existing AKR. Type the AKR name in the Data set name
field to display the File - AKR Allocate/Expand pop-up. If
expanding an existing AKR, type YES in the Expand
existing AKR field on that pop-up.

D - Delete member

Select option D to delete a program. Prior to selecting
option D, typethe AKR namein the Data set namefield and
the program name in the Program field.

R - Rename member

Select option R to rename a program. Prior to selecting
option R, typethe AKR namein the Dataset namefield, the
program namein the Programfield, and the new nameinthe
New name field.

15
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16

Field Description

Dataset name  Required. Type the name of the AKR directory. If the TSO ID
gualifier isthe same asthe user 1D, type the group, type, and program
without quotes. If the TSO ID qualifier is different than the user ID,
type the project, group, type, and program within quotes.

Member Required when deleting or renaming a program; otherwise, you can
enter the program name either in the Program field or in the Data set
name field. Type the name of the program in the AKR.

New name Required when renaming a program. Type the new name of the
program. The name must be 1 to 10 alphanumeric characters.

Volume seria Required if the dataset specified in the Data set name field is not
cataloged. Type the volume serial number. If the dataset is catal oged,
thisfield is optional.

Password Required if the dataset is protected. Type the dataset password.
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File - AKR Directory Pop-up

Fields

To list all membersin the specified AKR, follow this step:

» Leavethecommand input areablank onthe File- AKR Utility pop-up and press Enter.
The File - AKR Directory pop-up, shown in Figure 14, displays.

Figure14 « File- AKR Directory Pop-up

Command ===>

File - AKR Directory
Scroll ===> CSR

AKR: USER.TEST.AKR Row: 1
Total members: 26  Total entries: 29
D - Delete R - Rename Total records: 12000 Free space: 41.2%
Name New name Alias of Type Date Time Jobname Space
_ $$SEGMENTS INTERNAL DDMMYYYY HH:MM SRENMDR  0.0%
_ AT810B0 IN,RN DDMMYYYY HH:MM SRENDSMB 1.1%
DBMSCBL ETO70BO IN,RN DDMMYYYY HH:MM SRENDSMB
DBMSCBL ET760B0O IN,RN DDMMYYYY HH:MM SRENDSMB
_ DSM00022 IN,RN DDMMYYYY HH:MM SRENDSMB 0.3%
_ ETO70BO IN,RN DDMMYYYY HH:MM SRENDSMB 3.3%
_ ET760BO IN,RN DDMMYYYY HH:MM SRENDSMB 1.7%
_ ET927BJ IN,RN DDMMYYYY HH:MM SRENDSMB 2.8%
_ EO02031 IN,RN DDMMYYYY HH:MM SRENDSMB 1.6%
_ INDEXBUG IN,RN DDMMYYYY HH:MM SRENMDR2 0.3%
_ INDEXDEM IN,RN DDMMYYYY HH:MM SRENMDR9 0.3%
_ LSTRACEO IN,RN DDMMYYYY HH:MM SRENFKKB 0.3%
_ LSTRACE1 IN,RN DDMMYYYY HH:MM SRENFKKB 0.3%

Scroll to view members that are not visible, or type L (Locate) plus a character string to
scroll to a specific member. The pop-up scrollsto the member that most closely matches

the character string.

AKR Specifiesthe complete dataset name of the requested AKR as entered
on the File - AKR Utility pop-up.
Row Specifies the relative number in the AKR of the first member

displayed on this pop-up.

Total members

Specifies the total number of membersin this AKR, not including
aliases.

Total entries

Specifiesthetotal number of membersinthisAKR, including aliases.

Total records

Specifies the number of records allocated to this AKR, as entered in
the Space Amount field on the File - AKR Allocate/Expand pop-up
when the AKR was either allocated or expanded.

If the Space Unitswas entered as Tracks or Cylinders on that pop-up
instead of Records, the amount is converted to Recordsfor display in
the Total recordsfield.

17



ASG-Insight Reference Guide

18

Free space

Indicates the amount of available space in this AKR, rounded to the
nearest .1 percent.

Line command
area

Specifies the areato the left of the Name field, which accepts these
commands:

D - Delete TypeD to the left of each program you want to delete
from the AKR. Y ou can a so delete programs on the
File- AKR Utility pop-up.

R - Rename Type R to the left of the program you want to rename,
and type the new name in the New name field. When
you change the name of a primary program, the alias
name is automatically changed. Y ou can aso rename
programs on the File - AKR Utility pop-up.

Note:
Alias programs cannot be deleted or renamed.

Name

Specifies the names of the member in the AKR. Program names are
taken from the PROGRAM-ID statement. If the analyzed program
containsan ENTRY point, Nameisthe ENTRY point name.

If the name in the PROGRAM-ID statement was overridden at the
time the analyze job was submitted, Name is the name that you
entered in the AKR program namefield on the File - Analyze Submit
pop-up.

See"File- AKR Directory Pop-up" on page 17 for more information
about entriesin the AKR.

New name

Specifies the new member name. Thisfield is required when you
rename a member. The member name must be 1 to 10 alphanumeric
characters.

Alias of

Specifiesthe name of the program that containsthe ENTRY point, if
an analyzed program contains an ENTRY paint.

If the you overrode the name in the PROGRAM-ID statement at the
time the analyze job was submitted, Alias of isthe name that you
entered in the AKR program namefield on the File - Analyze Submit
pop-up.

An dias program cannot be deleted or renamed. The alias nameis
automatically changed when you either del ete or rename the primary
program.

See"File- AKR Directory Pop-up" on page 17 for moreinformation
about alias namesin the AKR.




2 File

Type

Indicates the type of analysisthat was performed on the member and
specified on the File - Analyze Submit pop-up. These are the valid

types:
AL
DA

DS

DX
EN
IN
RC
Q
ST
ASM

PROFILE

METRICS

INTERNAL

An Alliance analysis was performed.

A SmartDoc Extended analysis with a COBOL
compile was performed.

A SmartDoc analysis was performed. DC - A
SmartDoc analysis with a COBOL compile was
performed.

A SmartDoc Extended analysis was performed.
An Encore analysis was performed.

An Insight analysis was performed.

A Recap analysis was performed.

A SmartQuest analysis was performed.

A SmartTest analysis was performed.

The program is an Assembler source program.

This feature indicates the member contains profile
information. Generally, the member name is the
profile user ID. Profileinformation is automatically
saved when you use the SmartTest Session Tailoring
screen to specify the testing environment options.
After you specify program level testing optionson the
Session Tailoring screen (and they are saved in the
AKR profile member), the profile member is used by
SmartTest when you initiate atest session. A profile
isonly used (and updated) by the user for whom it is
created. The profile member automatically reflects
any modifications to the Session Tailoring screen.

ThisisaSmartDoc feature that indicates the member
contains metrics information. The Name field
contains $$METRIC or the name you assigned to the
metrics using the Rename function. The $$SMETRIC
member contains metrics calculated for the programs
inthis AKR.

Thisis an Encore feature that indicates the member
contains logic segment information. The Name field
contains $$SEGMENTS or the name assigned to the
member using the Rename function. The
$SSEGMENTS member contains the logic segment
information.
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Date Specifies the date the program was analyzed.

Time Specifies the time the program was analyzed.

Jobname Specifies the Job name used to analyze the program.

Space Specifies the percentage of space the program is using on this AKR.

This percentage is rounded to the nearest .1 percent.

File - AKR Allocate/Expand Pop-up

To allocate a new AKR

1  Fromthe ASG-ESW - AKR Utility pop-up, select option A and press Enter. The
File - AKR Allocate/Expand pop-up, shown in Figure 15, displays.

Figure15+« AKR Allocate/Expand Pop-up with SMSand a VSAM AKR

File - AKR Allocate/Expand
Command ===>

S - Submit JCL E - Edit JCL C - Specify Catalog
Expand existing AKR . . . NO (Yes or No)
AKR data set name . . . . "USER.TEST.AKR"

(Blank for default MGMTCLAS)

Management Class
(Blank for default STORCLAS)

Storage Class . . . . .

Volume . . . . . . .
Data Class . . . . . . (Blank for default DATACLAS)
Space units . . . . . RECORDS (Records, Tracks or Cylinders)
Space amount . . . . 4000 (Total AKR size in above units)
Unique . . . . . . . YES (Enter NO for a VSAM data space)
Job statement information:
//NAME JOB (ACCOUNT) ,NAME,
MSGCLASS=A
//* INSERT "/*ROUTE PRINT NODE.USER" HERE IF NEEDED.
/7*

2 TypeNO inthe Expand existing AKR field and press Enter. The space the AKR
needs depends on the size and the number of COBOL programs that are being

analyzed and placed in it.
To allocate a new AKR or to expand an existing AKR

1  Fromthe ASG-ESW - AKR Utility pop-up, select option A and press Enter. The
File - AKR Allocate/Expand pop-up, shown in Figure 15, displays.

2  TypeYES inthe Expand existing AKR field and press Enter.
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2 File

Option Description

S- Submit JCL Submits the generated JCL to allocate or expands the AKR shown
in the AKR Data Set Name field.

E - Edit JCL Enablesyou to edit the generated JCL used to allocate or to expand
the AKR shown in the AKR data set name field.

C - Specify Catalog Displays the AKR Catalog Information pop-up that is used to
specify the dataset name and password of acatalog, if required.

Field Description

Expand existing AKR Expandsthe AKR shown in the AKR data set namefield. Type
NO to allocate anew AKR. The default is NO.

AKR data set name Specifies the AKR name specified on the File - AKR Utility
Pop-up.

Management Class If your site uses SM S, type the management classfor the AKR.
The default is set during installation.

Storage Class If your site uses SMS, type the storage class for the AKR. The
default is set during installation.

Volume Required if you are not using SMS. Type the volume seria
number where the AKR is to reside.

Data Class If your site uses SMS, type the data class for the AKR. The
default is set during installation.

Space units Optional. Do not enter if you are using SMS. Type the type of
unitsto allocate. The units must be records, tracks, or cylinders.
The default is records.

Space amount Required if you are not using SMS. Type the amount of space
toallocatein thetype of units specified in the Space unitsfield.
The space needed for the AKR depends on the size and the
number of programs being analyzed and placed in it. See the
ASG-Center Installation Guide for space estimates.

Unique Optional. Type NO if the AKR isasub allocation in aVSAM
data space on the volume. Otherwise, type YES. The default is
YES.
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Job statement
information

Required to submit JCL. Type the appropriate JOB statement

information for your site. If you need to specify either aprivate
catalog or the password for your catal og, type C in the command
input areato display the AKR Catal og Information pop-up. Y ou
can use this pop-up to specify the Catalog DSN and Password.

Catalog DSN

Optional. Type the catalog dataset name if you want the AKR
dataset name to be added to a private catalog.

Password

Required if the CATALOG DSN is protected. Type the
password for the catalog dataset name specified in the
CATALOG DSN field.

File - ASG-SmartEdit Request Pop-up

22

Note:

This pop-up isonly available if SmartEdit isinstalled.

To browse or to edit the source code using SmartEdit, follow this step:

» Select File» SmartEdit and press Enter. The File - ASG SmartEdit Request pop-up,
shown in Figure 16, displays.

Figure16« File- ASG-SmartEdit Request Pop-up

File - ASG-SmartEdit Request

Select Edit or Browse, and select the Options
Panel display option.

Type of request
1 1. Edit

2. Browse

Then press Enter.

Options
/ Display options panel




2 File

Fields

Field Description

Type of request Either edits or browses the source code. The Edit or Browse Entry
pop-up displays.

Display options Displays the Edit or Browse Options pop-up before accessing the

panel Edit or the Browse Entry pop-up. If not specified, the Edit or
Browse Options pop-up is bypassed and the Edit or Browse Entry
pop-up displays. The default isto display the Edit or Browse
Options pop-up.

File - Execute Script Pop-up
To begin processing a script file, follow this step:

» Select File » Execute script and press Enter. The File - Execute Script pop-up, shown
in Figure 17, displays.

Figure 17« File- Execute Script Pop-up

File - Execute Script

Type a data set name, a data set name with a member name, or just a member
name in parentheses. Select the "Single step™ option if you wish to
execute the script one command at a time.

IT you wish to "resume™ normal execution of a "single step” script, select
the ""Resume automatic mode' option. If you wish to cancel a "single step"
script, select the "Cancel execution' option. The "resume'™ and *cancel™
options should be entered with a blank data set name field.

Data set name

Options

1 1. Automatic
2. Single step
3. Resume automatic mode
4. Cancel execution
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Fields

Field Description

Data set Required. Specifies the name of the script file to be processed.
name

Options Specifies the processing mode for the script file. These are the three
options:

- Automatic

Each command in the script file is executed consecutively. Thisis
the default.

e  Single Step
Each command in the script file displaysin the command input area.
Y ou can either change or erase the displayed command. Press Enter
to actually execute the displayed command. Processing of the script
file continues in this manner until all commands have been
displayed.

- Resume Automatic Mode

After ascript file has begun executing in Single step mode, selecting
Resume executes the remaining script file commands without
stepping through each.

=  Cancel execution
After ascript file has begun executing in Single step mode, selecting
Cancel stops the execution of the remaining script file commands.

Script files can a so be executed using the EXECUTE command. See
"EXECUTE Command" on page 209 for more information.
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View

This chapter describes items on the Insight View menu and contains these sections:

View Pull-down 27
Source View Screen 29
View - Tree View Request Pop-up 30
Tree View Screen 33
View - Structure View Reguest Pop-up 37
Perform Structure View Screen 33
View - Paragraph Cross-Reference Request Pop-up 34
View - Paragraph Cross Reference Pop-up 36
View - Program Summary Pop-up a7
Program Summary - Files Pop-up 48
Program Summary - Data Pop-up 50
Program Summary - Copy Members Pop-up 51
Program Summary - Sections/Paragraphs Pop-up 52
Program Summary - Control Flow Pop-up 54
Program Summary - Preprocessor Statements Pop-up 55
View - Levels Request Pop-up 57
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View - Reset Request Pop-up 58
View - Exclude Request Pop-up 59

Insight displays analyzed COBOL program information in source, graphical, and list
formats. These formats give different views of the program and itslogical components.
Use these views to examine the program and to learn a programs structure and function.

The View pull-down has three primary view methods to assist you in isolating,
understanding, and identifying the important sections of the source program. These are
the types of views:

View Description
Source view Presents the actual COBOL source code in source statements order.
Treeview Presents the paragraph hierarchy, that shows the program structurein

logical execution order.

Structureview  Presents the program structure graphically.

Y ou can change the magnification in all of the view methods (i.e., you can zoom in and
out of logical program components). Each view is created from the same original
COBOL source program, but presents a different perspective, and is concurrently
available and synchronized with the other views. Y ou may switch back and forth between
views and retain the results of certain analysisinquiries.

The Structure and Tree Views display the logical program components and can be
tailored to display varying program structure levels. Tailor these displays using the
Request pop-ups for each.

Y ou can request these program understanding list formats from any primary view:

The Paragraph Shows the control flow between paragraphs in the program.
Cross-reference

The Program Profile Providesinformation about file, copy member, section, control,
and database usage.




View Pull-down

Actions

3 View

Use the View pull-down shown in Figure 18 to perform these tasks:

=  View aprogram

<  View paragraph cross-reference information

-  View program information

- Display or exclude source according to program hierarchical structure

- Change the information level viewed

< Resetthedisplay

- Exclude lines from the display

To display the View pull-down, follow this step:

» Select View from the action bar and press Enter.

Figure 18+« View Pull-down

File Uiew

fearch Logic Task List Options Help

{

Lo R I ) I S

CoHAFa

[y

. Bource gral Understanding
. Tree...

o Btructure...

« Paragraph H-refu...
. Frogran sudHary...
. Z0OH in etoetstok: Aotk
. Z0oH out #edeth #edtetch
. Levelz...
. Reset...
« EHClude... debbbebk detebetok etk

I

Copwright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use pestricted to authorized 1icensees.
Visit the ASE Zupport Web Site at wuw. asq.cod

1. Source Displays the Source View screen, that shows the program in
COBOL source statement order.
2. Tree Displaysthe programinlogical execution order, showing logical

program units and the relationships between related units. When
you choose this action, the View - Tree View Request pop-up
displays allowing you to specify the format of the Tree View

display.
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3. Structure

Displaysthe program in agraphical format, with each box onthe
screen representing alogical program unit. When you choosethis
action, the View - Structure View Reguest pop-up displays

alowing you to specify the format of the Structure View display.

4. Paragraph X-ref

Displaysthe View - Paragraph Cross Reference Request pop-up
used to customize the View - Paragraph Cross Reference pop-up.

5. Program summary

Displaysthe View - Program Summary pop-up, used to select the
type of summary information displayed.

6. Zoomin

Displays source lines according to the hierarchical levels of the
program. When you select this action, a message displays to
remind you to position the cursor and to press Enter.

7. Zoom out

Excludes source lines according to the hierarchical levels of the
program. When you select this action, a message displays
reminding you to position the cursor and press Enter. Thisaction
is not valid on the Perform Structure View screen.

8. Levels

Displaysthe View - Levels Request pop-up used to specify the
new level number. Thisactionisvalid only onthe TreeView and
Perform Structure View screens.

9. Reset

Displaysthe View - Reset Request pop-up used to specify what
display featuresto reset, including highlighting, tags, excluded
lines, pending line commands, and messages.

10. Exclude

Displaysthe View - Exclude Request pop-up used to specify the
exclude options and string.




3 View

Source View Screen

Usage Notes

Note:

A program first displays in the Source View format. Select View » Source or type
SOURCEV I EW to return to Source View from the Tree View or the Perform Structure
View.

To display the COBOL source program code in a textual format, follow this step:

P Select View » Source and press Enter. The Source View screen, shown in Figure 19,
displays. This screen displays each source line and functions similar to the | SPF
Browse option.

Figure19« Source View Screen

File View Search Logic Task List Options Help

Source View Program: VIAIDEMO
Command ===> Scroll ===> CSR

TOP OF DATA
000001 IDENTIFICATION DIVISION.

000002 PROGRAM-ID. VIAIDEMO.

000003 AUTHOR. WRITTEN BY ASG AT LANGLVL 2.

000004 ENVIRONMENT DIVISION.

000005 CONFIGURATION SECTION.

000006 SOURCE-COMPUTER. IBM-370.

000007 OBJECT-COMPUTER. I1BM-370.

000008 INPUT-OUTPUT SECTION.

000009 FILE-CONTROL.

000010 SELECT MASTERIN ASSIGN TO S-MASTERIN.

000011 SELECT MASTER-RPT ASSIGN TO S-MREPORT.
000012 DATA DIVISION.

000013 FILE SECTION.

000014 FD MASTERIN

000015 RECORDING MODE IS F

000016 BLOCK CONTAINS O RECORDS
000017 LABEL RECORDS ARE STANDARD.
000018

000019 COPY VIAIMAST.

The Source View screen displaysindividual sourcelines, with the copy members properly
expanded. The name of the program that is being viewed displaysin the upper right corner
of the screen.

To close the active program and display the primary Insight screen, follow this step:

» Press PF3 or type END on the Source View screen. See the "END Command” on
page 200 for more information.

The Source View screen is aso available in the Task facility.
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View - Tree View Request Pop-up

To format a program to display on the Tree View screen

1  Select View » Tree and press Enter. The View - Tree View Request pop-up, shown
in Figure 20, displays.

Figure20« View - Tree View Request Pop-up

View - Tree View Request
Type request options. Then press Enter. For a name selection list
for a range (other than 1 or 2), type a pattern (e.g. ABC*) in the
name field.

Levels 2 of 5 of depth

Contents Range
1 1. Labels 1 1. Procedure division
2. Labels and performs 2. All entry points
3. Labels, performs and GOTOs 3. Perfrange name
4. Labels, performs, GOTOs and 4. Entry point name
conditionals 5. Nested program name
Name
Options
_  Repetition

2  Complete thesefields:

a  Specify the number of levels you want to view.
Y ou can changethe levels at any time by selecting View » Levelsaction or by
typing LEVELS and pressing Enter.

b  Select thetype of statements to be displayed in the Contents field.

¢  Specify how much of the program to display in the Range field.

Note:

Each configuration parameter field contains default values when this pop-up first
displays. If you change these defaults, the new values are retained for subsequent
Sessions.

3  PressEnter to display the Tree View screen shown in Figure 21 on page 33.
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3 View

Levels

Optional. Specifies the number of hierarchical levels of COBOL source
statements that display. Change the level depth value to either increase or
decrease the amount of detail displayed. The amount of detail increases as
the level depth increases.

The total number of levelsin the program displaysto theright of thisfield.
Type anumber equal to or less than this number, or enter the value MAX.
When you specify MAX levels, the actual number of levels displayed
depends on the Repetition Option. The default is 2.

Contents

Optional. Specifies the number of the statement type(s) to be displayed.
Each statement typeis a subset of the COBOL statements contained in the
program. Insight classifies COBOL statements into subsets by grouping
together COBOL verbs of asimilar nature.

These are the subsets available on this screen:

Labels The PROCEDURE DIVISION statement, and all section and
paragraph names in the PROCEDURE DIVISION. Thisis
the default.

Performs  Statements containing the PERFORM, SORT, or MERGE
verbs.

GOTOs Statements containing an ALTER or GO TO verb.

Conditionals Statements or parts of statements that conditionally change
the flow of control in aprogram such as |F, EL SE, and
WHEN.

Range

Optional. Specifies how much of the program isto be displayed.
These ranges are available:

1. Procedure Division  Displays the entire PROCEDURE DIVISION.
Thisisthe default.

2. All Entry Points Displays the entire PROCEDURE DIVISION
and all ENTRY points.

3. Perfrange Name Displays one perform range. If you select this
range, you must enter the perform range namein
the Namefield.

4. Entry Point Name Displaysone ENTRY point. If you select this
range, you must enter the entry point nameinthe
Namefield.
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5. Nested Program Name Displays one nested program. If you select this
range, you must enter the program name in the
Name field of the code that is executed by
entering the specified program. Requires Name
field.

Name Specifies the name of the perform range, entry point, or nested program to
be displayed. Thisfield isrequired if you select the Perfrange name, Entry
point name, or Nested program name for the Range. Thisfield isignored if
you select either range 1 or 2.

If thisfield is left blank, a selection list pop-up displays alowing you to
select thedesired name. Y ou can usewildcard characters[question mark (?)
for 1 character; asterisk (*) for zero or more characters] in thisfield to
reduce the size of the selection list. On the selection list pop-up, specify
the Name by typing S next to the desired name.

Repetition Determines whether perform range structures entirely display wherever
they appear in the program.

If not specified, the complete perform range structure displaysthefirst time
it displaysin the program. Subsequent references to the perform range do
not display, and are tagged as REPEAT to the right of the PERFORM
Statement.

If specified, the perform rangeis fully displayed wherever it occurs. The
default is display the perform range only the first timeit displays.

When you request MAX level depth, the actual number of levels displayed may be
different, depending on the value in the Repetition field. MAX displays all levelsin the
program; however, if the maximum level consists of only repeated perform ranges, then
the level display istruncated to the next higher level that does not consist exclusively of
repeated perform ranges.



3 View

Tree View Screen

The Tree View screen, shown in Figure 21, displayslogical program units and the
relationships between them. A logical program unit is a PERFORMed range of code
including GO TO code, or a CALLed program. COBOL source lines show Logical
programs, and indents show unit relationships.

Figure2le TreeView Screen

File View Search Logic Task List Options Help

Tree View LINE 1 OF 98
Command ===> Scroll ===> CSR
ASG15821 5 OF 5 LEVELS DISPLAYED IN THE VIEW.

TOP OF DATA
000000 PROCEDURE DIVISION.
000001 PERFORM PROGRAM-INIT.
000002 PROGRAM-INIT.
000002 PERFORM P0OO5-VAL-PARM THRU POO5-EXIT.
000003 POO5-VAL-PARM.
000003 IF DBA-DEPT-CODE > 24 COND
000003 :  PERFORM P999-ABEND-PROGRAM.
000004 :  P999-ABEND-PROGRAM.
000004 : CALL "ABENDPGM® USING ABEND-CODE. PGM EXIT
000003 IF DBA-DEPT-CODE < 16 COND
000003 :  PERFORM P999-ABEND-PROGRAM.
000004 :  P999-ABEND-PROGRAM. REPEATED
000004 : CALL “ABENDPGM™ USING ABEND-CODE.
000003 POO5-EXIT.
000002 PERFORM P010-OPEN THRU PO19-EXIT.
000003 P010-OPEN.
000003 CALL "DBAOPEN1" USING DBA-DEPT-CODE.
000003 CALL "DBAOPEN2" USING DBA-DEPT-CODE.
000003 PO19-EXIT.

Tree View Generated Tags

The left column on the Tree View screen indicates the nesting level for each statement.
Thistableliststhe valid tags:

+ Indicates lower levels of program structure not displayed. To view the
lower level structure, use the ZOOMIN command.

Indicates that the statement or label isartificially indented to highlight a
conditional statement.

COND Indicatesthe control flow verb ispart of aconditional (IF, AT END, €etc.).

PGM EXIT Indicates a program exit.

RECUR Indicates the PERFORM isrecursive.
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Tag Description

REPEATED If aPERFORM rangeisrepeated, aREPEATED tagisplaced ontheline
REP of the duplicate PERFORM range.

SOURCE Thedisplayed lineis actual source code.
SRC

The most basic Tree View displays paragraph and section labels. All executed
PERFORM statement labels under the paragraph label containing the PERFORM are
indented. Program exits also display.

Y ou can view Control flow statements to understand how the |abels are executed.
Indentation is directly related to the nesting level of the PERFORM statement.
Primary Commands

These primary commands perform the specified functions on the Tree View screen when
they are entered in the command input area:

Command Description

BRANCH L ocates the occurrence of the PERFORM within the Tree View display.
If the label is not shown, a message displays.

END Exits the Tree View screen.

JUMP Returnsto the Source View screen at the location corresponding to the
current cursor location where this command isissued on the Tree View
screen. Jump also functions as the J line command.

LEVELSn Redisplaysthe Tree View screento the nth level. Any level lessthannis
expanded to the requested level. Levels greater than n are removed. The
LEVELS command works globally throughout the displayed program.

RESET Removes highlighting, erases tags in columns 73 through 80, and
redisplays excluded lines.




3 View

ZOOMIN

Expands the Tree View diagram to the next lower hierarchical level.
Typing ZOOMIN on alabel expands all PERFORMSs contained by the
paragraph. If there are no more hierarchical levels, or they have aready
been expanded, the source displays for that label.

If all levels have been displayed and you type ZOOMIN, an error message
displays because ZOOMIN cannot be entered on a source line.

ZOOMOUT

Removes levels. Thefirst level removed is the source. If thereis no
source displayed, lower levels are removed. If both source and lower
levels have been removed, no more levels are removed.

Paragraphs or PERFORM s are marked as containing results (i.e., they are
tagged as USE, MOD, or REF). If the results at the source level are
desired, ZOOMIN may be used to see the source and the actual results.
Results do not display if they are not outside Tree View's bounds.

These commands work the same way in Tree View asthey do in Source
View:

- REPEAT

- RECALL

The EXCLUDE, FINDXTND, and HIGH commands function the same
way in Tree View asthey do in Source View except these operands are
not applicablein Tree View:

- FIRST
. LAST
- PREV
- NEXT

The LPRINT and LPUNCH commands can be executed inthe Tree View
screen, however, the only valid operands are asterisk (*) and NOTE.
LPRINT and LPUNCH copy the specified target to the List and Punch
file, respectively.

The SCROLL command can be executed in the Tree View screen,
however, these operands are the only valid operandsin Tree View:

- HI

- FIRST
- LAST -NHI
- NEXT
- PREV
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Line Commands

These line commands perform the specified functions on the Tree View screen:

Line Command Description

Fn Redisplays n excluded lines beginning with the first excluded line. The
default is 1.
J Returnsto the Source View screen at the location where this command

isissued on the Tree View screen. This command also functions as the
JUMP primary command.

Ln Redisplays n lines starting with the last line in the block of excluded
lines.

Sn Redisplays n lines starting with the first line in the block of excluded
lines. The default is 1.

SS Redisplays a block of lines. Type on the first and last line in the block
of linesto be redisplayed.

Xn Excludes n lines from being displayed. The default is 1.

XX Excludesablock of linesfrom being displayed. Type thiscommand on
thefirst and last line to excluded.

Zl Performs the ZOOMIN command at the line where it is entered. See
"ZOOMIN/ZOOMOUT Commands' on page 324 for more
information.

Z0 Performsthe ZOOMOUT command at the line whereiit is entered. See
"ZOOMIN/ZOOMOUT Commands' on page 324 for more
information.
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View - Structure View Request Pop-up

To format the program on the Perform Structure View screen

1  Select View » Structureand pressEnter. The View - Structure View Request pop-up,
shown in Figure 22, displays.

Figure22« View - Structure View Request Pop-up

View - Structure View Request

Type request options. Then press Enter. For a name selection list
for a range (other than 1 or 2), type a pattern (e.g. ABC*) in the
name field.

Levels 2 of 4 of depth

1 Procedure division

2. All entry points

3. Perform range name

4 Entry point name

5 Nested program name

Name

Options
_ Repetition

2 Specify these configuration parameters:

a  Specify the number of hierarchical levels you want to view.

Y ou can changethe levels at any time by selecting View » Levelsaction or by
typing LEVELS and pressing Enter.

b Specify how much of the program you want to display in the Range field.

Note:
Each field contains default values for the configuration parameters when the
View - Structure View Request pop-up first displays. If you change these defaults,
the new values are retained for subsequent sessions.

3 Press Enter to display the Perform Structure View screen, shown in Figure 23 on
page 40.
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Levels

Specifies the number of hierarchical levels of COBOL source statements
that display. Change the level depth value to increase or to decrease the
amount of detail displayed. Theamount of detail increases asthelevel depth

increases.

The total number of levelsin the program displays to the right of thisfield.
Type anumber equal to or less than this number, or enter the value MAX.
When you specify MAX levels, the actual number of levels displayed
depends on the Repetition Option. The default is 2.

Range

Specifies how much of the program isto be displayed. These are the valid

ranges:
1. Procedure Division

2. All Entry Points

3. Perfrange Name

4. Entry Point Name

5. Nested Program Name

Displays the entire PROCEDURE DIVISION.
Thisisthe default.

Displays the entire PROCEDURE DIVISION
and all ENTRY points.

Displays one perform range. If you select this
range, you must enter the perform range name
in the Name field.

Displays one ENTRY point. If you select this
range, you must enter the entry point namein
the Name field.

Displays one nested program. If you select this
range, you must enter the program name in the
Name field of the code that is executed by
entering the specified program. Requires the
Namefield.




Usage Notes

3 View

Name Required if you select the Perform range name, entry point name, or nested
program name for the Range. Thisfieldisignored if you select either Range
lor2

Typethe name of the perform range, entry point, or nested subprogram to be
displayed.

If you leave thisfield blank, aselection list pop-up displays allowing you to
select the desired target name. Wildcard characters [question mark (?) for 1

character; asterisk (*) for zero or more characters] can beenteredinthisfield
to reduce the size of the selection list.

On the selection list pop-up, specify the Name by typing S next to the
desired name.

Repetition  Specifies whether perform range structures display entirely display
wherever they appear in the program.

If not specified, the complete perform range structure displays the first time
it displaysin the program. A box containing the notation REPEAT
represents subsequent references to the perform range.

If specified, the perform range structure fully displays whenever it occurs.
The default isto display the perform range only the first timeit displays.

When you choose MAX level depth, the actual number of levels displayed may be
different, depending on the value in the Repetition field. MAX displays all levelsin the
program; however, if the maximum level consists of only repeated perform ranges, then
the level display istruncated to the next higher level that does not consist exclusively of
repeated perform ranges.
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Perform Structure View Screen
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The Perform Structure View screen, shown in Figure 23, represents a COBOL program
structure graphically and reflects the hierarchical relationship between the logical
components (usually PERFORMed code and CALL ed programs).

Figure 23« Perform Structure View Screen

File View Search Logic List Utility Help
Perform Structure View PROGRAM: VIAIDEMO

===> SCROLL ===> CSR
ASG15821 2 OF 4 LEVELS DISPLAYED IN THE VIEW.
+---- 001+
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i i
1 1
1 1
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N 1

1 1]
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H H 1000-EXIT}
[ + e +

L L L 1 L L 1

1 1 1 1 [} 1 1
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[ 4+ e B S T S R S B S + +REPEATED+

BOTTOM OF DATA

The Perform Structure View screen displays the logical program unitsand all transfers of
control between these components. Transfers of control include PERFORMs, GOTOs,
and CALLs.

Boxes represent logical program units, and lines between the boxes represent
relationships. Insight assigns a unique number to each box and displays that number in
the upper right corner of the box. The unit name displaysin the box. If the name does not
fit inside the box, the name is truncated and an asterisk (*) represents the remaining
characters.

If the box contains REPEATED, the first occurrence box number that displays the entire
perform range structure is contained inside the box in the lower right corner.

When this screen first displays, a message stating the number of levels displayed, and the
total number of program levels displays. Use the Levels option to change the number of
levels displayed.



Usage Notes

3 View

Use scrolling commands (UP, DOWN, LEFT, and RIGHT) to see the whole structure
chart. The More field displays in the upper right corner of the screen below the SCROLL
field when the screen is scrollable. The More field lists the available scrolling directions
for the current window, and indicate you can view additional data by scrolling in the
indicated direction(s). These are the indicators:

+ DOWN
- upP

> RIGHT
< LEFT

To view the COBOL source code statements for a particular logical program unit box on
the Structure View screen, follow this step:

» Select View » Zoomin, or type ZOOMIN, and press Enter.

The Source View screen displays as a pop-up with a shortened action bar. This screen
displays the highlighted COBOL source statements in the requested perform range and
excludes all other lines from the display.

Note:

For more information about the ZOOMIN/ZOOMOUT commands, see "Commands"' on
page 177. For more information about the Zoom in action on the View pull-down, see
"Actions' on page 27.
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View - Paragraph Cross-Reference Request Pop-up

To customize the View - Paragraph Cross Reference Request pop-up, follow this step:

» Select View » Paragraph X-ref and pressEnter. The View - Paragraph Cross-Reference
Request pop-up, shown in Figure 24, displays.

Figure24 « View - Paragraph Cross-Reference Request Pop-up

View - Paragraph Cross-Reference Request

To list transfers of control to or from paragraphs in the program,
type a target name and select a target type and direction. Then
press Enter. For a name selection list for a target type (other
than types 1 and 6), type a pattern (e.g. ABC*) in the target name
input field.

Target name

Target type Direction
1. None - use cursor 1 1. Previous
Mark name 2. Next
Perfrange name
Program name
Subset name
Line range
Label name

~NOoOOh~WN

Fields

Targetname  Optional. Type the mark name, perform range name, program name,
subset name, line range, or l1abel name used as abasis for the paragraph
cross-reference. If you want to use cursor positioning to select thetarget,
leave thisfield blank. The information you enter in the Target name
field must correspond to the information in the Target type field.

If thisfield isleft blank and you choose a Target type other than None,
aselection list pop-up displays that allows you to select the desired
target name. Wildcard characters [question mark (?) for 1 character;
asterisk (*) for zero or more characters] can be entered in thisfield to
reduce the size of the selection list. On the selection list pop-up, specify
the Name by typing S next to the desired name.

Target type Optional. Select the type of target represented by the entry in the Target
name field. The default is None - use cursor.

Choose from these options:
1. None - Use Cursor Specifies the target by positioning the cursor on
the desired target. When you select this Target

type, the previous View screen displaysto allow
cursor placement.
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Target Type Description

2. Mark

3. Perfrange

4. Program

5. Subset

Specifiesthat the entry inthe Target namefieldis
amark name (i.e., a set of source lines created
using the scratchpad pop-ups or the COPY,
MARK, MERGE, or RENAME commands). The
View - Paragraph Cross Reference pop-up
displays all paragraph namesthat contain the
specified mark name.

Specifiesthat the entry inthe Target namefieldis
a perform range name. All paragraph names that
contain the perform range display on the

View - Paragraph Cross Reference pop-up.

Specifiesthat the entry inthe Target namefieldis
aprogram name. All paragraph names that
contain the program display on the

View - Paragraph Cross Reference pop-up.

Specifiesthat the entry in the Target namefieldis
apredefined COBOL language subset.
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These are the predefined subsets:

ASsignment DEBug 10

CAll DEFinition LABé
Clcs DIRective MAINline
COBOLII DIVision MATH
COBOL/370 DL/l |DL/1 Output
COMment DML PARagraph
CONditional  ENtry PERform
COPY EXIt | PGMExit RETurn
DB2/SQL FALLthrough  SECtion
DDL GOto SORTMerge
DEAD IDMS STructure
DEADCode  INClude TESted
DEADData Input UNTested

Note:
See the ASG-Insight User’s Guide for a description of each subset and
subset type. The TESted and UNTested subsets are only available if
you have applied TCA results. See the ASG-SmartTest TCA User’s
Guide for more information.

A screen subset:
Highlighted | HI
NONHighlighted | NHI
Excluded | X
NONExcluded | NX
A tagged lines subset of tags appearing in columns 73 through 80.

The View - Paragraph Cross Reference pop-up displays all paragraph
names that contain statements of the specified subset type.

Line

Specifiesthe Target namefield entry isasingle line number or range of
lines. Columns 1 through 6 of the Source View display Line numbers.
The View - Paragraph Cross Reference pop-up displays all paragraph
names that contain the specified ling(s).
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Label Specifies the entry in the Target name field isalabel (i.e., any
PROCEDURE DIVISION paragraph name or section hame, or the
literals PROCEDURE and PROC). The View - Paragraph Cross
Reference pop-up displays all paragraph names that contain the
specified label.

Direction Specifies the type of transfer. These are the valid values:

Previous Displays paragraphs where control is transferred to the
target paragraph. The default is Previous.

Next Displays paragraphs where control is transferred from the
target paragraph.

View - Paragraph Cross Reference Pop-up

The View - Paragraph Cross Reference pop-up shows how control is transferred to or

from the target paragraphs. Use this pop-up to determine these items:

- How to get to a paragraph

<  Which paragraphs transfer control to a paragraph

- Which paragraphs does this paragraph transfer control to

Todisplay The View - Paragraph Cross Reference pop-up, follow this step:

» TypePREF on any screen or press Enter on the View - Paragraph Cross-Reference
Request pop-up. The View - Paragraph Cross Reference pop-up, shown in Figure 25,
displays.

Figure25« View - Paragraph Cross Reference Pop-up

View - Paragraph Cross Reference
Command ===> Scroll ===> CSR

Target(s): LABEL PROCEDURE
Direction: NEXT

A : Add to target P : Execute PREF S : Select for viewing
S Target paragraph(s) How Goes to
_ PROCEDURE DIVISION PERFORM PROGRAM-INIT
" " PERFORM POOO-NEXT

PROGRAM EXIT
BOTTOM OF DATA

To copy datato the List file, follow this step:

» Usethe LPRINT * command on this pop-up.
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Target(s)

Specifies the paragraph name(s) of the requested target.

Direction

Specifies the type of transfer. PREVIOUS highlights paragraphs
where control istransferred from and NEXT highlights paragraphs
where control is transferred to. The default is PREVIOUS.

Line command
area

Specifies the areato the left of the Comes from or Target
paragraph(s) field, which accepts these entries:

A Addsthe selected paragraph to the target paragraph(s). If the
directionisPREVIOUS, thetarget paragraph isadded at the top
of the list. If the direction is NEXT, the target paragraph is
added to the end of thelist.

P Executes another paragraph cross-reference.

S Returnsto the source code with the first line of the paragraph
displayed at the top of the screen.

Target
Paragraph(s)

The paragraphs requested as the target in the PREF command. Ditto
marks (') display when multiple paragraphs transfer control to the
same paragraph.

How

Indicates the way control is transferred from or to the target
paragraph.

If thetarget isreached through more than one occurrence of the same
transfer method, the number of occurrences, in parentheses, follows
the method of transfer. For example:

PERF(2), GO(3)

indicates that the target was reached through 2 PERFORMs and 3
GOTOs.

Note:

For acompletelist of paragraph control transfer methods and
abbreviations, see "Paragraph Control Transfer Methods' on

page 385.

Comes from

Displays when the direction is PREVIOUS. It lists the paragraph
namesthat transfer control to thetarget paragraph(s). All paragraphs
that relate to the target paragraph are grouped together.

Goesto

Displays when the direction isNEXT. It lists the paragraph names
that receive control from the target paragraph(s).
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View - Program Summary Pop-up

Fields

To select the type of summary information to view

1  Select View » Program Summary and press Enter. The View - Program Summary
pop-up, shown in Figure 26, displays.

Figure26« View - Program Summary Pop-up

Options
1

oOUTh WNP

View - Program Summary

Files

Data

Copy members
Sections
Control flow
CICS, DB2, etc.

2 Typethe number corresponding to the type of summary information you want to

view.

Each option on the View - Program Summary pop-up presents a collection of facts
about a particular program entity type, such as afile, dataitem, perform range, or
called subprogram. The default is Files. View the program summary information to
save time and facilitate decision making.

Files Displays the Program Summary - Files pop-up showing counts of
file usage and statements.
Data Displays the Program Summary - Data pop-up, that shows the

number of statementsthat include the various types of uses of data
items.

Copy members

Displays the Program Summary - Copy Members pop-up,
indicating the number of lines copied for all copy members.

Sections

Displaysthe Program Summary - Sections/Paragraphs pop-up, that
shows the number of linesin the various program sections and
paragraphs.
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Option Description

Control flow Displaysthe Program Summary - Control Flow pop-up, indicating
the number of each type of control flow statement.

CICS, DB2, etc. Displays the Program Summary - Preprocessor Statements pop-up
indicating the number of database statements, including SQL,
IDMS, CICS, and DL/I

Program Summary - Files Pop-up

To display file usage and statement counts, follow this step:

P Select View » Program Summary » Files and press Enter. The Program
Summary - Files pop-up, shown in Figure 27, displays.

Figure 27 « Program Summary Files Pop-up

Program Summary - Files

FD FD FD SD
Seq Rel Indx (Seq)
usage:
Input only . . . : 1 0 0 0
Output only . . : 2 0 0 0
Input/Output . . : 0 0 0 0
Total File Count . : 3 0 0 0
Input:
Statements . . . : 1 0 0 0
Paragraphs . . . : 1 0 0 0
Output:
Statements . . . : 10 0 0 0
Paragraphs . . . : 5 0 0 0
Fields
FD Seq Specifies File Descriptions (FDs) defined with ORGANIZATION IS
SEQUENTIAL inthe FILE-CONTROL paragraph.
RD Rel Specifies File Descriptions (FDs) defined with ORGANIZATION IS
RELATIVE in the FILE-CONTROL paragraph.
FD Indx Specifies File Descriptions (FDs) defined with ORGANIZATION IS
INDEXED in the FILE-CONTROL paragraph.
SD (Seq) Specifies Sort File Descriptions (SDs), categorized by Insight as

sequential files.
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Field Description

Input only Specifies the number of FD and SD definitions referenced only in
input (e.g., READ) statements.

Output only Specifies the number of FD and SD definitions referenced only in
output (e.g., WRITE) statements.

I nput/Output Specifies the number of FD and SD definitions referenced in both
input (e.g., READ) and output (e.g., WRITE, REWRITE) statements.

Total File Count Specifies the number of FD and SD definitionsin the FILE

SECTION.
[nput Specifies the number of statements that reference an FD or SD
Statements definition.
Paragraphs Specifies the number of paragraphs containing input statements that
reference an FD or SD definition.
Output Specifies the number of statements that reference an FD or SD
Statements definition.
Paragraphs Specifies the number of paragraphs containing output statements that

reference an FD or SD definition.
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Program Summary - Data Pop-up

Fields
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To display the number of statements that include the various dataitem typesin the

program, follow this step:

» Select View » Program Summary » Data and press Enter. The Program
Summary - Data pop-up, shown in Figure 28, displays.

Figure 28+« Program Summary - Data Pop-up

Total Count . . . :

Usage:

Redefines . . . . :
Modified, not used
Used, not modified
Indirect ref. only

Dead . . . . . .

Input statements :
Output statements :

Role:

SQL host variable :
Linkage . . . . . :

CALL ... Usin

g - :
in FD/RD/SD . . . :

Program Summary - Data
*

01/77 Subitem 88 COMP DISPLAY
24 133 1 10 0
: 1 0 0 0 0
7 81 0 2 0
7 22 1 1 0
4 19 0 0 0
: 3 4 0 2 0
1 0 0 0 0
10 0 (0] 1 0
0 0 0 0 0
: 1 3 0 1 0
3 2 0 1 0
2 24 0 0 0

ov77 Specifies the number of data variables defined as 01 or 77 level
data items.

Subitem Specifiesthe number of datavariables defined as subordinate to
01 level dataitems, with the exception of 88 level dataitems
that are counted separately.

88 Specifies the number of data variables defined as 88 level data
items.

COMP Specifies the number of data items defined with USAGE IS
COMP.

DISPLAY Specifies the number of data items defined with USAGE IS
DISPLAY.

Total Count Specifies the total number of data items defined as 01/77,
Subitem, 88, COMP, and DISPLAY .

Redefines Specifiesthe number of dataitems defined withaREDEFINES

clause.

Modified, not used

Specifies the number of dataitems modified but not used.




3 View

Used, not modified

Specifies the number of dataitems used but not modified.

Indirect ref. only

Specifies the number of dataitems referenced (i.e, used or
modified) through an dlias, e.g., aRENAME or REDEFINE.

Dead

Specifies the number of dataitems not used or modified,
directly or indirectly, in the program.

Input statements

Specifies the number of data items referenced in input
statements.

Output statements

Specifies the number of data items referenced in output
statements.

SQL host variable

Specifies the number of dataitems referenced in EXEC SQL
statements as host COBOL variables.

Linkage Specifies the number of dataitems appearing in the LINKAGE
section.

CALL ... Using Specifies the number of dataitems referenced in the USING
clause of CALL statements.

In FD/RD/SD Specifies the number of dataitems associated with an FD, RD,

or SD definition (i.e., the number of defining input/output
buffers).

Program Summary - Copy Members Pop-up

To display information about all COPY statementsin the program, including Librarian
-INC members, Panvalet ++INCLUDE members, and SQL INCLUDEsS, follow this step:

» Select View » Program Summary » Copy members and press Enter. The Program
Summary - Copy Members pop-up, shown in Figure 29, displays.

Figure29« Program Summary - Copy Members Pop-up

Command ===>

Program Summary - Copy Members

Scroll ===> CSR

Member Name

VIAIMAST

Lines Contents

24 01(1) OTHER-DATA(23)

BOTTOM OF DATA
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Fields

Field Description

Member Name  Specifies the member name asit displaysin the copy statement.

Lines Specifies the number of source lines copied for that member.

Contents Describes the overall contents of the copied member. These are the
valid descriptions:

- IDENTIFICATION DIVISION lines

- ENVIRONMENT DIVISION lines

- FD, SD, RD, and CD definitions

- 01, 88, and 77 level items

=  OTHER level items (i.e., 02 through 49 level)
- PROCEDURE DIVISION statements

«  Program elements from multiple DIVISIONs

Program Summary - Sections/Paragraphs Pop-up

52

To show the number of linesin the various program sections and paragraphs, follow this
step:

P Select View » Program Summary » Sections and press Enter. The Program
Summary - Sections/Paragraphs pop-up, shown in Figure 30, displays.

Figure 30+« Program Summary - Sections/Par agraphs Pop-up

Program Summary - Sections/Paragraphs
Location Lines
Data Division . . . . . . : 219
File Section . . . . . : 39
Working-Storage Section : 171
Linkage Section . . . . : 8
Procedure Division . . . : 266
Number of SECTIONs . . : 1
Number of labels . . . : 26
“EXIT only™ . . . . : 10
GOTO/ALTER targets . : 4
In-line code . . . . : 4
PERFORMed . . . . . : 22
Deadcode . . . . . . : 4
Number of statements . : 110
Within PERFORMs . . : 99
Deadcode . . . . . . : 4
Total . . . . . . . . . . : 496
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DataDivision  Specifiesthe total number of source lines, including comments, for
each of these sections:
-  File Section
<  Working-Storage Section
-  Linkage Section
Procedure Specifiesthe total number of PROCEDURE DIVISION sourcelines,
Division including comments. These subtotals are included:
«  Thenumber of SECTIONsin the PROCEDURE DIVISION.
e  Thenumber of paragraphsin the PROCEDURE DIVISION,
including these areas:
— the number of paragraphs containing only an EXIT
Statement
— and the number of paragraphs targeted by GO TO or
ALTER statements.
—  The number of paragraphs not reached via PERFORMs
(i.e., they execute as aresult of fall through code).
—  The number of paragraphs reached via PERFORMS.
—  Thenumber of paragraphscontaining dead code(i.e., code
that is never reachable).
The number of statements (not source lines) in the PROCEDURE
DIVISION areincluded for these statements:
e  Thenumber of statements executed by PERFORM statements.
=  Thenumber of unreachable statements.
Tota Specifies the number of source linesin the program, including

comment lines.
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Program Summary - Control Flow Pop-up

To show the number of each control flow statement type in the program, follow this step:

» Select View » Program Summary » Control flow and press Enter. The Program
Summary - Control Flow pop-up, shown in Figure 31, displays.

Figure3le Program Summary - Control Flow Pop-up

External CALL statements . . . .
Prograns CALLed . o & & . a &
PERFORM statedents o o o o 0 o« &
Murber of PERFORH ranges . . .

G0 TO statedents . & & & & & &«
HuHbetr of labels reached . . .

Hurber of ALTERed GO TOs . . .
AULti-way Branches  « o o o 0 w0«
GO TO...DEPENDING ON... . . .
EVALUATEw s« & & & & o & = &
OW COMDITION statedents . . . . &
End-of-file [AT ENDuual o o o

Frograd fumMary - Control Flow

Ranges PERFORHed HOPe than once . . &

Labels teackhed Wore than once . . . &

Other Input-Output cungirinnE

LI D DD

Fields

External CALL statements

Specifies the number of CALL statementsin the
PROCEDUREDIVISION. A subtotal of the number of
unique programs called isincluded.

PERFORM statements

Specifies the number of PERFORM statementsin the
program. Subtotals are included for the number of
unigue Perform Range targets and the number of
ranges performed multiple times.

GO TO statements

Specifies the number of GO TO statementsin the
program. Subtotals are included for the number of
uniquelabelsthat aretargets of GO TOs, the number of
labels that can be reached from multiple GO TOs, and
the number of GO TOs that are the targets of ALTER
statements.




3 View

Multi-way branches

Specifiesthe number of GO TO DEPENDING ON and
EVALUATE statements in the program. Subtotals are
included for the number of GO TO DEPENDING ON
and EVALUATE statements.

ON CONDITION statements

Specifies the number of statements containing
exception condition clauses, including SIZE,
OVERFLOW, INVALID KEY, NO DATA, END OF
PAGE, and END OF FILE. Subtotals are included for
the number of AT END condition statements, the
number of other 1/0 exceptions(e.g., INVALID KEY),
and the number of arithmetic exceptions (e.g., ON
OVERFLOW, ON SIZE ERROR, etc.).

Program Summary - Preprocessor Statements Pop-up

To display the number of database statements in the program, including SQL, IDMS,
CICS, and DL/I, follow this step:

» Select View » Program Summary » CICS, DB2, etc. The Program
Summary - Preprocessor Statements pop-up, shown in Figure 32, displays.

Figure 32+ Program Summary - Preprocessor Statements Pop-up

Program Summary - Preprocessor Statements
SQL IDMS  CICS DL/1
Usage:
Input only . . . : 7 0 N/A N/A
Output only .o 1 0 N/A N/A
Input/Output . . : 2 0 NZA N/A
Total Count . . . : 10 0 N/A N/A
Input:
Statements . . . : 2 0 0 0
Paragraphs . . . : 2 0 (0] 0
Output:
Statements . . . : 6 0 0 0
Paragraphs . . . : 5 0 0] 0
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SQL Specifies the number of Tables and Views referenced in EXEC SQL
statements.

IDMS Specifies the number of IDMS Record Names referenced in IDMS
COBOL statements.

CICS Specifies the number of EXEC CICS statements.

DL/I Specifies the number of EXEC DL/I statements, including CALL
'‘CBLTDLI' statements.

Input only Specifies the number of database definitions referenced only by
statements that query the database.

Output only Specifies the number of database definitions referenced only by
statements that update the database.

I nput/Output Specifiesthe number of database definitions referenced by statements
that query or update the database.

Total Count Specifies the number of database definitions.

Input Specifies the number of query-type statements that reference a

Statements database definition.

Input Specifiesthe number of paragraphs containing query-type statements

Paragraphs that reference a database definition.

Output Specifies the number of update-type statements that reference a

Statements database definition.

Output Specifiesthe number of paragraphs containing update-type statements

Paragraphs

that reference a database definition.




3 View

View - Levels Request Pop-up

To redisplay the current Tree View or Perform Structure View screen to the specified
level, follow this step:

P Select View » Levelsand press Enter. The View - Levels Request pop-up, shownin
Figure 33, displays.

Figure 33« View - Levels Request Pop-up

View - Levels Request
To re-build a Tree View or Structure View with a
different level of program hierarchy, type a
number or MAX. Then press Enter.

Levels 2 of 3 of depth

Field Description

Levels Specifies the number of hierarchical levelsto be displayed. Change
the level depth value to increase or decrease the amount of detail
displayed. The amount of detail increases asthe level depth increases.

Field

Thetotal number of levelsin the program displaysto the right of this
field. Type anumber egqual to or less than this number, or type the
value MAX to display al levels. The default is 2.
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View - Reset Request Pop-up

To remove highlighting, tags, messages, redisplay excluded lines, and cancel pending
line commands, follow this step:

P Select View » Reset and press Enter. The View - Reset Request pop-up, shown in
Figure 34, displays.

Figure 34« View - Reset Request Pop-up

E

Uiew - Resel Request

To reset sone or all program display features,
select an optian.

options

Then press Enter.

ALl

Highlights
Tags

Encluded lines
Line coHHands
Hezsages

Fields

All

Optional. If specified, al conditions indicated by each of the other
fields on thispop-up reset. If not specified, only those options selected
reset. The default isto reset all conditions.

Highlights

Optional. If specified, any line that was highlighted is returned to
nonhighlighted. If not specified, highlighted lines remain highlighted
unless the All option is specified. The default islines remain
highlighted.

Tags

Optional. If specified, tagsin the columns 73 through 80 are erased. If
not specified, tags remain unless the All option is specified. The
default is lines remain tagged.

Excluded lines

Optional. If specified, excluded lines redisplay. If not specified,
excluded linesremain excluded unlessthe All optionis specified. The
default is lines remain excluded.
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Line commands Optional. If specified, pending line commandscancel. If not specified,
pending line commands remain on the screen unless the All optionis
specified. The default is pending line commands remain displayed.

Messages Optional. If specified, short or long messages are removed from the
display. If not specified, messages remain displayed on the screen
unless the All option is specified. The default is messages remain
displayed.

View - Exclude Request Pop-up

To exclude lines from the screen display, follow this step:

» Select View » Exclude and press Enter. The View - Exclude Request pop-up, shownin
Figure 35, displays.

Figure35¢« View - Exclude Request Pop-up

Uiew - EHClude Request

To exdclude specific lines frodM the prograd being
viewed, select the desired option. Then press
Enter. For the "string” option, twpe the string
to be eHcluded.

options
1l 1. A1l lines
2. ALl highlighted lines
I. All non-highlighted lines
d. ALl lines containing a string

Ftring

A line of dashes and text stating n LINE(S) NOT DISPLAY ED represent excluded lines.
The Exclude action is valid on Source View and Tree View.
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Fields

Field Description

Options Specifies the lines to exclude from the screen display. These are the
valid options:
1. All Lines Excludes all lines from the screen
display. Thisisthe default.
2. All Highlighted Lines Excludes all lines highlighted as the

result of one or more actions or
commands from the screen display.

3. All Non-highlighted Lines  Excludes all non-highlighted lines
from the screen display.

4. All Lines Containing a String Excludesall linescontaining the string
specified in the String field. If this
Option is selected, the String field is
required.

String Required if Option 4 isselected. Typeastring of alphanumeric or DBCS
characters. Thisfield isignored if any other Option is selected.
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The Search facility enables you to find, highlight, scroll, print, punch, or exclude a
specified target. Depending on the value in the Action field and the current view screen,
these items can be atarget:

- Dataname

- Label name

- Paragraph name

- Pattern

- COBOL subset

- Perform range

- Program

e  User mark

«  Linenumber

The Search facility has three different viewsto assist you inisolating, understanding, and
identifying important sections of the source program. The three views, the Source View,
Tree View, and Perform Structure View, are created from the same original COBOL
source program, but present a different perspective. These views are concurrently

available and synchronized with the other views. Y ou can switch back and forth between
the views and retain the results of certain actions.

Search Actions

Find

62

Use the Find action to search the source code for one or all occurrences of the target. The
results are presented in these views:

Source View Positions the cursor at the first target in the specified
direction, highlights al occurrences found, and places tags
indicating the type of target found to the right of each
statement.

Tree View Positionsthe cursor at thefirst perform range containing the
target in atop/down manner, highlights all found
occurrences, and places tags indicating the type of target
found to the right of each statement.

Perform Structure View  Positionsthe cursor at thefirst perform range and highlights
all results found.




Highlight

Scroll

Print

4 Search

Use the Highlight action to highlight source code lines or boxes containing the specified
target. Previously highlighted lines or boxes remain unchanged. The results are presented
in these views:

Source View Positions the cursor at the first target in the specified
direction, highlights all occurrences found, and places tags
indicating the type of target found to the right of each
statement.

Tree View Positionsthe cursor at thefirst perform range containing the
target in a top/down manner, highlights all found
occurrences, and places tags indicating the type of target
found to the right of each statement.

Perform Structure View  Positionsthe cursor at thefirst perform range and highlights
all results found.

Use the Scroll action to position the screen to the line or box containing the target.
Previously highlighted lines or boxes remain unchanged. The results are presented in this
manner. The results for this action are the same in each view.

Note:
This action isvalid only on the Search - Any/Unknown Type pop-up for Tree View and
Perform Structure View.

Use the Print action to copy lines or boxes containing the specified target to the List file
for subsequent processing. The results for this Action are the same in each view.

Note:
Thisaction isvalid only on the Search - Any/Unknown Type pop-up for Tree View and
Perform Structure View.
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Punch

Exclude

Use the Punch action to copy lines or boxes containing the target to the Punch file for
subseguent processing. The results for this action are the samein each view.

Note:

This Action isvalid only on the Search - Any/Unknown Type pop-up for Tree View and
Perform Structure View.

Use the Exclude action to exclude source code lines containing the target. The results are
presented in these views:

View Description

Source View Searches the source code for one or al occurrences of the
target and omits the resulting source code lines.

TreeView Searches the source code for one or all occurrences of the
target and omits the resulting lines.

Perform Structure View  Searches the source code for one or al occurrences of the
target and positions the cursor to the first box containing an
excluded source code line.




Search Pull-down

Actions

4 Search

Use the Search pull-down shown in Figure 36 to conduct an intelligent source code
search for one or all occurrences of a specified target. This section describes the actions

available on the Search pull-down.
To display the Search pull-down, follow this step:

» Select Search on the action bar and press Enter.

Figure 36« Search Pull-down
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Copwright Allen &wstens Group, Inc., an unpublished work.

A proprietary product of AZG, Inc. Use restricted to authorized licensees.

Uizit the ASG Support Web Zite at www.asqg.cod

1. Data Displaysthe Search - Data Name pop-up used to search for dataitems.

2. Label Displaysthe Search - Label Name pop-up used to search for aspecified
label name.

3. Paragraph Displays the Search - Paragraph Name pop-up used to search for
statements in a paragraph.

4. String Displays the Search - Pattern String pop-up used to search for a
character string.

5. Subset Displaysthe Search - COBOL Subset Name pop-up used to search for
COBOL subsets.

6. Perform Displays the Search - Perform Range Name pop-up used to search for

statements within a perform range.
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7. Program Displays the Search - Program Name pop-up used to search for
statements in subprograms.

8. Mark Displays the Search - User Mark Name pop-up used to search for
statements in a set of marked lines.

9.Line Displaysthe Search - Line Range pop-up used to search for statements
within line ranges.

10. Any Displays the Search - Any/Unknown Type pop-up used to search for
targets when the type is unknown.

11. Branch Displays the Search - Branch Request pop-up used to branch to a

specific location.

Search - Data Name Pop-up

To find, highlight, scroll, print, punch, or exclude datanames, depending on the value in
the Action field and the current view screen, follow this step:

» Select Search P Data and press Enter. The Search - Data Name pop-up, shown in
Figure 37, displays.

Figure 37 ¢ Search - Data Name Pop-up

Type a data name and select search options. Then press Enter. For

Search - Data Name

enter a pattern (e.g. ABC*) in the name area.

a selection list,
Data name
References
1 1. All

2. Defs

3. Uses

4. Mods
Direction
1 1. All

2. Next

3. Previous

4. First

5. Last

Indirect impact Size change
1 1. None levels . . .
2. Of size change
3. Of value change

Options Action

No data aliasing 1 Find
IN-clause. .. 2. Highlight
Scroll
Print
Punch
Exclude

=

oUW
P
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Data name

Specifiesa COBOL dataname or qualified COBOL dataname. A
dataname refersto any valid COBOL reference for a data element.

To display the Selection List pop-up, leave the Data Name field blank or
type a pattern with wildcard characters [question mark (?) for one
character; asterisk (*) for zero or more characters).

Note:
See "Selection List Pop-ups' on page 96 for more information.

Datanames can be concatenated by placing a plus sign (+) between the
datanames.

References

Restricts the search to only those datanames that are defined, used, or
modified, when you specify thetype of datanamereference. Thesearethe
valid references:

1. All Includes occurrences of the dataname whereitsvalueis
defined, tested, used, set, or modified. Thisis the default.

2. Defs  Includes definitions of the dataname in the DATA DIVISION.

3. Uses Includes occurrences of the dataname where its value is being
tested or used.

4. Mods Includes occurrences of the dataname where its value is being
set or modified.

Indirect
impact

Expands the search to include occurrences of datanames indirectly
affected by the specified dataname. These are the valid values:

1. None Includes only occurrences of the dataname where it
isdirectly tested, used, set, modified, or defined
(based on the value of the Referencesfield). Thisis
the default.

2. Of sizechange Includes datanames that could be directly or
indirectly affected if the size of the specified
dataname were to be changed.

3. Of value change Includes datanames that could be directly or
indirectly affected if the value of the specified
dataname were to be changed.
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Size change
levels

Identifiesthe depth of theindirect impact of asize changethat isdesired.
When thisfield is used, all references affected within the specified level
show. If left blank, al levels are searched

Direction

Restricts the search to a specific direction or occurrence. These are the
valid values:

1. All Searches for al occurrences of the dataname and displays
the number found in the short/long message field. Thisis
the default.

2. Next Searches forward from a specified cursor position to the
next occurrence of the dataname. Next is valid on Source
View only.

3. Previous Searches backward from a specified cursor position to the
previous occurrence of the dataname. Previousisvalid on
Source View only.

4. First Searches from the top of the sourcefile to the first
occurrence of the dataname. First isvalid on Source View
only.

5. Last Searches backward from the bottom of the sourcefileto the
last occurrence of the dataname. Last is valid on Source
View only.

Options

No DataAliasing Specifiesthat aliases for the specified dataname are
ignored. If left blank, aliases of the dataname are
included. Thisisthe default.

Aliases include:

Parent higher level group item
Child lower level item
Rename/Redefinition  renamed, redefined, or 88
level items
IN-clause Optional. If specified, displaysthe IN-Clause Option

pop-up used to restrict the source lines or boxesto be
considered for asearch. If left blank, theentire source
code program is searched. The default is the entire
program. See"IN-Clause Option Pop-up" on page 97
for more information.
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Action

Optional. Specify the action to be performed on the dataname. These are
thevalid values:

Note:

Results depend on the current view screen. See "Search Actions' on
page 62 for more information.

1. Find

2. Highlight

3. Scroll

3. Print

4, Punch

5. Exclude

Searches for one or all occurrences of the dataname.
Double Byte Character Set (DBCS) identifiers or patterns
can be specified to locate DBCS strings. Find isthe default.

Highlights source code lines or boxes containing the
dataname. Lines or boxes already highlighted are not reset.

Positions the screen to the first line containing the
dataname. Previoudly highlighted lines remain unchanged.
Scroll isvalid on Source View only.

Copies lines containing the dataname to the List file. The
List fileis processed on the Options - Log/List/Punch
Definition pop-up. Print isvalid on Source View only.

Copieslines containing the datanameto the Punch file. The
Punch file is processed on the Options - Log/List/Punch
Definition pop-up. Punch isvalid on Source View only.

Omits source code lines containing occurrences of the
dataname from the display. In Perform Structure View, the
cursor is positioned to the first box representing alogical
program unit that contains an excluded source code line.
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Search - Label Name Pop-up

Use the Search - Label Name pop-up to find, highlight, scroll, print, punch, or exclude a
specified label name and all control transfers to that label name, depending on the value
in the Action field and the current view method.

To display the Search - Label Name pop-up, follow this step:

» Select Search P Label and press Enter. The Search - Label Name pop-up, shown in
Figure 38, displays.

Figure 38« Search - Label Name Pop-up

Search - Label Name

To find label name references, type a name and select search
options. Then press Enter. For selection list, type a pattern
(e.g. ABC*) in the name area.

Label name
Direction Options Action
1 1. All _ IN-clause... 1 1. Find
2. Next 2. Highlight
3. Previous 3. Scroll
4. First 4. Print
5. Last 5. Punch
6. Exclude

Fields

Label name  Required. Type any PROCEDURE DIVISION paragraph name or
section name. Y ou can also specify the PROCEDURE and PROC
literals.

To display the Selection List pop-up, leave the Label Namefield blank,
or enter a pattern with wildcard characters [question mark (?) for one
character; asterisk (*) for zero or more characters).

Note:
See "Selection List Pop-ups' on page 96 for more information.

L abel names may be concatenated by placing aplussign (+) between the
label names.
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Direction Restricts the search to a specific direction or occurrence. These are the
valid values:

1. All Searches for all occurrences of the label name and
displays the number found in the short/long message
field. Thisisthe default.

2. Next Searches forward from a specified cursor position to the
next occurrence of the label name. Next isvalid on
Source View only.

3. Previous  Searches backward from a specified cursor position to
the previous occurrence of the label name. Previousis
valid on Source View only.

4, First Searches from the top of the source file to the first
occurrence of the label name. First isvalid on Source
View only.

5 Last Searches backward from the bottom of the sourcefileto
the last occurrence of the label name. Last isvalid on
Source View only.

IN-clause Displays the IN-Clause Option pop-up used to restrict the source lines
or boxes to be considered for a search. If left blank, the entire source
code program is searched. The default is the entire program. See
"IN-Clause Option Pop-up" on page 97 for more information.

Action Specifies the action to be performed on the target. These are the valid

actions:

Note:

Results depend on the current view screen. See "Search Actions' on
page 62 for more information

1. Find Searches for one or all occurrences of the label name.
Thisisthe default.

2. Highlight  Highlights source code lines or boxes containing the
label name. Lines or boxes aready highlighted are not
reset.

3. Scrall Positions the screen to the first line containing the label

name. Previously highlighted lines remain unchanged.
Scroll isvalid on Source View only.

71



ASG-Insight Reference Guide

4. Print Copies lines containing the label name to the List file.
TheList fileis processed on the
Options - Log/List/Punch Definition pop-up. Print is
valid on Source View only.

5. Punch Copieslines containing the label name to the Punch file.
The Punch file is processed on the
Options - Log/List/Punch Definition pop-up. Punch is
valid on Source View only.

6. Exclude  Omitslines containing occurrences of the label name
from the display. In Perform Structure View, the cursor
is positioned to the first box representing alogical
program unit that contains an excluded source code line.

Search - Paragraph Name Pop-up

Use the Search - Paragraph Name pop-up to find, highlight, scroll, print, punch, or
exclude statements in a specified paragraph, depending on the value in the Action field
and the current view method.

To display Search - Paragraph Name pop-up, follow this step:

» Select Search P Paragraph and press Enter. The Search - Paragraph Name pop-up,
shown in Figure 39, displays.

Figure 39« Search - Paragraph Name Pop-up

Search - Paragraph Name
To find all statements in a paragraph, type a name and select the
search options. Then press Enter. For a name list, type a pattern
(e.g- ABC*) in the name area.

Paragraph name

Direction Options Action
1 1. All _ IN-clause... 1 1. Find
2. Next 2. Highlight
3. Previous 3. Scroll
4. First 4. Print
5. Last 5. Punch
6. Exclude
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Paragraph Name Specifies the name of the paragraph to search.

To display the Selection List pop-up, leavethe Paragraph Namefield
blank, or enter a pattern with wildcard characters [question mark (?)
for one character; asterisk (*) for zero or more characters).

Note:
See "Selection List Pop-ups' on page 96 for more information.

Paragraph names may be concatenated by placing aplus sign (+)
between the paragraph names.

Direction

Optional. The search can be restricted to a specific direction or
occurrence by specifying a direction. These are the valid values:

1 All Searches for all occurrences of the paragraph name
and displays the number found in the short/long
message field. Thisis the default.

2. Next Searches forward from a specified cursor position to
the next occurrence of the paragraph name. Next is
valid on Source View only.

3. Previous  Searches backward from a specified cursor position to
the previous occurrence of the paragraph name.
Previousisvalid on Source View only.

4. First Searches from the top of the source file to the first
occurrence of the paragraph name. First isvalid on
Source View only.

5. Last Searches backward from the bottom of the source file
to the last occurrence of the paragraph name. Last is
valid on Source View only.

IN-clause

Displays the IN-Clause Option pop-up used to restrict the source
lines or boxes to be considered for a search.

If left blank, the entire source code program is searched. The default
isthe entire program.

See "IN-Clause Option Pop-up" on page 97 for more information.
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Action

Specifies the action to be performed on the paragraph name. Results
depend on the current view screen. See "Search Actions' on page 62
for more information.

These are the valid values:

1. Find

2. Highlight

3. Scroll

4. Print

5. Punch

6. Exclude

Searches for one or all occurrences of the paragraph
name. Thisisthe default.

Highlights source code lines or boxes containing the
paragraph name. Lines or boxes already highlighted
are not reset.

Positions the screen to the first line containing the
paragraph name. Previously highlighted lines remain
unchanged. Scroll isvalid on Source View only.

Copieslines containing the paragraph nameto the List
file. The List fileis processed on the

Options - Log/List/Punch Definition pop-up. Print is
valid on Source View only.

Copies lines containing the paragraph name to the
Punch file. The Punch file is processed on the
Options - Log/List/Punch Definition pop-up. Punchis
valid on Source View only.

Omits lines containing occurrences of the paragraph
name from the display. In Perform Structure View, the
cursor is positioned to the first box representing a
logical program unit that contains an excluded source
codeline.




Search - Pattern String Pop-up

Fields

Figure 40, displays.

Figure40 e« Search - Pattern String Pop-up

To display the Search - Pattern String pop-up, follow this step:

4 Search

Use the Search - Pattern String pop-up to find, highlight, scroll, print, punch, or exclude a
pattern, depending on the value in the Action field and the current view method.

» Select Search » String and press Enter. The Search - Pattern String pop-up, shownin

Search - Pattern String
Type a string and select search options. Then press Enter.
String
String type Location
1 1. Simple 1 1. Any
2. Hexadecimal 2. Word
3. Text 3. Prefix
4. Picture 4. Suffix
Direction Options Action
1 1. All _ IN-clause... 1 1. Find
2. Next 2. Highlight
3. Previous 3. Scroll
4 First 4. Print
5 Last 5. Punch
6. Exclude
Begin column __ End column ___

String Required. Specifiesastring of alphanumeric or DBCS characters. Itis
not necessary to enclose the string in single or double quotes. All
characters are used for the pattern search.

String type Specifies the type of pattern string. These are the valid values:

1. Simple Indicates astring that is not ahexadecimal, text, or a

picture string. Thisisthe default.

2. Hexadecimal  Specific unprintable characters may be specified by

giving the EBCDIC hexadecimal value.

3. Text A character string may be entered regardless of
upper or lowercase by using the text option.
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4. Picture

Y ou may enter a string profile instead of exact
characters. Insight definesnine special charactersfor
usein picture strings. Y ou can combine these special
characters with other characters. These are the valid
special characters:

p= Any character

P-' Any non blank character
pP. Any non display character
P# Any numeric character
p-' Any character

P@  Any character

p< Any character

p>' Any character

P$ Any character

Location Specifies the location to search for the pattern string. These are the

valid values:

1. Any Specifies a string anywhere in the source code.

2.Word  Specifies astring preceded and followed by any

non-al phanumeric character (except hyphen).

3. Prefix  Specifies aword that begins with the specified string.

4. Suffix ~ Specifiesaword that ends with the specified string.
Direction Restricts the search to aspecific direction or occurrence. These arethe

valid values:

1. All Searchesfor all occurrences of the string and displaysthe

2. Next

3. Previous

number found in the short/long messagefield. Thisisthe
defaullt.

Searches forward from a specified cursor position to the
next occurrence of the string. Next is valid on Source
View only.

Searches backward from a specified cursor position to
the previous occurrence of the string. Previousisvalid on
Source View only.
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4. First Searches from the top of the source file to the first
occurrence of the string. First isvalid on Source View
only.

5. Last Searches backward from the bottom of the sourcefileto
the last occurrence of the string. Last isvalid on Source
View only.

IN-clause

Displaysthe IN-Clause Option pop-up used to restrict the source lines
or boxes to be considered for a search. If left blank, the entire source
code program is searched. The default is the entire program. See
"IN-Clause Option Pop-up” on page 97 for more information.

Action

Specifies the action to be performed on the string. These are the valid
values:

Note:

Results depend on the current view screen. See " Search Actions' on
page 62 for more information.

1. Find Searches for one or all occurrences of the string. Thisis
the default.

2. Highlight Highlights source code lines or boxes containing the
string. Linesor boxesthat are aready highlighted are not
reset.

3. Scrall Positionsthe screen to thefirst line containing the string.
Previously highlighted linesremain unchanged. Scroll is
valid on Source View only.

4. Print Copies lines containing the string to the List file. The
List fileis processed on the Options - Log/List/Punch
Definition pop-up. Print isvalid on Source View only.

5. Punch Copieslines containing the string to the Punch file. The
Punch fileis processed on the Options - Log/List/Punch
Definition pop-up. Punch isvalid on Source View only.

6. Exclude  Omitslinescontaining occurrencesof thestring fromthe
display. In Perform Structure View, the cursor is
positioned to thefirst box representing alogical program
unit that contains an excluded source code line.
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Field Description

Begin column  Specifiesthe column number where the search isto begin. The default
iscolumn 7.

End column Specifies the column number wherethe searchisto end. Thedefaultis
column 66.

Search - COBOL Subset Name Pop-up

Use the Search - COBOL Subset Name pop-up to find, highlight, scroll, print, punch, or
exclude statementsin COBOL subsets, depending on the value in the Action field and the
current view method.

To display the Search - COBOL Subset Name pop-up, follow this step:

» Select Search P Subset and press Enter. The Search - COBOL Subset Name pop-up,
shown in Figure 41, displays.

Figure4le Search - COBOL Subset Name Pop-up

Search - COBOL Subset Name

Type a subset name and select search options. Then press Enter.
For a selection list, type a pattern (e.g. ABC*) in the name area.

Subset name

Direction Options Action
1 1

1. All _ IN-clause... 1. Find
2. Next 2. Highlight
3. Previous 3. Scroll
4. First 4. Print
5. Last 5. Punch
6. Exclude
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Fields

Field Description

Subset name  Specifies the name of a predefined COBOL subset. Subsets can be
concatenated by placing a plus sign (+) between the subset names.

These are the predefined subsets:

ASsignment CAll Clcs

COBOLII COBOL/370 COMment
CONditional COPy DB2/SQL

DDL DEAD DEADCode
DEADData DEBug DEFinition
DIRective DIVision DL/I |DL/1
DML ENtry EXIt | PGMEXxit
FALLthrough GOto IDMS

INClude Input 10

LABd MAINIline MATH

Output PARagraph PERform
RETurn SECtion SORTMerge
STructure TESted UNTested
Note:

See the ASG-Insight User’s Guide for a description of each subset and
subset type.

A screen subset:

Highlighted | HI

NONHighlighted | NHI

Excluded | X

NONExcluded | NX

Tagged lines subsets of tags in columns 73 through 80.

To display the Selection List pop-up for subsets, leave the Subset name
field blank, or enter a pattern with wildcard characters [question mark
(?) for one character; asterisk (*) for zero or more characters).

See "Selection List Pop-ups' on page 96 for more information.
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Direction Restricts the search to a specific direction or occurrence. These are the
valid values:

1 All Searches for all occurrences of the subset and displays
the number found in the short/long messagefield. Thisis
the default.

2. Next Searches forward from a specified cursor position to the
next occurrence of the subset. Next isvalid on Source
View only.

3. Previous  Searches backward from a specified cursor position to
the previous occurrence of the subset. Previousisvalid
on Source View only.

4. First Searches from the top of the sourcefileto the first
occurrence of the subset. First isvalid on Source View
only.

5. Last Searches backward from the bottom of the sourcefile to
the last occurrence of the subset. Last isvalid on Source
View only.

IN-clause Displays the IN-Clause Option pop-up used to restrict the source lines
or boxes to be considered for a search. If left blank, the entire source
code program is searched. The default is the entire program.

See "|N-Clause Option Pop-up" on page 97 for more information.

Action Specifiestheaction to be performed on the subset. Resultsdepend on the
current view screen. See "Search Actions' on page 62 for more
information. These are the valid actions;

1. Find Searches for one or all occurrences of the subset. Thisis
the default.

2. Highlight  Highlights source code lines or boxes containing the
subset. Lines or boxes aready highlighted are not reset.

3. Scrall Positionsthe screen to thefirst line containing the subset.
Previously highlighted linesremain unchanged. Scroll is
valid on Source View only.

4. Print Copies lines containing the subset to the List file. The

List fileis processed on the Options - Log/List/Punch
Definition pop-up. Print isvalid on Source View only.
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Field Description

5. Punch Copieslines containing the subset to the Punch file. The
Punch file is processed on the Options - Log/List/Punch
Definition pop-up.

6. Exclude  Omitslines containing occurrences of the subset from
the display. In Perform Structure View, the cursor is
positioned at thefirst box representing alogical program
unit that contains an excluded source code line.

Search - Perform Range Name Pop-up

Use the Search - Perform Range Name pop-up to find, highlight, scroll, print, punch, or
exclude statements in a perform range, depending on the valuein the Action field and the
current view method.

To display the Search - Perform Range Name pop-up, follow this step:

» Select Search » Perform and press Enter. The Search - Perform Range Name pop-up,
shown in Figure 42, displays.

Figure 42« Search - Perform Range Name Pop-up

Search - Perform Range Name

Type a perfrange name and select search options. Then press Enter.
For a selection list, type a pattern (e.g. ABC*) in the name area.

Perfrange name

Direction Options Action
1 1. Al _  IN-clause... 1 1. Find
2. Next 2. Highlight
3. Previous 3. Scroll
4. First 4. Print
5. Last 5. Punch
6. Exclude
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Perfrange Name Specifiesthe namein a PERFORM statement, or the name of any
section contained in the DECLARATIVES.

To display the Selection List pop-up, leave the Perfrange Name

field blank, or enter a pattern with wildcard characters [question

mark (?) for one character; asterisk (*) for zero or more
characters]. See"Selection List Pop-ups' on page 96 for more
information.

Direction Restricts the search to a specific direction or occurrence. These
arethevalid values:

1. All Searches for all occurrences of the perform range
and displays the number found in the short/long
message field. Thisisthe default.

2. Next Searches forward from a specified cursor position
to the next occurrence of the perform range. Next
isvalid on Source View only.

3. Previous  Searches backward from a specified cursor
position to the previous occurrence of the perform
range. Previousisvalid on Source View only.

4. First Searches from the top of the sourcefile to the first
occurrence of the perform range. First isvalid on
Source View only.

5. Last Searches backward from the bottom of the source
file to the last occurrence of the perform range.
Last isvalid on Source View only.

IN-clause Displays the IN-Clause Option pop-up used to restrict the source

linesor boxesto be considered for asearch. If left blank, theentire
source code program is searched. The default is the entire
program. See "IN-Clause Option Pop-up" on page 97 for more
information.




4 Search

Field Description

Action Specifiesthe action to be performed on the perform range. Results
depend on the current view screen. See "Search Actions' on
page 62 for more information. These are the valid actions:

1. Find

2. Highlight

3. Scroll

4. Print

5. Punch

6. Exclude

Searchesfor one or all occurrences of the perform
range. Thisisthe default.

Highlights source code lines or boxes containing
the perform range. Lines or boxes already
highlighted are not reset.

Positions the screen to the first line containing the
perform range. Previously highlighted lines
remain unchanged. Scroll isvalid on Source View
only.

Copies lines containing the perform range to the
List file. The List fileis processed on the
Options - Log/List/Punch Definition pop-up. Print
isvalid on Source View only.

Copies lines containing the perform range to the
Punch file. The Punch file is processed on the
Options - Log/List/Punch Definition pop-up.
Punch isvalid on Source View only.

Omitslines containing occurrences of the perform
rangefromthedisplay. In Perform Structure View,
the cursor is positioned to the first box
representing alogical program unit that contains
an excluded source code line.
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Search - Program Name Pop-up

Use the Search - Program Name pop-up to find, highlight, scroll, print, punch, or exclude
statements in sub-programs, depending on the value in the Action field and the current
view method.

To display the Search - Program Name pop-up, follow this step:

» Select Search » Program and press Enter. The Search - Program Name pop-up, shown
in Figure 43, displays.

Figure43 e« Search - Program Name Pop-up

Search - Program Name
Type a (sub)program name and select search options. Then press
Enter. For a selection list, type a pattern (e.g. ABC*) in the name
area.

Program name

Direction Options Action

1 1. All _ IN-clause... 1 1. Find
2. Next 2. Highlight
3. Previous 3. Scroll
4. First 4. Print
5. Last 5. Punch
6. Exclude

Fields

Program name Specifies the name of the main program or any nested program.

To display the Selection List pop-up, |eave the Program name field
blank, or enter a pattern with wildcard characters [question mark (?)
for one character; asterisk (*) for zero or more characters]. See
"Selection List Pop-ups' on page 96 for more information.

Program names may be concatenated by placing a plus sign (+)
between the program names.

Direction Restricts the search to a specific direction or occurrence. These are
thevalid values:

1. All Searches for all occurrences of the program name
and displays the number found in the short/long
message field. Thisisthe default.

2. Next Searchesforward from aspecified cursor position to
the next occurrence of the program name. Next is
valid on Source View only.




4 Search

3. Previous

4, First

5. Last

Searches backward from a specified cursor position
to the previous occurrence of the program name.
Previousisvalid on Source View only.

Searches from the top of the source file to the first
occurrence of the program name. First isvalid on
Source View only.

Searches backward from the bottom of the source
fileto thelast occurrence of the program name. Last
isvalid on Source View only.

IN-clause Displays the IN-Clause Option pop-up used to restrict the source
lines or boxes to be considered for a search. If left blank, the entire
source code program is searched.

Thedefaultistheentire program. See"IN-Clause Option Pop-up” on
page 97 for more information.

Action Specifies the action to be performed on the program name. Results

depend on the current view screen. See ' Search Actions' on page 62
for more information. These are the valid actions:

1. Find

2. Highlight

3. Scroll

4. Print

Searches for one or all occurrences of the program
name. Thisisthe default.

Highlights source code lines or boxes containing the
program name. Lines or boxes already highlighted
are not reset.

Positions the screen to the first line containing the
program name. Previously highlighted lines remain
unchanged. Scroll isvalid on Source View only.

Copies lines containing the specified target to the
List file. The List file the Options - Log/List/Punch
Definition pop-up. Print isvalid on Source View
only.
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5. Punch Copies lines containing the specified target to the
Punch file. The Punch file is processed on the
Options - Log/List/Punch Definition pop-up. Punch
isvalid on Source View only.

6. Exclude Omits lines containing occurrences of the program
name from the display. In Perform Structure View,
the cursor is positioned to the first box representing
alogical program unit that contains an excluded
source cade line.

Search - User Mark Name Pop-up

Use the Search - User Mark Name pop-up to find, highlight, scroll, print, punch, or
exclude sets of marked lines, depending on the value in the Action field and the current
view method.

To display the Search - User Mark Name pop-up, follow this step:

P Select Search » Mark and press Enter. The Search - User Mark Name pop-up, shown
in Figure 44, displays.

Figure44 « Search - User Mark Name Pop-up

Search - User Mark Name

Type a mark name and select search options. Then press Enter. For
a selection list, type a pattern (e.g. ABC*) in the name area.

Mark name
Direction Options Action
1 1. All _  IN-clause... 1 1. Find
2. Next 2. Highlight
3. Previous 3. Scroll
4. First 4. Print
5. Last 5. Punch
6. Exclude
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4 Search

Mark name

Specifiesa 1 to 10 aphanumeric character name given to a set or path.

To display the Selection List pop-up, leave the Mark Name field blank or
enter a pattern with wildcard characters [question mark (?) for one
character; asterisk (*) for zero or more characters).

See "Selection List Pop-ups' on page 96 for more information.

Direction

Restricts the search to a specific direction or occurrence. These are the

valid values:

1. All Searchesfor all occurrences of the mark name and displays
the number found in the short/long message field. Thisis
the default.

2. Next Searches forward from a specified cursor position to the
next occurrence of the mark name. Next isvalid on Source
View only.

3. Previous  Searches backward from a specified cursor position to the
previous occurrence of the mark name. Previousisvalid on
Source View only.

4. First Searches from the top of the sourcefileto the first
occurrence of themark name. Firstisvalid on SourceView
only.

5. Last Searches backward from the bottom of the sourcefileto the
|ast occurrence of the mark name. Last is valid on Source
View only.

IN-clause

Displaysthe IN-Clause Option pop-up used to restrict the source lines or
boxes to be considered for a search. If left blank, the entire source code
program is searched. The default isthe entire program. See "IN-Clause
Option Pop-up" on page 97 for more information.

Action

Specifies the action to be performed on the mark name. Results depend
on the current view screen. See "Search Actions' on page 62 for more
information. These are the valid actions:

1. Find Searches for one or all occurrences of the mark name.
Thisisthe default.

2. Highlight  Highlights source code lines or boxes containing the
mark name. Lines or boxes already highlighted are not
reset.
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Search - Line Range Pop-up

88

3. Scroll

4, Print

5. Punch

6. Exclude

Positions the screen to the first line containing the mark
name. Previously highlighted lines remain unchanged.
Scroll isvalid on Source View only.

Copies lines containing the mark name to the List file.
The List fileis processed on the

Options - Log/List/Punch Definition pop-up. Print is
valid on Source View only.

Copieslines containing the mark nameto the Punch file.
The Punch fileis processed on the

Options - Log/List/Punch Definition pop-up. Punchis
valid on Source View only.

Omits lines containing occurrences of the mark name
from the display. In Perform Structure View, the cursor
is positioned to the first box representing alogical
program unit that contains an excluded source code line.

Use the Search - Line Range pop-up to find, highlight, scroll, print, punch, or exclude a
single line or range of lines, depending on the value in the Action field and the current

view method.

To display the Search - Line Range pop-up, follow this step:

» Select Search P Line and press Enter. The Search - Line Range pop-up, shownin

Figure 45, displays.

Figure45 e« Search - Line Range Pop-up

1

Line range

Direction

Search - Line Range

Type a line range (or line) and select search options. Then press
Enter.

b wWNE

Options

Previous

Action
_ IN-clause... 1 1. Find
2. Highlight
3. Scroll
4. Print
5. Punch
6. Exclude




Fields

4 Search

Line Range Specifies asingle line number or range of lines. Line numbers display
in columns 1 through 6 of the Source View.

Direction Restricts the search to a specific direction or occurrence. These are the
valid vaues:

1. All Searches for al occurrences of the line range and
displays the number found in the short/long message
field. Thisisthe default.

2. Next Searches forward from a specified cursor position to the
next occurrence of thelinerange. Next isvalid on Source
View only.

3. Previous  Searches backward from a specified cursor position to
the previous occurrence of the line range. Previousis
valid on Source View only.

4. First Searches from the top of the sourcefile to the first
occurrence of the line range. First isvalid on Source
View only.

5. Last Searches backward from the bottom of the sourcefileto
the last occurrence of the line range. Last isvalid on
Source View only.

IN-clause Displays the IN-Clause Option pop-up used to restrict the source lines
or boxesto be considered for a search. If Ieft blank, the entire source
code program is searched. The default is the entire program. See
"IN-Clause Option Pop-up" on page 97 for more information.

Action Specifies the action to be performed on the line range. These are the

valid actions:
1. Find

2. Highlight

Searches for one or all occurrences of the line range.
Thisisthe default.

Highlights source code lines or boxes containing the
line range. Lines or boxes aready highlighted are not
reset.
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3. Scroll

4. Print

5. Punch

6. Exclude

Positions the screen to thefirst line containing the line
range. Previously highlighted lines remain unchanged.
Scroll isvalid on Source View only.

Copies lines containing the line range to the List file.
TheList fileis processed on the

Options - Log/List/Punch Definition pop-up. Printis
valid on Source View only.

Copieslinescontaining thelinerangeto the Punchfile.
The Punch fileis processed on the

Options - Log/List/Punch Definition pop-up. Punchis
valid on Source View only.

Omits lines containing occurrences of the line range
from the display. In Perform Structure View, the
cursor is positioned to the first box representing a
logical program unit that contains an excluded source
code line.

Results depend on the current view screen. See "Search Actions' on
page 62 for more information.




4 Search

Search - Any/Unknown Type Pop-up

Fields

Use the Search - Any/Unknown Type pop-up to find, highlight, scroll, print, punch, or
exclude targets when the type is unknown, does not fit one of the predefined categories,
or isacombination of predefined categories.

To display the Search - Any/Unknown Type pop-up, follow this step:

P Select Search » Any and press Enter. The Search - Any/Unknown Type pop-up, shown
in Figure 46, displays.

Figure46 e« Search - Any/Unknown Type Pop-up

Search - Any/Unknown Type

To find references to a target of "unknown" type (data, label,
etc.), type the target and select search options. Then press Enter

Target
Direction Options Action
1 1. Al _  IN-clause... 1 1. Find
2. Next 2. Highlight
3. Previous 3. Scroll
4. First 4. Print
5. Last 5. Punch
6. Exclude

Target Specifies the name of the target. Target names can be concatenated by
placing aplus sign (+) between them. To reuse the target of the previous
search, type an asterisk (*) in the Target field.

For COBOL Il Release 3 or later programs, a dataname that may be
ambiguous or used multipletimes can be qualified by using OF followed by
the program name.

Direction Indicates the direction for the search. These are the valid values:

1. All Searches for all occurrences of the target and displays the
number found in the short/long message field. Thisisthe
default.

2. Next Searches forward from a specified cursor position to the

next occurrence of the target.

3. Previous Searches backward from a specified cursor position to the
previous occurrence of the target.
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4, First

5. Last

Searches from the top of the sourcefile to the first
occurrence of the target.

Searches backward from the bottom of the sourcefileto the
last occurrence of the target.

IN-clause Displays the IN-Clause Option pop-up used to restrict the source lines or
boxes to be considered for a search. If left blank, the entire source code
program is searched. The default is the entire program. See "IN-Clause
Option Pop-up" on page 97 for more information.

Action Specifies the action to be performed on the target. Results depend on the
current view screen. See "Search Actions' on page 62 for more
information. These are the valid actions:

1. Find

2. Highlight

3. Scroll

4, Print

5. Punch

6. Exclude

Searches for one or al occurrences of the specified
target.

Highlights source code lines or boxes containing the
specified targets. Lines or boxes already highlighted are
not reset.

Positionsthe screen to thefirst line or box containing the
specified target. Previously highlighted lines or boxes
remain unchanged.

Copies lines or boxes containing the specified target to
theList file. The List fileis processed on the
Options - Log/List/Punch Definition pop-up.

Copies lines or boxes containing the specified target to
the Punch file for subsequent processing. The Punch file
is processed on the Options - Log/List/Punch Definition

pop-up.

Omitslines containing occurrences of thetarget fromthe
display.
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Search - Branch Request Pop-up

To position the cursor at the target on the Source View screen, follow this step:

» Select Search » Branch and press Enter. The Search - Branch Request pop-up, shown

in Figure 47, displays.

Figure 47« Search - Branch Request Pop-up

Option

Target name

Search - Branch Request

To branch to another area of the program, select the Option desired
For Option 1, type the branch location (Target) information. Then
press Enter. For a name selection list (for Target type 2, 3 or 4),
type a pattern (e.g. ABC*) in the name field.

1 1. Branch to target
2. Return to previous "Branch to target'" location
3. Branch to transfer(s) of control to cursor position

Target type

2. Label name
3. Perfrange name
4. Program name

1 1. None - use cursor

Fields

Option

Branch to target

Return to branch
|ocation

Display all
transfers of control
to cursor position

Specifies the type of branch to perform. These are the valid options:

Positions the cursor to the name specified in the Target name field. If
you select this Option, the Target name field is required. Thisisthe
default.

Positions the cursor to the statement from where the previous branch
occurred.

Redisplays the Source View screen with along message telling you to
position the cursor to the desired branch location and press Enter. The
cursor is positioned to the statement that branches to the specified
branch location.

If more than one statement transfers control to the specified branch
location, the Branch Previous Options pop-up displays allowing you to
select the desired statement.

If this Option is selected, the Target name and Target type fields are
invalid.
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Target name

Required if Option 1 is selected. Type a Perform Range name, label
name, paragraph name, or section name. For COBOL |l Release 3 or
later programs, you can al so enter a subprogram name.

For Perform Ranges and label names, if the specified nameis not fully
gualified and there are multiple Perform Ranges or labels with the
specified name, the cursor is positioned on the first statement found.

For COBOL Il Release 3 or later programs, a dataitem, label or
program name that may be ambiguous or used multiple times can be
qualified by using OF followed by the program name.

To display the Selection List pop-up, leave the Target name blank or
enter a pattern with wildcard characters [question mark (?) for one
character; asterisk (*) for zero or more characters], and select Target
type2, 3, or 4. Onthe Selection List pop-up, select the desired name by
typing S next to the desired name. See "Selection List Pop-ups' on
page 96 for more information.

Target type

None - Use Cursor

Label Name

Perfrange Name

Subprogram Name

Specifiesthe number of the target type corresponding to the entry in the
Target namefield. Thisfield isvalid for Option 1 only. These are the
valid target types.

Redisplays the Source View screen with along message stating to
position the cursor to the selected statement and press Enter. Thisisthe
default.

If the statement isa GO TO, PERFORM, or internal CALL, the cursor
is positioned to the target of that statement. If you select any other
statement type, the cursor is positioned to the next sequentia statement
to be executed. The PROCEDURE DIVISION label islocated if the
cursor is positioned outside the PROCEDURE DIVISION

Positions the cursor to the specified paragraph or section name. If the
specified nameis not fully qualified and there are multiple paragraphs
or sections with the specified name, the cursor is positioned to the first
paragraph or section found.

Positions the cursor to the specified Perform Range. If the specified
nameis not fully qualified and there are multiple Perform Ranges with
the specified name, the cursor is positioned to the first Perform Range
found.

Positions the cursor to the specified nested program. For COBOL 1|
Release 3 and later programs, adataitem, label, or program name that
may be ambiguous or used multiple times can be qualified by using OF
followed by the program name.
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Branch Previous Options Pop-up

Fields

To select a statement for branching, follow this step:

» Type BRANCH PREVI0US. This pop-up displays when more than one statement
transfers control to the specified branch location on the Search - Branch Request
pop-up. The Branch Previous Options pop-up, shown in Figure 48, displays.

Figure 48+ Branch Previous Options Pop-up

Branch Previous Options LINE 1 OF 3
Command ===> Scroll ===> CSR

Select the statement to be viewed. Then press Enter.

S Line Source statement.

_ 000300 PERFORM P999-ABEND-PROGRAM.
_ 000302 PERFORM P999-ABEND-PROGRAM.
_ 000448 PERFORM P999-ABEND-PROGRAM

BOTTOM OF DATA

When this pop-up first displays, the short message field indicates the number of
statements found.

Field Description

Line command area The areato the left of the Line field, which acceptsthe Sline
command. Type S to select the identified source statement
and to position the cursor to that statement on the Source

View screen.
Line Specifies the source statement line number.
Source statement Specifies the source code statement.
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Selection List Pop-ups

To display the Selection List pop-up
1 Leave the name field blank.

Or

Enter a pattern with wildcard characters [question mark (?) for one character;
asterisk (*) for zero or more characters] in the name field. The Selection List
pop-up, shown in Figure 49, displays.(The selection list pop-ups are the same

except for the type of list displayed.)

Selection list pop-ups are available for the data, perform range, paragraph, program,

mark, subset, and branch searches.

Figure49 e« Selection List - Data Names Pop-up

Command ===>

Selection List - Data Names

(%]

Data name

ABEND-CODE
ADDRESS1
AREA-CODE
AVG-AMT (DEAD)
BILLING-DAYS
CHECK-CODE (DEAD)
cITyY

CLIENT-ID
CONSOLE
CUR-PREFIX
CURRENT-ZIP-DATA
CUSTOMER-ID
DBA-DEPT-CODE
DEBUG-PARM
DET-ADDRESS
DET-AREA-CODE
DET-BILLING-DAYS

Scroll ===> CSR

2  Sdlect aname from thelist by typing S in the line command area. Y ou can select

more than one name on these pop-ups:

<  Selection List - Data Names

=  Sdection List - Label/Paragraph Names
Selection List - Subset Names

«  Selection List - Program Names

3  PressEnter to redisplay the Search pop-up with the selected name(s) in the

appropriate field.
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Fields

4 Search

To restrict the source lines considered for a search, follow this step:

» Specify the N-clause option on a Search pop-up. The IN-Clause Option pop-up, shown

in Figure 50, displays.

Figure50 ¢ IN-Clause Option Pop-up

Line range

IN-Clause Option

To restrict the source lines to be considered, type one or more
IN-Clause names. Then press Enter.

For a selection list, type a
pattern in the appropriate name field.

Subset name . . .

Paragraph Name

Perfrange name

Program name

User MARK name .

Linerange Specifies asingle line number or range of lines.
Subset name Specifies a predefined COBOL language subset name. These are the
valid subsets:
ASsignment CAll Clcs
COBOLII COBOL/370 COMment
CONditional COPy DB2/SQL
DDL DEAD DEADCode
DEADData DEBug DEFinition
DIRective DIVision DL/l | DL/1
DML ENtry EXIt | PGMEXit
FALLthrough GOto IDMS
INClude Input 10
LABé MAINline  MATH
Output PARagraph  PERform
RETurn SECtion SORTMerge
STructure TESted UNTested
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Note:

See the ASG-Insight User’ s Guide for a description of each subset
and subset type

A screen subset:

Highlighted | HI

NONHighlighted | NHI

Excluded | X

NONExcluded | NX

Tagged lines subsets of tags in columns 73 through 80.

Paragraph SpecifiesaPROCEDURE DIVISION paragraph or section name. The
Name PROCEDURE and PROC literals can also be specified.

Perfrange name Optional. Type the name specified in aPERFORM statement or the
name of any section contained in the DECLARATIVES. The search
includes all statements executed as a result of the PERFORM
Statement.

Programname  Optional. Type the name of the main program or any nested program.
The search includes al code contained in the program, including all
programs physically nested inside the specified program.

In most cases, you may specify any combination of IN-clause options. However, some
Insight-defined mark names are incompatible with other logical sets of COBOL
statements and the combinations are not allowed.

All fields on this pop-up are optional. If al fields areleft blank, the searchis not restricted
(i.e., the entire program is searched).



Logic

This chapter describes items on the Insight Logic menu and contains these sections:

Logic Pull-down 101
Logic Order Search - Data Name Pop-up 102
Logic Order Search - Label Name Pop-up 105
Logic Order Search - COBOL Subset Name Pop-up 107
Logic Order Search - Perform Range Name Pop-up 110
Logic Order Search - User Mark Name Pop-up 112
Logic Order Search - Subprogram Name Pop-up 114
Logic Order Search - Line Number Range Pop-up 116
Selection List Pop-ups 118
Logic Order Search - Trace IN-Clause Option Pop-up 119

TheLogic facility isaconvenient way to view pathsin logical execution order, and to see
how and where specific information is used. The logic order search displays resultsin
these three ways:

=  Show references only- highlights the targets on the path from the starting point to
where the logic order search ends. For example, if the target is Data name and Uses
is selected for References with Forward as the Direction, the highlighted result
would be all the COBOL source statements where a USE of this dataname exists
and are reachable in execution order from the starting point.
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Show execution path(s) from starting point to reference(s) - highlights all
executabl e statements on the path from the starting point to where the logic order
search ends. This path of executable statements from the starting point to each of
the resulting targetsis retained in a path named NETWORK. NETWORK has all
the paths that take you from the starting point of the logic order search to al the
results. The parts of NETWORK that go to the individual results are |abeled
SUBNET1 through SUBNETN, where n isthe number of results that were found.

A new NETWORK is created each time you use this Action. Use the Scratchpad
pop-ups or the MARK command to copy and save aNETWORK.

Y ou can use saved paths for additional analysis when they are used as targets for
other Source View searches or commands.

Trace (single-step) - stops at each conditional statement on the path from the
starting point to the target of the search. A message indicates the reason for
stopping. For adecision point, the line number where the trace function stopped and
the line number to with continue are shown.

All executable statements in the path between a decision and a new decision point
are highlighted. This path of executable statementsis retained in a path named
TRACK. A new TRACK is created each time this Action is used. The Scratchpad
pop-ups or MARK command can be used to copy and save a TRACK.

This table contains information tags displayed in columns 73 through 80 for each
highlighted line:

DECISION Specifies the decision point.

STOP PNT Specifies the intermediate (informational) stopping point.
START Specifies the beginning of the trace function.

OPTION n Specifies the option choice.

TARGET Specifies the destination of the trace function.

Multiple information tags on aline are separated with aforward slash (/).
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Logic Pull-down

To follow program execution or search for a specified target, follow this step:

» Select Logic on the action bar and press Enter. The Logic pull-down, shown in
Figure 51, displays.

Figure51« Logic Pull-down

File Wiew 3Zearch Logic Task List Options Help

_ 1. Data... nder=tandi ng
CodHand ===k ______ 2. Label...
3. Eubset...
detetek d. Perford...
Hetdetebk Se Hatkaaa
etttk E. Prograd... etttk
Hetototok Tu LiNEaus Hebottok
etetotok etetotok e etk
EEE EEE B Hepok
stebetetoh
steteddok

Copyright ALlen Systens Group, IncC., an unpublished wark.
A proprietary product of A%G, Inc. Use restricted to authorized licensess.
Visit the ASE Support Web Tite at wuw,asg.cod

Actions

1. Data Displaysthe Logic Order Search - Data Name pop-up used to follow
program logic to a specific dataname.

2. Labd Displaysthe Logic Order Search - Label Name pop-up used to follow
program logic to a specific label name.

3. Subset Displaysthe Logic Order Search - COBOL Subset Name pop-up used
to follow program logic to a COBOL subset.

4. Perform Displaysthe Logic Order Search - Perform Range Name pop-up used
to follow program logic within a perform range.

5. Mark Displays the Logic Order Search - User Mark Name pop-up used to
follow program logic within a marked set of lines.
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6. Program Displaysthe Logic Order Search - Subprogram Name pop-up used to
follow program logic in subprograms.

7.Line Displays the Logic Order Search - Line Number Range pop-up used
to follow program logic within ranges of lines.

Logic Order Search - Data Name Pop-up

To follow program logic to a specific dataname, follow this step:

» Select Logic » Dataand press Enter. The Logic Order Search - Data pop-up, shown in
Figure 52, displays.

Figure52« Logic Order Search - Data Name Pop-up

Logic Order Search - Data Name

To find data name references in execution order, type the name and
starting point, and select search options. Then press Enter. For a
data or label name selection list, type a pattern (e.g. ABC*) in the
appropriate input area.

Data name

Start line/label (if any)

References Direction Options
1 1. Al 1 1. Next _ Trace
2. Uses only 2. Previous IN-clause. ..
3. Mods only 3. Forward (all)
4. Backward (all)

1 1. Show data name reference(s)
2. Show execution path(s) from starting point to reference(s)
3. Trace (single-step) from starting point to reference(s)
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5 Logic

Data name

Specifiesa COBOL dataname or qualified COBOL dataname.
Dataname refers to any valid COBOL reference for a data element.

To display the Selection List pop-up, leave the Data name field blank
or enter a pattern with wildcard characters [question mark (?) for one
character; asterisk (*) for zero or more characters).

See "Selection List Pop-ups' on page 118 for more information.

Start line/label

Specifies the line number or label name from where to begin the
search.

To use cursor position for the beginning of the search, leave thisfield
blank. A message prompting you to verify cursor position displays.

To display the Selection List pop-up, enter a pattern with wildcard
characters[question mark (?) for one character; asterisk (*) for zero or
more characters].

See "Selection List Pop-ups' on page 118 for more information.

References

Restricts the trace to only those datanames that are defined, used, or
modified, by specifying thetype of datanamereferences. These arethe
valid values:

1. All Includes occurrences of the dataname where its value
is defined, tested, used, set, or modified. Thisisthe
defauilt.

2. Usesonly  Includes occurrences of the dataname whereits value
is being tested or used.

3. Modsonly Includes occurrences of the dataname whereits value
is being set or modified.

Direction

Optional. Thelogical search can berestricted to a specific direction or
occurrence by specifying a direction. These are the valid values:

1. Next Searchesor tracesforward from the starting point to the
next occurrence of the target in each execution path.
Thisisthe default.

2. Previous  Searches or traces backward from the starting point to
the previous occurrence of the target in each execution
path.

3. Forward  Searchesor tracesforward from the starting point to all
occurrences of the target.

4. Backward Searches or traces backward from the starting point to
all occurrences of the target.

103



ASG-Insight Reference Guide

Direction Description

TraceIN-Clause Displaysthe Logic Order Search - Trace IN-Clause Option pop-up to
narrow the scope of the logic order trace to a specified perform range
or marked set of lines. If not specified, the scope includes the entire
program. Y ou can only use this option if you selected number 3 for
Action. The default is the entire program is used for the trace.

See "Logic Order Search - Trace IN-Clause Option Pop-up” on
page 119 for more information.

Action Specifies how to display the results logic order search results. These
arethevalid actions:

1. Show Data Name Reference(s)

Highlights only the datanames on the path from the starting point
to where the logic order search ends. Thisis the default.

2. Show Execution Path(s) from Starting Point to Reference(s)

All executabl e statements on the path from the starting point to
where the logic order search stops are highlighted.

3. Trace (single-step) from Starting Point to Reference(s)

Thelogic order search stops at all conditional statements on the
path from the starting point to the target of the search.
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Logic Order Search - Label Name Pop-up

Fields

To follow program logic to a specific label name, follow this step:

» Select Logic » Label and press Enter. The Logic Order Search - Label Name pop-up,
shown on Figure 53, displays.

Figure53« Logic Order Search - Label Name Pop-up

Label name

Logic Order Search - Label Name

To find label references in execution order, type the label and
starting point, and select search options. Then press Enter. For a
label name selection list, type a pattern (e.g. ABC*) in the
appropriate input area.

Direction
1 1. Next

Action

Start line/label (if any)

2. Previous
3. Forward (all)
4. Backward (all)

1 1. Show label name reference(s)
2. Show execution path(s) from starting point to reference(s)
3. Trace (single-step) from starting point to reference(s)

Options
Trace IN-clause...

Label name

Specifiesany PROCEDURE DIVISION paragraph name or section
name. The PROCEDURE and PROC literals can also be specified.

To display the Selection List pop-up, leave the Label name field
blank or enter a pattern with wildcard characters [question mark (?)
for one character; asterisk (*) for zero or more characters).

See "Selection List Pop-ups' on page 118 for more information.

Start line/label

Specifies the line number or label name from where to begin the
trace.

To use cursor position for the beginning of the search, leave this
field blank. A message prompting you to verify cursor position
displays.

To display the Selection List pop-up, enter a pattern with wildcard

characters[question mark (?) for one character; asterisk (*) for zero
or more characters].

See "Selection List Pop-ups' on page 118 for more information.
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Direction

Restricts the logical search to a specific direction or occurrence.
These are the valid values:

1. Next Searches or traces forward from the cursor position
to the next occurrence of the target. Thisisthe
default.

2. Previous  Searchesor traces backward from the cursor position
to the previous occurrence of the target.

3. Forward  Searches or traces forward from the cursor position
to all occurrences of the target.

4. Backward Searchesor traces backward from the cursor position
to all occurrences of the target.

Trace IN-clause

Displaysthe Logic Order Search - Trace IN-Clause Option pop-up
to narrow the scope of the logic order search to a specified perform
range or marked set of lines. If not specified, the scope includesthe
entire program. This option can only be used if number 3isselected
for Action. The default is the entire program is used for the trace.

See "Logic Order Search - Trace IN-Clause Option Pop-up" on
page 119 for more information.

Action

Specifies how to display the results of thelogic order search. These
arethevalid actions:

1. Show Label Name Reference(s)

Only thetargets on the path from the starting point to where the
logic order search ends are highlighted. This is the default.

2. Show Execution Path(s) from Starting Point to Reference(s)

All executabl e statements on the path from the starting point to
where the logic order search stops are highlighted.

3. Trace (single-step) from Starting Point to Reference(s)

Thelogic order search stopsat all conditional statementsonthe
path from the starting point to the target of the search.




Logic Order Search - COBOL Subset Name Pop-up

Fields

To follow program logic to a COBOL subset, follow this step:

5 Logic

» Select Logic» Subset and press Enter. The Logic Order Search - COBOL Subset Name

pop-up, shown in Figure 54, displays.

Figure54 « Logic Order Search - COBOL Subset Name Pop-up

ABC*) in the appropriate input area.

Subset name

Logic Order Search - COBOL Subset Name

To find subset references in execution order, type the subset name
and starting point, and select search options. Then press Enter.
For a subset or label name selection list, type a pattern (e.g.-

Start line/label (if any)

Direction Options

1 1. Next _  Trace IN-clause...
2. Previous
3. Forward (all)
4. Backward (all)

Action
1 1. Show subset name reference(s)

2. Show execution path(s) from starting point to reference(s)
3. Trace (single-step) from starting point to reference(s)

Field Description

Subset name  Specifies the name of a predefined COBOL subset. These are the valid

subsets:

ASsignment CAll
COBOLII COBOL/370
CON(ditional COPy

DDL DEAD
DEADData DEBug
DIRective DIVision
DML ENtry
FALLthrough GOto
INClude Input
LABel MAINIline
Output PARagraph

Clcs
COMment
DB2/SQL
DEADCode
DEFinition
DL/l | DL/1
EXIt | PGMEXxit
IDMS

10

MATH
PERform
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RETurn SECtion SORTMerge

STructure TESted UNTested

Note:

See the ASG-Insight User’s Guide for a description of each subset and
subset type.

These are the screen subsets:

Highlighted | HI
NONHighlighted | NHI
Excluded | X
NONExcluded | NX

Tagged lines subsets of tags in columns 73 through 80.

To display the Selection List pop-up for subsets, leave the Subset name
field blank, or enter a pattern with wildcard characters [question mark
(?) for one character; asterisk (*) for zero or more characters).

See "Selection List Pop-ups' on page 118 for more information.

Start Specifies the line number or label name to begin the trace.

lineflabel To use cursor position for the beginning of the search, leave thisfield

blank. A message prompting you to verify cursor position displays.

To display the Selection List pop-up, enter a pattern with wildcard
characters [question mark (?) for one character; asterisk (*) for zero or
more characters].

See "Selection List Pop-ups' on page 118 for more information.

Direction Restricts the logical search to a specific direction or occurrence by
specifying adirection. These are the valid values:

1. Next Searchesor tracesforward from the cursor position to the
next occurrence of the target. Thisisthe default.

2. Previous  Searches or traces backward from the cursor position to
the previous occurrence of the target.

3. Forward  Searchesor tracesforward from the cursor position to all
occurrences of the target.

4. Backward Searches or traces backward from the cursor position to
all occurrences of the target.
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Field Description

Trace Displays the Logic Order Search - Trace IN-Clause Option pop-up to

IN-clause narrow the scope of the logic order search to a specified perform range
or marked set of lines. If not specified, the scope includes the entire
program. Thisoption can only be used if number 3isselected for Action.
The default is the entire program is used for the trace.

See"L ogic Order Search - Trace IN-Clause Option Pop-up" on page 119
for more information.

Action Specifies how to display the logic order search results. These are the
valid actions:

1. Show Subset Name References

Only the targets on the path from the starting point to where thelogic
order search ends are highlighted.

2. Show Execution Path(s) from Starting Point to Reference(s)

All executable statements on the path from the starting point to where
the logic order search stops are highlighted.

3. Trace (single-step) from Starting Point to Reference(s)

The logic order search stops at all executable statements on the path
from the starting point to where the search ends.
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Logic Order Search - Perform Range Name Pop-up

Fields

110

To follow program logic within a perform range, follow this step:

» Select Logic » Perform and press Enter. The Logic Order Search - Perform Range
Name pop-up, shown in Figure 55, displays.

Figure55¢ Logic Order Search - Perform Range Name Pop-up

Perfrange name

Direction
1 1. Next

Action

Logic Order Search - Perform Range Name

To find “perform range" references in execution order, type the name
and starting point, and select search options. Then press Enter.
For a perform range or label name selection list, type a pattern
(e.g- ABC*) in the appropriate input area.

Start line/label (if any)

2. Previous
3. Forward (all)
4. Backward (all))

1 1. Show perfrange name reference(s)
2. Show execution path(s) from starting point to reference(s)
3. Trace (single-step) from starting point to reference(s)

Options
Trace IN-clause...

Perfrange name Specifies the name in a PERFORM statement or the name of any

section contained in the DECLARATIVES.

To display the Selection List pop-up, leave the Perfrange Name field
blank or enter a pattern with wildcard characters [question mark (?)
for one character; asterisk (*) for zero or more characters|.

See "Selection List Pop-ups' on page 118 for more information.

Start line/label

Specifies the line number or label name to begin the trace.

To use cursor position for the beginning of the search, leavethisfield
blank. A message prompting you to verify cursor position displays.

To display the Selection List pop-up, enter a pattern with wildcard
characters[question mark (?) for one character; asterisk (*) for zero or
more characters].

See "Selection List Pop-ups' on page 118 for more information.
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Direction

Restrictsthelogical searchto aspecific direction or occurrence. These
arethe valid values:

1. Next Searches or traces forward from the current cursor
position to the next occurrence of thetarget. Thisisthe
default.

2. Previous  Searches or traces backward from the current cursor
position to the previous occurrence of the target.

3. Forward Searches or traces forward from the current cursor
position to all occurrences of the target.

4, Backward Searches or traces backward from the current cursor
position to all occurrences of the target.

Trace IN-clause

Displaysthe Logic Order Search - Trace IN-Clause Option pop-up to
narrow the scope of thelogic order search to aspecified performrange
or marked set of lines. If not specified, the scope includes the entire
program. This option can only be used if number 3 is selected for
Action. The default is the entire program is used for the trace.

See "Logic Order Search - Trace IN-Clause Option Pop-up" on
page 119 for more information.

Action

Specifies how to display the logic order search results. These are the
valid actions:

1. Show Perfrange Name References

Only the targets on the path from the starting point to where the
logic order search ends are highlighted.

2. Show Execution Path(s) from Starting Point to Reference(s)

All executabl e statements on the path from the starting point to
where the logic order search stops are highlighted.

3. Trace (single-step) from Starting Point to Reference(s)

Thelogic order search stopsat all executabl e statements on the path
from the starting point to where the search function ends.

m



ASG-Insight Reference Guide

Logic Order Search - User Mark Name Pop-up

Fields

112

To follow program logic to a specific mark name, follow this step:

Select Logic » Mark and press Enter. The Logic Order Search - User Mark Name pop-up,
shown in Figure 56, displays.

Figure56« Logic Order Search - User Mark Name Pop-up

Logic Order Search - User Mark Name

To find mark name references in execution order, type the name and
starting point, and select search options. Then press Enter. For a
mark or label name selection list, type a pattern (e.g. ABC*) in the
appropriate input area.

Mark name

Start line/label (if any)

Direction Options

1 1. Next _  Trace IN-clause...
2. Previous
3. Forward (all)
4. Backward (all)

Action

1 1. Show mark name reference(s)
2. Show execution path(s) from starting point to reference(s)
3. Trace (single-step) from starting point to reference(s)

Mark name  Specifiesa 1 to 10 a phanumeric character name given to a set or path
using the COPY, MARK, MERGE, or RENAME commands, or one of
these system-generated paths:

Path: Created by:
TRACK | TRK A TRACE command.

NETWORK | NET A FLOW command.

SUBNETN | SUBN A path created by the FLOW command that
reaches from the beginning of the NETWORK
to one of the results (nth result).

The TRACK, NETWORK, and SUBNET paths can also be created using
the Logic Order Search pop-ups (see "Logic Pull-down" on page 101).
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Start line/
|abel

Specifies the line number or label name at which to begin the trace.

To use cursor position for the beginning of the search, leave thisfield
blank. A message prompting you to verify cursor position displays.

To display the Selection List pop-up, enter a pattern with wildcard
characters [question mark (?) for one character; asterisk (*) for zero or
more characters].

See "Selection List Pop-ups' on page 118 for more information.

Direction

Restricts the logical search to a specific direction or occurrence by
specifying adirection. These are the valid value:

1. Next Searchesor tracesforward from the cursor position to the
next occurrence of the target. Thisisthe default.

2. Previous Searches or traces backward from the cursor position to
the previous occurrence of the target.

3. Forward Searches or traces forward from the cursor position to all
occurrences of the target.

4. Backward  Searches or traces backward from the cursor position to
all occurrences of the target.

Trace
IN-clause

Displays the Logic Order Search - Trace IN-Clause Option pop-up to
narrow the scope of thelogic order search to a specified perform range or
marked set of lines. If not specified, the scope includes the entire
program. This option can only be used if number 3is selected for Action.
The default is the entire program is used for the trace.

See"Logic Order Search - Trace |N-Clause Option Pop-up" on page 119
for more information.

Action

Specifieshow to display thelogic order search results. Thesearethevalid
actions:
1. Show Mark Name References
Only the targets on the path from the starting point to where the logic
order search ends are highlighted.
2. Show Execution Path(s) from Starting Point to Reference(s)
All executable statements on the path from the starting point to where
the logic order search stops are highlighted.
3. Trace (single-step) from Starting Point to Reference(s)

The logic order search stops at al executable statements on the path
from the starting point to where the search ends.
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Logic Order Search - Subprogram Name Pop-up

Fields

114

To follow program logic in sub-programs, follow this step:

» Select Logic » Program and press Enter. The Logic Order Search - Subprogram Name
pop-up, shown in Figure 57, displays.

Figure57 < Logic Order Search - Subprogram Name Pop-up

Logic Order Search - Subprogram Name

To find program name references in execution order, type the name
and starting point, and select search options. Then press Enter.
For a program or label name selection list, type a pattern (e.g.
ABC*) in the appropriate input area.

Program name

Start line/label (if any)

Direction Options

1 1. Next _  Trace IN-clause...
2. Previous
3. Forward (all)
4. Backward (all)

Action

1 1. Show program name reference(s)
2. Show execution path(s) from starting point to reference(s)
3. Trace (single-step) from starting point to reference(s)

Programname  Specifies the name of the main program or any nested program. To
display the Selection List pop-up, leave the Program Namefield blank
or enter a pattern with wildcard characters [question mark (?) for one
character; asterisk (*) for zero or more characters).

See "Selection List Pop-ups' on page 118 for more information.

Start line/label  Specifiesthe line number or label name from whereto begin thetrace.
To use cursor position for the beginning of the search, leavethisfield
blank. A message prompting you to verify cursor position displays.
To display the Selection List pop-up, enter a pattern with wildcard
characters [question mark (?) for one character; asterisk (*) for zero
or more characters].

See "Selection List Pop-ups' on page 118 for more information.
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Direction

Restrictsthe search to aspecific direction or occurrence. Thesearethe
valid values:

1. Next Searches or traces forward from the cursor position to
the next occurrence of the target. Thisisthe default.

2. Previous  Searchesor tracesbackward from the cursor positionto
the previous occurrence of the target.

3. Forward  Searches or traces forward from the cursor paosition to
all occurrences of the target.

4. Backward Searchesor tracesbackward fromthe cursor position to
all occurrences of the target.

Trace IN-clause

Displaysthe Logic Order Search - Trace IN-Clause Option pop-up to
narrow the scope of thelogic order trace to a specified perform range
or marked set of lines. If not specified, the scope includes the entire
program. This option can only be used if number 3 is selected for
Action. The default is the entire program is used for the trace.

See "Logic Order Search - Trace IN-Clause Option Pop-up" on
page 119 for more information.

Action

Specifies how to display the logic order search results. These are the
valid actions:
1. Show Program Name References
Only the targets on the path from the starting point to where the
logic order search ends are highlighted.
2. Show Execution Path(s) from Starting Point to Reference(s)
All executable statements on the path from the starting point to
where the logic order search function stops are highlighted.
3. Trace (single-step) from Starting Point to Reference(s)

Thelogic order search stops at all executable statements on the
path from the starting point to where the search ends.
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Logic Order Search - Line Number Range Pop-up

To follow program logic within ranges of lines, follow this step:

» Select Logic » Line and press Enter. The Logic Order Search - Line Number Range
pop-up, shown in Figure 58, displays.

Figure58e« Logic Order Search - Line Number Range Pop-up

Logic Order Search - Line Number Range

To find line range references in execution order, type the range and
starting point, and select search options. Then press Enter. For a
label name selection list, type a pattern (e.g. ABC*) in the "start"
field.

Line range

Start line/label (if any)

Direction Options

1 1. Next _  Trace IN-clause...
2. Previous
3. Forward (all)
4. Backward (all)

Action

1 1. Show line number range reference(s)
2. Show execution path(s) from starting point to reference(s)
3. Trace (single-step) from starting point to reference(s)

Fields

Line range Specifiesasinglelinenumber or range of lines. Line numbersdisplay
in columns 1 through 6 of the Source View.

Start line/label Specifies the line number or label name from where to begin the
trace. To use cursor position for the beginning of the search, leave
thisfield blank. A message prompting you to verify cursor position
displays. To display the Selection List pop-up, enter a pattern with
wildcard characters [question mark (?) for one character; asterisk (*)
for zero or more characterg].

See "Selection List Pop-ups' on page 118 for more information.
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Direction

Restricts the search to a specific direction or occurrence by
specifying adirection. These are the valid values:

1. Next Searches or traces forward from the cursor position to
the next occurrence of the target. Thisisthe default.

2. Previous Searchesor tracesbackward fromthe cursor positionto
the previous occurrence of the target.

3. Forward  Searches or traces forward from the cursor position to
all occurrences of the target.

4. Backward Searchesor tracesbackward from the cursor positionto
all occurrences of the target.

Trace IN-clause

Displaysthe Logic Order Search - Trace IN-Clause Option pop-up to
narrow the scope of thelogic order trace to aspecified perform range
or marked set of lines. If not specified, the scope includes the entire
program. This option can only be used if number 3 is selected for
Action. The default is the entire program is used for the trace.

See "Logic Order Search - Trace IN-Clause Option Pop-up" on
page 119 for more information.

Action

Specifies how to display the logic order search results. These are the
valid actions:
1. Show Line Number Reference(s)

Only the targets on the path from the starting point to where the
logic order search ends are highlighted. This is the default.

2. Show Execution Path(s) from Starting Point to Reference(s)

All executable statements on the path from the starting point to
where the logic order search stops are highlighted.

3. Trace (single-step) from Starting Point to Reference(s)

The logic order search stops at all executable statements on the
path from the starting point to where the search ends.
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Selection List Pop-ups

To display selection lists for dataname, label name, COBOL subset name,
perform range name, and program name logic order searches

1 Perform one of these actions:

- Enter a pattern [question mark (?) for one character; asterisk (*) for zero or
more characters] and press Enter.

- Leave the Name field blank and press Enter.

- Select Start line/label field from the various pop-ups and press Enter.

Figure 59 illustrates the Selection List - Data Names pop-up. The selection list
pop-ups are the same except for the type of list displayed.

Figure59 e« Selection List - Data Names Pop-up

Selection List - Data Names
Command ===> Scroll ===> CSR

w

Data name

ABEND-CODE
ADDRESS1
AREA-CODE
AVG-AMT (DEAD)
BILLING-DAYS
CHECK-CODE (DEAD)
cITY

CLIENT-ID
CONSOLE
CUR-PREFIX
CURRENT-Z1P-DATA
CUSTOMER- 1D
DBA-DEPT-CODE
DEBUG-PARM
DET-ADDRESS
DET-AREA-CODE
DET-BILLING-DAYS

2  Select adataname by typing S in the line command and press Enter. The selected
name is placed in the name field of the Logic Order Search pop-up.

Usethe LOCATE primary command to can scroll through the list of names.
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Torestrict the source lines considered for a trace

1

2

Figure 60« Logic Order Search - Trace IN-Clause Options Pop-up

Logic Order Search - Trace IN-Clause Option

To restrict the source lines to be considered for a Trace, type one
or more IN-Clause selections. Then press Enter. For a selection

list, type a pattern (e.g. ABC*) in the appropriate input area.

Perform range . .

User MARK name

2. Uses only 2. Previous IN-clause. ..

3. Mods only 3. Forward (all)
4. Backward (all)

3 1. Show data name reference(s)

2. Show execution path(s) from starting point to reference(s)

3. Trace (single-step) from starting point to reference(s)

Type the perform range or user mark name to search and press Enter.

5 Logic

From the Logic Order Search pop-up, specify Action 3 - Trace (single-step) from
starting point to reference(s) and the Trace IN-clause option, and press Enter. The
Logic Order Search - Trace IN-Clause Option pop-up, shown in Figure 60, displays.

To display the Selection List pop-up for the Perform range or the User MARK name
fields, follow this step:

» Enter a pattern with wildcard characters [question mark (?) for one character; asterisk

Fields

(*) for zero or more characters] and press Enter.

Perform range Specifies the perform range to search.

User MARK name Specifies the name of the mark to search.
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Task

This chapter describes items on the Insight Task menu and contains these sections:

Task Pull-down 122
Automated Task - Modify Program Output Pop-up 123
Modify Output Task - Output Selection Pop-up 124
Modify Output Task - Statement Selection Pop-up 126
Modify Output Task - Data Name Selection Pop-up 127
Automated Task - Modify a Computation Pop-up 129
Automated Task - Debug a Program Abend pop-up 134
Automated Task - Result Options Pop-up 137
Options - COPY/Include Libraries Pop-up 138

The Task facility automates program maintenance and enhancement tasks, such as
finding the incorrect output source, enhancing computations, and finding the abends
source.

Insight shows tasks resultsin Source View or an edit session.

Note:
See the ASG-Insight User’s Guide for more information.
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Task Pull-down

To access the selection pop-ups used to automate common program maintenance and
enhancement tasks, follow this step:

» Select Task ontheaction bar and press Enter. The Task pull-down, shown in Figure 61,
displays.

Figure6le Task Pull-down

File Wiew 3earch Logic Task List oOptions Help

AsE= | _ 1. Hodify output...
CoWHand ===} _____________ 2. Hodify coWputation... | ____.
3. Debug abend...
Hetetolototeteteteiok 4. Eee task results in AEG-EHartEdit...
Hepetobok: Hepolobk  debobetdok Hetstobok
setetotok F setetstok
tetedoiok tetedoiok e ] Aotk
Hetstobok Hetstobok detstobobk debeietok ekt
shetetstok
setededok

Gopyright AlLlen Systens Group, INcC., an unpublished vork.
A proprietary product of A%G, Inc. Use restricted to authorized 1icensess.
Visit The ASE Support Web Zite at wuw,asg.cod

Actions

1. Modify Output Displays the Automated Task - Modify Program Output
pop-up used to begin selecting output names for the Modify
Program Output task or to review previous selections.

2. Modify Computation Displaysthe Automated Task - Modify a Computation pop-up
used to begin selecting datanamesfor the M odify Computation
task or to review previous selections.

3. Debug Abend Displays the Automated Task - Debug a Program Abend
pop-up used to begin the Debug Abend task or to review
previous selections.

4. See Task Resultsin  Displaysthe Edit Options pop-up used to specify and/or verify
the Editor options for the editor.

If SmartEdit isinstalled, this action displays the Edit Options
screen for SmartEdit.
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Automated Task - Modify Program Output Pop-up

To begin modifying, correcting, or understanding statements involved in outputting aline
on areport or arecord on afile, follow this step:

» Select Task » Modify and press Enter. The Automated Task - Modify Program Output
pop-up, shown in Figure 62, displays.

Figure 62« Automated Task - Modify Program Output Pop-up

Automated Task - Modify Program Output

This "task' automates the process of finding all program statements
involved in building a field on a report, display screen, file or
database. The "task results" can facilitate modifications or
uncover the reasons for erroneous program output.

The following selection screens quickly narrow the search to an
output type, a statement and a field name. The final screen offers
a choice of "view" options for the task results.

1 1. Begin selections
2. Review previous selections

Options

Begin selections Displays the Maodify Output Task - Output Selection pop-up
used to select the incorrect output to be examined in the Task
facility. Thisis the default.

Review previous Displays the Modify Output Task - Output Selection pop-up
selections with the previously selected output name highlighted.
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Modify Output Task - Output Selection Pop-up

To select the output to examine, follow this step:

» Select option 1 or 2 onthe Automated Task - Modify Program Output pop-up and press
Enter. The Modify Output Task - Output Selection pop-up, shown in Figure 63,
displays.

Figure 63« Modify Output Task - Output Selection Pop-up

Modify Output Task - Output Selection
Command ===> Scroll ===> CSR

The names listed below are the output "files" in the program. Select the
"“file" to be investigated. Then press Enter. (Type "S" to select, "U" to
un-select, or "V" to view in Source View.)

Is output performed in CALLed programs (Y/N)? NO

S Output Name Type

_ CONSOLE DD Name

_ MASTER-RPT FD
SYSOUT DD Name

Fhhkdhhhddhhhdrr BOTTOM OF DATA ****kkkskkkkhrkk

A message indicates the number of files producing program output when this pop-up first
displays.

Fields

Is Output Performed  Specifieswhether all CALL statements display. Type YES to
in CALLed Programs display all CALL statements for selection. NO is the default

Linecommand area  Refersto the areato the left of the Output Name field, which
accepts these line commands:

S  Sdlectsthe output name and displays the Modify Output
Task - Statement Selection pop-up to select the statement
producing the incorrect output.

U Desdectsapreviously-selected output name. The nameis
no longer highlighted.

V  Displaysthe Source View screen with a shortened action
bar, showing the source statement selected for viewing
positioned in the middle of the screen, to see the statement
in context. The statement is highlighted and tagged to the
right with LINE RNG. Usethe END command to return to
the Modify Output Task - Output Selection pop-up.
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Field Description

Output name Specifiesthe file namesthe program produces output for. When
viewing previous selections, the selected name is highlighted.

Type Indicates the type of output. These are the valid values:

FD - File description

RD - Report description

SD - Sort description

DD Name - SYSOUT or CONSOLE output
CICS- CICS output

IMS- CBLTDLI CALL statement

CALL - Non-CBLTDLI CALL statement

SQL TABLE SQL TABLE declared and/or created in the
program

SQL VIEW - SQL VIEW declared and/or created in the
program

IDMS RECORDS - IDM S records referenced in the
program
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Modify Output Task - Statement Selection Pop-up

To select the statement producing the incorrect output, follow this step:

» Select an output name on the M odify Output Task - Output Selection pop-up and press
Enter. The Modify Output Task - Statement Selection pop-up, shown in Figure 64,

displays.

Figure 64 « Modify Output Task - Statement Selection Pop-up

Modify Output Task - Statement Selection
Command ===> Scroll ===> CSR

The statements listed below "write" to the selected "file". Select the
statement to be investigated. Then press Enter. (Type "S* to select, "U"
to un-select, or "V" to view in Source View.)

Selected output: MASTER-RPT

S Line Output statement
000352 WRITE MAST-RPT FROM DETAIL-LINE1.
000357 WRITE MAST-RPT FROM DETAIL-LINE2.
000365 WRITE MAST-RPT FROM DETAIL-LINE3.
000372 WRITE MAST-RPT FROM DETAIL-LINE4.
000424 WRITE MAST-RPT FROM SUB-PRINT.
000434 WRITE MAST-RPT FROM RPT-HDG-LINE1.
000435 WRITE MAST-RPT FROM RPT-HDG-LINE2.
000454 WRITE MAST-RPT FROM TOTAL-PRT
BOTTOM OF DATA

The selection list contains al statements that write to the previously-selected output
name.

Fields

Selected output  Specifies the output name that was selected on the M odify Output
Task - Output Selection pop-up.

Linecommand Specifiesthe areato theleft of the Linefield, which acceptstheseline
area commands:

S Sdectsthe statement and displaysthe Modify Output Task - Data
Name Selection pop-up to select the dataname producing the
incorrect output.

U Unselects a previously-selected statement. The statement is no
longer highlighted.

V Displaysthe Source View screen with a shortened action bar,
showing the source statement selected for viewing positioned in
the middle of the screen, to see the statement in context. The
statement is highlighted and tagged to the right with LINE RNG.
Use the END command to return to the Modify Output
Task - Statement Selection pop-up.
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Field Description

Line Specifies the Source View line number.
Output Specifies the statements corresponding to the selected output. When
statement viewing previous selections, the selected statements is highlighted.

Modify Output Task - Data Name Selection Pop-up

To select the dataname responsible for the incorrect output, follow this step:

P Select astatement on the Modify Output Task - Statement Selection pop-up and press
Enter. The Modify Output Task - Data Name Selection pop-up, shown in Figure 65,

displays.

Figure 65+« Modify Output Task - Data Name Selection Pop-up

Modify Output Task - Data Name Selection
Command ===> Scroll ===> CSR

The names listed below are data items that are output by the "write"”
statement selected. Select the item to be investigated. Then press Enter.
(Type "S" to select, "U" to un-select, or "V" to view in Source View.)
Selected statement: 000352 WRITE MAST-RPT FROM DETAIL-LINE1.

S Data name

The selection list contains al datanames referenced on the selected write statement.
When this screen first displays a message indicates the number of datanames found.
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Fields

Usage Notes

128

Selected
Statement

Specifies the statement selected on the Modify Output
Task - Statement Selection pop-up.

Line command
area

Specifiesthe areato theleft of the Linefield, which acceptstheseline
commands:

S

Sel ects the dataname and displays the Automated Task - Result
Option pop-up to choose how to display the results of the Task
facility.

Unsel ects apreviously-sel ected dataname. The nameisno longer
highlighted.

View Source. Displays the Source View screen with a shortened
action bar, showing the source statement selected for viewing
positioned in the middle of the screen, to see the statement in
context. The statement is highlighted and tagged to the right with
LINE RNG. Use the END command to return to the Modify
Output Task - Data Name Selection pop-up.

Data name

Specifies the datanames contained in the selected statement. When
viewing previous selections, the selected dataname is highlighted.

The Modify Output Task - Data Name Selection pop-up is the last Modify Output Task
selection pop-up. After you select a dataname, the Automated Task - Result Options
pop-up displays, allowing you to see the resultsin Source View, modify the resultsin the
editor, or return to the first selection pop-up to review the selections.

See "Automated Task - Result Options Pop-up" on page 137 for more information.
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Automated Task - Modify a Computation Pop-up

Options

To begin modifying, correcting, or understanding the statements involved in computing
or assigning a dataname, follow this step:

P Select Task » Modify computation and press Enter. The Automated Task - Modify a
Computation pop-up, shown in Figure 66, displays.

Figure 66« Automated Task - Modify a Computation Pop-up

Automated Task - Modify a Computation

This "task™ automates the process of finding all program statements
involved in the computation (or assignment) of a data variable. The
"task results" can facilitate modifications or uncover the reasons
for erroneous calculations.

The following selection screens quickly narrow the search to a data
name and a computation statement. The final screen offers a choice
of "view" options for the task results.

1 1. Begin selections
2. Review previous selections

Option Description

Begin Selections  Displaysthe Modify Computation Task - Data Name Entry pop-up
used to enter the dataname to be examined. Thisis the default.

Review Previous  Displaysthe Modify Computation Task - Data Name Selection
Selections pop-up with previously selected dataname highlighted.
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Modify Computation Task - Data Name Entry Pop-up

To enter a dataname for examination or to access the Modify Computation Task - Data
Name Selection pop-up, follow this step:

» Select option 1 on the Automated Task - Modify a Computation pop-up and press
Enter. The Modify Computation Task - Data Name Entry pop-up, shown in Figure 67,
displays.

Figure 67 « Modify Computation Task - Data Name Entry Pop-up

Modify Computation Task - Data Name Entry
Type the data name being computed or assigned. Then press Enter.
For a data name selection list, type a pattern (e.g. ABC*) in the
data name area.

Data name

Field

Field Description

Dataname Specifiesa COBOL dataname or qualified COBOL dataname. The
Modify Computation Task - Statement Selection pop-up displaysto
specify the statement to examine. Dataname refers to any valid COBOL
reference for a data element.

To display the Modify Computation Task - Data Name Selection pop-up,
leave thisfield blank or enter a pattern with wildcard characters[question
mark (?) for one character; asterisk (*) for zero or more characters].
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Modify Computation Task - Data Name Selection Pop-up

To select the dataname to examine, follow this step:

» Enter apatternin the Data Name field on the Modify Computation Task - Data Name
Entry pop-up and press Enter. The Modify Computation Task - Data Name Selection

pop-up, shown in Figure 68, displays.

Figure 68« Modify Computation Task - Data Name Selection Pop-up

Command ===>

Modify Computation Task - Data Name Selection

Scroll ===> CSR

Pattern *
S Data name

ABEND-CODE
ADDRESS1
AREA-CODE
BILLING-DAYS
CITY

CLIENT-I1D
CUR-PREFIX
CURRENT-ZIP-DATA
CUSTOMER-ID

The data names listed below are assigned value in this program. Select the
name to be investigated. Then press Enter. (Type "S" to select, "U" to
un-select, or "V" to view in Source View.)

Qualification

01 MASTER-IN

05 PHONE, 01 MASTER-IN

05 LOAN-INFORMATION, 01 MASTER-IN
01 MASTER-IN

01 MASTER-IN

01 CURRENT-ZIP-DATA

05 CLIENT-1D, 01 MASTER-IN

The selection list contains all datanames computed or assigned avalue in the program for
the specified pattern. A message indicates the number of datanames found when this

pop-up first displays.

Fields

Pattern

Specifies the pattern that was used to obtain the list of
datanames.

Line command area

Specifiestheareato theleft of the Linefield, which acceptsthese
line commands:

S Selectsthe dataname and displays the Modify Computation
Task - Statement Selection pop-up to select a statement for
examination.

U Unsdects a previoudly-selected dataname. The nameis no
longer highlighted.

V  View Source. Displays the Source View screen as a pop-up
with a shortened action bar, showing the source statement
selected for viewing positioned in the middle of the screento
see the statement in context. The statement is highlighted
and tagged to the right with LINE RNG. Use the END
command to return to the Modify Computation Task - Data
Name Selection pop-up.
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Data name Specifiesthe datanamesincluded in the pattern that are assigned

value in the program. When viewing previous selections, the
selected dataname is highlighted.

Qualification Specifiesthe parent(s) of the datavariable name. The qualifying

parent name includes the level number and the dataname.

Modify Computation Task - Statement Selection Pop-up

132

To select a statement for examination and display a list of statements that
compute the selected dataname

1

Select a dataname on the Modify Computation Task - Data Name Selection pop-up.

Or
Enter a dataname on the Modify Computation Task - Data Name Entry pop-up.

Press Enter to display the Modify Computation Task - Statement Selection pop-up
shown in Figure 69.

Figure 69« Modify Computation Task - Statement Selection

Modify Computation Task - Statement Selection
Command ===> Scroll ===> CSR

The statements listed below assign value to the selected data name.
Select the statement to be investigated. Then press Enter. (Type "S*
to select, "U" to un-select, or "V" to view in Source View.)

Selected name: ABEND-CODE

S Line Computation/assignment statement
_ 000059 77 ABEND-CODE PIC S9(4) COMP VALUE +0.
_ 000493 MOVE +999 TO ABEND-CODE.

_ 000494 CALL "ABENDPGM®™ USING ABEND-CODE.
BOTTOM OF DATA




Fields

Usage Notes

6 Task

Selected name

Specifies the dataname that you entered on the Modify
Computation Task - Data Name Entry pop-up or selected
on the Modify Computation Task - Data Name Selection

pop-up.

Line command area

Specifiesthe areato theleft of the Linefield, which accepts
these line commands:

S

Sel ects the statement and displays the Automated
Task - Result Options pop-up that allows you to choose
how the results of the Task facility display.

Unselects a previously - selected statement. The name
isno longer highlighted.

View Source. Displays the Source View screen asa
pop-up with a shortened action bar, showing the source
statement selected for viewing positioned in the middle
of the screen to see the statement in context. The
statement is highlighted and tagged to the right with
LINE RNG. Usethe END command to return to the
Modify Computation Task - Statement Selection

pop-up.

Line

Specifies the Source View line number.

Computation/assignment

statement

Specifiesthe statements that compute or assign valueto the
selected dataname. When viewing previous selections, the
selected statements is highlighted.

The Modify Computation Task - Statement Selection pop-up isthe last Modify
Computation Task selection pop-up. After you select a statement, the Automated

Task - Result Options pop-up displays, allowing you to see the resultsin Source View,
modify the results in the editor, or return to the first selection pop-up to review the

selections.

See "Automated Task - Result Options Pop-up" on page 137 for more information.
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Automated Task - Debug a Program Abend pop-up

To begin debugging a data-related abend in a program, follow this step:

» Select Task » Debug and press Enter. The Automated Task - Debug a Program Abend
pop-up, shown in Figure 70, displays.

Figure 70« Automated Task - Debug a Program Abend

Automated Task - Debug a Program Abend

This "task™ automates the process of finding all program statements
that build data variables for a statement that is causing an abend.
The ""task results" help uncover the reasons for the failure.

The following selection screens quickly narrow the search to the
statement causing the abend. The final screen offers a choice of
"view" options for the task results.

1 1. Begin selections
2. Review previous selections

The task isolates the statements that compute or assigns values to the data variablesin an
abending statement.

Options

Begin selections  Displaysthe Debug Abend Task - Line Number Entry pop-up used
to enter the Source View line number or range of lines where the
program abend occurred. Thisis the default.

Review previous  Displaysthe Debug Abend Task - Line Number Entry pop-up that
selections allows you to review the line number(s) entered.

Debug Abend Task - Line Number Entry Pop-up

To enter the Source View line number, or range of lines, where the program
abend occurred

1  Select Task » Debug abend and press Enter. The Automated Task - Debug aProgram
Abend pop-up displays.

2  Sdlect option 1 or 2 and press Enter. The Debug Abend Task - Line Number Entry
pop-up, shown in Figure 71 on page 135, displays.
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3 Enter the beginning and ending line where the abend occurred and press Enter. The
statements in the range of lines displays.

Figure 71+« Debug Abend Task - Line Number Entry Pop-up

Debug Abend Task - Line Number Entry

Type the (Source View) line number or the line number range
containing the abending program statement. Then press Enter.

Beginning line number . . 000355

Ending line number . . . (if any)

Fields

Beginning line number Required. Specifies the Source View line number where the
abend occurred, or the beginning line number in arange of
lines where the abend occurred.

Ending line number Specifies the last Source View line number in arange of
lines where the abend occurred.

Debug Abend Task - Statement Selection Pop-up

To select a statement for further examination and to display alist of statements that
reference one or more data variables in the specified range of lines, follow this step:

» Enter aline number on the Debug Abend Task - Line Number Entry pop-up. The
Debug Abend Task - Statement Selection pop-up, shown in Figure 72, displays.

Figure 72 « Debug Abend Task Statement Selection Pop-up

Debug Abend Task - Statement Selection
Command ===> Scroll ===> CSR

The statements listed below are in the selected range and reference one or
more data variables. Select the statement to be investigated. Then press
Enter. (Type "S" to select, "U" to un-select, or "V" to view in Source
View.)

Selected lines: 355 -

S Line Statements containing variables

_ 000355 MOVE YEAR-TO-DATE-INTEREST TO DET-YTD-INT.
BOTTOM OF DATA
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Fields

Selected lines

Specifies the Source View line number(s) entered on the Debug
Abend Task - Line Number Entry pop-up.

Line command area

Specifies the areato the |eft of the Line field, which accepts
these line commands:

S

Selects the statement and displays the Automated
Task - Result Options pop-up to choose how to display the
results of the Task facility.

Unselects a previously selected statement. The nameisno
longer highlighted.

Displays the Source View screen as a pop-up with a
shortened action bar, showing the source statement selected
for viewing positioned in the middle of the screen to seethe
statement in context. The statement is highlighted and
tagged to theright with LINE RNG. Usethe END command
to return to the Modify Computation Task - Statement
Selection pop-up.

Line

Specifies the Source View line number.

Statements containing
variables

Specifies the statements in the specified range of lines that
reference data variables. When viewing previous selections, the
selected statements is highlighted.

Usage Notes

The Debug Abend Task - Statement Selection pop-up isthe last Debug Abend Task
selection pop-up. After you select a statement, the Automated Task - Result Options
pop-up displays, allowing you to see the resultsin Source View, modify the resultsin the
editor, or return to the first selection pop-up to review the selections.

See "Automated Task - Result Options Pop-up" on page 137 for more information.
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Automated Task - Result Options Pop-up

To choose how the Task facility results display, follow this step:

» Select dataname (for Modify Program Output Task) or statement (for Modify
Computation Task or Debug Abend Task). The Automated Task - Result Options

pop-up, shown in Figure 73, displays.

Figure 73« Automated Task - Result Options Pop-up

Automated Task - Result Options

The selections are complete for this "task'. All program statements that
relate to these selections are available for viewing. Select the desired
option. Then press Enter.

1 1. Source View - See the task results in Source View**
2. Editor - Modify the results in your editor
3. Review - Return to first selection screen

** Source View tags:

START - Selected starting statement
1T - Intermediate target
TARGET - Statement that initialize component variables

TARGET-U - Target with an uninitialized variable
TARGET-U? - Target with possible uninitialized variable

Options

Source View Redisplays the Source View screen with the statements highlighted
and tagged. All other lines are excluded from the display. Thisisthe
default option.

Editor Displaysthe Options- COPY /Include Libraries pop-up used to access
your editor.lf SmartEdit isinstalled, displays the
Options - COPY/Include Libraries pop-up for SmartEdit.

Review Redisplaysthefirst selection list pop-up to review the selections.
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Options - COPY/Include Libraries Pop-up

To specify a source manager for the editor, follow this step:

» Select Task P> Seetask resultsin the editor or select Editor on the Automated
Task - Result Options pop-up. The Options - COPY /Include Libraries pop-up, shown

in Figure 74, displays.

Figure 74 « Options- COPY/IncludeLibraries Pop-up

File COBOL SourceManager Options

Options - COPY/Include Libraries
Command ===> Scroll ===> PAGE

Specify Source Manager, COBOL Version and COPY/Include Libraries.

Source Manager . . : PDS/Sequential COBOL Version . : COBOL 74
COPY List:
Data Set Name
Member . . . . . :
Description
Copy/Include Data Set Name(s) Type VolSer Unit Password
/ "VIAUSER.TESTDOO1.CNTL" PDS

BOTTOM OF DATA

Field

Field Description

Source Manager  Specifies the abbreviation of the source manager that contains your
program. These are the valid values:

1. PDS/Sequential
2. Librarian

3. Panvalet

4. SCLM

5. Other (User)
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This chapter describes items on the Insight List menu and contains these sections:

List Pull-down 140
List - CALL Statements Pop-up 141
List - Equates Pop-up 142
List - User Marks Pop-up 143
List - Perform Range Names Pop-up 145
List - Program/Subprogram Names Pop-up 146
List - COBOL Subset Names Pop-up 147
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List Pull-down

To access pop-ups that list information about CAL LS, equates, marks, PERFORMS,
programs, and subsets, follow this step:

» Select List onthe action bar and press Enter. The List pull-down, shown in Figure 75,
displays.

Figure 75« List Pull-down

File Uiew 3Zearch Logic Task List Options Help

AZG-EEW - — 1. Calls...
CoWHand ===k ___________________ 2. Equates...
3. Harks...
Aetebbtstoiettstebbstetoteth d. PerforHs... Aetebbtteittstebbsttotcttztok
Aebetebbtstbttetobbtstobtdok S PrograHs... Aetebtettotettstobtatatotott=k
Hetototok Hetotoke B. Zubsets... Hetobotok
etttk Aotk
detststck detststck Hetetettek debelelk b oo
Aotttk Aotttk Aotttk Aebebclk Aotk
Hetebeek
Atttk

Copyright ALlen $ystens Group, Inc., an unpublished work.
A proprietary product of ASG, IncC. Use restricted to authorized licensees.
Vigit the ASG Support Meb Site at wuw.asg.coH

Actions

1. Cdls DisplaystheList - CALL Statements pop-up that listsprograms CALLed
by the active program.

2.Equates  Displaysthe List - Equates pop-up that lists all equates for the active
program.

3. Marks Displaysthe List - User Marks pop-up that lists all existing marksand is
used to change comments, merge sets, and copy, delete, or rename setsor
paths.

4. Performs  Displaysthe List - Perform Range Names pop-up that lists all COBOL
perform ranges in the active program.

5. Programs Displaysthe List - Program/Subprogram Names pop-up that lists the
internal subprograms defined within a COBOL |l Release 3 or later
program.

6. Subsets  Displaysthe List - COBOL Subset Names pop-up that lists the subsets
along with abrief description of each.
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List - CALL Statements Pop-up

To display programs CALLed by the current program, follow this step:

P SelectList» Calls, or type LIST CALLS on any screen, and press Enter. The
List - CALL Statements pop-up, shown in Figure 76, displays.

Figure 76« List - CALL Statements Pop-up

List - CALL Statements
Command ===> Scroll ===> CSR

Select the program CALL(sS) to be viewed. Then press Enter.

S Called program Mode
_ " ABENDPGM*™ STATIC
_ T"DBACLSEl" STATIC
_ "DBACLSE2" STATIC
_ "DBAOPEN1" STATIC
_ "DBAOPEN2" STATIC
_ "DBAREAD1*" STATIC
_ "DBAREAD2* STATIC
_ “"VIAIDEM1*® STATIC

BOTTOM OF DATA

A message indicates the number of CALLs listed when this pop-up first displays.

Y ou can copy the CALLed subprograms list to the List file by typing LPRINT * on this
pop-up.

Fields

S (line command Specifiesthe areato the left of the CALLed program field, which

areq) accepts the S line command that selects a CALLed subprogram
for viewing. The screen where you requested the List - CALL
Statements pop-up redisplays with the related CALL statements
highlighted and tagged.

Called program Specifies the name of the CALLed module.

Mode Specifiesthe type of CALL. These are the valid types:

STATIC The abject of the CALL isaliteral and the
associated program is link-edited into the same
load module as the CALLing program.

DYNAMIC Theobject of the CALL isanidentifier andis
determined at run time. Programs referenced may
or may not be link-edited into the same load
module as the CALLing program.

INTERNAL A CALL to anested source subprogram.
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List - Equates Pop-up

Fields

142

To display all existing equates for the active program, follow this step:

P Select List » Equates, or type LIST EQUATES on any screen, and press Enter. The
List - Equates pop-up, shown as Figure 77, displays.

Figure 77« List - Equates Pop-up

List - Equates

Command ===> SCROLL ===> CSR
Name Program Substitution String Columns 001-052

MSTR VIAIDEMO  MASTER-IN + MASTERIN

PARAS VIAIDEMO  PROGRAM-INIT + POO5-VAL-PARM THRU POO5-EXIT

ZIPDATA VIAIDEMO  ZIP-CODE + HLD-ZIP + DET-ZIP-CODE

BOTTOM OF DATA

Y ou can copy the Equates list to the List file by typing LPRINT * on this pop-up.

Name Specifies the name assigned to the equate.

Program Specifies the name of the program containing the equate.

Substitution  Specifies the actual datathe NAME represents. Prior to execution, this
String string is substituted into any command that uses the equate name. This

field isleft and right scrollable so you can view the entire string. The
right-most column contains a greater than (>) symbol when the
substitution string extends past the screen column capability. To change
the substitution string, type over it.

Type blanks over the substitution string to delete the equate.




List - User Marks Pop-up

Usethe List - User Marks pop-up to perform these functions:
- Display adirectory or list of all existing marks

- Change comments

- Mergesets

=  Copy setsor paths

- Delete sets or paths

- Rename sets or paths

To display the List - User Marks pop-up, follow this step:

7 List

» Select List » Marks, or type LIST MARKS on any screen, and press Enter. The

List - User Marks pop-up, shown in Figure 78, displays.

Figure 78+« List - User Marks Pop-up

List - User Marks
Command ===> Scroll ===> CSR

C : Copy set/path 1 to set/path 2. D : Delete existing set/path 1.
M : Merge set/path 1 with set 2. R : Rename set/path 1 to set/path 2.
S : Select the mark to be viewed.

Set/path 1 Set/path 2 Comments
_ NETWORK PATH FLOW FROM LINE 231 TO 2 TARGET(S) OF "EXITS*
_ SUBNET1 PATH FROM LINE 231 TO TARGET(S) ON LINE 494
_ SUBNET2 PATH FROM LINE 231 TO TARGET(S) ON LINE 251
_ TRACK PATH TRACE FROM 231 TO TARGET(S) OF ENTRY

BOTTOM OF DATA

Y ou can copy the Equates list to the List file by typing LPRINT * on this pop-up.
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Fields

Field Description

Linecommand Specifiestheareato theleft of the Set/Path 1 field, which acceptsthese
area line commands:

C Copiesaset or path. Typethetarget of the copy in the Set/path 2
field.

M  Merges sets. Type the target of the merge in the Set/path 2 field.

S Sedlectsanitem for viewing. The screen where you requested the
List - User Marks pop-up redisplays with the marks highlighted
and tagged.

D Deletesan existing set or path.
R Renamesaset or path. Type the new namein the Set/path 2 field.

Set/path 1 Specifies the name of the set or path.

Type Specifies the type field, between the Set/path 1 field and the Set/path
2 field, identifies the item as a set or path.

Set/path 2 Specifiesthe appropriate mark name. Thisfieldisrequiredif you enter
the C, M, or R line command.

Comments Specifies comment space. Change existing comments by typing over
them.
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List - Perform Range Names Pop-up

To display al COBOL perform rangesin the active program, follow this step:

» Select List» Performs, or type LIST PERFORMS on any screen, and press Enter. The
List - Perform Range Names pop-up, shown in Figure 79, displays.

Figure 79« List - Perform Range Names Pop-up

List - Perform Range Names
Command ===> SCROLL ===> CSR

Select the perform range to be viewed. Then press Enter.
Perform range name

PROGRAM-INIT

POOO-NEXT THRU POOO-EXIT
POO5-VAL-PARM THRU POOS5-EXIT
PO10-OPEN THRU PO19-EXIT

P100-PRINT THRU P119-EXIT

P120-READ THRU P129-EXIT
P150-SUBTOT THRU P169-EXIT
P155-CL-SUBTOT THRU P159-EXIT
P160-HDG THRU P169-EXIT
P999-ABEND-PROGRAM OF ABEND-PROGRAM
BOTTOM OF DATA

A message indicates the number of CALLs listed when this pop-up first displays.

Fields

S(linecommand area) Specifiesthe areato the left of the Perform range name field,
which acceptsthe Sline command to select aperform rangefor
viewing. The screen where you requested the List - Perform
Range Names pop-up redisplays with the perform ranges
highlighted and tagged.

Performrange name  Specifies the perform label name.

Usage Notes
Scroll down to view the rest of thelist.

Y ou can copy the CALLed subprograms list to the List file by typing LPRINT * onthis
pop-up.
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List - Program/Subprogram Names Pop-up

To display the internal subprograms defined within a COBOL |l Release 3 or later
program, follow this step:

P Select List » Programs, or type LIST PROGRAMS on any screen, and press Enter. The
List - Program/Subprogram Names pop-up, shown in Figure 80, displays.

Figure80 ¢ List - Program/Subprogram Names Pop-up

List - Program/Subprogram Names
Command ===> Scroll ===> CSR

Select the program name to be viewed. Then press Enter.

Program name

VIAIDEMO

BOTTOM OF DATA

Internal subprograms are indented in relation to their hierarchy.
When this pop-up first displays a message indicates the number of CALLs listed.

Y ou can copy the CALLed subprograms list to the List file by typing LPRINT * onthis
pop-up.

Fields

S(linecommand area) Specifiesthe areato the left of the Perform range namefield,
which accepts the S line command to select a subprogram for
viewing. The screen where you requested the
List - Program/Subprogram Names pop-up redisplays with the
subprograms highlighted and tagged.

Program name Specifies the program or subprogram ID.
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List - COBOL Subset Names Pop-up

To display the subsets along with a brief description of each, follow this step:

P Select List » Subsets, or type LIST SUBSETS on any screen, and press Enter. The
List - COBOL Subset Names pop-up, shown in Figure 81, displays.

Figure8le List - COBOL Subset Names Pop-up

List - COBOL Subset Names
Command ===> Scroll ===> CSR

Select the subset to be viewed. Then press Enter.
S Subset Description

_ ASsignment - COBOL: ACCEPT, ADD, SUBTRACT, MULTIPLY, DIVIDE,
BY, COMPUTE, MOVE, FROM, INSPECT, EXAMINE,
STRING, UNSTRING, SET, SEARCH, TRANSFORM;
IDMS: ACCEPT, CHECK, ERASE, GET, INQUIRE, LOAD,
PUT, RETURN;
SQL: FETCH, SELECT INTO, SET.

_ CAl - COBOL: CALL, CANCEL, ENTRY, intrinsic function
calls;

CICS: LINK, XCTL;
IDMS: ATTACH, LINK, XCTL.

_ Clcs - EXEC CICS, EXEC DLI commands.

_ cosoLl11 - CALL (COBOLII), PERFORM (COBOLII), CONTINUE, SET,
SERVICE LABEL, EVALUATE, INITIALIZE, end verbs.

_ COBOL370 - Statements and clauses unique to COBOL/370, such as

intrinsic function calls, procedure pointers and

Fields

S(linecommand area) Specifiesthe areato the left of the Perform range name field,
which accepts the S line command to select a subset for
viewing. The screen where you requested the List - COBOL
Subset Names pop-up redisplays with the subsets highlighted
and tagged.

Subset Specifies the subset name. See the ASG-Insight User’s Guide
for a description of each subset type.

Description Specifies the description of the subset.

Usage Notes
Scroll to view the rest of the list.

Y ou can copy the CALLed subprograms list to the List file by typing LPRINT * onthis
pop-up.
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Options

This chapter describes items on the Insight Options menu and contains these sections:

Options Pull-down 149
Options - Product Parameters Pop-up 151
Options - Product Allocations Pop-up 152
Options - Log/List/Punch Definition Pop-up 154
Options - Script File Allocations Pop-up 157
Options - PF Key Definition Pop-up 158
Options - Processing Modes Pop-up 160
Options - Scratchpad Pop-up 161

Options Pull-down

Y ou use the Options pull-down to set parameters and options, and to define PF keys. This
pull-down also provides access to the scratchpad, and is used to refresh the Source View

display. This section describes the actions available on the Options pull-down.
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Actions
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To display the Options pull-down, follow this step:

» Select Options on the action bar and press Enter. The Options pull-down, shown in

Figure 82, displays.

Figure 82« Options Pull-down

File Uiew =Zearch Logic Task List Options Help

AFE-ESM — Progra | _ 1. Product paraneters...
ConHand ===3 Z. Product allocations... -
3. Log-listspunch...
Aototototototeiciototototcicloiniok: d. Ecript file allocations...
ok 5. PF keyz...
Hetebetok debebotck eick . Hodes...
seetokk: btk ook 7. Icratchpad...
&. Refresh
statotot statotot Attt etobieh Aot
Aetetetat: Aetetetat: Attt stetotstoh Aot
sokctohok
ootk

copuright ALlen $wstens Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the ASG Support Web Site at wWW.asq.coH

1. Product Parameters

Displays the Options - Product Parameters pop-up used to
set parameters that affect the online operation of Insight.

2. Product Allocations

Displays the Options - Product Allocations pop-up used to
specify DASD volumesfor the Log, List, Punch, and Work
files, and to specify space for the Work file.

3. Log/List/Punch

Displays the Options - Log/List/Punch Definition pop-up
used to set valuesfor allocating, formatting, and processing
the Insight Log, List, and Punch files.

4. Script File Allocations

Displays the Options - Script File Allocations pop-up used
to modify the default script file dataset names for your
session.

5. PF Keys

Displays the Options - PF Key Definition pop-up used to
display or change PF key values.

6. Modes

Displays the Options - Processing Modes pop-up used to
enable and disable Insight processing modes.




8 Options

Action Description

7. Scratchpad Displays the Options - Scratchpad pop-up used to select
options for equates and marks.

8. Refresh Updates the CALL summariesfor programs CALLed by
the active program.

Options - Product Parameters Pop-up

Fields

To set the Insight online operation parameters, follow this step:

» Select Options» Product parameters, or type PARMDEF on any screen, and press Enter.
The Options - Product Parameters pop-up, shown in Figure 83, displays.

Figure 83« Options- Product Parameters Pop-up

Options - Product Parameters
Command ===>

Type the desired parameters below to customize the operation of
the product. Then press Enter.

Alarm . . . . . . . YES (Yes or No)
Save Equates . . . . NO (Yes or No)
Save Marks . . . . . NO (Yes or No)
Cursor character . . % (token substitution character)
Field Description
Alarm Controlsthe audible alarm ontheterminal. Type YES for thealarm to
sound when an error message displays. Type NO for no alarm. The
default isYES.

Save Equates Saves eguates at the end of a Source View session. TypeNO if you do
not want to save equates. Thisvalue can be overridden when using the
END, GOBACK, PROGRAM, RETURN, and SAVE commands.
The default isYES.

See "EQUATE Command" on page 201 for more information about
equates.
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Save Marks

Saves marks at the end of a Source View session. Type NO if you do
not want to save marks. This value can be overridden when using the
END, GOBACK, PROGRAM, RETURN, and SAVE commands.
The default is YES.

Seethe"MARK Command" on page 265 for more information about
user marks.

Cursor
Character

Sets the cursor token substitution character. The default is %. Cursor
substitution saves time by allowing you to use this character in a
command and then place the cursor under the token in the source
code.

See "Cursor Substitution Character”" on page 183 for more
information.

Options - Product Allocations Pop-up

152

To specify the DASD volumes for the Log, List, Punch, and Work files; and to specify
Work file space, follow this step:

» Select Options » Product allocations, or type ALLOCDEF on any screen, and press
Enter. The Options - Product Allocations pop-up, shown in Figure 84, displays.

Figure 84« Options- Product Allocations Pop-up

Command ===>

Log Ffile:

Options - Product Allocations

Management Class
Storage Class
List file:
Management Class
Storage Class
Punch file:
Management Class
Storage Class
Work file:
Management Class
Storage Class
Data Class . . .

Primary space
Secondary space

MGMT1 Generic unit . . . SYSDA
. STOR1 Volume serial

MGMT1 Generic unit . . . SYSDA
. STOR1 Volume serial

MGMT1 Generic unit . . . SYSDA
. STOR1 Volume serial

MGMT1 Generic unit . . . SYSDA
. STOR1 Volume serial
. DATA1 Space units . CYLS

1

1




Fields

8 Options

Log File

Specifies the SMS classes or the device type and volume serial
number for the Insight Log file. The Log fileis used for error
messages and log commands. Thefile characteristics are specified on
the Options - Log/List/Punch Definition pop-up. Thelog file nameis
userid.INShnnnn.VIALOG. If the TSO prefix is different from
the user 1D, the dataset name is preceded by the prefix value.

List File

Specifies the SM S classes or the device type and the volume serial
number for the List file, that is allocated the first time you type
LPRINT. The List fileisused for LPRINT output. Thefile
characteristics are specified on the Options - Log/List/Punch
Definition pop-up. Thelist file nameis
userid.INSnnnnn.VIALIST. If the TSO prefix is different from
the user 1D, the dataset name is preceded by the prefix value.

Punch File

Specifies the SM S classes or the device type and the volume seridl
number for the Punch file, that is alocated the first time you type
LPUNCH. The Punch fileis used for LPUNCH output. Thefile
characteristics are specified on the Options Log/List/Punch
Definition pop-up. The punch file nameis
userid.INSnnnnn.VIAPUNCH. If the TSO prefix is different
from the user 1D, the dataset name is preceded by the prefix value.

Work File

Specifies the SM S classes or the device type, volume serial number,
and space requirements for the Work file space that is allocated upon
entry into Insight. The Work fileis atemporary file. Space
requirements for it depend on the size of the COBOL programs you
work with. Approximately one cylinder is required for a’5,000 line
program on a 3380 device.
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Options - Log/List/Punch Definition Pop-up

154

To set values for alocating, formatting, and processing the Insight Log, List, and Punch
files, follow this step:

P Select Options» Log/list/punch, or type PRINTLOG or PRINTLST on any screen, and
press Enter. The Options - Log/List/Punch Definition pop-up, shown in Figure 85,

displays.

Figure 85« Options- Log/List/Punch Definition Pop-up

Options - Log/List/Punch Definition
Command ===>

1 - Process LOG File 2 - Process LIST File 3 - Process PUNCH File

Options LOG LIST PUNCH
Process Option . . . . . . PD PD PK
Primary tracks R 1 1
Secondary tracks .. .2 5 5
Lines per page . . . . . . 56 56 56
Sysout class . . . . . . . * * *

Process Options: PK (Print/Keep), PD (Print/Delete), K, or D.
LOG FILE IS ALLOCATED

Job Statement Information:
//NAME JOB (ACCOUNT) ,NAME

// MSGCLASS=A
/* INSERT */*ROUTE PRINT NODE.USER" HERE IF NEEDED.
//7*

Aninternal error allocatesthe Log file. The List file is allocated the first time you type
LPRINT. The Punch fileis alocated the first time you type LPUNCH .

The Options - Product Allocations pop-up specifies the Log, List, and Punch file
volumes.
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8 Options

1- Process LOG File Verify or change the Options for the Log file and type 1 to

process the Log file. If the PK or PD Process Option is
specified, type the required Job statement information prior
to selecting this option. The Log fileis processed when you
press Enter. Y ou do not need to exit Insight to print the Log
file. By default, thelog file name is
userid.INSnnnnn.VIALOG. If the TSO prefix is different
from the user 1D, the dataset name is preceded by the prefix
value.

2 - Process LIST File Verify or change the Options for the List file and type 2 to

processthe List file. If the PK or PD Process Optionis
specified, type the required Job statement information prior
to selecting this option. The List fileis processed when you
press Enter. Y ou do not need to exit Insight to print the List
file. Thelist filenameisuserid.INSnnnnn.VIALIST. If
the TSO prefix isdifferent fromtheuser I D, the dataset name
is preceded by the prefix value.

3 - Process PUNCH File Either verify or change the Options for the Punch file and

type 3 to process the Punch file. If the PK or PD Process
Option is specified, type the required Job statement
information prior to selecting this option. The Punch fileis
processed when you press Enter. Y ou do not need to exit
Insight to processthe Punch file. Noticethat the all ocation of
the Punch fileis used by the Browse facility for determining
the space used by the temporary file created during aBrowse
session. The punch file nameis
userid.INSnnnnn.VIAPUNCH. If the TSO prefix is
different from the user 1D, the dataset name is preceded by
the prefix value.

Fields

Process Option

Specifies one of the valid processing options. The default is PD for
the Log and List files, and PK for the Punch file.

Primary tracks

Specifies the number of primary tracks to allocate. A size change
does not take effect until the next alocation occurs. The defaultis 1.

Secondary tracks

Specifiesthe number of secondary tracksto allocate. A size change
does not take effect until the next allocation occurs. These are the
defaults: 2 for the Log file, 5 for the List and Punch files.
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Field Description

Lines per page Specifies the number of linesto print per page. Standard maximum
values are 60 for 6 lines per inch and 80 for 8 lines per inch. The
default is 56.

Sysout class Specifiesthe SYSOUT class value. The default is*, that sends the
SY SOUT tothedestinationidentified inthe M SGCL A SSparameter
on the JOB statement.

Process Options  Liststhe options available for the Log, List, and Punch files. These
arethevalid values:

PK Print and keep
K Keep without printing
PD Print and delete
D Delete without printing

XXXXX FILEIS  Displayswhen the Log, List, or Punch fileis properly alocated. If

ALLOCATED the message does not appear, check the assignments on the
Options- Product Allocations pop-up. XXXXX isLOG, LIST, or
PUNCH depending on the file that was allocated.

Job Statement Specifiesthe correct job statement information for your install ation.
Information These JCL statementsarerequired if the PK or PD processoptionis
specified.

156



Options -

Fields

Usage Notes

8 Options

Script File Allocations Pop-up

To display and/or modify the default script file concatenation sequence for your session,
follow this step:

» Select Options » Script file allocations and press Enter. The Options - Script File
Allocations pop-up, shown in Figure 86, displays.

Figure 86« Options- Script File Allocations Pop-up

File View Search Logic Task List Options Help

Options - Script File Allocations
Command ===>

R - Restore default Script allocations
Enter desired Script file concatenation.

Script file data set names:

"ASG.UTIL.SCRIPT"

Field Description

Restore default Script Allocations  Restores the defaults set during the install process.

Script File Data Set Names Specifies the dataset names for the desired default
script files. Thefiles are concatenated in the order
entered.

Note:

When initializing for defaults, the lines fill from the bottom to alow concatenation.

Default script files are specified for your site when Insight isinstalled. Y ou can use the
Options - Script File Allocations pop-up to modify the default dataset names or the
concatenation sequence for the script files. The changes are maintained in your profile.
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Options - PF Key Definition Pop-up
To display and/or redefine PF key values, follow this step:

» Select Options » PF keys, or type KEYS on any Insight screen. The Options - PF Key
Definition pop-up, shown in Figure 87, displays.

PF keys 1 through 12 initially display. A similar screen exists for PF keys 13 through 24,
that displays by pressing Enter. Any command or data value can be assigned to a PF key.

Figure 87 ¢« Options- PF Key Definition Pop-up

Options - PF Key (01-12) Definition
Command ===>

Press Enter to process changes and/or to display alternate keys.
Press PF3/15 (END) to exit.

Number of PF keys: 24 Terminal type: 3278

PFO1 HELP
PFO2 SPLIT
PFO3 END
PFO4 RPREF
PFO5 RFIND
PFO6 FX %
PFO7 UP
PFO8 DOWN
PFO9 SWAP
PF10 BRANCH
PF11 BRANCH BACKUP
PF12 RECALL

Fields

Number of PF Keys Specifies the number of PF keys supported.

Terminal Type Indicates the type of terminal being used. Insight supports
these 3270 type terminals:

- Model 2 (24 lines x 80 columns)
<  Mode 3 (27 lines x 80 columns)
- Model 4 (43 lines x 80 columns)

- Model 5 (27 lines x 133 columns)

PFO1 through PF12 or Specifies the values assigned to the PF keys, that you can

PF13 through PF24 change by typing over the number. To reset a PF key to its
default value, delete the entry and press Enter. To set a PF
key to have no value (i.e., to turn off a PF key) type NOP .
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When Insight isinstalled, PFO1 through PF12 and PF13 through PF24 are set to the
default values for the primary PF keys. These are the default values:

Value Description

PF01/13 HELP
PFO7/19 UP
PF02/14 SPLIT
PF08/20 DOWN
PF03/15 END
PF09/21 SWAP
PF04/16 RPREF
PF10/22 BRANCH
PFO5/17 RFIND
PF11/23 BRANCH BACKUP
PF06/18 FX %
PF12/24 RECALL
Note:

The aternate PF keys may be PFO1 through PF12 or PF13 through PF24, depending on

your site's specifications.
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Options - Processing Modes Pop-up

To set processing modes

1  Select Options » Modes and press Enter. The Options - Processing M odes pop-up,
shown in Figure 88, displays.

Figure 88+ Options - Processing M odes Pop-up

Command

—==>

Options - Processing Modes
Scroll ===> CSR

Type option settings. Then press PF3/15 (END) to save options and exit.

OFF Display internally generated Primary Commands
OFF Script facility is disabled
OFF Exclude all lines before executing Primary Commands

Description

2 Change the settings by typing over them.

Y ou can also change the setting using the SET command, for example, by typing
SET LEARN ON. See"SET Command" on page 311 for more information.

Fields

Option

The processing mode to be enabled or disabled.

LEARN

SCRIPT

XMODE

When LEARN is ON, all primary commands generated
internally when actions from the pull-downs are executed
display on the LEARN Mode - Generated Command pop-up.
See the"SET Command" on page 311 for more information.
The default for this option is OFF.

When SCRIPT isON, ascript fileis allocated. From that point
on, al Insight primary commands are captured in thisfile.
When SCRIPT is OFF, thefileis closed and saved. The script
filenameisuserid.INSnnnnn.VIASCRIP. If the TSO
profile prefix is not the same as the user ID, then this name is
preceded by a prefix value.

When XMODE isON, all lines are excluded from the screen
before a primary command is executed. The default is OFF.
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Field Description

Set Displays current setting for each mode. Y ou can change the settings by
typing over them. Values not set to the default status are shown in bold.

Description Provides descriptions of the options. The Script facility description also
indicates whether it is enabled or disabled.

Options - Scratchpad Pop-up

Use the Options - Scratchpad pop-up to define equates and to create, copy, delete, merge,
or rename marks.

To display the Options - Scratchpad pop-up, follow this step:

» Select Options» Scratchpad and press Enter. The Options - Scratchpad pop-up, shown
in Figure 89, displays.

Figure 89« Options - Scratchpad Pop-up

Options - Scratchpad

Select the desired option to create or modify
Equates and Marks. Then press Enter.

Options
1 Equate. ..
Mark. . .
Copy.- - -
Delete. ..
Merge...
Rename. ..

O WNE

Options

Option Description

Equate Displays the Options - Scratchpad Equate pop-up used to define a
unique name representing a character string or group of dataitems. See
"Options - Scratchpad Equate Pop-up" on page 162 for more
information.

Mark Displays the Options - Scratchpad Mark pop-up used to save the
requested target asamark set or path. See " Options - Scratchpad Mark
Pop-up" on page 164 for more information.
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Option Description

Copy Displays the Options - Scratchpad Copy pop-up used to copy a mark
set or path. See "Options - Scratchpad Copy Pop-up” on page 166 for
more information.

Delete Displaysthe Options - Scratchpad Delete pop-up used to delete amark
set or a path. See "Options - Scratchpad Delete Pop-up” on page 168
for more information.

Merge Displaysthe Options - Scratchpad Merge pop-up used to add the lines
from the specified target to the specified mark name. See "Options -
Scratchpad Merge Pop-up” on page 168 for more information.

Rename Displays the Options - Scratchpad Rename pop-up used to change the
name of amark path or a set of lines. See "Options - Scratchpad
Rename Pop-up" on page 170 for more information.

Options - Scratchpad Equate Pop-up

To define a character string name, follow this step:

» Select Equate on the Options - Scratchpad pop-up and press Enter. The
Options - Scratchpad Equate pop-up, shown in Figure 90, displays.

Figure 90« Options- Scratchpad Equate Pop-up

Options - Scratchpad Equate
To create an equate, type a name and string. Then press Enter.
Equate name

Equated string
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Fields

Fields Description

Equate name Specifiesthe namethat you want to assign to the character
string. Names must conform to these standards:

- 1 to 10 aphanumeric characters

- First character must be alphabetic or a period
< A hyphenisthe only special character allowed
- May be 1 to 4 DBCS characters

Equated string Specifiesacharacter string to be substituted by the equate.
A character string can be along command, pattern,
dataname, or concatenated dataname, etc. Y ou can specify
literals and blanks in the character string if desired. The
string may be aDBCS string. If the equated string is not
entered, the equate name is del eted.
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Options - Scratchpad Mark Pop-up
To save the requested target as amark set or path, follow this step:

» Select Options» Mark and press Enter. The Options - Scratchpad Mark pop-up, shown
in Figure 91, displays.

Figure9le Options- Scratchpad Mark Pop-up

Options - Scratchpad Mark
To create a mark, type a name and a target. Then press Enter. For a
name selection list for a target type, type a pattern (e.g. ABC*) in
the target name area.
Mark name . .

Target name .

Target type
1 1. Mark name

2. Perfrange name

3. Program name

4. Subset name

5. Line range

6. Label name
Comments . .

Fields

Field Description

Mark name Specifiesthe name you want to assign to the set of lines or path. The
name must be 1 to 10 alphanumeric characters.

Target name Specifies the name of the target you want to save.
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Target type
Mark name

Perfrange
Name

Program Name

Subset Name

Line Range

Label Name

Comments

Specifies the type of target you want to save.

A 1to 10 aphanumeric character name given to a set or path using
the COPY, MARK, MERGE, or RENAME commands, or one of
these system-generated paths:

System generated path: Created by:
TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.

SUBNETN | SUBn A path created by the FLOW command that
reaches from the beginning of the NETWORK to one of the results
(nth result).

Note:
The TRACK, NETWORK, and SUBNET paths can also be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on
page 101).

The name specified in a PERFORM statement including all
statements executed as aresult of a PERFORM statement, or the
name of any section contained in the Declaratives.

The name of the main program or any nested program representing
all the code contained in the program. Thisincludesall the programs
physically nested inside the specified program.

A predefined COBOL language subset. Seethe ASG-Insight User’s
Guidefor alist of each subset and its description.

A single line number or range of lines. Line numbers display in
columns 1 through 6 of Source View.

Any PROCEDURE DIVISION paragraph name or section name.
The PROCEDURE and PROC literals can also be specified.

Provides a description or other comments for the mark.
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Options - Scratchpad Copy Pop-up

To copy the contents of a path or set of linesto amark, follow this step:

» Select Copy on the Options - Scratchpad pop-up and press Enter. The
Options - Scratchpad Copy pop-up, shown in Figure 92, displays.

Figure 92« Options- Scratchpad Copy Pop-up

Options - Scratchpad Copy
To create a mark, type a name and a target. Then press Enter. For a
name selection list for a target type, type a pattern (e.g. ABC*) in
the target name area.
Mark name . .

Target name .

Target type

1 . Mark name
Perfrange name
Program name
Subset name
Line range
Label name

OUAWNE

Comments

Fields

Field Description

Mark name Specifies the name you want to assign to the set of lines or path. The
name must be 1 to 10 alphanumeric characters.

Target name  Specifies the name of the target you want to save.
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Target type
Mark name

Perfrange
name

Program
name

Subset
name

Specifies the type of target you want to save.

Specifiesa 1 to 10 alphanumeric character name given to a set or path
using the COPY, MARK, MERGE, or RENAM E commands, or one of
these system-generated paths:

System generated path:  Created by:
TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.

SUBNETN | SUBN A path created by the FLOW command that
reaches from the beginning of the
NETWORK to one of the results (nth
result).

Note:
The TRACK, NETWORK, and SUBNET paths can also be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on
page 101).

Specifies the name in a PERFORM statement, including al of the
statements executed as aresult of a PERFORM statement, or the name
of any section contained in the Declaratives.

Specifies the name of the main program or of any nested program
representing all of the code contained in the program. Thisincludes al
of the programs physically nested inside the specified program.

Specifies a predefined COBOL language subset. See the ASG-Insight
User’s Guide for alist of each subset and its description.

Linerange Specifiesasingleline number or arange of lines. Line numbersdisplay

in columns 1 through 6 of Source View.

Label Specifies any PROCEDURE DIVISION paragraph name or section
name name. Y ou can also specify the PROCEDURE and PROC literals.
Comments Provides a description or other comments for the mark.

Y ou can also copy paths and sets using the COPY command. See the "COPY Command"
on page 194 for more information.
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Options - Scratchpad Delete Pop-up
To delete amark set or path, follow this step:

» Select Delete on the Options - Scratchpad pop-up and press Enter. The
Options - Scratchpad Delete pop-up, shown in Figure 93, displays.

Figure 93« Options- Scratchpad Delete Pop-up

Options - Scratchpad Delete
To delete a mark, type the mark name. Then press Enter.

Mark name . .

Field

Mark name  Specifies the name of the mark you want to delete.

Usage Notes

Y ou can also delete marks using the DELETE command. See the "DELETE Command"
on page 198 for more information.

Options - Scratchpad Merge Pop-up
To add the lines from the specified target to the specified mark name, follow this step:

» Select Merge on the Options - Scratchpad pop-up and press Enter. The
Options - Scratchpad Merge pop-up, shown in Figure 94, displays.

Figure 94 « Options- Scratchpad Merge Pop-up

Options - Scratchpad Merge
To expand a mark, type the name and target. Then press Enter. For a
name selection list for a target type, type a pattern (e.g. ABC*) in
the target name area.
Mark name . .

Target name .

Target type
1 . Mark name
Perfrange name
Program name
Subset name
Line range
Label name

OUAWNE

Comments
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Mark name Specifies the name you want to assign to the new set of lines or path.

The name must be 1 to 10 alphanumeric characters.

Target name  Specifies the name of the target you want to add.
Target type Specifies the type of target you want to add.

Mark name A 1to 10 alphanumeric character name given to a set or path using the
COPY, MARK, MERGE, or RENAME commands, or one of these
system-generated paths:

System generated path: Created by:

TRACK | TRK A TRACE command.

NETWORK | NET A FLOW command.

SUBNETN | SUBn A path created by the FLOW command that
reachesfrom the beginning of the NETWORK
to one of the results (nth result).

Note:

The TRACK, NETWORK, and SUBNET paths can be created using

the Logic Order Search pop-ups (see "Logic Pull-down" on page 101.

Perfrange  The name specified in aPERFORM statement, including all statements

name executed as aresult of a PERFORM statement, or the name of any
section contained in the Declaratives.

Program The name of the main program or of any nested program representing

name al of the code contained in the program. Thisincludes all of the
programs physically nested inside the specified program.

Subset A predefined COBOL language subset. See the ASG-Insight User’s

name Guide for alist of each subset and its description.

Linerange A singleline number or arange of lines. Line numbers display in
columns 1 through 6 of Source View.

L abel Any PROCEDURE DIVISION paragraph name or section name. Y ou

Name can a so specify the PROCEDURE and PROC literals.

Comments Provides a description or other comments for the mark.

169



ASG-Insight Reference Guide

Y ou can also merge marks using the MERGE command. See the "M ERGE Command"
on page 268 for more information.

Options - Scratchpad Rename Pop-up

To change the name of amark path or set of lines, follow this step:

» Select Rename on the Options - Scratchpad pop-up and press Enter. The
Options - Scratchpad Rename pop-up, shown in Figure 95, displays.

Figure 95« Options- Scratchpad Rename Pop-up

Options - Scratchpad Rename

To rename a mark, type the old and new
name. Then press Enter.

Oold mark name

New mark name

Fields

Field Description

Old mark name Specifies the mark name that you want to change.

New mark name  Specifies the new name that you want to assign to the mark. The
name must be 1 to 10 alphanumeric characters.

Usage Notes

Marks can aso be renamed with the RENAME command. See the"RENAME
Command" on page 289 for more information.
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Help

This chapter describes items on the Insight Help menu options and contains these
sections:

Help Pull-down 172
Help - Specific ASG Command Pop-up 174
Help - Specific ASG Message Number Pop-up 175
Help - About Pop-up 175
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Help Pull-down

To access the online help facility, follow this step:

» Select Help on the action bar and press Enter. The Help pull-down, shownin Figure 96,
displays.

Figure 96 « Help Pull-down

File Wiew 3Zearch Logic Task List Options Help

. Current screen

. Current Ressage

. ALl coHHands

. Fpecific COMRand...
. Epecific HeSSage...
. CoMAon abends

« Table of contents...
« IndeHa..

. Action bar...

. About...

AZG-EIM - Prograd Underst

!

CoHHand ===

[ Rl L) B D

%
%
%

Copyright ALlen Systens Group, INcC., an unpublished vork.
A proprietary product of A%G, Inc. Use restricted to authorized 1icensess.
Visit the ASE Support Web Tite at wuw,asg.cod

Actions

1. Current Screen Displayshelp for the screen or pop-up that iscurrently displayed.

2. Current Message  Displays help for the message that is currently displayed.

3. All Commands Displaysacompletelist of al Insight primary commands, where
specific command information displays by selecting the
appropriate number.

4. Specific Command Displays the Help - Specific ASG Command pop-up used to
obtain help about a specific Insight primary command.

5. Specific Message  Displaysthe Help - Specific ASG Message Number pop-up used
to obtain help about a specific message number.

6. Common Abends  Displaysthe Abends screen, where you can display information
about a specific abend by selecting the appropriate number.
Select topic 2 on this screen to display the ASG Abend Codes
screen, that lists all the user abends and their explanations.
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Action Description

7. Table of Contents  Displaysthe Help Table of Contents used to request help for
general information. See the "Help Facility" on page 393 for
more information and an example of the online Help Table of
Contents.

8. Index Displays the Help Index used to request help for specific
information. See the "Help Facility" on page 393 for more
information and an example of the online Help Index.

9. Action Bar Displays the Action Bar help pop-up that contains general
information about the action bar and selections to help for each
of the pull-downs.

10. About Displaysthe Help - About pop-up that listsinformation about the
currently installed levels of Insight and Center.

Usage Notes

Y ou can also use the HEL P command to access help. See the "HEL P Command" on
page 235 for more information.
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Help - Specific ASG Command Pop-up

To obtain help about a specific Insight primary command, follow this step:

» Select Help P Specific ASG Command and press Enter. The Help - Specific ASG
Command pop-up, shown in Figure 97, displays.

Figure 97 « Help - Specific ASG Command Pop-up

Help - Specific ASG Command
To display a message that describes a ASG
command, type the command below. Then press
Enter.

Command . . . .

To display additional command information, enter
the HELP command (PF1/13) from the screen that
displays the command message.

Fields

Field Description

Command Specifies a primary command. The Help Tutorial for that command
displays. See the "Help Facility" on page 393 for more information.
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Help - Specific ASG Message Number Pop-up
To display help for a specific messageA SG, follow this step:

» Select Help P Specific ASG Message Number and press Enter. The Help - Specific
ASG Message Number pop-up, shown in Figure 98, displays.

Figure 98« Help - Specific ASG M essage Number Pop-up

Help - Specific ASG Message Number

To display the description of a message, type
the message number below. Then press Enter.

Message . . . .
Fields
Message Specifies a message number. The HEL P Explanation and Action

Panel for that message displays. See the "Help Facility" on page 393
for more information.

Help - About Pop-up

To display information about the currently installed rel eases of Insight and Center, follow
this step:

» Select Help » About and press Enter. The Help - About pop-up, shown in Figure 99,
displays.

Figure 99« Help - About Pop-up

Help - About

The following is release information for this
ASG product.

Product name . . . . . . . : ASG-Insight
Release number . . . . . - X.X
Maintenance level . . . . I nnn

ASG-Center release number : X.X
Maintenance level . . . . I nnn

Operating system . . . . . : MVS(ESA)
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Fields

Field Description

Product name Specifies Insight or the name of the ESW product you are
currently running.

Release number Specifies the currently installed release number of Insight.
Maintenance level Specifies the currently installed Insight PRS number.
ASG-Center release Specifies the currently installed release number of Center.
number
Maintenance level Specifies the currently installed Center PTF number.
Operating system Specifies the operating system you are running.

Note:

Thisinformation is requested when you contact ASG
Customer Support for assistance. Y ou can also display this
information by typing PRODLVL on any screen.
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Commands

This chapter describes Insight commands and contains these sections:

Command Processing 180
Recalling/Repesating Commands 181
Cursor Position 182
Cursor Substitution Character 183
Command Diagrams 183
& (Retain) Command 186
ALLOCDEF Command 187
ANALYZE Command 188
BRANCH Command 189
CALL Command 192
CANCEL Command 193
COPY _Command 194
CURRENT Command 197
DELETE Command 198
END Command 200
EQUATE Command 201
EXCLUDE Command 203
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Section Page

EXECUTE Command 209
FIND Command 212
FINDXTND Command 216
FLOW Command 228
GOBACK Command 234
HELP Command 235
HIGH Command 236
JUMP Command 243
KEY S Command 244
LEVELS Command 246
LIST Command 247
LOCATE Command 249
LPRINT Command 251
LPUNCH Command 258
MARK Command 265
MERGE Command 268
PARMDEF Command 271
PREF Command 272
PRINTLOG Command 275
PRINTLST Command 276
PROCESS Command 277
PRODLVL Command 281

PROGRAM Command 282
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Section Page

QUALIFY Command 283
RECALL Command 284
REDO Command 287
REFRESH Command 288
RENAME Command 289
REPEAT Command 290
RESET Command 291
RETURN Command 292
RFIND Command 293
RHIGH Command 294
RPREF Command 295
RSCROLL Command 296
RSTRUCTURE-VIEW Command 297
RTRACE Command 298
RTREEVW Command 301
SAVE Command 302
SCROLL Command 303
SELECT Command 310
SET Command 311
SOURCEVIEW Command 312
STRUCTURE-VIEW Command 313
TRACE Command 315
TREEVIEW Command 321
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VIEW Command 323
ZOOMIN/ZOOMOUT Commands 324
Line Commands 325

In addition to processing requests from pull-downs and pop-ups, Insight accepts the
primary and line commands that you enter in the same manner as | SPF commands. Y ou
can enter primary commands on screens and pop-ups that contain a command input area;
line commands are entered in a selection column field or in the prefix area over the line
numbersin Source View. Insight supports al | SPF system commands on the appropriate
screens. All Insight commands are described in this chapter.

Some of the most frequently used commands have been assigned to PF keys. The KEY S
command can be entered from any command input area to change the PF key
assignments. See the online help for detailed information about PF key assignments.

Command Processing

Insight line commands process before primary commands. Commands you enter by
pressing a PF key are handled as if you entered them in the command input area. If you
enter acommand by pressing a PF key and there is a command in the command input
area, the contents of the command input area append to the PF key command. The
combined commands then execute as a whole. Multiple commands entered in the
command input area are separated by a semicolon (;) and process in aleft-to-right
sequence. Command results display when one of these conditions occur:

=  Thelast command processes and all commands in the sequence complete
successfully.

< A command is not successfully processed. If an error occurs in the sequence,
processing stops and an error message displays. Results display for the commands
that successfully completed. The command causing the error and all remaining
commands in the sequence display in the command input area.

Each command in a command sequence is recognized separately for use with the
RECALL command.
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Insight remembers the last twenty primary commands entered. These methods can be

used to repeat commands:

Type RECALL to display the last command entered in the command input area.
After the recalled command displays, it can be modified, deleted, or executed again.
Enter the RECALL command repeatedly to display the commandsin reverse
sequence without executing them. To execute a recalled command, press Enter
while the command displays in the command input area.

Type REPEAT to execute the last stacked primary command again (if itisa

repeatable command).

These are the Insight primary commands that can be repeated:

BRANCH
CANCEL
COPY
DELETE
EQUATE
EXCLUDE
EXECUTE
FIND
FINDXTND
FLOW
HIGH
LIST
LPRINT
LPUNCH
MARK

MERGE

PREF
REFRESH
RENAME
RESET

RPREF
SCROLL
SELECT

SET
SOURCEVIEW
STRUCTURE-VIEW
TRACE
TREEVIEW
ZOOMIN
ZOOMOUT
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These methods can be used to repeat the last primary command entered:

Use the & (Retain) command preceding a primary command to keep the command
displayed in the command input area after execution. Thisis the quickest way to
repeat a command when minor changes are required before execution.

Use the REDO command to re-execute the last FIND, FINDXTND, HIGH, PREF,
SCROLL, or TRACE command (see "REDO Command" on page 287 for more
information).

Use the RFIND command to repeat the last FIND or FINDXTND command from
the cursor position. PFO5/17 is the default PF key for the RFIND command.

Use the RHIGH command to repeat the last HIGH command from the cursor
position.

Use the RPREF command to display the last View - Paragraph Cross Reference
pop-up or to function as a PREF command with the cursor location asthe target and
default direction (see "RPREF Command" on page 295 for more information).
PF04/16 is the default PF key for the RPREF command.

Use the RSCROLL command to repeat the last SCROLL command from the cursor
position.

Use the RTRACE command to continue the last TRACE command from where it
stopped (see "RTRACE Command" on page 298 for more information). PFO6/18 is
the default PF key for the RTRACE command.

Cursor Position

182

The result of the command depends on the starting point of the search. Y ou can specify a
starting point by entering aline number or alabel name, or by using the cursor as the
starting point. These are the rulesiif the cursor is used as the starting point:

Command input area In the first column of the first source line on the screen
Line command area From the first column on that line
Program source From the cursor position
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Cursor Substitution Character

The cursor character is a token substitution character that you can use in any primary
command on the Source View screen. A token is a contiguous set of characters preceded
by and followed by a blank, period, comma, or parenthesis. Y ou define the cursor
substitution character on the Options - Product Parameters pop-up. Y ou may choose any
character, but it should be one that is unique and rarely used in commands. The default is
percent (%).

The cursor substitution character saves you time and typing effort when you are working
with commands. Type the cursor substitution character anywhere on the command line,
then place the screen cursor on the token that is to replace it in the command. For
example, to find all occurrences of HLD-ZIP-PREFIX, type FINDXTND in the command
input area:

FX %

Then place the screen cursor anywhere on HLD-ZIP-PREFIX in the source code. The
command FX HLD-ZIP-PREFIX executes when you press Enter. Notice that the cursor
substitution character must have a space before and after it.

Y ou can use multiple cursor tokens to specify consecutive tokens in the source code. For
example:

FX % % %
If you then place the screen cursor on HLD-ZIP-PREFI X, the next two tokens are picked
up in the command, resulting in the command FX HLD-ZIP-PREFIX OF HLD-ZIP. The

first token isHLD-ZIP-PREFI X, the second token is OF, and the third tokenisHLD-ZIP.
The tokens must be consecutive.

Command Diagrams

These are the notational conventions and symbols used to describe command syntax:

ABBREViations Ilustrates the command abbreviation, which is shown in
uppercase letters. Lowercase letters in the command are optional.

lowercase Indicates user-supplied variable information.

UPPERCASE Indicates commands or keywords.

Underline Specifies the default value of an operand.
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Item Description

| Separates synonymous commands or operands.

s Indicates that the command syntax is continued on the next line.

Indicates the command syntax is continued from the previousline.

9—
Indicates the end of the command syntax.
— required — Indicates that the operand or keyword appearing on the main
command lineis required.
choice] —— | ndicates that one operand is required.
hoice2 j
choice3
Contionar] Indicates that an operand or keyword appearing below the main
optiona command lineis optional.
: Indicates that operands are optional.
I:chomel—
choice2
— Indicates that more than one operand can be chosen.
choicel—
choice2—!

A — Indicates that operands can be concatenated by placing aplussign

(+) between them.
I:choicel—
choice2—
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Figure 100 illustrates a syntax diagram for the LPUNCH command. LPUNCH or a
minimum of LPU can be entered. Y ou must enter LPUNCH with atarget operand as
indicated by the name variable on the main path of the line. If the path is followed down
the first or second vertical line, you can specify any of the target operands or an asterisk
(*). If you specify more than one operand, separate each with a space. Operands that can
be concatenated are indicated by areturning arrow that includesaplussign (+) intheline.
Dataname operands (Ref, Usg, etc.) pertain to all datanames in a concatenated series.

Continuation lines are numbered 1 and 2 with 1 being the main path of the line.
Continuation line 2 shows that the asterisk (*) operand is entered with no other values
since the line from it extends to the end of the path, bypassing the direction and intarget
operands. The direction and intarget operands are optional since they are below the main
path of theline.

Figure 100+ Command Syntax Diagram

—+
LPUn ch Y name >
——LABEL——
——MARK——
+PERFRANGE
—PROGRAM—
——SUBSET—
range—
——LINE——
name—
LPARAGRAPH-
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IDMS—| Use NOAlias T TT
: Mod —INDirect %Sle LEVels n
Def VALue

—T 'strina PREFIX
—P 'string SUFFIX

string
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— Next L —
—Prev IN-Y name—
—Flrst —MARK
—LAst —PERFRANGE —

——All —PROGRAM—
—SUBSET—
TS
—LINE
ﬁnamef
—~PARAGRAPH
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& (Retain) Command

Y
A

&any primary command

Function

The Retain command executes the specified primary command and keeps it displayed in
the command input area for repeated use or modification.

Operands
Ampersand (&) must be followed by a primary command.

Usage Notes

The Retain command is useful if you want to repeatedly execute the same primary
command or make minor changes to a command.

For example, after you execute the FINDXTND command for a data item, you may
desire to execute an LPRINT command on the same dataitem. Y ou could perform this
function quickly and easily by using the retain command.

Example

To find the EOF-FLAG and keep & FINDXTND EOF-FLAG displayed in the command
input area, type this command:

&FINDXTND EOF-FLAG
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ALLOCDEF Command

ALLOCDEF | ADEF

Y
A

Function
The ALLOCDEF command displays the Options - Product Allocations pop-up used to
specify the DASD volumesfor the Log, List, Punch, and Work files; and to specify space
for the Work file.

Operands

None.

Usage Notes

The Options - Product Allocations pop-up can also be displayed by selecting Options »
Product allocations and pressing Enter.

Y ou can enter the ALLOCDEF command on any screen.

187



ASG-Insight Reference Guide

ANALYZE Command

ANalyze

Function

Operands

Usage Notes

188
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A

The ANALY ZE command displays the File - Analyze Submit pop-up used to submit a
compile/analyze job without ending the current Insight function. A program must be
analyzed before it can be used in Insight.

None.

The File-Analyze Submit pop-up can also be displayed by selecting File » Analyze and
pressing Enter.

Y ou can use the ANALY ZE command on any Insight screen. If viewing a program in
Source View and a program is encountered that has not been analyzed, perform these

steps:

To analyze a program

1  TypeANALYZE in the command input area.
2 Submit the analyze job for the program.

3 TypeEND inthe command input area.

TS0 displays a message when the analyze job has completed. Usethe CALL, VIEW, or
PROGRAM command to view the program.

Note:

See "Analyze" on page 339 for additional information about submitting an analyze job.
See the online help for more information about the File - Analyze Submit pop-up.




BRANCH Command
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1

Branch

Function

Operands

name-——
—PERFRANGE—
—PROGRAM——
—LABEL
—PARAGRAPH—
—BACKup
—PREVIOUS

The BRANCH command is used to position the cursor at the specified target. This
command is used to scroll from a statement such as a PERFORM, to the paragraph being
performed. Use the BACKUP operand to return to the statement where the BRANCH

occurred.

Blank

No operand isrequired if the cursor ispositioned on aGO TO or
PERFORM statement. The BRANCH command automatically
locates the target of the GO TO, PERFORM, or internal CALL
statement. Internal CALL statementsarethe CALLsinaCOBOL
Il Release 3 program that call programslocated in the same source
module. If the cursor is positioned on any other statement, the
BRANCH command locates the next sequential statement to be
executed. The PROCEDURE DIVISION label islocated if the
cursor is positioned outside the PROCEDURE DIVISION.

PERFRANGE
name

L ocates the specified PERFORM range. If the specified nameis
not fully qualified and there are multiple PERFORM ranges with
the specified name, the cursor is positioned on thefirst PERFORM
range found. A message displays indicating the number of
PERFORM ranges found.

PROGRAM name

L ocatesthe specified nested program. For COBOL |l Release 3 or
later programs, a dataitem, label, or program name that may be
ambiguous or used multiple times can be qualified by using OF
followed by the program name. For example, if the |abel
P120-READ existsin another program and also in the program
VIAIDEM1, it can be qualified as P120-READ OF VIAIDEM 1.
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Usage Notes

190

LABEL name L ocates the specified paragraph or section name. If the specified
name is not fully qualified and there are multiple paragraphs or
sections with the specified name, the cursor is positioned on the
first paragraph or section found. A message displaysindicating the
number of paragraphs or sections found.

PARAGRAPH L ocates the specified paragraph name. If the specified nameis not

name fully qualified and there are multipl e paragraphswith the specified
name, the cursor is positioned on the first paragraph found. A
message displays indicating the number of paragraphs found.

BACKup Positions the cursor where the Branch occurred.

PREVious Works in conjunction with the current cursor location to position
the cursor at the GO TO, PERFORM, or CALL statement wherea
target was reached.

Note:

If more than one statement transfers control to the specified branch location (or cursor
position), the Branch Previous Options pop-up displays.

The Branch function can also beinitiated from the Search - Branch Request pop-up. To
display the Search - Branch Request pop-up select Search » Branch and press Enter. See
the online help for more information.

The BRANCH command is very helpful when you are tracking branching logic. This
command can be used to track branching logic several levels deep into PERFORMed
code, then return to each PERFORM statement. An effective way to use the BRANCH
command is to position the cursor on a PERFORM or GO TO statement, then press
PF10/22. (BRANCH isthe default setting for the PF10/22 key; BRANCH BACKUP s
the default for the PF11/23 key.) The screen position is saved for use with the BACKUP
operand based on these conditions:

< A PERFORM range or LABEL name s entered on the command line.
e  Thecursorisplaced on aGO TO or PERFORM statement.
The PROCEDURE DIVISION label displays when you enter the BRANCH command

with no operands and the cursor is positioned in a part of the program other than the
PROCEDURE DIVISION.

If aPROGRAM EXIT or STOP RUN is encountered, a pause occurs and a message
displaysindicating that alogical end is reached. Press PF10/22 to continue the BRANCH
command.
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Example 1. This example assumes that the cursor is positioned on PERFORM
READ-ALL. The screen is scrolled and the cursor is positioned on the READ-ALL

paragraph.
BRANCH

Example 2. This example assumes that the cursor is positioned on the READ-ALL
paragraph. The screen is scrolled and the cursor is positioned on the PERFORM
READ-ALL statement.

BRANCH PREVIOUS

Example 3. The screen is scrolled and the cursor is positioned on the P120-READ
paragraph.

B P120-READ

Example 4. The screenis scrolled and the cursor is positioned on the PROGRAM-INIT
paragraph.

B PROGRAM-INIT

Example 5. The screen is scrolled and the cursor is positioned at the location from
where the B PROGRAM-INIT command was entered.

B BACKUP
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CALL Command

Call

Y
A

L pgm !

Function
The CALL command is used to start a Source View session for another program without
ending the current session. The GOBACK or END command can be used to return to the
original program.

Operands

Blank Displaysthe AKR Program Selection pop-up for selection of aprogram.
See the online help for more information.

pgm Specifiesa COBOL program or entry point name. If the specified
program or entry point is not available in the current AKR, an error
message displays.

Usage Notes

The CALL command provides you a means of following logic paths across CALLed
programs. CALL remembers the location within the CALLing program and displays the
CALLed program. When finished with the CALLed program, use the GOBACK
command to return to the location in the CALLing program. See the "GOBACK
Command" on page 234 and the "PROGRAM Command" on page 282 for additional
information.

Examples

Example 1. In this example the current Source View program is VIAIDEMO, this
command callsthe VIAIDEM1 program:

CALL VIAIDEM1

Example 2. Returnsto the VIAIDEMO Source View session without saving marks or
equates that you created in VIAIDEM1:

GOBACK VIAIDEMO NOSAVE
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CANCEL Command

Y
A

CANCcel
Function
The CANCEL command terminates the current function without saving changesto marks
and equates made during the session.
Operands

None.

Usage Notes

CANCEL isthe equivalent of an END NOSAVE command. It terminates the function
without saving new marks or equates, or changes to existing marks or equates.
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COPY Command

Y

—+

mark- »o

Copy

Function

Operands

194

name »<
L LABEL 7o name LNOTEji‘
—MARK comment

— PERFRANGE —
—PROGRAM—
—SUBSET

Ne— T e
—LINE
—4|—name—
| PARAGRAPH

The COPY command is used to copy the contents of a path or set of linesto amark. This
allows you to save the same information under a different name for additional use. Y ou
can aso include a new description if desired.

Operand Description

LABEL name  Specifiesa PROCEDURE DIVISION paragraph name or section
name, or the literals PROCEDURE and PROC. All transfers of
control to the label name are included.

MARK name  Specifiesalto 10 aphanumeric character name given to aset or path
using the COPY, MARK, MERGE, or RENAME commands, or one
of these system-generated paths:

System generated path:  Created by:

TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.
SUBNETN | SUBN A path created by the FLOW command

that reaches from the beginning of the
NETWORK to one of the results (nth
result).

Note:
The TRACK, NETWORK, and SUBNET paths can aso be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on
page 101).
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PERFRANGE  Specifiesthenamein aPERFORM statement including all statements
name executed as aresult of a PERFORM statement, or the name of any
section contained in the Declaratives.

PROGRAM Specifiesthe name of either the main program or any nested program.
name All code contained in the specified program is used.

SUBSET name Specifiesapredefined COBOL language subset. See the ASG-Insight
User’s Guide for alist of each subset and its description.

LINE range Specifiesasingleline number or range of lines. Line numbersdisplay
in columns 1 through 6 of Source View.

PARAGRAPH  Specifiesa PROCEDURE DIVISION paragraph name or section
name name, or the literals PROCEDURE and PROC. The entire paragraph
or section isincluded.

TO Specifies an optional keyword indicating the mark name that follows
iswhere the target is copied.

mark-name Specifies a name assigned to a path or set of lines using the MARK
command or the Options - Scratchpad Mark pop-up. The name you
specify must meet these requirements:

< A maximum of 10 alphanumeric characters, including hyphens.
Names longer than 10 characters truncate.

«  Must begin with an alphabetic character.

=  Thisnameisassigned to the new path or set

NOTE comment Provides an optional description about the name. Comment text can
be a maximum of 50 alphanumeric or 23 DBCS characters. If you do
not enter NOTE comment, the existing comment is copied to the new
mark name. If you enter NOTE with no comment text, the existing
comment is not copied to the new mark name.

Y ou can aso use the Options - Scratchpad Copy pop-up to copy paths and sets. See the
online help for more information.

The same path or set of lines can be copied to different names. The TO mark-name you

specify must be unique. If you specify an existing mark-name, an error message
displays and the copy function is not performed.
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To concatenate targets, place a plus sign (+) between the target names. For example,
IO+CALL. You can use aconcatenated set name wherever aset nameisvalid. These sets
can be concatenated:

- LABEL - LINE

- MARK - PROGRAM

- PERFRANGE - PARAGRAPH
- SUBSET

For COBOL Il Release 3 or later programs, you can qualify adataitem, label, or program
name that may be ambiguous or used multiple times by using OF followed by the
program name. For example, if the label P120-READ exists in another program and also
in the program VIAIDEMY1, you can qualify it as P120-READ OF VIAIDEM1.

Example 1. This command copies the contents of TRACK into FICA:
COPY TRACK TO FICA
Example 2. Thiscommand copies al highlighted linesto MY SET:

COPY HI TO MYSET
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CURRENT Command

CURRent

Function

Operands

Usage Notes

A\
A

The CURRENT command is used to save the current location of the cursor. The
LOCATE &CURRENT command can then be used to reposition the screen to the saved
location.

Only one CURRENT command can be in effect. A new CURRENT command replaces
the prior one.

Note:
The CURRENT command is valid only on the Source View screen.

None.

The CURRENT and LOCATE & CURRENT commands increase the ability to control
the position in the source during script processing.

Use the CURRENT command to save your current location while you browse related
data items.
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DELETE Command

Function

DELete

Operands

198

——marknamel

——markname2

X

markname3J

—LABEL
—PERFRANGE —
—PROGRAM——+
—SUBSET
— PARAGRAPH—

Cone__J e
L LINE

—hame

L From ]

The DELETE command is used to delete a mark name and its contents. Thiscommand is
also used to delete a mark name, path, or a set of lines from an existing mark name.

marknamel,
markname2,
markname3

Specifies aname assigned to a path or set of linesusing the COPY,
MERGE, MARK, or RENAME commands, or one of these
system-generated paths:

System generated path:  Created by:
TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.

Note:
The TRACK and NETWORK paths can also be created using the
Logic Order Search pop-ups (see "Logic Pull-down" on

page 101).

LABEL name

Specifiesa PROCEDURE DIVISION paragraph name or section
name, or the literals PROCEDURE and PROC. All transfers of
control to the label name are also del eted.

PERFRANGE
name

Specifies the name in a PERFORM statement including all
statements executed as aresult of a PERFORM statement, or the
name of any section contained in the Declaratives.

PROGRAM name

Specifies the name of the main program or any nested program
representing all the code contained in the program. This includes
al the programs physically nested inside the specified program.

SUBSET name

Specifies a predefined COBOL language subset. See the
ASG-Insight User’s Guide for a description of each subset.
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PARAGRAPH Specifiesa PROCEDURE DIVISION paragraph name or section
name name, or the literals PROCEDURE and PROC. The entire
paragraph or section is deleted.

LINE range Specifies asingle line number or range of lines. Line numbers
display in columns 1 through 6 of Source View.

IN/FROM Deletes the specified mark name, path, or set of lines from the
markname3 existing markname3.

Y ou can delete mark names that you no longer need by using the DELETE command. If
you attempt to delete amark name that does not exist, an error message displays. Y ou can
also delete the NETWORK and TRACK system-generated paths. SUBNETs are
automatically deleted when you del ete the corresponding NETWORK.

Note:

To delete amark name and its contents, select Options » Scratchpad, then select Delete
from the Options - Scratchpad pop-up. See the online help for moreinformation about the
Options - Scratchpad pop-up.

The set of linesin one mark name can be deleted from another mark name. In addition, a
path or line range can be deleted from an existing mark name.

Example 1. This command deletes the mark name FICA and its contents:

DELETE FICA
Example 2. This command deletes line 17 from the mark name FICA:
DELETE 17 FROM FICA

Example 3. Thiscommand deletes the set of linesin the mark name FICA from the
mark name WITHHOLD:

DELETE FICA FROM WITHHOLD
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tSave:‘
Nosav

X

The END command is used to terminate the current function and to redisplay the previous
screen.

Operand Description

Blank If you enter the END command with no operands, the values specified on
the Options - Product Parameters pop-up are used to determine if marks
and equates are to be saved.

Save Saves marks and equates created for this program in the AKR. This
operand overrides the values set on the Options - Product Parameters
pop-up.

Nosave Specifies that the marks and equates created for this program are not

saved. This operand overrides the values set on the Options - Product
Parameters pop-up.

The END command (default PFO3/15) terminates any Insight function. While in Source
View, you can enter the command and the desired operand in the command input area, or
you can enter the operand in the command input area and press the PF key. The previous
function or screen displays.
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EQUATE Command

Equate ——name [
string—‘

Function

Operands

Usage Notes

The EQUATE command is used to define a name for a character string.

name Specifies a name for the character string. Names must conform to these
standards:

- 1 to 10 aphanumeric characters

- First character must be alphabetic or a period
< A hyphenisthe only specia character alowed
<  Thename may also be 1 to 4 DBCS characters

string Specifiesacharacter string to be substituted by the EQUATE command. A
character string can be along command, pattern, dataname, concatenated
dataname, etc. Y ou can specify literals and blanksin the character string if
desired. Y ou must enclose character strings that include blanks within
single or double quotes. The string may be a DBCS string.

If you do not enter the string operand, the equated name is deleted

Y ou can define equates on the Options - Scratchpad Equate pop-up, and delete them from
both the Options - Scratchpad Equate and the Options - Scratchpad Delete pop-ups.
Change the substitution string on the List - Equates pop-up by typing over it with the new
value.

Use equated names to reduce the number of keystrokes during a Source View session.
Y ou can use multiple equatesif desired.
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If you use an equated name in another EQUATE command, you must first define it. For
example:

EQ CC TOT-COST
EQ BB CC + PROD-COST

BB now contains TOT-COST + PROD-COST
Y ou can save the eguates that you created in Source View in the AKR. Seethe "SAVE

Command" on page 302 for more information. To delete an equated name, type EQUATE
and the name without the string.

Note:

See the online help for more information about the Options - Scratchpad Equate pop-up,
the Options - Scratchpad Delete pop-up, and List - Equates pop-up.

Example 1. Thiscommand equates the name A to EOF-FLAG:
EQ A "EOF-FLAG"
To find EOF-FLAG, type this command:
FIND A
Example 2. This command equates AA to TOT-COST:
EQ AA TOT-COST
To change AA to be TOT-COST * PROD-COST, type this command:
EQ AA * PROD-COST.
Example 3. This command equates BB to the FIND 'END-OF-FILE-FLAG' command:

EQ BB FIND "END-OF-FILE-FLAG"
BB to FIND "END-OF-FILE-FLAG"

This command deletes the BB equate:

EQ BB
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Function

Operands

The EXCLUDE command performs a FINDXTND command on the specified target,
excluding the resulting lines.

Operand Description

LABEL name  Specifiesa PROCEDURE DIVISION paragraph name or section
name, or the literals PROCEDURE and PROC. All transfers of
control to the label name are included.

MARK name  Specifiesalto 10 aphanumeric character name given to aset or path

using the COPY, MARK, MERGE, or RENAME commands, or one
of these system-generated paths:
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System generated path:  Created by:

TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.
SUBNETN | SUBN A path created by the FLOW command

that reaches from the beginning of the
NETWORK to one of the results (nth
result).

Note:
The TRACK, NETWORK, and SUBNET paths can aso be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on
page 101).

PERFRANGE  Specifiesthenamein aPERFORM statement including all statements

name executed as aresult of a PERFORM statement, or the name of any
section contained in the Declaratives.
This operand isvalid in Source View only

PROGRAM Specifies the name of the main program or any nested program

name representing all the code contained in the program. Thisincludes al
the programs physically nested inside the specified program.

SUBSET name Specifiesapredefined COBOL language subset. See the ASG-Insight
User’s Guide for alist of each subset and its description.

LINE range  Specifiesasingleline number or range of lines. Line numbersdisplay
in columns 1 through 6 of Source View.

PARAGRAPH  Specifiesa PROCEDURE DIVISION paragraph name or section

name name, or the literals PROCEDURE and PROC. The entire paragraph
or section isincluded.

asterisk (*) Reuses the target of the previous search, exclude, find, highlight, or
scroll action or command.

DATA name Specifiesa COBOL dataname or qualified COBOL dataname.
Dataname refersto any valid COBOL reference for a data element.
These subordinate operands apply to the dataname and can be used to
further qualify the EXCLUDE command: REF, USE, MOD, DEF,
ALIAS,NOALIAS, DIRECT, and INDIRECT. Thedefaultsare REF,
ALIAS, and DIRECT.

SQL name Excludes datanames that are DB2/SQL variables only.
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IDMS name

Excludes datanames that are IDM S variables only.

. hame

Excludes datanames that are COBOL variables only.

Ref

Excludes occurrences of the dataname where its value is defined,
tested, used, set, or modified. Thisisthe default value for the DATA
name operand.

Use

Excludes occurrences of the dataname where its value is being tested
or used.

Mod

Excludes occurrences of the dataname where its value is being set or
modified.

Def

Excludes definitions of the datanamein the DATA DIVISION

Allas

I ncludes occurrences of the aliases for the dataname. These are the
valid aliases;

- Parent - higher level group item

-  Child - lower level item

< Rename/Redefinition - renamed, redefined, or 88 level items
Thisisthe default value for the DATA name operand.

NOAlias

Ignores aliases for the specified dataname.

DIRect

Excludes occurrences of the dataname (and aliasesif specified) where
itisdirectly tested, used, set, modified, or defined (based on the REF,
USE, MOD, or DEF selection). The default for the DATA name
operand is direct; however, if you specify the SIZE, VALUE, or
LEVELS operand, INDIRECT is assumed.

INDirect

Includes any dataname indirectly affected by the specified dataname
(and diasesif specified). Theindirect dataitem can be further
qualified using the SIZE, VALUE, and LEVELS subordinate
operands. These subordinate operands indicate the type of indirect
reference to be located. SIZE and all levels are the defaults for the
INDIRECT operand.

SlZe

Includes occurrences of datanamesthat could be directly or indirectly
affected if the size of the specified dataname were to be changed.
SIZEisonly valid withthe INDIRECT operand. Thisisthe default for
the INDIRECT operand.
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VALue

Includes occurrences of datanames that could either be directly or
indirectly affected if the value of the specified dataname were to be
changed. The LEVELS subordinate operand is not used with
VALUE. VALUE isonly valid with the INDIRECT operand.

LEVelsn

Includes all of the data items affected within the specified number of
indirect levels. The VALUE subordinate operand is not used with
LEVELS. All levelsisthedefault for the LEVEL Soperand. LEVELS
isonly valid with the INDIRECT operand.

PATTERN

Indicates that the charactersthat follow are part of astring. Thisisan
optional keyword

string

Specifies astring of alphanumeric or DBCS characters. If the pattern
string contains blanks, it must be enclosed in single or double quotes.
Y ou can further qualify the pattern string by using the WORD,
PREFIX, or SUFFIX subordinate operands. These subordinate
operands describe how the pattern string is to be used.

X'string

Specifies the hexadecimal string option. Specific unprintable
characters may be specified by giving the EBCDIC hexadecimal
value. The string must be enclosed in single or double quotes.

T'string'

Specifies the text string option. Y ou may enter a character string
regardless of upper or lowercase by using the text option. The string
must be enclosed in single or double quotes.

Pstring'

Specifies the picture string option. A string profile may be entered
instead of exact characters. The string must be enclosed in single or
double quotes. Insight defines nine specia characters for usein
picture strings. These special characters can be combined with other
characters. These are the specia characters:

P=" Any character

P-'"  Any nonblank character
P."  Any nondisplay character
P#  Any numeric character
P-' Any character

P@" Any character

P<' Any character

P>'" Any character

P$  Any character




Usage Notes

10 Commands - EXCLUDE Command

WORD Specifies the specified pattern string preceded and followed by any
non-al phanumeric character (except a hyphen).

PREFIX Specifies aword that begins with the specified pattern string.

SUFFIX Specifies aword that ends with the specified pattern string.

Columnl Specifies the column number where the search isto begin.

Column2 Specifies the column number where the search isto end.

Blank Excludes all lines from the display.

ALL Excludes al lines from the display. The ALL operand cannot be
entered with any other operands. Thisis the default.

Next Searches forward from the cursor position to the next occurrence of
the requested target.

Prev Searches backward from the cursor position to the previous
occurrence of the requested target.

Flrst Searches from the top of the source file to the first occurrence of the
requested target.

LAst Searches backward from the bottom of the sourcefile to the first
occurrence of the requested target.

All Searches for al occurrences of the requested target and displays the
number found in the short/long messagefield. Thisisthe default value
for the EXCLUDE command.

IN Restricts the EXCLUDE command to the specified target type.

Y ou can exclude lines by using the X (Exclude) and XX (Exclude Block) line commands
on the View - Exclude Request pop-up. To display the View - Exclude Request pop-up,
select View » Exclude and press Enter. Y ou can also exclude lines by using one of the
Search pop-ups available on the Search pull-down.

The EXCLUDE command can be used to remove specific lines from the screen resulting
from a previous command. Excluded lines are represented by a line of dashes and text
stating n LINE(S) NOT DISPLAYED. The X or XX line commands can also be used to
exclude lines from the screen.
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To concatenate targets, place aplus sign (+) between the target names. For example, 10 +
CALL. Theserules apply to concatenation:

- A concatenated dataname can be used wherever adataname is valid. Dataname
subordinate operands (REF, ALIAS, etc.) pertain to all datanamesin aconcatenated

series.
- A concatenated set name can be used wherever a set nameisvalid. These sets can
be concatenated:
- LABEL - LINE
- MARK - PROGRAM
- PERFRANGE - PARAGRAPH
- SUBSET - PATTERN

e  Theasterisk (*) operand can be concatenated once with any number of other
operands (e.g., * + 10 + MY SET); however, the * operand cannot be concatenated
toitself (* +* isinvalid). The* operand may appear in any order in the
concatenated list.

For COBOL |l Release 3 or later programs, adataitem, label, or program name that may
be ambiguous or used multiple times can be qualified by using OF followed by the
program name. For example, if the label P120-READ exists in another program and also
in the program VIAIDEM, then it can be qualified as P120-READ OF VIAIDEM1.

This command removes all unhighlighted lines from the screen:

EXCLUDE NHI
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EXECUTE Command

EXECute

Function

Operands

:

member) <«
( )
STEP dsn (member)— \—PARMS paramet(—:‘rsJ

dsn
RESUME

CANCELJ

The EXECUTE command is used to read and execute the commandsin a script file.
Script files can contain EXECUTE commands that execute lower level (nested) script
files. The STEP operand allows you to step through each script command.

STEP

Steps through the commands in the script file. Each command in the
script file displays in the command input area. The displayed command
can be changed or erased from the command input area. Press Enter to
execute the displayed command. Processing of the script file continuesin
this manner until all commands have been displayed and/or executed.

RESUME

Executes the remaining script file commands without stepping through
each. EXECUTE RESUME is entered after a script fileis executed with
the STEP operand specified.

CANCEL

Cancels the remaining script file commands. EXECUTE CANCEL can
be entered after ascript file is executed with the STEP operand specified.

member

Specifiesthe script member in adefault script file defined during product
installation. Y ou can modify either the default script files or their
concatenation sequencefor your profile by using the Script file allocation
action on the Options pull-down. The parentheses are required.

dsn(member)

Specifies the dataset and member name of a partitioned file that contains
the script commands to be executed. This member must bein card image
format (LRECL=80). The specified dataset member must be entered
following TSO usage conventions in this format:

'‘pds.dsn(member)’

If you omit the quotes, your TSO prefix or user ID isthe high-level
qualifier.
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dsn

Specifies the dataset name of a sequential file that contains the script
commands to be executed. This dataset must be in card image format
(LRECL=80). The specified dataset name must be entered following
TSO usage conventions in this format:

'sequential .dataset.name'

If the quotes are omitted, your TSO prefix or userID isthe high-level
qualifier.

PARMS Specifies parameters to be passed to the script being executed.
parameters Commandswithin ascript file may contain substitution variables

numbered & 1 through & 9. Parameter val ues are passed at execution time
to the substitution variables using the PARM S operand of the EXECUTE
command. Type the parameters values in the numerical order 1 through
9. If morethan 9 parameter values are entered, thefirst nine are used and
the remainder are ignored. If substitution variables are included in the
script and parameters are not included in the EXECUTE command, the
substitution variable values are passed as null.

Substitution variables can be used anywhere in the executabl e script
commands, but are not substituted if they occur in comment lines.

Parameter values may contain any non-quoted literal without embedded
blanks.

The EXECUTE command reads the specified dataset and executes the script contained in
thefile. The script can contain EXECUTE commands that execute lower level (nested)
script files. Script filesthat create aloop are recognized and an error message displays.

The STEP operand provides you a means of stepping through each script command. This
allows you to modify or skip commands as desired.

Scripts must be sequential datasets or members of partitioned datasets. In both cases,
scripts must bein card image format (LRECL=80). Scripts can be used to perform these
repetitive tasks:

Initiate atest session
Set default values
Set up atest session
Execute a test
Re-execute atest

Execute a predefined command sequence



Examples

10 Commands - EXECUTE Command

Comments can beincluded in script files by typing an asterisk (*) in column onefollowed
by the comment text.

Script files can also be executed from the File - Execute Script pop-up. Select
File » Execute to display the File - Execute Script pop-up.

Example 1. Type this command to cause the first command in the script file to be
displayed in the command input area:

EXECUTE STEP “USERID.INSOO0015.VIASCRIP*

The command is executed and the next command in the script file displaysin the
command input area. Y ou can change or bypass (erase) any command when it displaysin
the command input area.

Example 2. InthisEXECUTE command, all script commandsin member SCRIPTOL in
the default script datasets are sequentially executed:

EXECUTE (SCRIPTO1)

These commands can consist of any valid Insight primary command. For example,
BRANCH, FX, LPRINT.

Example 3. In this example, the program name MY PROG and the dataname
HIRE-DATE pass as parameters to the script in member SCRIPTO02 in the default script
files.

EXECUTE (SCRIPT02) PARMS MYPROG HIRE-DATE

If the script contains these commands, the parameters are substituted in the commandsin
place of the substitution variables to alow flexibility in using the script:

QUALIFY &1
FX &2

These are the actual commands resulting from the parameter substitution:

QUALIFY MYPROG
FX HIRE-DATE

Note:
See "PROCESS Command" on page 277 for additional uses of EXECUTE parameters.
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FIND strina
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]
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Function
The FIND command searches for one or all occurrences of the specified character string.
The syntax is similar to the ISPF/PDF FIND command. To locate DBCS strings, specify
Double Byte Character Set (DBCS) identifiers or patterns with the FIND command.
Operands

string Specifies a string of aphanumeric or DBCS characters. If the string
contains blanks, it must be enclosed in single or double quotes. The
string cannot contain mixed al phanumeric and DBCS characters. You
can further qualify the string by using the WORD, PREFIX, or
SUFFIX subordinate operands. These subordinate operands describe
how the string is to be used:

X'string' Specifiesthe hexadecimal string option. Y ou may specify specific
unprintable characters by giving the EBCDIC hexadecimal value. The
string must be enclosed in single or double quotes.

T'string' Specifiesthe text string option. Y ou can enter a character string
regardless of upper or lowercase by using the text option. The string
must be enclosed in single or double quotes.

Pstring' Specifiesthe picture string option. Y ou can enter a string profile
instead of exact characters. The string must be enclosed in single or
double quotes. Insight defines nine specia charactersfor usein picture
strings. These special characters can be combined with other
characters:

P=" Any character
P-'" Any nonblank character
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P."  Any nondisplay character
P#  Any numeric character
P-'  Any character

P@ Any character

P<'  Any character

P>' Any character

P$  Any character

asterisk (*) Reuses the target of the previous FIND.

WORD Specifies the string preceded and followed by any non-al phanumeric
character (except a hyphen).

PREFIX Specifies aword that begins with the specified string.

SUFFIX Specifies aword that ends with the specified string.

Columnl Specifies the column number where the search isto begin.

Column2 Specifies the column number where the search isto end.

Next Searchesforward from the cursor position to the next occurrence of the
requested target. Thisisthe default value for the FIND command.

Prev Searches backward from the cursor position to the previous occurrence
of the requested target.

Flrst Searches from the top of the source file to the first occurrence of the
regquested target.

LAst Searches backward from the bottom of the sourcefile to the first
occurrence of the requested target.

All Searches for al occurrences of the requested target and displays the
number found in the short/long message field.

IN Restricts the FIND command to the specified target type.
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MARK name  Specifiesalto 10 aphanumeric character name given to a set or path
using the COPY, MARK, MERGE, or RENAM E commands, or one of
these system-generated paths:

System generated path:  Created by:

TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.
SUBNETN | SUBN A path created by the FLOW command

that reaches from the beginning of the
NETWORK to one of the results (nth
result).

Note:
The TRACK, NETWORK, and SUBNET paths can also be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on
page 101).

PERFRANGE Specifiesthe namein a PERFORM statement including all statements
name executed as aresult of a PERFORM statement, or the name of any
section contained in the Declaratives.

PROGRAM Specifies the name of the main program or of any nested program
name representing all of the code contained in the program. Thisincludesall
of the programs physically nested inside the specified program.

SUBSET Specifies a predefined COBOL language subset. See the ASG-Insight
name User’s Guide for alist of each subset and its description.

LINE range  Specifiesasingleline number or arange of lines. Line numbersdisplay
in columns 1 through 6 of Source View.

PARAGRAPH Specifies any PROCEDURE DIVISION paragraph name or section
name name, or the literals PROCEDURE and PROC. The entire paragraph
or section isincluded.

Y ou can aso conduct a search by selecting a Search pop-up on the Search pull-down.

The search begins from the current line when the you specify the NEXT or PREV
operands. When you specify the ALL operand, all lines are searched regardless of the
current line or direction. Any excluded lines containing FIND targets are displayed and
highlighted. The IN operand restricts the FIND command to only the targets you
specified.
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To concatenate targets, place aplus sign (+) between the target names. For example, 10 +
CALL. These are the rules for concatenation:

- A concatenated dataname wherever a dataname is valid. Dataname subordinate
operands (REF, ALIAS, etc.) pertain to all datanames in a concatenated series.

- A concatenated set name can be used wherever a set name is valid. These sets can

be concatenated:

- LINE - MARK

- PERFRANGE - PARAGRAPH
- PROGRAM - SUBSET

For COBOL Il Release 3 or later programs, you may qualify a dataitem, label, or
program name that may be ambiguous or used multiple times by using OF followed by
the program name. For example, if the label P120-READ exists in another program and
also in the program VIAIDEM 1, then you can qualify it as P120-READ OF VIAIDEM 1.

Example 1. Inthis command, all occurrences of XY Z are highlighted:

FIND *"XYZ" ALL

Example 2. In thiscommand, the FIND command searchesfor the DATA NAME string
without regard to case. The DATA NAME string can be uppercase, lowercase, or mixed
case:

FIND T"DATA NAME*

Example 3. In this example, the FIND command searches for two non-blank characters
separated by a blank:

FIND P™= =~
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Function

The FINDXTND command performs a COBOL intelligent search of the source code for
either one or all occurrences of the specified target.

Operand Description

LABEL name  Specifiesa PROCEDURE DIVISION paragraph name or section
name, or the literals PROCEDURE and PROC. All transfers of
control to the label name are included.

Operands
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MARK name

Specifiesalto 10 aphanumeric character name given to aset or path
using the COPY, MARK, MERGE, or RENAME commands, or one
of these system-generated paths:

System generated path: Created by:
TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.

SUBNETN | SUBn A path created by the FLOW command
that reaches from the beginning of the
NETWORK to one of theresults (nth
result).

Note:
The TRACK, NETWORK, and SUBNET paths can aso be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on
page 101).

PERFRANGE
name

Specifies the name specified in a PERFORM statement including all
statements executed asaresult of aPERFORM statement, or the name
of any section contained in the Declaratives.

This operand isvalid in Source View only

PROGRAM
name

Specifies the name of the main program or any nested program
representing all the code contained in the program. Thisincludes al
the programs physically nested inside the specified program.

SUBSET name

Specifiesapredefined COBOL language subset. See the ASG-Insight
User’s Guide for alist of each subset and its description.

LINE range

Specifiesasingleline number or range of lines. Line numbersdisplay
in columns 1 through 6 of Source View.

PARAGRAPH
name

Specifies a PROCEDURE DIVISION paragraph name or section
name, or the literals PROCEDURE and PROC. The entire paragraph
or section isincluded.

asterisk (*)

Reuses the target of the previous search, exclude, find, highlight, or
scroll action or command.

DATA name

Specifies a COBOL dataname or qualified COBOL dataname.
Dataname refersto any valid COBOL reference for a data element.
These subordinate operands apply to the dataname and can be used to
further qualify the EXCLUDE command: REF, USE, MOD, DEF,
ALIAS,NOALIAS, DIRECT, and INDIRECT. Thedefaultsare REF,
ALIAS, and DIRECT.
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SQL name

Excludes datanames that are DB2/SQL variables only.

IDMS name

Excludes datanames that are IDM S variables only.

. hame

Excludes datanames that are COBOL variables only.

Ref

Excludes occurrences of the dataname where its value is defined,
tested, used, set, or modified. Thisisthe default value for the DATA
name operand.

Use

Excludes occurrences of the dataname where its value is being tested
or used.

Mod

Excludes occurrences of the dataname where its value is being set or
modified.

Def

Excludes definitions of the dataname in the DATA DIVISION

Allas

Includes occurrences of the aliases for the dataname. These are the
valid aliases:

«  Parent - higher level group item

-  Child - lower level item

<  Rename/Redefinition - renamed, redefined, or 88 level items
Thisisthe default value for the DATA name operand.

NOAlias

Ignores aliases for the specified dataname.

DIRect

Excludes occurrences of the dataname (and aliasesif they are
specified) whereit is directly tested, used, set, modified, or defined
(based onthe REF, USE, MOD, or DEF selection). The default for the
DATA name operand is direct; however, if the SIZE, VALUE, or
LEVELS operand is specified, INDIRECT is assumed.

INDirect

Includes any dataname indirectly affected by the specified dataname
(and diasesif specified). Theindirect dataitem can be further
qualified using the SIZE, VALUE, and LEVEL S subordinate
operands. These subordinate operands indicate the type of indirect
reference to be located. SIZE and all levels are the defaults for the
INDIRECT operand.

SlZe

Includes occurrences of datanamesthat could be directly or indirectly
affected if the size of the specified dataname were to be changed.
SIZEisonly vaid withthe INDIRECT operand. Thisisthe default for
the INDIRECT operand.
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VALue

Includes occurrences of datanamesthat could be directly or indirectly
affected if the value of the specified dataname were to be changed.
The LEVEL Ssubordinate operand isnot used with VALUE. VALUE
isonly valid with the INDIRECT operand.

LEVelsn

Includes all dataitems affected within the specified number of
indirect levels. The VALUE subordinate operand is not used with
LEVELS. All levelsisthedefault for the LEVEL Soperand. LEVELS
isonly valid with the INDIRECT operand.

PATTERN

Indicates the characters that follow are part of a string.

string

Specifies a string of alphanumeric or DBCS characters. If the pattern
string contains blanks, it must be enclosed in single or double quotes.
Y ou can further qualify the pattern string by using the WORD,
PREFIX, or SUFFIX subordinate operands. These subordinate
operands describe how the pattern string is to be used.

X'string'

Specifies the hexadecimal string option. Y ou can specify specific
unprintable charactersby giving the EBCDIC hexadecimal value. The
string must be enclosed in single or double quotes.

T'string'

Specifiesthetext string option. Usethetext option to enter acharacter
string regardless of upper or lowercase. The string must be enclosed
in single or double quotes.

Pstring'

Specifies the picture string option. Y ou may enter a string profile
instead of exact characters. The string must be enclosed in single or
double quotes. Insight defines nine specia characters for usein
picture strings. These special characters can be combined with other
characters. These are the specia characters and their meanings:

p=' Any character

P-' Any nonblank character
P! Any nondisplay character
P# Any numeric character
pP-' Any character

P@  Any character

pP< Any character

P> Any character

P$ Any character

WORD

Specifies the pattern string preceded and followed by any
non-alphanumeric character (except a hyphen).
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PREFIX Specifies aword that begins with the specified pattern string.

SUFFIX Specifies aword that ends with the specified pattern string.

Columnl Specifies the column number where the search isto begin.

Column2 Specifies the column number where the search isto end.

ALL Excludes all lines from the display. Y ou cannot enter the ALL
operand with any other operands. Thisis the default.

Next Searches forward from the cursor position to the next occurrence of
the requested target.

Prev Searches backward from the cursor position to the previous

occurrence of the requested target.

Flrst Searches from the top of the source file to the first occurrence of the
requested target.
LAst Searches backward from the bottom of the source file to the first

occurrence of the requested target.

All Searches for all occurrences of the requested target and displays the
number found in the short/long messagefield. Thisisthedefault value
for the EXCLUDE command.

IN Restricts the EXCLUDE command to the specified target type.

Usage Notes

If you are using | SPF 4.1 or later, make sure the Long Message in pop-up | SPF setting is
disabled when you execute the FX command. If this setting is not disabled, a portion of
the display screen is overlayed with the FX results formatted in along message pop-up.
Additional problems can result when you execute the RFIND command following an FX
command.

Y ou can also conduct a search by selecting a Search pop-up on the Search pull-down. See
the online help for more information.
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To concatenate targets, place a plus sign (+) between the target names. For example,
IO+CALL. These rules apply to concatenation:

- A concatenated dataname can be used wherever adataname is valid. Dataname
subordinate operands (REF, ALIAS, etc.) pertain to all datanamesin aconcatenated

series.
- A concatenated set name can be used wherever a set nameisvalid. These sets can
be concatenated:
- LABEL - LINE
- MARK - PROGRAM
- PERFRANGE - PARAGRAPH
- SUBSET - PATTERN

e  Theasterisk (*) operand can be concatenated once with any number of other
operands (e.g., * + 10 + MY SET); however, the * operand cannot be concatenated
toitself (* +* isinvalid). The* operand may appear in any order in the
concatenated list.

For COBOL Il Release 3 or later programs, you can qualify adataitem, label, or program
name that may be ambiguous or used multiple times by using OF followed by the
program name. For example, if the label P120-READ exists in another program and also
in the program VIAIDEM, then it can be qualified as P120-READ OF VIAIDEM1.

Highlighting is used to indicate the occurrences found. Lines already highlighted are
reset, so that only the results of the current command are highlighted. If you exclude lines
containing targets, they redisplay on the screen. Tags are placed on the source code lines
indicating the type of target found. These tags are placed in columns 73 through 80:

LABEL name LABELREF

MARK name TRACK
NETWORK
MARK SUBNET

PERFRANGE name PERF RNG

PROGRAM name PROGRAM PGM tag
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Tag Description

SUBSET name Specifies a predefined COBOL subset name. These are the
valid subsets:
ASsignment  DEBug 10
CAll DEFinition LABd
Clcs DIRective MAINIline
COBOLII DIVision MATH
COBOL/370 DL/l |DL/1  Output
COMment DML PARagraph
CONditional  ENtry PERform
COPy EXIt|PGM  ExitRETurn
DB2/SQL FALLthrough SECtion
DDL GOto SORTMerge
DEAD IDMS STructure
DEADCode  INClude TESted
DEADData Input UNTested

SUBSET name - HIGH

SCREEN NONHIGH
EXCLUDE
NONX

SUBSET name - DECISION

TRACE tags OPTION
START
TARGET

LINE range LINE RNG

PARAGRAPH name PARAGRAP

DATA name DATA REF
DATA USE
DATA MOD

DATA DEF
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PATTERN string

Specifies the pattern string. The NEXT and PREV operands
start the search from the current position and locate the
closest occurrence. If you specify ALL, al linesare searched
regardless of the current line or direction. A message
displays indicating the number of targets found.

When you enter an unqualified dataname and more than one
occurrence of the specified dataname exists, all occurrences
arefound. Thisallowsyouto seeall like datanames but under
different group level names, then allows you to select the
appropriate dataname. A message displaysif you enter an
invalid qualification.

When you enter adataname with the REF operand, the screen
is positioned to show thefirst occurrence of the datanamein
the PROCEDURE DIVISION. DEF information in the
DATA DIVISION is aso highlighted.

FX INDIRECT

L ocates the specified indirect dataname. A dataname can
impact other datanames in source statements. These
datanames can be subsequently propagated indirectly
through other statements, and referenced at each level. For
example, consider this code:

MOVEA TOB
MOVEBTOC
MOVECTOD

When the dataname of interest is A, the first statement
contains adirect reference to A. The direct referenceto a
datanameislevel 1. Thelast two statements contain indirect
referencesto A, based on the propagation of the dataname A
by moving itsvalueto B, then to C, then to D. The second
statement is alevel 2 reference to dataname A, and the last
statement isalevel 3 reference to dataname A.

All levelsof theindirect impact to adatanamedisplay, or you
can view onelevel at atimeusing the LEVEL S operand. For
example, to locate al datanames that could be indirectly
affected by a change in the size of the specified dataname,
usethecommand FX A SIZE. Becausethe LEVEL Soperand
is not specified, the default of ALL LEVELSisused. This
results in acomplete list of all datanames that must be
reviewed (for asize change of the specified dataname). If the
LEVEL Soperand isspecified (e.g.,, FX A SIZELEVELS?2),
only the results of that many levels are highlighted. The
ripple effect can be more clearly identified by starting with
LEVELS 1, then increasing the number of levelsto be
searched.
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When using INDIRECT SIZE, any occurrence of an affected
dataname in the USING clause of a CALL statement is
tagged asaMOD. The CALLed subprogram must be
examined for other datanames affected as aresult of the
CALL. IN target can be used to restrict the search to the
specified IN target.

When the REF operand is specified or used by default, all
appropriate references are highlighted. If thereferenceisa
DEfinition, USE, or MODification, the lineistagged
accordingly. If the line contains a USE and a M ODification,
it istagged as a REFerence.

DBCSstrings

The FINDXTND command supports DBCS strings. See
"FIND Command" on page 212 for detailed information.

Examples

Example 1. ThisFINDXTND command searches backward for the previous occurrence
of ause of DATE-CODE or its aliases:

FINDXTND DATE-CODE USE PREV

Example 2. In this command, the definition of DATE-CODE (without any aliasing) in
the DATA DIVISION is highlighted:

FX DATE-CODE DEF NOALIAS

Example 3. In this command, all occurrences of the SWITCH field used in conditional

statements are highlighted:

FX SWITCH IN COND

Example 4.

01 A.

05 B PIC X.

05 C.

10 D PIC X.
10 E PIC X.

01 Z REDEFINES A.

05 71 PIC XXX.

66 L RENAMES Z.
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These statements apply if you enter a FINDXTND command for C with ALIAS
specified:

=  Alistheparent.

- D and E are the children.
-  Zisaredefine/rename.

- Zlisaredefine/rename.

- L isarename.

Example 5.

000010 READ INFILE INTO A.
000020 MOVE A TO B.

000030 MOVE B TO C.

000040 WRITE OUTFILE FROM C.

The MOD operand is used to locate only those placeswhere B isdirectly or indirectly set
or modified. Thefieldsin lines 10 and 20 are highlighted since B ismodified by A online
20, and A ismodified by the READ statement on line 10.

This FINDXTND command shows the possible origin of the data value:

FX B MOD INDIRECT VALUE

The USE operand is used to locate every place B isdirectly or indirectly used. Thefields
in lines 30 and 40 are highlighted because both statements use B. The FINDXTND
command below shows that the value of B isused to modify C on line 30. On line 40, the
value of C that was received from B is used. This FINDXTND command shows all
possible destinations of adatafield:

FX B USE INDIRECT VALUE

Example 6.

000010 01 A.

000020 05 B. PIC XX.
000070 01 C.

000080 05 D PIC XX.
001010 MOVE B TO X.

001020 MOVE C TO A.

001030 MOVE SPACES TO D.
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The FINDXTND command below is used to locate all groups whose definitions might
have to be changed every time the definition for B changes. The results are lines 10, 20,
70, 80, 1010, and 1020. Any change in the size of B isachangein the size of A aswell.
This means the definition for C should be changed since A now has a different record
layout, and the statement on line 1020 would not execute as intended. D is also shown as
aresult because it is at the same offset within C as B iswithin A, and is the same size

as B.

FX B REF INDIRECT

Note:
The number of results from FX INDIRECT REF depends greatly on the target name. For
best results, select atarget that is the smallest group item whose subfields are to be
modified.

Example 7. These examples use this codetoillustratethe LEVELS, VALUE, and SIZE
operands:

000010 MOVE A
000020 MOVE X
Y
Y

000080 MOVE
000100 MOVE

This command identifies the datanames in the program directly affected by a changein
A. Thislist consists of only dataname A and its related aliases.

FX A INDIRECT LEVELS O

This command identifies the statement (move of size from A to B) that shows B might be
affected by this move. This statement (line 10) and the definitions of A and B are
highlighted.

FX A INDIRECT LEVELS 1

This command highlights the definitions of A, B, and X, plus the statements on lines 10
and 20.

FX A INDIRECT LEVELS 2
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This command identifies all direct and indirect uses of the value of A. The statement on
line 10 would be highlighted.

FX A USE INDIRECT VALUE

This command identifies all direct and indirect modifications to the value of A. The
statement on line 100 would be highlighted.

FX A MOD INDIRECT VALUE

This command identifies where A is affected by a change in the size of the target
dataname. The statements on line 20 and 100 would be highlighted.

FX A USE INDIRECT SIZE
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FLOW Command
\ 2
FLow name »<
LFROMfﬁnumber LTOJ —MARK Next—
—LINE —PERFRANGE— Prev—-
—4|7name —PROGRAM— Flrst—
—LABEL —SUBSET— LASt—
—’—range— All
—LINE
CippeL— ame—
—LABEL
r* nam ‘
LDATA% REF—
Use—
Mod—
Function

Operands
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The FLOW command follows all possible execution paths from a given pointin a
program searching for the specified target(s). The identified paths are stored with mark
names of NETWORK and SUBNETN.

Operand Description

FROM Specifies an optional keyword that is entered with aline number or
label to indicate where the FLOW command is to begin.

LINE number  Specifiesthe line number where the FLOW command is to begin.

LABEL name  Specifiesthe paragraph or section name of the PROCEDURE
DIVISION or the literals PROCEDURE or PROC where the FLOW
command is to begin.

TO Specifies an optional keyword that is followed by atarget for the
FLOW command.
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MARK name

Specifiesalto 10 aphanumeric character name given to aset or path
using the COPY, MARK, MERGE, or RENAME commands, or one
of these system-generated paths:

System generated path:  Created by:
TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.

SUBNETN | SUBN A path created by the FLOW command
that reaches from the beginning of the
NETWORK to one of the results (nth
result).

Note:
The TRACK, NETWORK, and SUBNET paths can also be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on
page 101).

PERFRANGE
name

Specifiesthenamein aPERFORM statement including all statements
executed as aresult of a PERFORM statement, or the name of any
section contained in the Declaratives.

This operand isvalid in Source View only

PROGRAM
name

Specifies the name of the main program or any nested program
representing all the code contained in the program. Thisincludes al
the programs physically nested inside the specified program.

SUBSET name

Specifies a predefined subset. These are the valid subsets:

ASsignment  DEBug 10

CAll DEFinition LABel

Clcs DIRective MAINline
COBOLII DIVision MATH
COBOL/370 DL/l |DL/1  Output
COMment DML PARagraph
CONditional  ENtry PERform
COPy EXIt|PGM  ExitRETurn
DB2/SQL FALLthrough SECtion
DDL GOto SORTMerge
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DEAD IDMS STructure
DEADCode INClude TESted
DEADData Input UNTested

A screen subset:

Highlighted | HI
NONHighlighted | NHI
Excluded | X
NONExcluded | NX

Tagged lines subsets of tags in columns 73 through 80.

Note:
See the ASG-Insight User’s Guide for a description of each subset

LINE range

Specifiesasingleline number or range of lines. Line numbersdisplay
in columns 1 through 6 of Source View.

LABEL name

Specifies any PROCEDURE DIVISION paragraph name or section
name, or the literals PROCEDURE and PROC. All transfers of
control to the label name are included.

DATA name

Specifiesa COBOL dataname or qualified COBOL dataname.
Dataname refers to any valid COBOL reference for a data element.
These subordinate operands apply to the dataname and can be used to
further qualify the EXCLUDE command: REF, USE, MOD, DEF,
ALIAS,NOALIAS, DIRECT, and INDIRECT. Thedefaultsare REF,
ALIAS, and DIRECT.

Ref

Excludes occurrences of the dataname where its value is defined,
tested, used, set, or modified. Thisisthe default value for the DATA
name operand.

Use

Excludes occurrences of the dataname where its value is being tested
or used.

Mod

Excludes occurrences of the dataname where its value is being set or
modified.

Next

Searches forward from the cursor position to the next occurrence of
the requested target.

Prev

Searches backward from the cursor position to the previous
occurrence of the requested target.
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Forward Flows forward from the current cursor position to all occurrences.

Backward Flows backward from the current cursor position to all occurrences.

Y ou can aso identify execution pathsin aprogram by using the Logic Order Search
pop-ups that can create paths with mark names of NETWORK and SUBNETN. See
Chapter 5, "Logic," on page 99 for more information about the Logic Order Search

pop-ups.

The FLOW command is used to determine the execution flow of a program and indicates
if the specified targets can be reached from a given point. A path of the executable
statements that are followed is captured and called NETWORK. Y ou can save the
NETWORK and use it for additional analysis. Display aNETWORK by using the
FINDXTND NET command.

To concatenate targets, place aplus sign (+) between the target names. For example,
IO+CALL. These rules apply to concatenation:

< A concatenated dataname can be used wherever a dataname is valid. Dataname
subordinate operands (REF, USE, MOD) pertain to all datanamesin a concatenated

series.
- A concatenated set name can be used wherever a set nameisvalid. These sets can
be concatenated:
- LABEL - LINE
- MARK - PROGRAM
- PERFRANGE - SUBSET

For COBOL Il Release 3 or later programs, you can qualify adataitem, label, or program
name that may be ambiguous or used multiple times by using OF followed by the
program name. For example, if the label P120-READ existsin another program and also
in the program VIAIDEM1, then it can be qualified as P120-READ OF VIAIDEM1.

The FROM operand is used as the starting point for the FLOW command. If you do not
specify a FROM operand, the cursor position is used as the starting point.

231



ASG-Insight Reference Guide

232

If you position the cursor on an executable COBOL statement, the starting point of the
search is based on the location of the cursor aswell as the target and direction specified in
the FLOW command. For example:

FLOW data-name forward

If the cursor is before the statement, the statement is included.

FLOW data-name backward

If you place the cursor is after the last character of the statement, the statement is
included.

If the starting point is an inexecutable COBOL statement, these genera rules apply:

- Comment lines and compiler directives occurring at the end of an executable code
block are considered part of the paragraph or section that follows. The search
begins at the paragraph or section name that follows.

= Alinefollowed by one or more executable statements prior to the succeeding
section, or alinethat is part of the last section, is considered part of the preceding
section and the search begins at the end of the statement, before the comment or
directive.

- Blank lines that occur at the end of an executable code block, and that are not
preceded by a comment or compiler directive, are considered part of the preceding
paragraph or section. The search begins at the end of the last executable statement
in the preceding paragraph.

= A blank linethat follows all executable statements of the preceding paragraph, and
that is preceded by a comment or compiler directive, is considered part of this
paragraph. The search begins at the paragraph or section name in this paragraph.

< Ablanklinethat isfollowed by one or more executable statements, or that is part of
the last paragraph or section of the program, is considered part of the preceding
paragraph. The search begins at the end of the preceding paragraph.
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Special Conditions

If you specify a dataname with USE NEXT or USE PREV, special conditions are

considered. When the FLOW command searches for the next use, the value currently in
the dataname is the target of the search. If a modification of that variable is encountered
along apath, that portion of the execution path is not reflected in the result. The sameis
true for PREV. FLOW locates all uses occurring before a modification of the dataname.

For example:
MOVE ZIP-CODE TO OUT-ZIP-CODE (Z1P-CODE = 46201)
l\-/IOVE HOLD-ZIP TO ZI1P-CODE (HOLD-ZIP = 93721)
l\-/IOVE Z1P-CODE TO OUT-ZI1P-CODE (Z1P-CODE = 93721)

If you enter the FLOW USE PREV command on the last line, the first line would
not be shown as a result because the value of ZIP-CODE is modified between the
starting and ending points.

Example

The FLOW command below flows to the previous uses of LOAN-AMT where the same
value was used.

FLOW LOAN-AMT USE PREV
To show the network produced by the FLOW command, type this command:

FX NETWORK
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GOBACK Command

\
A

GOback
Lpng kSave

Nosav

Function

The GOBACK command is used to reverse a CALL or VIEW command and return to a
Source View session.

Operands

Blank Specifies that the program where the last CALL or VIEW was executed is
returned to the Source View. Marks and equates are saved or not saved,
depending on the values specified on the Options - Product Parameters

pop-up.

pgm Specifiesaprogram or entry point in the AKR. A Source View session must
currently be active for this program.

Save Saves marks and equates created for this program in the AKR. This operand
overrides the values on the Options - Product Parameters pop-up.

Nosave  Specifiesthat marksand equates created for this program are not saved. This
operand overrides the values on the Options - Product Parameters pop-up.

Usage Notes

The GOBACK command ends the current Source View session and returns to the Source
View session wherea CALL or VIEW command was entered. Specifying a program
name returns to a particular program in the calling chain.

Example

The current program is VIAIDEMO. To display the VIAIDEM1 program on the Source
View screen, type

CALL VIAIDEM1

After the above command finishes executing, type GOBACK to return to the VIAIDEMO
Source View session.
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Help | ? 1
—7MESSAGE|MSG4J [ viamsgr| |
msg#
———COMMANDSs
——cmd
——ABENDs
——SCREEN
Function
The HEL P command displays information about the current Insight screen, pop-up,
commands, messages, or abend codes.
Operands

Blank

Displays the Help Tutorial for the current screen or pop-up, that
describes all the fields on the screen or pop-up, and any specia
processing considerations. If a message displays, type HELP with
no operands to display the Help Explanation and Action Panel for
the current message.

MESSAGE | MSG

Displays the Help Explanation and Action Panel, that shows the
specified short and long message, an explanation of the current
message, and any actions to be performed.

ASGmsg# | msg#

Specifies the message number where the Help Explanation and
Action Panel screenisto be displayed. Thisnumber consists of 1 to
4 digits. It is not necessary to enter leading zeros.

COMMANDSs

Displaysalist of all Insight primary commands. Information for a
particular command can then be displayed by selecting the
appropriate number.

cmd

Specifies an Insight primary command. When help is requested for
acommand, along message displays giving a brief description of
that command. Requesting help again then displays more detailed
information about the command.

ABENDs

Displays the Abends screen that lists the types of abend codes.

SCREEN

Displays help for the current screen or pop-up, that describes all
fields on the screen or pop-up, and any special processing
considerations.
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HIGH Command

HIGH A name
FLABEL
FMARK
| PERFRANGE|
| PROGRAM—|
L SUBSET——

\4

range—
—LINE

name—

“PARAGRAPH-
*

+
r name

DATAJ SQL— Ref DIRect— L—ALlasﬂ
IDMS— Use NOAlias
: Mod INDirect

Def %SIZ@J LLEVeIs nJ

VALue
L—ALlas
NOAlias
string

7PATTERNJ |EX'strinq‘ —WORD Lcolumn lJ LcolungJ
L *

*

T 'string—{ ——PREFIX
P 'string'— “——SUFFIX

Y

Y
A

— Next— L _
—Prev— IN-Y name—|
——FIrst— —MARK
——LAst— —PERFRANGE—
—All —PROGRAM—
—SUBSET

P Rl
- LINE
ﬁnamef
L PARAGRAPH

Function

The HIGH command highlights source code lines containing the specified targets. Lines
already highlighted are not reset.

Operand Description

LABEL name  Specifiesthe paragraph or section name of the PROCEDURE
DIVISION or the literals PROCEDURE or PROC where the FLOW
command is to begin.

Operands

MARK name  Specifiesalto 10 aphanumeric character name given to aset or path
using the COPY, MARK, MERGE, or RENAME commands, or one
of these system-generated paths:

236



10 Commands - HIGH Command

System generated path:
TRACK | TRK
NETWORK | NET
SUBNETn | SUBN

Created by:
A TRACE command.
A FLOW command.

A path created by the FLOW command
that reaches from the beginning of the
NETWORK to one of the results (nth
result).

Note:
The TRACK, NETWORK, and SUBNET paths can aso be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on
page 101).

PERFRANGE  Specifiesthe namein a PERFORM statement including al of the
name statements executed asaresult of aPERFORM statement, or the name
of any section contained in the Declaratives.
This operand isvalid in Source View only
PROGRAM Specifies the name of the main program or of any nested program
name representing all of the code contained in the program. Thisincludes
all of the programs physically nested inside the specified program.
SUBSET name Specifies a predefined subset name. These are the valid subsets:

ASsignment  DEBug 10

CAll DEFinition LABe

Clcs DIRective MAINline
COBOLII DIVision MATH
COBOL/370 DL/I|DL/1  Output
COMment DML PARagraph
CONditional  ENtry PERform
COPy EXIt|PGM  EXxitRETurn
DB2/SQL FALLthrough SECtion
DDL GOto SORTMerge
DEAD IDMS STructure
DEADCode  INClude TESted
DEADData Input UNTested
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A screen subset;

Highlighted | HI
NONHighlighted | NHI
Excluded | X
NONExcluded | NX

Tagged lines subsets of tags in columns 73 through 80.

Note:
See the ASG-Insight User’s Guide for a description of each subset

LINE range Specifiesasingleline number or range of lines. Line numbersdisplay
in columns 1 through 6 of Source View.

PARAGRAPH  Specifiesa PROCEDURE DIVISION paragraph name or section

name name, or the literals PROCEDURE and PROC. The entire paragraph
or section isincluded.

asterisk (*) Reuses the target of the previous HIGH command.

DATA name Specifiesa COBOL dataname or qualified COBOL dataname.
Dataname refers to any valid COBOL reference for a data element.
These subordinate operands apply to the dataname and can be used to
further qualify the EXCLUDE command: REF, USE, MOD, DEF,
ALIAS,NOALIAS, DIRECT, and INDIRECT. The defaultsare REF,
ALIAS, and DIRECT.

Ref Excludes occurrences of the dataname where its value is defined,
tested, used, set, or modified. Thisisthe default value for the DATA
name operand.

SQL name Includes datanames that are DB2/SQL variables only.

IDMS name Includes datanames that are IDM S variables only.

: hame Includes datanames that are COBOL variables only.

Ref Includes occurrences of the dataname where its value is defined,
tested, used, set, or modified. Thisisthe default value for the DATA
name operand.

Use Excludes occurrences of the dataname where its value is being tested

or used.
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Mod

Excludes occurrences of the dataname where its value is being set or
modified.

Def

Includes definitions of the dataname in the DATA DIVISION

Allas

Searches backward from the cursor position to the previous
occurrence of the requested target.

Includes occurrences of the aliases for the dataname. These are the
valid aliases:

e  Parent - higher level group item

<  Child - lower level item

- Rename/Redefinition - renamed, redefined, or 88 level items
Thisisthe default value for the DATA name operand.

NOAlias

Ignores aliases for the specified dataname.

DIRect

Includes occurrences of the dataname (and aliases if specified) where
itisdirectly tested, used, set, modified, or defined (based on the REF,
USE, MOD, or DEF selection). The default for the DATA name
operand is direct; however, if you specify the SIZE, VALUE, or
LEVELS operand, INDIRECT is assumed.

INDirect

Includes any dataname indirectly affected by the specified dataname
(and aiasesif specified). You can further qualify the indirect data
item by usingthe SIZE, VALUE, and LEV EL S subordinate operands.
These subordinate operands indicate the type of indirect referenceto
be located. SIZE and all levels are the defaults for the INDIRECT
operand.

SlZe

Includes datanames that could be directly or indirectly affected if the
size of the specified dataname were to be changed. SIZE isonly valid
with the INDIRECT operand. Thisisthe default for the INDIRECT
operand.

VALue

Includes occurrences of datanamesthat could be directly or indirectly
affected by achangeif the value of the specified dataname wereto be
changed. The LEVELS subordinate operand is not used with
VALUE. VALUE isonly valid with the INDIRECT operand.

LEVelsn

Includes al data items affected within the specified number of
indirect levels. The VALUE subordinate operand is not used with
LEVELS. All levelsisthedefault for the LEVEL Soperand. LEVELS
isonly valid with the INDIRECT operand.
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PATTERN

Indicates the characters that follow are part of a string.

string

Specifiesastring of aphanumeric or DBCS characters. If the pattern
string contains blanks, it must be enclosed in single or double quotes.
The pattern string can be further qualified by using the WORD,
PREFIX, or SUFFIX subordinate operands. These subordinate
operands describe how the pattern string is to be used.

X'string

Specifies the hexadecimal string option. Y ou can specify specific
unprintable charactersby giving the EBCDIC hexadecimal value. The
string must be enclosed in single or double quotes.

T'string'

Specifies the text string option. A character string may be entered
regardless of upper or lowercase by using the text option. The string
must be enclosed in single or double quotes.

Pstring'

Specifies the picture string option. A string profile may be entered
instead of exact characters. The string must be enclosed in single or
double quotes. Insight defines nine specia charactersfor usein
picture strings. These special characters can be combined with other
characters.

These are the special characters:
p= Any character

P-' Any nonblank character
P! Any nondisplay character
P# Any numeric character
pP-' Any character

P@  Any character

P< Any character

P> Any character

P$ Any character

WORD

Specifies the specified pattern string preceded and followed by any
non-al phanumeric character (except a hyphen).

PREFIX

Specifies aword that begins with the specified pattern string.

SUFFIX

Specifies aword that ends with the specified pattern string.

Columnl

Specifies the column number where the search isto begin.

Column2

Specifies the column number where the search isto end.




Usage Notes

10 Commands - HIGH Command

Next Searches forward from the current cursor position to the next
occurrence of the requested target.

Prev Searches backward from the current cursor position to the previous
occurrence of the requested target.

Flrst Searches from the top of the source file to the first occurrence of the
requested target.

LAst Searches backward from the bottom of the source file to the first
occurrence of the requested target.

All Searches for al occurrences of the requested target and displays the
number found inthe short/long messagefield. Thisisthe default value
for the HIGH command.

IN Restricts the HIGH command to the specified target type.

Source code lines can also be highlighted by selecting a Search pop-up on the Search
pull-down. See the online help for more information.

To concatenate targets, place aplus sign (+) between the target names. For example,
1O + CALL. These rules apply to concatenation:

< A concatenated dataname can be used wherever a dataname is valid. Dataname
subordinate operands (REF, ALIAS, etc.) pertain to all datanames in a concatenated

series.
- A concatenated set name can be used wherever a set nameisvalid. These sets can
be concatenated:
- LABEL - LINE
- MARK - PROGRAM
- PERFRANGE - PARAGRAPH
- SUBSET - PATTERN

=  Theasterisk (*) operand can be concatenated once with any number of other
operands (e.g., * + IE+ MY SET); however, the* operand cannot be concatenated
toitself (* +* isinvalid). The* operand may appear in any order in the
concatenated list.
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For COBOL Il Release 3 or later programs, you can qualify adataitem, label, or program
name that may be ambiguous or used multiple times by using OF followed by the
program name. For example, if the label P120-READ exists in another program and also
in the program VIAIDEM, then it can be qualified as P120-READ OF VIAIDEM1.

Lines can be added to a highlighted set. For example, to see all PERFORM statements,
then to add the conditional statements related to one of the PERFORM statements, use
FINDXTND PERFORM, then use HIGH CONDITIONAL to add the additional lines.

To step through all 10 statements, type HIGH 10 NEXT. Keep repeating the
command until the end of the program is located.

The H or HH line commands can also be used to highlight source code lines during a
Source View session.

All lines containing 10 statements are highlighted. Existing highlighted lines are not reset
when this command is issued.

HIGH I0PF15
Next, type this command:
FX LAB IN HI

Only labels within the highlighted lines are highlighted. All other highlighted lines are
reset.
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JUMP Command

A\
A

JUMP

Function

The JUMP command is used to return to the Source View screen at the location
corresponding to the cursor position on the Tree View screen.

Operands
None.

Usage Notes

The JUMP command is used in conjunction with the cursor position. Type JUMP in the
command input area, position the cursor to the line containing the target of the jump, and
press Enter.

The Jline command can also be used to return to the Source View screen from the Tree
View screen.
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KEYS Command

LOAD dsn
\—dsn (membery——

L:J string

KEYS SAVE q
E E sn
\—dsn (membery——

PFnn

Function

The KEY S command, entered with no operands, displays the Options - PF Key
Definition pop-up. This screen isused to display and/or modify the current Insight PF key
assignments.

The KEY S command may also save, restore, or modify the PF key assignments without
displaying the Options - PF Key Definition pop-up.

Operands

SAVE Saves the current PF Key definitions in a sequentia or partitioned
dataset. If you do not specify a dataset name, this is the default name:

TSOuserid.PPPnnnnn.VIAPFKEY
where nnnnn is a unique, system-generated number.

LOAD Restores the PF Key definitions from the specified sequential or
partitioned dataset. A dataset name must be specified for the LOAD
operand.

dsn Specifies a sequential dataset name. If you include quotes, the dataset

nameisused asis. If you do not include quotes, your TSO prefix or
userID is appended to the front of the dataset name and VIAPFKEY is
appended to the end of the dataset name. For example, if you type this
command:

SAVE TEST1
the generated dataset name would be TSOuserid.TEST1.VIAPFKEY.
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dsn(member) Specifiesapartitioned dataset and member name. If youinclude quotes,
the dataset name and member name are used asis. If you do not use
quotes, your TSO prefix or userlD is appended to the front of the
dataset name. If the PDS member already exists, it is overwritten.

PFnn Provides acommand line update to the PF key definition. For example,
this command assigns the text RESET EXCLUDED to PF key 21.

KEYS PF21 RESET EXCLUDED

If the text to be assigned beginswith an equals sign (=), you must enter
two equal symbols separated by aspace.lf anull stringisentered for the
PFnn operand, the PF Key assignment reverts to the default value for
the current ESW product.

The script facility verifies that the PF Key number isvalid.

Y ou can enter the KEY S command without operands on any Insight screen to display
and/or modify the current PF key assignments. Values assigned to the Insight PF keys
have no effect on other ISPF applications.

Use the SAVE and LOAD operands to save or restore PF Key settings. This feature
allows you to use the KEY S command in scripts to set PF Key assignments as desired.
This also provides a mechanism for multiple users to share a set of PF Key definitions.

The PFnn operand allows you to use the KEY S command in a script file to modify PF
Key settings during script file execution.

Y ou can aso display the Options - PF Key Definition pop-up by selecting PF Keyson the

Options pull-down. See the online help for more information about PF key assignments,
the Options - PF Key Definition pop-up, and the Options pull-down.
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X

LEVELs L&Lﬂbd

Function

The LEVELS command redisplays the current Tree View or Structure View screen to the
specified level of program hierarchy depth.

Operand Description

number Redisplays the current screen to the level depth specified.

Operands

MAX Redisplays the current screen to the maximum number of levelsin the
program.

Usage Notes

Y ou can aso change levels from the View - Levels Request pop-up. To display the
View - Levels Request pop-up, select View » Level and press Enter.

The LEVELS command redisplays the current screen to the level specified. If there are
less levels than the number specified, they expand to the requested level. If there are
levels greater than the number specified, they are removed. The LEVELS command is
only valid on the Tree View and Structure View screens.
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List

Function

Operands

10 Commands - LIST Command

Calls:
Equates
Marks
Performs
PRograms | PGms—|
Subsets

TheLIST command is used to display the specified pop-up. List pop-ups are available for
each operand shown above.

Blank Displaysthe List Menu pop-up that allowsyou to select one of the
other List pop-ups.

Cdls Displaysthe List - CALL Statements pop-up that shows all of the
COBOL statements containing CALLSs to other programsin the
active program. This pop-up also classifiesthe CALLsinto
internal, static, and dynamic.

Equates DisplaystheList - Equates pop-up that showsall of the equatesfor
the active program.

Marks DisplaystheList - User Marks pop-up that showsthe marksfor the
active program.

Performs Displaysthe List - Perform Range Names pop-up that shows all of

the COBOL PERFORM ranges in the active program.

PRograms | PGms

Displays the List - Program/Subprogram Names pop-up, that
shows the nested program hierarchy structure.

For COBOL Il Release 3 or later programs, you can qualify adata
item, label, or program name that may be ambiguous or used
multiple times by using OF followed by the program name. For
example, if the label P120-READ exists in another program and
also in the program VIAIDEM1, then it can be qualified as
P120-READ OF VIAIDEM1.

Subsets

Displaysthe List - COBOL Subset Names pop-up that shows all
subsets along with a brief description of each. Valid in Source
View.
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Usage Notes

Y ou can a so access these pop-ups by selecting an action on the List pull-down.

List Menu Pop-up

The List Menu pop-up is used to select the specified pop-up that displays pertinent
information about the program being viewed. A screen similar to Figure 101 displays
when you type L 1ST without operands.

Figure101+ LIst Menu Pop-up

List Henu
Felect the list fo be displaved. Then press Enter.

& Eeyvord Diescription

CALLE List CALLed prograns and their Aode
EQUATEE List EQUATEE for the curtent prograd
HARKE List HAREE for the current prograd
PERFORHE Li=t PERFORH ranges

PROGRAHE List PROGRAME and subPROGRAHE

SUBSETE List GOBOL SUBSETE and their descriptions

| I T N T I

Select any item on this pop-up by typing S to the left of the desired keyword. The pop-up
for the selected option displays.
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LOCATE Command

Locate string »<
. Iabe)—g‘
&CURRent

Function
The LOCATE command scrolls to the selectable label or entry that most closely matches
the specified string. LOCATE isvalid on the Source View screen, the File - AKR
Directory pop-up, the File - AKR Program Selection pop-up, all List pop-ups except the
List -Program/Subprogram Names pop-up, and the Trace Decision Options pop-up.
Operands

string Specifiesan a phanumeric or DBCS character string that |ocates a particul ar
item on alist or directory type screen.

-label Locatesalinelabel enteredintheline command area (columns 1 through 6)
on the Source View screen.

&CURRent Positions the Source View screen to the last location marked by the
CURRENT command. If no CURRENT command has preceded the
LOCATE & CURRENT command, the message &CURRENT NOT AVAIL
displays and the screen is not repositioned. The & CURRENT operand is
only valid on the Source View screen.

Usage Notes

Y ou can specify acharacter string when an exact program name or list item is not known.
The LOCATE command displays the item that most closely matches the specified
character string. Matching is done a phabetically.
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Examples

Example 1. This command displays the line containing an item that matches or
follows S:

LOCATE S

Example 2. This command positions the display to the location marked by the most
recent CURRENT command.

LOCATE &CURRENT
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LPRINT Command

LPrint name
FLABEL-
FMARK
FPERFRANGE-
FPROGRAM—
FSUBSET

v
[

range—
LINE

name—

-PARAGRAPH-

L *
P — :
DATA SQL— Ref DIRect: ﬁALIaS
IDMS— Use NOAlias
: |

: Mod NDirect
Def SIZeJ LLEVeIs nJ

VALue
bALIaS

NOAlias:

string
7PATTERNJ |EX 'string" EWORD Lcolumn 1J Lcolumn ZJ
L%

T 'string PREFIX
P 'string" SUFFIX

v
N

Y
A

1»
—— Next— L + \—NOTE comment—‘
IN

——Prev—y name—
——FIrst—j —MARK
——LAst—] —PERFRANGE—
—All —PROGRAM—

—SUBSET——

N T 9
LINE
ﬁ—namef
L PARAGRAPH

Function

The LPRINT command is used to copy lines containing the specified target to the List
file. The List file is processed on the Options - Log/List/Punch Definition pop-up.

Operand Description

LABEL name  Specifiesthe paragraph or section name of the PROCEDURE
DIVISION or the literals PROCEDURE or the PROC where the
FLOW command isto begin.

Operands
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MARK name

Specifiesalto 10 aphanumeric character name given to aset or path
using the COPY, MARK, MERGE, or RENAME commands, or one
of these system-generated paths:

System generated path: Created by:
TRACK | TRK A TRACE command.

NETWORK | NET A FLOW command.

SUBNETN | SUBn A path created by the FLOW command
that reaches from the beginning of the
NETWORK to one of theresults (nth
result).

Note:
The TRACK, NETWORK, and SUBNET paths can aso be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on
page 101).

PERFRANGE
name

Specifiesthenamein aPERFORM statement including all statements
executed as aresult of a PERFORM statement, or the name of any
section contained in the Declaratives.

This operand isvalid in Source View only

PROGRAM
name

Specifies the name of the main program or any nested program
representing all the code contained in the program. Thisincludes al
the programs physically nested inside the specified program.

SUBSET name

Specifies a predefined subset. These are the valid subsets:

ASsignment  DEBug 10

CAll DEFinition LABd
Clcs DIRective MAINline
COBOLII DIVision MATH
COBOL/370 DL/l |DL/2  Output
COMment DML PARagraph
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CONditional  ENtry PERform
COPy EXIt|PGM  ExitRETurn
DB2/SQL FALLthrough SECtion
DDL GOto SORTMerge
DEAD IDMS STructure
DEADCode  INClude TESted
DEADData Input UNTested

A screen subset:

Highlighted | HI
NONHighlighted | NHI
Excluded | X
NONExcluded | NX

Tagged lines subsets of tags in columns 73 through 80.

Note:
See the ASG-Insight User’s Guide for a description of each subset

LINE range Specifiesasingleline number or range of lines. Line numbersdisplay
in columns 1 through 6 of Source View.

PARAGRAPH  Specifiesa PROCEDURE DIVISION paragraph name or section

name name, or the literals PROCEDURE and PROC. The entire paragraph
or section isincluded.

DATA name Specifiesa COBOL dataname or qualified COBOL dataname.
Dataname refers to any valid COBOL reference for a data element.
These subordinate operands apply to the dataname and can be used to
further qualify the EXCLUDE command: REF, USE, MOD, DEF,
ALIAS NOALIAS, DIRECT, and INDIRECT. The defaultsare REF,
ALIAS, and DIRECT.

SQL name Includes datanames that are DB2/SQL variables only.

IDMS name Includes datanames that are IDM S variables only.

: name Includes datanames that are COBOL variables only.

Ref Includes occurrences of the dataname where its value is defined,

tested, used, set, or modified. Thisisthe default value for the DATA
name operand.
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Use

Excludes occurrences of the dataname where its value is being tested
or used.

Mod

Excludes occurrences of the dataname where its valueis being set or
modified.

Def

Includes definitions of the dataname in the DATA DIVISION

Allas

Searches backward from the cursor position to the previous
occurrence of the requested target.

Includes occurrences of the aliases for the dataname. These are the
valid aliases:

e  Parent - higher level group item

<  Child - lower level item

- Rename/Redefinition - renamed, redefined, or 88 level items
Thisisthe default value for the DATA name operand.

NOAlias

Ignores aliases for the specified dataname.

DIRect

Includes occurrences of the dataname (and aliases if specified) where
itisdirectly tested, used, set, modified, or defined (based on the REF,
USE, MOD, or DEF selection). The default for the DATA name
operand is direct; however, if you specify the SIZE, VALUE, or
LEVELS operand, INDIRECT is assumed.

INDirect

Includes any dataname indirectly affected by the specified dataname
(and aiasesif specified). You can further qualify the indirect data
item using the SIZE, VALUE, and LEVELS subordinate operands.
These subordinate operands indicate the type of indirect referenceto
be located. SIZE and all levels are the defaults for the INDIRECT
operand.

SlZe

Includes datanames that could be directly or indirectly affected if the
size of the specified dataname were to be changed. SIZE isonly valid
with the INDIRECT operand. Thisisthe default for the INDIRECT
operand.

VALue

Includes occurrences of datanamesthat could be directly or indirectly
affected by achangeif the value of the specified dataname wereto be
changed. The LEVELS subordinate operand is not used with
VALUE. VALUE isonly valid with the INDIRECT operand.
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LEVelsn

Includes al data items affected within the specified number of
indirect levels. The VALUE subordinate operand is not used with
LEVELS. All levelsisthedefault for the LEVEL Soperand. LEVELS
isonly valid with the INDIRECT operand.

PATTERN

Indicates the characters that follow are part of a string.

string

Specifiesastring of aphanumeric or DBCS characters. If the pattern
string contains blanks, it must be enclosed in single or double quotes.
The pattern string can be further qualified using the WORD, PREFI X,
or SUFFIX subordinate operands. These subordinate operands
describe how the pattern string is to be used.

X'string

Specifies the hexadecimal string option. Specific unprintable
characters may be specified by giving the EBCDIC hexadecimal
value. The string must be enclosed in single or double quotes.

T'string'

Specifies the text string option. A character string may be entered
regardless of upper or lowercase by using the text option. The string
must be enclosed in single or double quotes.

Pstring'

Specifies the picture string option. Y ou can enter a string profile
instead of exact characters. The string must be enclosed in single or
double quotes. Insight defines nine specia characters for usein
picture strings. These special characters can be combined with other
characters.

These are the special characters:
p=' Any character

P-' Any nonblank character
P! Any nondisplay character
P# Any numeric character
pP-' Any character

P@  Any character

pP< Any character

P> Any character

P$ Any character

WORD

Specifies the specified pattern string preceded and followed by any
non-al phanumeric character (except a hyphen).

PREFIX

Specifies aword that begins with the specified pattern string.
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SUFFIX Specifies aword that ends with the specified pattern string.

Columnl Specifies the column number where the search isto begin.

Column2 Specifies the column number where the search isto end.

asterisk (*) Causes the entire virtual screen (all data that can be viewed by
scrolling forward and backward) to be copied to the List file. All
excluded lines are copied to the List file as excluded lines (as they
appear on the screen at the time the LPRINT * command is entered).

Next Searches forward from the current cursor position to the next
occurrence of the requested target.

Prev Searches backward from the current cursor position to the previous
occurrence of the requested target.

Flrst Searches from the top of the source file to the first occurrence of the
requested target.

LAst Searches backward from the bottom of the sourcefile to the first
occurrence of the requested target.

All Searches for all occurrences of the requested target and displays the
number found in the short/long messagefield. Thisisthedefault value
for the HIGH command.

IN Restricts the HIGH command to the specified target type.

NOTE comment Places descriptive comment linesin the List file. These commentsare

included in the printed output from the List file. Text of the comment
may be a maximum of 50 aphanumeric or 23 DBCS characters.

Lines can also be copied to the List file by selecting a Search pop-up on the Search
pull-down. See the online help for more information.

To concatenate targets, place aplus sign (*) between the target names. For example, 10 +
CALL. Theserules apply to concatenation:

- A concatenated dataname can be used wherever adataname is valid. Dataname
subordinate operands (REF, ALIAS, etc.) pertain to all datanamesin aconcatenated

series.
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- A concatenated set name can be used wherever a set name is valid. These sets can

be concatenated:

- LABEL - LINE

- MARK - PROGRAM

- PERFRANGE - PARAGRAPH
- SUBSET

For COBOL |l Release 3 or later programs, you can qualify adataitem, label, or program
name that may be ambiguous or used multiple times by using OF followed by the
program name. For example, if the label P120-READ exists in another program and also
in the program VIAIDEM1, then it can be qualified as P120-READ OF VIAIDEM1.

LPRINT copies the specified target to the List file for subsequent printing.

LPRINT * can be entered on these pop-ups and the Tree View and Source View screen to
copy them to the List file:

- List - CALL Statements

List - Equates

e  List- User Marks

- List - Perform Range Names

. List - Program/Subprogram Names
e List- COBOL Subset Names

=  View - Paragraph Cross Reference

Example 1. To copy al lines containing the characters ZI P for subsequent printing, type
this command:

LPRINT ZIP

Example 2. To copy the entire source fileto the List file, type this command:

LPRINT *
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LPUNCH Command

+

LPUnch name >» 1
FLABEL
FMARK
rPERFRANGE
FPROGRAM—
FSUBSET——
range —|
FLINE
name—
LPARAGRAPH-
*.
{ ] name ‘ ]
DATA SOL— Ref DIRect kALlasﬂ
EIDMS EUsej t NOAlias
: Mod INDirect
Def SIZeJ LLEVeIs nJ
VALue
kALlasﬂ
NOAlias
string
fPATTERNJ X'strina’ WORD Lcolumn lJ Lcolumn ZJ
T 'strina’ PREFIX
P 'string’ SUFFIX
—* » 2

1» »<«
Next L -
Prev IN-Y name—|
First —MARK
Last —PERFRANGE—

All —PROGRAM—
—SUBSET——
T Bl
—LINE
o name
—PARAGRAPH

Function
The LPUNCH command is used to copy lines containing the specified target to the Punch
file for subsequent processing. The Punch file is processed on the
Options - Log/List/Punch Definition pop-up.

Operands

Operand Description

LABEL name  Specifiesthe paragraph or section name of the PROCEDURE
DIVISION or the literals PROCEDURE or PROC where the FLOW
command is to begin.

MARK name  Specifiesalto 10 aphanumeric character name given to aset or path
using the COPY, MARK, MERGE, or RENAME commands, or one
of these system-generated paths:
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System generated path:
TRACK | TRK
NETWORK | NET
SUBNETn | SUBN

Created by:
A TRACE command.
A FLOW command.

A path created by the FLOW command
that reaches from the beginning of the
NETWORK to one of the results (nth
result).

Note:
The TRACK, NETWORK, and SUBNET paths can aso be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on
page 101).

PERFRANGE  Specifiesthenamein aPERFORM statement including all statements
name executed as aresult of a PERFORM statement, or the name of any
section contained in the Declaratives.
This operand isvalid in Source View only
PROGRAM Specifies the name of the main program or any nested program
name representing all the code contained in the program. Thisincludes al
the programs physically nested inside the specified program.
SUBSET name Specifies a predefined subset. These are the valid subsets:

ASsignment  DEBug 10

CAll DEFinition LABe

Clcs DIRective MAINline
COBOLII DIVision MATH
COBOL/370 DL/I|DL/1  Output
COMment DML PARagraph
CONditional  ENtry PERform
COPy EXIt|PGM  EXitRETurn
DB2/SQL FALLthrough SECtion
DDL GOto SORTMerge
DEAD IDMS STructure
DEADCode  INClude TESted
DEADData Input UNTested
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A screen subset;

Highlighted | HI
NONHighlighted | NHI
Excluded | X
NONExcluded | NX

Tagged lines subsets of tags in columns 73 through 80.

Note:
See the ASG-Insight User’s Guide for a description of each subset

LINE range Specifiesasingleline number or range of lines. Line numbersdisplay
in columns 1 through 6 of Source View.

PARAGRAPH  Specifiesa PROCEDURE DIVISION paragraph name or section

name name, or the literals PROCEDURE and PROC. The entire paragraph
or section isincluded.

DATA name Specifies a COBOL dataname or qualified COBOL dataname.
Dataname refers to any valid COBOL reference for a data element.
These subordinate operands apply to the dataname and can be used to
further qualify the EXCLUDE command: REF, USE, MOD, DEF,
ALIAS,NOALIAS, DIRECT, and INDIRECT. The defaultsare REF,
ALIAS, and DIRECT.

SQL name Includes datanames that are DB2/SQL variables only.

IDMS name Includes datanames that are IDM S variables only.

: name Includes datanames that are COBOL variables only.

Ref Includes occurrences of the dataname where its value is defined,
tested, used, set, or modified. Thisisthe default value for the DATA
name operand.

Use Excludes occurrences of the dataname where its value is being tested
or used.

Mod Excludes occurrences of the dataname where its value is being set or
modified.

Def Includes definitions of the dataname in the DATA DIVISION
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Allas

Searches backward from the cursor position to the previous
occurrence of the requested target.

Includes occurrences of the aliases for the dataname. These are the
valid aliases;

- Parent - higher level group item

«  Child - lower level item

«  Rename/Redefinition - renamed, redefined, or 88 level items
Thisisthe default value for the DATA name operand.

NOAlias

Ignores aliases for the specified dataname.

DIRect

Includes occurrences of the dataname (and aliases if specified) where
itisdirectly tested, used, set, modified, or defined (based on the REF,
USE, MOD, or DEF selection). The default for the DATA name
operand is direct; however, if you specify the SIZE, VALUE, or
LEVELS operand, INDIRECT is assumed.

INDirect

Includes any dataname indirectly affected by the specified dataname
(and aliasesif specified). You can further qualify the indirect data
item using the SIZE, VALUE, and LEVEL S subordinate operands.
These subordinate operands indicate the type of indirect referenceto
be located. SIZE and all levels are the defaults for the INDIRECT
operand.

SlZe

Includes datanames that could be directly or indirectly affected if the
size of the specified dataname were to be changed. SIZE isonly valid
with the INDIRECT operand. This isthe default for the INDIRECT
operand.

VALue

Includes occurrences of datanamesthat could be directly or indirectly
affected by achangeif the value of the specified dataname wereto be
changed. The LEVELS subordinate operand is not used with
VALUE. VALUE isonly valid with the INDIRECT operand.

LEVelsn

Includes al data items affected within the specified number of
indirect levels. The VALUE subordinate operand is not used with
LEVELS. All levelsisthedefault for the LEVEL Soperand. LEVELS
isonly valid with the INDIRECT operand.

PATTERN

Indicates the characters that follow are part of a string.
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string

X'string'

T'string

Pstring'

Specifies a string of alphanumeric or DBCS characters. If the pattern
string contains blanks, it must be enclosed in single or double quotes.
Y ou can further qualify the pattern string using the WORD, PREFI X,
or SUFFIX subordinate operands. These subordinate operands
describe how the pattern string is to be used:

Specifies the hexadecimal string option. Y ou can specify specific
unprintable charactersby giving the EBCDIC hexadecimal value. The
string must be enclosed in single or double quotes.

Specifiesthetext string option. Usethetext option to enter acharacter
string regardless of upper or lowercase. The string must be enclosed
in single or double quotes.

Specifies the picture string option. Y ou can enter a string profile
instead of exact characters. The string must be enclosed in single or
double quotes. Insight defines nine specia charactersfor usein
picture strings, and you can combine these special characters with
other characters.

These are the special characters:
pP=' Any character
P-' Any nonblank character

P! Any nondisplay character
P# Any numeric character

pP-' Any character
P@  Any character
pP< Any character
P> Any character
P$ Any character

WORD

Specifies the specified pattern string preceded and followed by any
non-al phanumeric character (except a hyphen).

PREFIX

Specifies aword that begins with the specified pattern string.

SUFFIX

Specifies aword that ends with the specified pattern string.

Columnl

Specifies the column number where the search isto begin.

Column2

Specifies the column number where the search isto end.
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asterisk (*)

Causes the entire virtual screen (all data that can be viewed by
scrolling forward and backward) to be copied to the List file. All
excluded lines are copied to the List file as excluded lines (as they
appear on the screen at the time the LPRINT * command is entered).

Next

Searches forward from the current cursor position to the next
occurrence of the requested target.

Prev

Searches backward from the current cursor position to the previous
occurrence of the requested target.

Flrst

Searches from the top of the source file to the first occurrence of the
requested target.

LAst

Searches backward from the bottom of the sourcefile to the first
occurrence of the requested target.

All

Searches for al occurrences of the requested target and displays the
number found in the short/long messagefield. Thisisthe default value
for the HIGH command.

Restricts the HIGH command to the specified target type.

Y ou can also copy lines to the Punch file by selecting a Search pop-up on the Search
pull-down. See the online help for more information.

LPUNCH copies the specified targets to the Punch file for subsequent processing.

To concatenate targets, place aplussign (+) between the target names. For example, 10 +
CALL. These rules apply to concatenation:

- A concatenated dataname can be used wherever adataname is valid. Dataname
subordinate operands (REF, ALIAS, etc.) pertain to all datanamesin aconcatenated

series.
- A concatenated set name can be used wherever a set name is valid. These sets can
be concatenated:
- LABEL - LINE
- MARK - PROGRAM
- PERFRANGE - PARAGRAPH
- SUBSET
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For COBOL |l Release 3 or later programs, adataitem, label, or program name that may
be ambiguous or used multiple times can be qualified by using OF followed by the
program name. For example, if the label P120-READ exists in another program and also
in the program VIAIDEM, then it can be qualified as P120-READ OF VIAIDEM1.

LPUNCH * can be entered on Tree View and Source View screens.

This command copies all the input and output statements of the current program into the
Punch file.

LPUNCH 10



MARK Command

—+
Mark —Y name
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mark-

FLABEL
FMARK
rPERFRANGE+
rPROGRAM—
rSUBSET

range —
~LINE

name —

-PARAGRAPH-

*

Function

»
[ ps-] name LNOTEﬁ‘
comment

The MARK command is used to save the requested target as a mark set or path. An
optional description can beincluded if desired.

Operands

LABEL name

Specifies the paragraph or section name of the PROCEDURE
DIVISION or the literals PROCEDURE or PROC where the FLOW
command is to begin.

MARK name

Specifiesa 1 to 10 a phanumeric character name given to aset or path
using the COPY, MARK, MERGE, or RENAME commands, or one
of these system-generated paths:

System generated path:  Created by:
TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.

SUBNETN | SUBN A path created by the FLOW command
that reaches from the beginning of the
NETWORK to one of theresults (nth
result).

Note:
The TRACK, NETWORK, and SUBNET paths can aso be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on
page 101).

PERFRANGE
name

Specifies the name specified in a PERFORM statement including all
statements executed asaresult of aPERFORM statement, or the name
of any section contained in the Declaratives.

This operand isvalid in Source View only
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PROGRAM
name

Specifies the name of the main program or any nested program
representing all the code contained in the program. Thisincludes al
the programs physically nested inside the specified program.

SUBSET name

Specifies a predefined subset. These are the valid subsets:

ASsignment  DEBug 10

CAll DEFinition LABe

Clcs DIRective MAINIline
COBOLII DIVision MATH
COBOL/370 DL/l |DL/2  Output
COMment DML PARagraph
CONditional  ENtry PERform
COPy EXIt| PGM ExitRETurn
DB2/SQL FALLthrough SECtion
DDL GOto SORTMerge
DEAD IDMS STructure
DEADCode  INClude TESted
DEADData Input UNTested
A screen subset:

Highlighted | HI

NONHighlighted | NHI

Excluded | X

NONExcluded | NX
Tagged lines subsets of tags in columns 73 through 80.

Note:
See the ASG-Insight User’s Guide for a description of each subset

LINE range

Specifiesasingleline number or range of lines. Line numbersdisplay
in columns 1 through 6 of Source View.

PARAGRAPH
name

Specifies a PROCEDURE DIVISION paragraph name or section
name, or the literals PROCEDURE and PROC. The entire paragraph
or section isincluded.
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AS Specifies an optional keyword indicating the mark name that follows
is the name to be assigned to the target.

mark-name A name assigned to a path or set of lines using the MARK command
or the Options - Scratchpad Mark pop-up. The specified name must
meet these requirements:

< A maximum of 10 alphanumeric characters, including hyphens.
Names longer than 10 characters truncate.

«  Must begin with an alphabetic character.

NOTE comment Providesan optional description about the new mark name. Comment
text can be amaximum of 50 alphanumeric or 23 DBCS characters. If
the NOTE comment operand is not entered, the existing comment is
copied to the new mark name. If NOTE is entered without comment
text, the existing comment is not copied to the new mark name.

Y ou can also create, copy, delete, merge, and rename mark sets and paths by selecting
one of the options on the Options - Scratchpad pop-up. See the online help for more
information.

To concatenate targets, place aplus sign (+) between the target names. For example,
IO+CALL. A concatenated set name can be used wherever a set nameisvalid. These sets
can be concatenated:

- LABEL - LINE

- MARK - PROGRAM

- PERFRANGE . PARAGRAPH
- SUBSET

For COBOL Il Release 3 or later programs, you can qualify adataitem, label, or program
name that may be ambiguous or used multiple times by using OF followed by the
program name. For example, if the label P120-READ exists in another program and also
in the program VIAIDEM1, then it can be qualified as P120-READ OF VIAIDEM1.

Thetarget of aMARK command can be saved multiple times under different names.

This command captures the system-generated path called TRACK and is named FICA
(both paths exist).

MARK TRACK AS FICA
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MERGE Command

—+

mark-

MErge name »<
-LABEL Lwith]  name LNOTEﬁ
FMARK comment
| PERFRANGE-|
L PROGRAM—|
L SUBSET

range —|
LLINE
—————————————r—hame—
LPARAGRAPH-!
*

Function
The MERGE command adds the lines from the specified target to the specified mark
name. If the specified mark name does not exist, it is created. A comment included with
the MERGE command replaces an existing one.

Operands

Operand Description

LABEL name  Specifiesthe paragraph or section name of the PROCEDURE
DIVISION or the literals PROCEDURE or PROC where the FLOW
command is to begin.

MARK name  Specifiesalto 10 aphanumeric character name given to aset or path
using the COPY, MARK, MERGE, or RENAME commands, or one
of these system-generated paths:

System generated path:  Created by:

TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.
SUBNETN | SUBN A path created by the FLOW command

that reaches from the beginning of the
NETWORK to one of the results (nth
result).

Note:
The TRACK, NETWORK, and SUBNET paths can aso be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on
page 101).
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PERFRANGE The name specified in a PERFORM statement including all
name statements executed asaresult of aPERFORM statement, or the name
of any section contained in the Declaratives. Thisoperandisvalidin
Source View only
PROGRAM The name of the main program or any nested program representing all
name the code contained in the program. This includes all the programs
physically nested inside the specified program.
SUBSET name Specifies a predefined subset. These are the valid subsets:
ASsignment  DEBug 10
CAll DEFinition LABe
Clcs DIRective MAINIline
COBOLII DIVision MATH
COBOL/370 DL/l |[DL/A  Output
COMment DML PARagraph
CONditional  ENtry PERform
COPy EXIt|PGM  ExitRETurn
DB2/SQL FALLthrough SECtion
DDL GOto SORTMerge
DEAD IDMS STructure
DEADCode  INClude TESted
DEADData Input UNTested
A screen subset:
Highlighted | HI
NONHighlighted | NHI
Excluded | X
NONExcluded | NX
Tagged lines subsets of tags in columns 73 through 80.
Note:
See the ASG-Insight User’s Guide for a description of each subset
LINE range  Specifiesasingleline number or range of lines. Line numbersdisplay
in columns 1 through 6 of Source View.
PARAGRAPH  Specifiesa PROCEDURE DIVISION paragraph name or section
name name, or the literals PROCEDURE and PROC. The entire paragraph

or section is included.
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WITH Specifies an optional keyword indicating the mark name that follows
isto be merged with the specified target.

mark-name Specifies a name assigned to a path or set of lines using the MARK
command or the Options - Scratchpad Mark pop-up. The specified
name must meet these requirements:

< A maximum of 10 alphanumeric characters, including hyphens.
Names longer than 10 characters truncate.

«  Must begin with an alphabetic character.

NOTE comment Provides an optional description about the name. Comment text can
be a maximum of 50 al phanumeric or 23 DBCS characters. If you do
not enter the NOTE comment operand, the existing comment is
copied to the new mark name. If you enter NOTE without comment
text, the existing comment is not copied to the new mark name.

Usage Notes

Y ou can also merger paths and sets on the Options - Scratchpad Merge pop-up. Seethe
online help for more information. A set of lines can be merged with another set of lines,
or a path can be merged to a set of lines.

To concatenate targets, place aplus sign (+) between the target names. For example,
IO+CALL. A concatenated set name can be used wherever a set nameisvalid. These sets
can be concatenated:

- LABEL - LINE

- MARK - PROGRAM

- PERFRANGE . PARAGRAPH
- SUBSET

For COBOL Il Release 3 or later programs, you can qualify adataitem, label, or program
name that may be ambiguous or used multiple times by using OF followed by the
program name. For example, if the label P120-READ exists in another program and also
in the program VIAIDEM1, then it can be qualified as P120-READ OF VIAIDEM1.

Example
The command below merges the contents of TRACK with the set of lines called FICA.

MERGE TRACK WITH FICA
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PARMDEF Command

X

PARMDEF | PDEF

Function
The PARMDEF command displays the Options - Product Parameters pop-up. The
Options - Product Parameters pop-up is used to set parameters that affect the online
operation of Insight.

Operands

None.

Usage Notes

Y ou can also display the Options - Product Parameters pop-up by selecting Options b
Product parameters.
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PREF Command

+

Pref —Y

v

—4’*Setname* NeXt:‘
—MARK Prev

Function

Operands

272

—PERFRANGE—
—PROGRAM—
—SUBSEF——~

Cone—__ T e®
- LINE

name
7LABELq
—PARAGRAPH

name—-—

The PREF command is used to display the View - Paragraph Cross Reference pop-up for
the requested target. The View - Paragraph Cross Reference pop-up shows how control is
transferred to or from the target paragraphs.

Operand Description

Blank If no operand is entered, the target paragraph set is determined
by the cursor location when the PREF command is issued.

MARK setname Specifiesa 1 to 10 character SBCSor alto 4 character DBCS
name given to aset using the COPY, MARK, MERGE, or
RENAME commands.

PERFRANGE name  Specifiesthe first statement within the specified PERFORM
range.

PROGRAM name Specifies the first executable statement within the specified
program.
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SUBSET name Specifies a predefined subset. These are the valid subsets:
ASsignment  DEBug 10
CAll DEFinition LABd
Clcs DIRective MAINIine
COBOLII DIVision MATH
COBOL/370 DL/l |DL/2  Output
COMment DML PARagraph
CONditional  ENtry PERform
COPy EXIt|PGM  ExitRETurn
DB2/SQL FALLthrough SECtion
DDL GOto SORTMerge
DEAD IDMS STructure
DEADCode  INClude TESted
DEADData Input UNTested
A screen subset:
Highlighted | HI
NONHighlighted | NHI
Excluded | X
NONExcluded | NX
Tagged lines subsets of tags in columns 73 through 80.
Note:
See the ASG-Insight User’s Guide for a description of each
subset
LINE range Specifies asingle line number or range of lines. Line numbers
display in columns 1 through 6 of Source View.
LABEL name Specifies any PROCEDURE DIVISION paragraph name or

section name, or the literals PROCEDURE and PROC. All
transfers of control to the label name are included.

PARAGRAPH name

Specifies a PROCEDURE DIVISION paragraph name or
section name, or the literals PROCEDURE and PROC. The
entire paragraph or section isincluded.
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Next Generates alist of paragraphsto where the target paragraph
transfers control.
Prev Generates alist of paragraphs that transfer control to the target

paragraph. Thisisthe default for the PREF command.

Y ou can also display the View - Paragraph Cross Reference pop-up by selecting View »
Paragraph X-ref and pressing Enter.

The PREF command includes all paragraphs containing the target lines. For example,
PREF IO displays every paragraph containing |O statements.

To concatenate targets, place a plus sign (+) between the target names. For example,
IO+CALL. A concatenated set name can be used wherever aset nameisvalid. These sets
can be concatenated:

< LABEL - LINE

- MARK - PROGRAM

- PERFRANGE - PARAGRAPH
- SUBSET

For COBOL Il Release 3 or later programs, you can qualify adataitem, label, or program
name that may be ambiguous or used multiple times by using OF followed by the
program name. For example, if the label P120-READ exists in another program and also
in the program VIAIDEM, then it can be qualified as P120-READ OF VIAIDEM1.

When there is a blank target with the cursor located on excluded lines, these items apply:

=  Thefirst line of the excluded block isimplicitly selected.

- If the selected line is not alabel, then a backward search is done to locate the
previous label. Thislabel then becomes the target.

Note:
See the online help for more information about the View - Paragraph Cross Reference
pop-up.

The command below displays the View - Paragraph Cross Reference pop-up with all
paragraphs that transfer control to the WRITE-ROUTINE paragraph.

PREF WRITE-ROUTINE
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PRINTLOG Command

PRINTLOG | PLOg »<

Function

The PRINTLOG command is used to display the Options - Log/List/Punch Definition
pop-up. On this pop-up the Log, List, and Punch files are processed.

Operands
None.

Usage Notes

The Options - Log/List/Punch Definition pop-up can aso be displayed by selecting
Options » Log/list/punch and pressing Enter.

The PRINTLOG command can be issued on any Insight screen.
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PRINTLST Command

PRINTLST | PLIst

Function

The PRINTLST command is used to display the Options - Log/List/Punch Definition
pop-up. On this pop-up the Log, List, and Punch files can be printed.

Operands
None.

Usage Notes

The Options - Log/List/Punch Definition pop-up can aso be displayed by selecting
Options » Log/list/punch and pressing Enter.

The PRINTLST command can be issued from any Insight screen.
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PROCESS Command

PROCess

Function

Operands

(member) model command »<
LSTEPJ

dsn (member)—
'dsn’
‘dsn (member)—

The PROCESS command defines an action to be performed repetitively on afile of input
items.

Thisfile may contain the resultslist from an ESW product, or thefile can be nested by the
user. Theinput items, called tokens, may be any text without embedded blanks or any
text enclosed in quotes. Tokens must be separated by one or more spaces.

The PROCESS primary command process the first nine tokensin afile. Any tokens
beyond nine are ignored. Any tokens referenced in the PROCESS command but not
present in the token file are passed as null.

Tokens enclosed in quotes retain their quotes after substitution in the model statement.

This exampleillustrates a possible format for arecord in the token file:

tokenl "token 2" token3 token4 token5 "token 6" token7 token8 token9

Insight, Encore, SmartTest, and Alliance can produce an output file using LPRINT,
LPUNCH, or the Query Facility. This file can be edited to produce afile of tokens that
can be read by the PROCESS primary command.

STEP Steps through the commands in the script file. Each command in the
script file displaysin the command input area. The displayed
command can be changed or erased from the command input area.
Press Enter to execute the displayed command. Processing of the
script file continues in this manner until all commands have been
displayed or executed.

(member) Specifies amember in the default script library (defined during
product installation) that contains tokens to be processed. The
default script libraries may be modified for your profile using the
Script file allocation action on the Options pull-down. Parentheses
arerequired if only the member is entered.
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dsn(member)  Specifies a partitioned dataset member that contains tokens to be
processed. This dataset must be in card image format (LRECL=80).
The specified dataset name and member must be entered following
TSO usage conventions in this format:

"pds.dataset.name(member)*

Quotes are required unless the high-level qualifier isyour TSO
UserlD.

dsn Specifies a sequential dataset that contains tokens to be processed.
This dataset must be in card image format (LRECL=80). The
specified dataset must be entered following TSO usage conventions
in this format:

"sequential .dataset._name*

Quotes are required unless the high-level qualifier isyour TSO
prefix or userID.

Model command  Specifiesany ESW product command that isvalidin a Script fileand
that can be defined using substitution variables. Tokensfrom thefile
are always substituted in the model command in numerical order
from 1 through 9 for the substitution variables & 1 through & 9.

When the PROCESS command is included in a script, the model
command may optionally reference substitution variables that were
passed to the script. Thisis done by specifying any of the override
substitution variables & & 1 through & & 9.

The PROCESS command allows automated processing of the results from any ESW
product that can produce atext file of tokens.

For example, if Alliance creates afile of records named user id.PROGDATA.TEXT
where each record contained a program name and a dataname, the file can be processed
with the command:

PROCESS PROGDATA.TEXT EXECUTE SCANPROG.SCRIPT PARMS &1 &2

This command reads each record of the file PROGDATA.TEXT in turn and substitutes
program name from the record into substitution variable & 1 and dataname from the
record into substitution variable & 2. It then executes the named script
(useri1d.SCANPROG.SCRIPT), passing the substituted variables & 1 and & 2.



Examples
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The script file SCANPROG.SCRIPT might contain these commandsto qualify a program
for viewing and execute another script file for the program.

Q &l
EXECUTE PROGPROC.SCRIPT PARMS &2

This allows the processing of multiple programs with a single command sequence.

To accomplish thistask, the PROCESS command verifies and opens the specified file.
These logic steps are repeated until an end-of-file occurs for the specified file.

To process multiple programs with a single command sequence

1 Read arecord. If therecord isnull or contains an asterisk (*) in column 1, ignore the
record and begin again.

2 Substitute tokens from the record into the substitution variables & 1 through &9.
3 Construct acommand using the model statement with the variable substitution.
4  Execute the constructed command asif it were a script command.

5  Repeat step 1 and subsequent steps until you reach an end-of -file.

PROCESS commands may occur within scripts and may be nested. If PROCESS
commands are nested, they must refer to different datasets.

These examples show how you might use the PROCESS command in its most basic form
to process a dataname list and then how this basic concept could be extended to automate
the same action for alist of programs.

The third exampleillustrates the use of override substitution variables.

Example 1. Given afile of datanames called userid.DATANAME.LIST, you could
execute this PROCESS command:

PROCESS DATANAME.LIST HI &1
Executing this command while on the Program View screen causes the HIGHLIGHT
command (HI) to be executed repetitively for each dataitem in thefile

userid.DATANAME.LIST.

Example 2. Given afile of program names called user 1d.PROGRAM.LIST, you
could execute this PROCESS command:

PROCESS PROGRAM.LIST EXEC MYSCRIPT.SCRIPT PARMS &1
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Assume that user 1d.MY SCRIPT.SCRIPT contains these commands:

* STEP 1: OPEN THE PROGRAM

QUALIFY &1

* STEP 2: POSITION TO THE PROGRAM VIEW SCREEN (SmartTest only)
FX 1

* STEP 3: PROCESS THE DATA NAME LIST

PROCESS DATANAME.LIST HI &1

* STEP 4: SAVE THE RESULTS OF THE PROCESS COMMAND

SAVE MARKS AS &I1MK

* STEP 5: CLOSE THE PROGRAM

QUALIFY CANCEL

The set of commandsin userid.MY SCRIPT.SCRIPT execute one time for each
program in user id.PROGRAM.LIST. userid.MY SCRIPT.SCRIPT contains a
PROCESS command that executes the model command, HIGHLIGHT, onetimefor each
record in userid.DATANAME.LIST.

TheresultisaMARK set, named pgmnameMK, for each programin
user id.PROGRAM.LIST. Each MARK set contains highlighted references to usesin
the program of all datanamesin userid.DATANAME.LIST.

Example 3. This exampleillustrates the technique of passing override substitution
variables & &1 and & & 2 to the PROCESS command contained in the script.

EXEC (MYSCRIPT) PARMS ARGl ARG2 ARG3

Assume the script in member MY SCRIPT in the default script libraries contains this
PROCESS command:

PROCESS "PROGRAM.LIST®" EXEC (PGSCRIPT) PARMS &&2 &1 &2 &&1

The parameters from the initial EXECUTE statement and the tokens from the file are
substituted in the PROCESS statement model command:

&&2 is passed the value ARG2

&1 is passed the First token of each record read from the File
"PROGRAM_LIST"

&2 is passed the second token of each record read from the
file "PROGRAM._LIST"

&&1 is passed the value ARG1
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PRODLVL Command

X

PRODLVL

Function
The PRODLVL command is used to display the current Insight and Center product level.

Operands
None.

Usage Notes

Thisinformation is requested when you contact ASG Customer Support for assistance.
Thisinformation can also be displayed from the Help - About pop-up. To display the
Help - About pop-up, select Help » About and press Enter.

The PRODLVL command displays the product name, operating system, product release
number, and release level on the message line, in this format:

ASG15541 INSIGHT-0S(XA) Rn.n AT Lnnn, CENTER Rn.n AT Lnnn
where:
Rn . n isthe release number.

Lnnn istherelease level.
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PROGRAM Command

PROgram Lpng Savej‘
e

Nosav

Function
The PROGRAM command is used to end the current Source View session and enter a
new Source View session for the specified program. Thisis useful when you are viewing
a system of multiple programs.

Operands

Blank Displays the AKR Program Selection pop-up for selection of a program.

pgm Specifiesa COBOL program or an entry point name. If the specified
program or entry point name is unavailable in the current AKR, an error
message displays.

Save Saves equates and marks for this program in the Application Knowledge

Repository. This operand overrides the values on the Options - Product
Parameters pop-up.

Nosave Specifies that equates and marks for this program are not saved. This
operand overrides the values on the Options - Product Parameters pop-up.

Usage Notes

Y ou can aso enter anew Source View session for a new program from the File - Open
Program Request pop-up. To display the File - Open Program Request pop-up, select File
» Open and press Enter.

Using the PROGRAM command is the easiest way of switching to another program.
However, Insight does not save the calling sequence. This means the GOBACK
command cannot be issued to return to a previous program.

Example
When current Source View program is VIAIDEMO and this command is entered:

PROGRAM VIAIDEM1 NOSAVE

The VIAIDEM1 program displays without saving marks and equates for VIAIDEMO.
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QUALIFY Command

Qualify

Function

Operands

X

pgm
LCANceIﬁ
ALL

The QUALIFY command displays the specified program on the Source View screen for
investigation. The qualified program becomes the current program, and program
understanding commands operate on the qualified program. Additional programs can be
qualified as needed.

Operand Description

pgm Specifies the program to be displayed on the Source View screen.
CANCce Closes the current program.
ALL Closes al open programs.

AKRname pgm Specifiesan AKR name. If you do not specify another AKR name,
Insight uses the profile AKR in batch.
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RECALL Command

RECall
COMmand | CMDj kNEXTf
MESsage | MSG PREV —

POPup

Function

The RECALL command is used to display the previous primary command, message, or
pop-up. The last 20 commands executed and the last 20 messages displayed are stacked.
Use the RECALL command to redisplay these commands or messages.

Operands

Blank

Displays the last primary command that was stacked. After you
enter the RECALL command operands, subsequently typing
RECALL with no operandsreusesthe same operandsthat werelast
entered.

COMmand | CMD

Displays a stacked primary command. Thisisthe default value.

MESsage | MSG Displays a stacked message.

NEXT Displays the next command or message in the stack.

PREV Displays the previous command or message in the stack. Thisis
the default value.

POPup Displays the pop-up that was most recently requested from a

pull-down.

Usage Notes

Y ou can enter the RECALL command repeatedly to display any of the 20 stacked
commands, messages, or pop-ups. The NEXT and PREV operands can be used to move
forward or backward through the stacked commands or messages. After the desired
command displays, you can execute it again by pressing Enter. Any command that is
recalled can be changed before you execute it. To re-execute the last saved primary
command again without modification, use the REPEAT command.
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The operands you specify for the RECALL command remain in effect until one of these
conditions occur:

= A different operand is specified.

- Adifferent primary command is executed. When this occurs, the RECALL
command default operands are automatically set. A message displays that indicates
all stacked commands or messages have been shown and the stack is being
redisplayed.

These commands are not stacked for use by the RECALL command:

ANALYZE LOCATE RECALL RSCROLL
CALL PARMDEF REDO RTRACE
END PRINTLOG REPEAT RTREEVW
GOBACK PRINTLST RETURN SAVE
HELP PRODLVL RFIND UPDATE
KEYS PROGRAM RHIGH VIEW

This example assumes these seven commands were entered for the current program and
that seven messages were displayed:

1 XALL
2 ZOOMIN
3 PREF

4 ZOOMOUT

5 KX
6 SCROLL
7 KX

To display the previous message (number 7), type RECALL MSG. The MSG operand
remainsin effect until the COMMAND or CMD operand is specified.
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Therefore, typing RECALL without changing the operands displays the previous message
(number 6). For example, typing RECALL with no operands displays the previous
command (number 7). The CMD operand remains in effect until aMSG operand is
specified.

RECALL CMD

Therefore, typing RECALL without changing the operands displays the previous
command (number 6).

This command displays the next command (number 7).

RECALL MD NEXT
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REDO Command

Y
A

REDo
i:trace-dec-op
BACKu

Function
The REDO command executes the corresponding repeat command from the cursor
position, as shown below.
FIND RFIND
FINDXTND RFIND
HIGH RHIGH
PREF RPREF
SCROLL RSCROLL
TRACE RTRACE
Only the commands listed in the table above are re-executed when you type REDO.
Operands
Description
Blank Re-executesthelast command entered. Theseoperandsarevalid
only if the last command was TRACE. Otherwise, they are
ignored.

trace-dec-opt Specifies a TRACE command decision option.

BACKup Returns to the decision point where the last decision option was
entered.

Usage Notes

REDO automatically executes the corresponding repeat command, depending on the last
command entered. For example, if the last command entered was FIND, RFIND is
executed.
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REFRESH Command

X

REFresh

Function
Updates the call summaries for programs called by the active program.

Operands
None.

Usage Notes

Call summaries can aso be updated by selecting Refresh on the Options pull-down. See
the online help for more information.

REFRESH is used to update information in the active program regarding any CALLed
program whose source was analyzed since opening the program.
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RENAME Command

REName

mark—name—L—J—mark—namc i
TO NOTEﬁ

comment

Function
The RENAME command changes the name of a mark path or set of lines.

Operands

mark-name Specifies aname assigned to a path or set of lines using the MARK
command or the Options- Scratchpad Mark pop-up. The specified name
must meet these requirements:

- Must be a maximum of 10 aphanumeric or 4 DBCS characters
and can include hyphens.

< Nameslonger than 10 characters truncate.

- Name must begin with an alphabetic character.

TO Specifiesan optional keyword indicating the name following isthe new
mark name.

NOTE Includes an optional description about the mark name. Comment text

comment can be amaximum of 50 alphanumeric or 23 DBCS characters. If the

NOTE comment operand is not entered, the existing comment is copied
to the new mark name. If NOTE is entered without comment text, the
existing comment is not copied to the new mark name.

Usage Notes

Marks can also be renamed on the Options - Scratchpad Rename pop-up. See the online
help for more information.

An error message displaysif the mark name to be renamed does not exist or the resulting
mark name already exists.

Example

When this command is entered, the mark name SETA is changed to SETB. SETA isho
longer valid as a mark name.

RENAME SETA TO SETB
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REPEAT Command

X

REPEat

Function

Operands

Usage Notes

Example

290

Executes the last stacked primary command again.

None.

Type REPEAT in the command input area to re-execute the last stacked primary
command. The command is executed from the cursor position.

To modify the command before it is re-executed, use the RECALL command.

To display the next occurrence of ahighlighted line, type this command:
SCROLL HI' NEXT

Instead of re-entering the same command, type this command:
REPEAT

This command executes the SCROLL HI NEXT command again from the cursor
position.



RESET Command

RESet

Function

Operands

Usage Notes

10 Commands - RESET Command

y

—All

—Hi

—Taa
—Excluded | X
r—Lines
—Messaae
—line range

—m—marknamef
MARK

X

The RESET command removes highlighting and tags, cancels pending line commands,
terminates message lines, and/or redisplays all excluded lines.

Blank Defaultsto the value ALL.

All Resetsall conditionsindicated by each of the operands. Thisisthe default.

Hi Removesthe highlighting from any line that was highlighted as aresult of
another Insight command.

Tag Erases tagsin columns 73 through 80 set as a result of another Insight
command.

Excluded | X  Displaysany excluded lines.

Lines Clears any pending line commands.

Message Erases short or long messages that display.

Line Resetsthe HI, TAG, EXCLUDED, LINES, and MESSAGE conditions

range only for the specified line or range of lines.

MARK Resetsthe HI, TAG, EXCLUDED, LINES, and MESSA GE conditions

markname  only for statements belonging to the mark set. The keyword MARK isnot

needed if there is no ambiguity.

Y ou can also reset Features from the View - Reset pop-up. To display the View - Reset
pop-up, select View » Reset and press Enter. Any combination of operands can be
specified for the RESET command.
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RETURN Command

RETurn

Function

Operands

Usage Notes

292

X

Savee—_‘
Nosav

The RETURN command is used to terminate the current function and return to the first
Insight screen displayed.

Operand Description

Blank Specifies that the values specified on the Options - Product Parameters
pop-up are used to determine if marks and equates are to be saved.

Save Saves marks and equates created for this program in the AKR. This
operand overrides the values set on the Options - Product Parameters

pop-up.

Nosave Specifies that marks and equates are not saved for this program. This
operand overrides the values set on the Options - Product Parameters

pop-up.

Using the RETURN command is a quick way of ending an Insight function.
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RFIND Command

RFind

X

Function

The RFIND command is used to repeat the last FIND or FINDXTND command from the
cursor position.

Operands
None.

Usage Notes

The RFIND command is a convenient way to locate the next occurrence of the specified
target of aFIND or FINDXTND command. The search is performed in the direction
indicated in the FIND or FINDXTND command. RFIND is assigned to the PFO5/17 key
as a default.

The REDO command can aso be used to execute the RFIND command. See "REDO
Command" on page 287 for more information.
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RHIGH Command

RHIgh »<
Function
The RHIGH command is used to repeat the last HIGH command from the cursor
position.
Operands
None.

Usage Notes

Type RHIGH in the command input areato repeat the last HIGH command from the
cursor position.

The REDO command can also be used to execute the RHIGH command. See "REDO
Command" on page 287 for more information.
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RPREF Command

RPref »<
Function
When on the Source View screen, use the RPREF command to redisplay the last
View - Paragraph Cross Reference pop-up. When on the View - Paragraph Cross
Reference pop-up, use the RPREF to redisplay the last Source View screen.
Operands

None.

Usage Notes

The View - Paragraph Cross Reference pop-up redisplays with the exact information as
previously shown. RPREF can be used to go back and forth between the source and the
View -Paragraph Cross Reference pop-up.

When an RPREF (and no PREF) command is entered, RPREF functions as a PREF
command with the cursor position as the target and default direction.

The REDO command can also be used to execute the RPREF command. See "REDO
Command" on page 287 for more information.
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RSCROLL Command

RSCroll »<«
Function
The RSCROLL command is used to repeat the last SCROLL command from the cursor
position.
Operands
None.

Usage Notes

Type RSCROLL in the command input areato repeat the last SCROLL command from
the cursor position.

The REDO command can also be used to execute the RSCROLL command. See "REDO
Command" on page 287 for more information.
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RSTRUCTURE-VIEW Command

RSTRUCTure-view | RSTView

X

Function
The RSTRUCTURE-VIEW command is used to return to the previous Perform Structure
View screen.

Operands
None.
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RTRACE Command

RTrace
i:trace—dec—op\:‘
BACKup

Function
The RTRACE command is used to continue the last TRACE command from where it
stopped.
Operands
Blank Displays the Trace Decision Options pop-up. When RTRACE

is entered without an operand and not at a decision point, the
trace function is resumed from the stopping point.

trace-dec-opt

Specifies a TRACE command decision option.

BACKup

Returnsto the decision point where the last decision option was
entered. The TRACK isreset to include only those lines that
werein it when that decision point was reached. Only one
BACKUP s alowed following an RTRACE command. A
message displays if there is no previous decision point or if
BACKUP has aready been done.

Usage Notes

The RTRACE command can be used to continue a trace function without exiting the
Source View screen. Type the desired option number in the command input area and
press Enter. This process can be continued until the end of the trace functionisreached. If
adifferent path isto be followed, type BACKUP in the command input area, press Enter,
and select the desired option.

If atrace function isinterrupted and another primary command is entered, the messages
displayed by the trace function are cleared. To continue the trace function, type RTRACE.
The screen is then scrolled to the last trace location and the messages redisplay.

If adecision point prompt is unclear, the Trace Decision Options pop-up that explainsthe
decision point can be displayed. Type RTRACE without an operand to display the Trace
Decision Options pop-up. The Trace Decision Options pop-up shows this information:
the possible options from the decision point; the type of branch; the line number; and the
first statement of the destination. An asterisk (*) next to an option indicates that option

was traced.
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The REDO command can also be used to execute the RTRACE command. See "REDO
Command" on page 287 for more information.

Trace Decision Options Pop-up

Fields

The Trace Decision Options Pop-up (Figure 102) displays when you type RTRACE
without an operand. This pop-up is used to list all possible options from the decision
point, the type of branch, the line number, and the first statement of the destination. An
asterisk displayed next to an option shows that you have already TRACEd that option.

Figure 102« Trace Decision Options Pop-up

Trace Decizion Opfions
Cornand ===} _ Ecroll ===k IR

Trace of i TESTCALL

Direction: FORMARD

Faragraph: 00015 PROCEDURE DIMVIZION.
Decisions 000015 IF WE-CHKP-COUNTER = 18

Option Info indicates TARGET's and '#' for Code already TRACE'd

Zelect one of the following decizion options: Option
% Option Info

_ 1. TRUE [@@081% HOVE & TO ME-CHEP-INTERVAL ,ME-CHEKR-COUNTER)
_ 2. FALSE [@00028 ELSE)

EQTTOH OF DATA

Trace of Specifies the name of the target you are tracing. For a
dataname, it also indicates the usage (USE, MOD, REF). If an
IN clause was specified, it is also displayed.

Direction Specifies the direction requested for the trace (NEXT,
PREVIOUS, FORWARD, or BACKWARD).

Paragraph Specifies the line number and name of the paragraph that
contains the decision point.

Decision Specifies the line number and statement of the decision point.

S(linecommand area) Specifiestheline command area, to theleft of the Option field,
accepts the Sline command to select the option.
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Field Description

Option Specifiesthe all feasible options from the decision point. Each
option liststhe type of branch, line number, and first statement
of the destination.

Option Info Indicates whether the option is the requested target or has
already been traced.
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RTREEVW Command

X

RTREEvw | RTV
Function
The RTREEVW command returns to the previous Tree View screen.

Operands
None.

Usage Notes

The Tree View screen isredisplayed with the exact information as previously shown. See
the online help for more information about the Tree View screen.
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SAVE Command

SAve

Function

Operands

Usage Notes

302

X

Marks-
Equates—
All

The SAVE command is used to save marks and/or equates in the AKR. This command
overrides the values set on the Options - Product Parameters pop-up.

Operand Description

Blank Defaultsto the value ALL.

Marks Saves all marks created or changed for the active program. This operand
overrides the values set on the Options - Product Parameters pop-up.

Equates Saves all equates entered for the active program. This operand overrides
the values set on the Options - Product Parameters pop-up.

All Saves marks and equates entered for the active program. This operand
overridesthe values set on the Options - Product Parameters pop-up. This
isthe defaullt.

Marks and equates can aso be saved on the File - Save pop-up, and on the File - Close
pop-up. See the online help for more information.

Save values established on the Options - Product Parameters pop-up can be overridden
using the SAVE command.



SCROLL Command

+
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v
[

Scroll A name
FLABEL
-MARK
+PERFRANGE|
FPROGRAM—
FSUBSET—
range—
—LINE
name—
PARAGRAPH*
name
DATAJ SQL— Ref DIRect— L—ALlasﬂ
IDMsf Use NOAlias
INDirect:
Def L»SIZe LLEVeIs nJ
VALue
L—ALlasﬂ
NOAlias
string
7PA'I‘I'ERNJ X'string'— —WORD Lcolumn lJ Lcolumn 2J
T 'string'— —PREFIX
P 'string'— “——SUFFIX
number » 2
fBOXJ
1)» »<«
——Next— +
—Prev—| LIN 4 name—|
——Flrst— —MARK
——LAst— —PERFRANGE—
—AIl— —PROGRAM—
—SUBSET——
T Rl
—LINE
ﬁ—namef
—PARAGRAPH
2)»
Function
The SCROLL command is used to position the screen to the first line containing the
specified target. Highlighted lines remain unchanged.
Operands

Operand Description

LABEL name

Specifies the paragraph or section name of the PROCEDURE
DIVISION or the literals PROCEDURE or PROC where the FLOW
command is to begin.
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MARK name

Specifiesalto 10 aphanumeric character name given to aset or path
using the COPY, MARK, MERGE, or RENAME commands, or one
of these system-generated paths:

System generated path:  Created by:
TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.

SUBNETN | SUBN A path created by the FLOW command
that reaches from the beginning of the
NETWORK to one of the results (nth
result).

Note:
The TRACK, NETWORK, and SUBNET paths can also be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on
page 101).

PERFRANGE
name

Specifiesthenamein aPERFORM statement including all statements
executed as aresult of a PERFORM statement, or the name of any
section contained in the Declaratives. This operand isvalid in Source
View only

PROGRAM
name

Specifies the name of the main program or any nested program
representing all the code contained in the program. Thisincludes al
the programs physically nested inside the specified program.

SUBSET name

Specifies a predefined subset. These are the valid subsets:

ASsignment  DEBug 10

CAll DEFinition LABel
Clcs DIRective MAINline
COBOLII DIVision MATH
COBOL/370 DL/l |DL/1  Output
COMment DML PARagraph
CONditional  ENtry PERform
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COPy EXIt|PGM  ExitRETurn
DB2/SQL FALLthrough SECtion
DDL GOto SORTMerge
DEAD IDMS STructure
DEADCode  INClude TESted
DEADData Input UNTested

A screen subset:

Highlighted | HI
NONHighlighted | NHI
Excluded | X
NONExcluded | NX

Tagged lines subsets of tags in columns 73 through 80.

Note:
See the ASG-Insight User’s Guide for a description of each subset

LINE range Specifiesasingleline number or range of lines. Line numbersdisplay
in columns 1 through 6 of Source View.

PARAGRAPH  Specifiesa PROCEDURE DIVISION paragraph name or section

name name, or the literals PROCEDURE and PROC. The entire paragraph
or section isincluded.

asterisk (*) Reuses the target of the previous SCROLL.

DATA name Specifies a COBOL dataname or qualified COBOL dataname.
Dataname refers to any valid COBOL reference for a data element.
These subordinate operands apply to the dataname and can be used to
further qualify the EXCLUDE command: REF, USE, MOD, DEF,
ALIAS,NOALIAS, DIRECT, and INDIRECT. Thedefaultsare REF,
ALIAS, and DIRECT.

SQL name Includes datanames that are DB2/SQL variables only.

IDMS name Includes datanames that are IDM S variables only.

: name Includes datanames that are COBOL variables only.
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Ref

Includes occurrences of the dataname where its value is defined,
tested, used, set, or modified. Thisisthe default value for the DATA
name operand.

Use

Excludes occurrences of the dataname where its value is being tested
or used.

Mod

Excludes occurrences of the dataname where its value is being set or
modified.

Def

Includes definitions of the datanamein the DATA DIVISION

Allas

Searches backward from the cursor position to the previous
occurrence of the requested target.

Includes occurrences of the aliases for the dataname. These are the
valid aliases:

=  Parent - higher level group item

-  Child - lower level item

- Rename/Redefinition - renamed, redefined, or 88 level items
Thisis the default value for the DATA name operand.

NOAlias

Ignores aliases for the specified dataname.

DIRect

Includes occurrences of the dataname (and aliasesif specified) where
itisdirectly tested, used, set, modified, or defined (based on the REF,
USE, MOD, or DEF selection). The default for the DATA name
operandisdirect; however, if the SIZE, VALUE, or LEVEL Soperand
is specified, INDIRECT is assumed.

INDirect

Includes any dataname indirectly affected by the specified dataname
(and aliases if specified). The indirect dataitem can be further
gualified using the SIZE, VALUE, and LEVELS subordinate
operands. These subordinate operands indicate the type of indirect
reference to be located. SIZE and al levels are the defaults for the
INDIRECT operand.

SlZze

Includes datanames that could be directly or indirectly affected if the
size of the specified dataname were to be changed. SIZE isonly valid
with the INDIRECT operand. Thisisthe default for the INDIRECT
operand.
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VALue

Includes occurrences of datanamesthat could be directly or indirectly
affected by achangeif the value of the specified dataname wereto be
changed. The LEVELS subordinate operand is not used with
VALUE. VALUE isonly valid with the INDIRECT operand.

LEVelsn

Includes all dataitems affected within the specified number of
indirect levels. The VALUE subordinate operand is not used with
LEVELS. All levelsisthedefault for the LEVEL Soperand. LEVELS
isonly valid with the INDIRECT operand.

PATTERN

Indicates the characters that follow are part of a string.

string

X'string'

T'string'

Pstring'

Specifies a string of alphanumeric or DBCS characters. If the pattern
string contains blanks, it must be enclosed in single or double quotes.
The pattern string can befurther qualified using the WORD, PREFI X,
or SUFFIX subordinate operands. These subordinate operands
describe how the pattern string is to be used:

Specifies the hexadecimal string option. Specific unprintable
characters may be specified by giving the EBCDIC hexadecimal
value. The string must be enclosed in single or double quotes.

Specifies the text string option. A character string may be entered
regardless of upper or lowercase by using the text option. The string
must be enclosed in single or double quotes.

Specifies the picture string option. A string profile may be entered
instead of exact characters. The string must be enclosed in single or
double quotes. Insight defines nine specia characters for usein
picture strings. These special characters can be combined with other
characters.

These are the special characters:
p=' Any character

P-' Any nonblank character
P! Any nondisplay character
P# Any numeric character
pP-' Any character

P@  Any character

pP< Any character

P> Any character

P$  Any character
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Usage Notes
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WORD Specifies the pattern string preceded and followed by any
non-al phanumeric character (except a hyphen).

PREFIX Specifies aword that begins with the specified pattern string.

SUFFIX Specifies aword that ends with the specified pattern string.

Columnl Specifies the column number where the search is to begin.

Column2 Specifies the column number where the search isto end.

Next Searches forward from the current cursor position to the next
occurrence of the requested target.

Prev Searches backward from the current cursor position to the previous
occurrence of the requested target.

Flrst Searches from the top of the source file to the first occurrence of the
requested target.

LAst Searches backward from the bottom of the source file to the first
occurrence of the requested target.

All Searches for all occurrences of the requested target and displays the
number found in the short/long messagefield. Thisisthedefault value
for the HIGH command.

IN Restricts the HIGH command to the specified target type.

Box Number Identifies a scroll to a specific box number, rather than aline. This

operand is only availablein Perform Structure View.

The screen can also be scrolled by selecting a Search pop-up on the Search pull-down.
See the online help for more information.

To concatenate targets, place aplus sign (+) between the target names. For example, 10 +
CALLS. Theserules apply to concatenation:

< A concatenated dataname can be used wherever a dataname is valid. Dataname
subordinate operands (REF, ALIAS, etc.) pertain to all datanames in aconcatenated
series.
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- A concatenated set name can be used wherever a set name is valid. These sets can

be concatenated:

- LABEL - LINE

- MARK - PROGRAM

- PERFRANGE - PARAGRAPH
- SUBSET

The asterisk (*) operand can be concatenated once with any number of other operands
(eg., * +10 + MY SET); however, the asterisk (*) operand cannot be concatenated to
itself (* +* isinvalid). The* operand may appear in any order in the concatenated list.

For COBOL |l Release 3 or later programs, adataitem, label, or program name that may
be ambiguous or used multiple times can be qualified by using OF followed by the

program name. For example, if the label P120-READ existsin another program and also
in the program VIAIDEM1, then it can be qualified as P120-READ OF VIAIDEM1.

This command displays the first occurrence of aline containing the characters ZIP.

SCROLL ZIP
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SELECT Command

Select trace-dec-opt
T L pgm

Function

Operands

310

X

The SELECT command is used to select the desired option from alist. SELECT is used
on the Trace Decision Options pop-up and the AKR Program Selection pop-up. SELECT
followed by the desired option can be entered in the command input area. An S can be
entered to the left of the displayed items to select a particular item on any screen with a
selection field.

Operand Description

trace-dec-opt Specifies a TRACE command decision option.

pgm Specifies the complete program name from the AKR Program
Selection pop-up.

Note:
See "RTRACE Command" on page 298 for more information about the Trace Decision
Options pop-up.




SET Command

SET

Function

Operands

10 Commands - SET Command

LEarn———
SCript————— | —OFF
RESULTH

XMode

X

o

The SET command is used to enable or disable the mode indicated by the specified

operand.

Blank Displays the Options - Processing Modes pop-up that shows the current
setting for each SET command mode.

LEarn Displaysall primary commands generated internally when actionsfromthe
pull-downs execute. The default for this operand is OFF.

SCript Allocatesascript filewhenthe SET SCRIPT ON command isissued. From
that point on, al Insight primary commands are captured in thisfile. When
the SCRIPT OFF command isissued, the script fileis closed and saved.
Thescriptfilenameisuserid.INSnnnnn.VIASCRIP. If the TSO profile
prefix is not the same asthe user ID, then thisnameis preceded by a prefix
value.

RESULT  Savestheresultsof primary commands ascommentsin the script filewhen
used with the SCRIPT operand.

XMode Excludes all lines from the screen before a primary command is executed

when this mode is ON. This mode affects all primary commands with the
exception of these:

- BRANCH
- LOCATE
- SCROLL
« HIGH

- RFIND

The default value for this operand is OFF.
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Usage Notes

Any modes that you either enabled or disabled with the SET command can also be
enabled or disabled on the Options - Processing M odes pop-up.

To display the Options - Processing Modes pop-up, follow this step:
P Select Options » Modes and press Enter.

Or

Type SET (with no operands) on any screen and press Enter.

See the online help for more information about the Options - Processing Modes pop-up.

LEARN Mode - Generated Command Pop-up

The LEARN Mode - Generated Command pop-up displays the internally-generated
primary command when actions are requested on pop-ups, if the LEARN mode is set to
ON with the SET command or on the Options - Processing Modes pop-up (shown in
Figure 103).

Figure 103+ LEARN Mode - Generated Command Pop-up

LEARN Mode - Generated Command

To process the generated command, press Enter. To cancel
the command, press PF3/15 (END).

Command TREEVIEW 2

Follow the instructions on the pop-up to process or cancel the command.

SOURCEVIEW Command

SOURCEVIEW | SView

X

Function

The SOURCEVIEW command is used to display the Source View screen. This screen
shows the program in source code order.

Operands

None.
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STRUCTURE-VIEW Command

STRUCTure-view | STView »<«
name— bﬁ—tnumber:‘ 'ﬁ—[YESj
—PERFRANGEE| LEVELs MAX REPetition NO
—PROGRAM

Function

Operands

—ENtry—Li
name—

The STRUCTURE-VIEW command transfersthe display of the program being viewed to
the Perform Structure View screen.

Operand Description

Blank Specifies that the defaults are used.
PERFRANGE Specifies the starting paragraph for the Perform Structure View
name screen. A nameisany PROCEDURE DIVISION paragraph name

or section name.

PROGRAM name  Specifies the main program or any of the nested programs
representing all the code that is executed by entering the specified
program.

For COBOL |l Release 3 or later programs, a program name that
may be ambiguous or used multiple times can be qualified by
using OF followed by the program name. For example, if the label
P120-READ existsin another program and also in the program
VIARDEM, then it can be qualified as P120-READ OF
VIARDEM1.

ENTRY name Displays the main program structure and the structure for all
ENTRY points. If anameis specified, the structure for that entry

point displays.
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Operand Description

LEVELs Controls the amount of information displayed on entering
Perform Structure View. Specify the number of nested control
flow structures to be displayed. The default, 2, displays the first
two levels of nested performs. MAX displays the maximum
nesting level. However, if the maximum nesting level consists of
only repeated perform ranges, then the nested level istruncated to
the next higher level that does not consist exclusively of repeated
perform ranges.

REPetition Controlsthe display of duplicated perform range structures. If
REPETITION is YES, all duplicate perform ranges display. If
REPETITION isNO, duplicate perform range structures are only
flagged as REPEATED. The default isNO.

Usage Notes

The Perform Structure View screen can also be displayed by selecting View » Structure
and pressing Enter.

Type STRUCTURE-VIEW in the command input area to transfer the display to the

Perform Structure View screen. Use the END command to return to screen where the
STRUCTURE-VIEW command was entered.
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TRACE Command

TRace

\4

MARK Forward —
PERFRANGE Backward -
PROGRAM—

—+
v

+ﬂ Next
—hame Prev

name —|
7FROM7ﬁnumber LTOJ 7SUBSETJ
—LINE j—range—
ﬁ—name —LINE
- LABEL —4’—name—
—LABEL
+
\2 \

name
LDATA4 ERE‘f

Use—|
Mod -

\ 4

Function

Operands

\ 4
A

MARK
PERFRANGE —|
PROGRAM—

The TRACE command is used to follow the execution of a program, searching for the
specified target. The MARK and PERFRANGE operands trace the path represented by
the MARK name, PERFRANGE name, or PROGRAM name. Tracing to aSUBSET
name, LINE range, LABEL name, or DATA name traces from the starting point to the
lines represented by these targets.

Blank Specifiesthat the default direction of NEXT is used. Thetrace begins
at the cursor position and continues to the program exit.

FROM Indicates where the TRACE command isto begin. The MARK name,
PERFRANGE name, and PROGRAM name operands cannot be used
with this operand.

LINE number  Specifiesthe line number where the TRACE command is to begin
when the target isa SUBSET name, LINE range, LABEL name, or
DATA name.

LABEL name  Specifiesthe paragraph, section, or division name where the TRACE
command isto begin when thetargetisaSUBSET name, LINE range,
LABEL name, or DATA name.
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TO

Specifies an optional keyword that is followed by atarget to indicate
where the TRACE command isto end.

MARK name

Specifiesa 1 to 10 a phanumeric character name given to aset or path
using the COPY, MARK, MERGE, or RENAME commands, or one
of these system-generated paths:

System generated path:  Created by:
TRACK | TRK A TRACE command.
NETWORK | NET A FLOW command.

SUBNETN | SUBN A path created by the FLOW command
that reaches from the beginning of the
NETWORK to one of theresults (nth
result).

Note:
The TRACK, NETWORK, and SUBNET paths can aso be created
using the Logic Order Search pop-ups (see "Logic Pull-down" on
page 101).

PERFRANGE
name

Specifiesthenamein aPERFORM statement including all statements
executed as aresult of a PERFORM statement, or the name of any
section contained in the Declaratives. Thisoperand isvalid in Source
View only

PROGRAM
name

Specifies the name of the main program or any nested program
representing all the code contained in the program. Thisincludes al
the programs physically nested inside the specified program.

SUBSET name

Specifies a predefined subset. These are the valid subsets:

ASsignment  DEBug 10

CAll DEFinition LABd
Clcs DIRective MAINline
COBOLII DIVision MATH
COBOL/370 DL/l |DL/2  Output
COMment DML PARagraph
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CONditional  ENtry PERform
COPy EXIt|PGM  ExitRETurn
DB2/SQL FALLthrough SECtion
DDL GOto SORTMerge
DEAD IDMS STructure
DEADCode  INClude TESted
DEADData Input UNTested

A screen subset:

Highlighted | HI
NONHighlighted | NHI
Excluded | X
NONExcluded | NX

Tagged lines subsets of tags in columns 73 through 80.

Note:
See the ASG-Insight User’s Guide for a description of each subset

LINE range

Specifiesasingleline number or range of lines. Line numbersdisplay
in columns 1 through 6 of Source View.

LABEL name

Specifies any PROCEDURE DIVISION paragraph name or section
name, or the literals PROCEDURE and PROC. All transfers of
control to the label name are included.

DATA name

Specifiesa COBOL dataname or qualified COBOL dataname.
Dataname refers to any valid COBOL reference for a data element.

These subordinate operands apply to the dataname and can be used to
further qualify the EXCLUDE command: REF, USE, MOD, DEF,
ALIAS,NOALIAS, DIRECT, and INDIRECT. Thedefaultsare REF,
ALIAS, and DIRECT.

Ref

I ncludes occurrences of the dataname where its value is defined,
tested, used, set, or modified. Thisisthe default value for the DATA
name operand.

Use

Excludes occurrences of the dataname where its value is being tested
or used.

Mod

Excludes occurrences of the dataname where its valueis being set or
modified.
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Operand Description

Next Searches forward from the current cursor position to the next
occurrence of the requested target.

Prev Searches backward from the current cursor position to the previous
occurrence of the requested target.

Forward Traces forward from the current cursor position to all occurrences
Backward Traces backward from the current cursor position to all occurrences.
IN Restricts the HIGH command to the specified target type.

Execution paths in a program can also be identified using the Logic Order Search
pop-ups, that can create a path with amark name of TRACK. See Chapter 5, "L ogic," on
page 99 for more information.

To concatenate targets, place a plus sign (+) between the target names. For example,
IO+CALL. These rules apply to concatenation:

- A concatenated dataname can be used wherever a dataname is valid. Dataname
subordinate operands (REF, USE, MOD) pertain to all datanamesin a concatenated

series.
- A concatenated set name can be used wherever a set nameisvalid. These sets can
be concatenated.
- LABEL - LINE
- MARK - PROGRAM
- PERFRANGE - SUBSET

For COBOL |l Release 3 or later programs, adataitem, label, or program name that may
be ambiguous or used multiple times can be qualified by using OF followed by the
program name. For example, if the label P120-READ exists in another program and also
in the program VIAIDEM1, then it can be qualified as P120-READ OF VIAIDEM1.

When TRACE is entered with only a direction operand, this occurs:

Direction Tracesto the...

Next program exit statements.

Previous PROCEDURE DIVISION statement or the program ENTRY points.
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Forward program exit statements.

Backward PROCEDURE DIVISION statement or the program ENTRY points.

The trace function can be performed on an existing path (e.g., NETWORK, SUBnN), or
from a specific starting point to atarget. The execution path followed during the trace
function is automatically saved into aMARK path called TRACK. This path hasasingle
entry and exit beginning with the line where a trace function starts and ending where the
trace function is discontinued. TRACK isvalid until a new trace function isinitiated.

Unconditional PERFORMSs can be included in TRACK without following a path into the
PERFORMed unit by using the BY PASS PERFORMED CODE decision option. This
method shortens the trace function without a detailed trace of the PERFORMed unit.

Using the trace function is a convenient way to view pathsin logical execution order. All
executabl e statements on the path from the starting point to where the trace function stops
are highlighted. A long message indicates the reason for stopping. For a decision point,
the line number where the trace function stopped and the line number to continue with
show.

Columns 73 through 80 contains these information tags on atraced line:

DECISION for a decision point

STOP PNT for an intermediate stopping point
START for the beginning of the trace function
OPTION n for an option choice

TARGET for a destination of the trace function

Multiple information tags appearing on a line are separated with a slash (/).

The trace function stops and redisplays the Source View screen when these occur:
=  Atargetisreached.

= A decision point isreached. All valid options are presented in columns 73 through
80 and line three of the Source View screen.

-  Beforeentering or exiting a PERFORMed unit (DECISION).

= AtaGOTO statement that transfersto code not displayed on the screen (STOP
PNT).

- At aGOTO or EXIT from PERFORMSsin the forward direction, or aLABEL in the
backward direction (STOP PNT).
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- The bottom of the screen isreached in the NEXT or FORWARD direction, or the
top of the screen isreached in the PREVIOUS or BACKWARD direction (STOP
PNT).

<  Anapparent decision point is reached but only one choice exists. Thisisshown asa
stopping point rather than a decision point.

To continue the trace function, type the desired option in the command input area and
press Enter.

Note:

See Chapter 5, "Logic," on page 99 or the online help for more information about
TRACKSs and the Logic Order Search pop-ups.

Example 1. Thiscommand traces forward to the first EXIT in the program:
TRACE EXITS

To highlight the resulting MARK path, type this command:
FX TRACK

Example 2. This command traces forward through SUBNET1, that is a part of the
NETWORK created by the FLOW command:

TRACE SUBNET1
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TREEView | TV

name—
—PERFRANGEE|
—PROGRAM

BNty
name—

Function

CONDitional—|

LABELS ‘L ] Lnumtt‘ YESj
STRUCture—j LEVELs MAX: REPetition NO
PERF

The TREEVIEW command displays the Tree View screen, that shows a structural
program representation in logical execution order. This command can also be executed
on the Tree View screen to end the current Tree View and start anew Tree View with the

specified targets.

Operands

Blank

Specifies that the defaults are used.

PERFRANGE name

Specifies the starting paragraph for the Tree View display. A
name is any PROCEDURE DIVISION paragraph name or
section name. The PROCEDURE literal can also be specified.

PROGRAM name

Specifies the main program or any of the nested programs
representing all the code that is executed by entering the
specified program.

For COBOL Il Release 3 or later programs, adataitem, label, or
program name that may be ambiguous or used multiple times
can be qualified by using OF followed by the program name. For
example, if the label P120-READ existsin another program and
also in the program VIAIDEM1, then it can be qualified as
P120-READ OF VIAIDEM 1.

ENTRY name

Displays the main program structure and the structure for all
ENTRY points. If anameis specified, the structure for that
ENTRY point displays.

LABELS

Generates a Tree View display of the structure of the program
using the paragraphs and section labels of the control flow
statements. LABEL Sisthe default.

STRUCture

Generates a Tree View display of the structure of the program
using control flow verbs (PERFORM, GO TO, ALTER, €tc.)
and program labels.
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CONDitional GeneratesaTree View display of the conditional statementsthat
surround control flow statements, plus the control flow
statements and labels.

PERF Generates a Tree View display of the perform range hierarchy
for the program.

LEVELsnumber Controls the amount of information displayed on entering Tree
View. Specify the number of nested control flow structuresto be
displayed. The default, 2, displays the two levels of nested
performs.

MAX Displaysthe maximum nesting level. However, if the maximum
nesting level consists of only repeated PERFORM ranges, then
the nested level istruncated to the next higher level that does not
consist exclusively of repeated PERFORM ranges.

REPetition Controls the display of duplicate perform ranges. If YESis
specified, all duplicate perform ranges display. If NOis
specified, duplicate perform ranges are only flagged as
REPEATED and are not expanded unlessyou type ZOOMIN for
the perform ranges. The default is NO.

Usage Notes
The Tree View screen can also be displayed by selecting View » Tree and pressing Enter.
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VIEW Command

X

View ogm

Function

The VIEW command is used to start a new Source View session for the specified
program while retaining the current session.

Operand Description

Blank Displays the AKR Program Selection pop-up for selection of a program.

Operands

pgm Specifies aprogram a Source View session isto be started for.

Usage Notes

When finished with the requested program, the END or GOBACK command returns to
the original session.
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ZOOMIN/ZOOMOUT Commands

ZOOMin | ZI

X

ZOOMOut | ZO >«

Function

Operands

Usage Notes

324

The ZOOMIN and ZOOMOUT commands are used to display or exclude source lines
according to the hierarchical levels of the program.

None. These commands are entered in the command input area with no operands and are
dependent on the cursor location.

ZOOMIN and ZOOMOUT are also available on the View pull-down. See the online help
for more information.

The ZOOMIN and ZOOMOUT commands show the structure of aprogram and provide a
means of stepping through each level or going directly into or out of a particular section
of source code. The ZI and ZO line commands can also be used to perform the ZOOMIN
and ZOOMOUT functions,

Program level hierarchy consists of the IDENTIFICATION DIVISION statement, the
PROGRAM-ID statement, and the END PROGRAM statement, if any. Thisis especially
useful in revealing the hierarchy of nested programs that is possible with COBOLI|
Release 3.

PROCEDURE DIVISION hierarchy consists of section labels, paragraph labels, and
paragraph code. DATA DIVISION hierarchy consists of sections, FDs, 01, or 77 levels,
and all definitions within an 01 level.

For example, begin by excluding all lines from the screen, then type ZOOMIN. The
program level information is shown including the program name and its last physical line.
For COBOLII Release 3 modules with sub-programs, this information shows for each of
the programs. Type ZOOMIN again. The PROGRAM-ID and END-PROG display first
then the DIVISION headings are shown. Type ZOOMIN in the command input area and
place the cursor on the PROCEDURE DIVISION statement, then press Enter. (Or, place
the cursor on the PROCEDURE DIVISION statement, then press PF07/19.) Al
PROCEDURE DIVISION headings display.
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To see the source within a particular heading, scroll to it and type ZOOMIN again. The
paragraph names display. Continue following this process to see the code and copy
statements within several paragraphs. Type ZOOMOUT on a paragraph name to exclude it
from the screen after it isviewed. All source lines under the paragraph name are excluded
from the screen.

These are the general guidelines for ZOOMIN:

- If the cursor is on an excluded block of lines, ZOOMIN displays the highest
structure level within that block of lines. If there are multiple statements at that
level, they also display.

- If ZOOMIN isissued repeatedly from the same cursor position, successive heading
levels display.

These are the general guidelines for ZOOMOUT:

=  Thecursor cannot be positioned on an excluded line when ZOOMOUT is entered.

- ZOOMOUT excludesthelevelsin alowest to highest order. If ZOOMOUT is
issued repeatedly from the same cursor location, successive heading levels are
excluded.

Line Commands

Line commands are entered over the line numbers in the prefix area on the screen. Line
commands are either single format or block format. Single format refersto aline
command being entered on an individual line. Figure 104 illustrates the line command to
exclude line 332.

Figure 104 « Single Format Line Command Example

000331 MOVE ZIP-CODE TO HLD-ZIP.
X00332 IF HLD-ZIP-PREFIX EQUAL CUR-PREFIX
000333 NEXT SENTENCE

A number can be included with some single format commands to indicate a specified
number of linesto be processed using the same command. Processing begins with theline
where the command is entered, and includes the current line and subsequent lines as
indicated by the number specified. If the specified number of lines exceeds the available
source lines, al remaining lines are processed. The maximum you can enter is 99999.
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Figure 105 illustrates the single format Exclude line command followed by a number to
exclude lines 332 through 336.

Figure 105+ Single Format Line Command with a Number Specified

000331 MOVE ZIP-CODE TO HLD-ZIP.

X50332 IF HLD-ZIP-PREFIX EQUAL CUR-PREFIX
000333 NEXT SENTENCE

000334 ELSE

000335 PERFORM P150-SUBTOT

000336 THRU P169-EXIT

000337 MOVE HLD-ZIP-PREFIX TO CUR-PREFIX

Block format refers to double character line commands entered on multiple lines. Block
line commands process for al lines between (and including) the lines containing the
commands. Figure 106 illustrates the block format Exclude Block command being used
to exclude lines 332-336.

Figure 106 « Block Format Line Command Example

000331 MOVE ZIP-CODE TO HLD-ZIP.

XX0332 IF HLD-ZIP-PREFIX EQUAL CUR-PREFIX
000333 NEXT SENTENCE

000334 ELSE

000335 PERFORM P150-SUBTOT

XX0336 THRU P169-EXIT

000337 MOVE HLD-ZIP-PREFIX TO CUR-PREFIX

Line commands can be removed by typing over them with spaces, pressing ERASE EOF
with the cursor at the beginning of the command, or by typing RESET in the command
input area.

Line commands can be ambiguous when entered. Figure 107 illustrates a common
ambiguity.

Figure 107 « Ambiguous Line Command Example

024500 MOVE ZIP-CODE TO HLD-ZIP.
X24600 IF HLD-ZIP-PREFIX EQUAL CUR-PREFIX
024700 NEXT SENTENCE

It isunclear whether two lines, 24 lines or 246 lines are to be excluded. If two lines are to
be excluded, one or more spaces should be entered following the X2. The ERASE EOF
key could be used to erase the numbers following the X2.
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F (First) Line Command

Fn
Function
The F (First) line command redisplays the specified number of excluded lines. These
lines redisplay starting with the first line in the block of excluded lines.
Operands

n. The number of excluded linesto redisplay. The default is 1. If the number specified is
greater than the number of excluded lines, al linesin the excluded block redisplay.

Usage Notes

The F (First) line command redisplays lines excluded as the result of any primary or line
command that excludes lines from the screen display.

Example

Figure 108 and Figure 109 illustrate the first two lines in the excluded block being
redisplayed.

Figure108« F (First) Line Command Example

000002 PROGRAM-1D. PRDEMO.
F2 - = = = = = = - = = 5 LINES NOT DISPLAYED
000008 INPUT-OUTPUT SECTION.

Figure109« F (First) Line Command Results

000002 PROGRAM-1D. PRDEMO.

000003  AUTHOR. WRITTEN BY ASG AT LANGLVL 2.

000004 ENVIRONMENT DIVISION.

- - - - - - 3 LINES NOT DISPLAYED

000008 INPUT-OUTPUT SECTION.
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H (Highlight) Line Command

HNn

Function

Operands

Usage Notes

Example

328

The H (Highlight) line command is used to highlight aline or group of lines.

n. The number of consecutive linesto highlight. The default is 1. If the number specified
is greater than the number of available lines, all remaining lines are highlighted.

The H (Highlight) line command is used to highlight a contiguous group of lines.

Figure 110 and Figure 111 illustrate the Highlight line command being used to highlight
three source code lines.

Figure110+« H (Highlight) Line Command Examples

H3 281 CALL "VIAIDEM1® USING MASTER-IN

000282 MASTER-END-OF-FILE
000283 MASTER-REPORT-DATE.
000284

000285 PERFORM P100-PRINT

000286 THRU P119-EXIT.

Figure111l+ H (Highlight) Line Command Results

000281 CALL "VIAIDEM1" USING MASTER-IN

000282 MASTER-END-OF-FILE
000283 MASTER-REPORT-DATE.
000284

000285 PERFORM P100-PRINT

000286 THRU P119-EXIT.
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HH (Highlight Block) Line Command

HH

Function
The HH (Highlight Block) line command is used to highlight a block of lines.

Operands
None.

Usage Notes

The HH (Highlight block) line command is entered in the prefix area on the first and last
line of the block to be highlighted.

Example

Figure 112 and Figure 113 illustrate the HH line command being used to highlight three
source code lines.

Figure112+« HH (Highlight Block) Line Command Example

HHO281 CALL "VIAIDEM1® USING MASTER-IN

000282 MASTER-END-OF-FILE
HHO283 MASTER-REPORT-DATE.
000284

000285 PERFORM P100-PRINT

000286 THRU P119-EXIT.

Figure 113+ HH (Highlight Block) Line Command Results

000281 CALL "VIAIDEM1" USING MASTER-IN

000282 MASTER-END-OF-FILE
000283 MASTER-REPORT-DATE.
000284

000285 PERFORM P100-PRINT

000286 THRU P119-EXIT.

329



ASG-Insight Reference Guide

J (Jump) Line Command

J
Function
The J (Jump) line command is used to return to the Source View screen at the location
corresponding to the line where this command isissued on the Tree View screen.
Operands

None.

Usage Notes

Enter the J (Jump) line command on the line that you want to return to.

Label Line Command

. label

Function
The Label line command is used to assign a name to a particular source line.

Operands

label. A period followed by 1 to 5 aphabetic characters to be used as the name for the
linewhereit is entered.

Usage Notes

Y ou can use the LOCATE primary command followed by alabel nameto scroll to the
labelled line.

Example

Figure 114 illustrates the .Iabel line command being used to label line 281 to EQL. Line
281 can be referenced with EQL aswell asline 281.

Figure114 « Label Line Command Example

.EQL81 CALL *VIAIDEM1® USING MASTER-IN

000282 MASTER-END-OF-FILE
000283 MASTER-REPORT-DATE.
000284

000285 PERFORM P100-PRINT

000286 THRU P119-EXIT.

000287
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L (Last) Line Command

Ln

Function

The L (Last) line command redisplays the specified number of excluded lines. These
lines redisplay starting with the last line in the block of excluded lines.

Operands

n. The number of excluded linesto redisplay. The default is 1. If the number specified is
greater than the number of excluded lines, al linesin the excluded block redisplay.

Usage Notes

TheL (Last) line command redisplays lines excluded as the result of any primary or line
command that excludes lines from the screen display.

Example

Figure 115 and Figure 116 illustrate the L line command being used to redisplay the last
two lines in the excluded block.

Figure115« L (Last) Line Command Example

000002 PROGRAM-1D. VIAIDEMO.
L2

- - - = - = - - - - 5 LINES NOT DISPLAYED
000008 INPUT-OUTPUT SECTION.

Figure116+ L (Last) Line Command Results

000002 PROGRAM-1D. VIAIDEMO.

- = = = = = = = = = = = = 3 LINES NOT DISPLAYED
000006 SOURCE-COMPUTER.  1BM-370.
000007 OBJECT-COMPUTER. 1BM-370.
000008 INPUT-OUTPUT SECTION.
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S (Show) Line Command

Sn

Function

Operands

Usage Notes

Example

332

The S (Show) line command is used to redisplay the specified number of excluded lines.
These lines redisplay starting with the first line in the excluded block.

n. The number of consecutive excluded lines to show. The default is 1. If the number
specified is greater than the number of excluded lines, al linesin the excluded block

redisplay.

The S (Show) line command redisplays lines excluded as the result of any primary or line
command that excludes lines from the screen display.

Figure 117 and Figure 118 illustrate the S line command being used to redisplay two
excluded source lines.

Figure117+ S(Show) Line Command Example

000002 PROGRAM-1D. VIAIDEMO.
S2 - - - - - - - - - - 5 LINES NOT DISPLAYED
000008 INPUT-OUTPUT SECTION.

Figure118+« S(Show) Line Command Results

000002 PROGRAM-1D. VIAIDEMO.

000003  AUTHOR. WRITTEN BY ASG AT LANGLVL 2.

000004 ENVIRONMENT DIVISION.

- - - - - - 3 LINES NOT DISPLAYED

000008 INPUT-OUTPUT SECTION.
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SS (Show Block) Line Command

SS

Function

Operands

Usage Notes

Example

The SS (Show block) line command is used to redisplay a block of excluded lines.

None.

The SS (Show block) line command is entered in the line command area on the first and

last line of the excluded blocks to be redisplayed.

Figure 119 and Figure 120 illustrate the SS line command being used to redisplay two

blocks of excluded lines.

Figure119+ SS(Show block) Line Command Example

000401 CA4H-TO-NUM.

SS0402 * MOVE COMP-4 (HALFWD) TO NUMERIC (UNSIGNED)

--- - - - - - - - - - - -4 LINES NOT DISPLAYED
000407 * MOVE COMP-4 (HALFWD) TO NUMERIC (SIGNED)

--=- - - - - - - - - - - -4 LINES NOT DISPLAYED
SS0412 C4H-TO-C1.

Figure 120« SS (Show Block) Line Command Results

000401 C4H-TO-NUM.
000402 * MOVE COMP-4 (HALFWD) TO NUMERIC (UNSIGNED)

000403 MOVE N-C4HALF  TO 77-NU.
000404 MOVE N-C4HALFS TO 77-NU.
000405 MOVE X-C4HALF  TO 77-NU.
000406 MOVE X-C4HALFS TO 77-NU.
000407 * MOVE COMP-4 (HALFWD) TO NUMERIC (SIGNED)
000408 MOVE N-C4HALF  TO 77-NUS.
000409 MOVE N-C4HALFS TO 77-NUS.
000410 MOVE X-C4HALF  TO 77-NUS.
000411 MOVE X-C4HALFS TO 77-NUS.

000412 C4H-TO-C1.
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X (Exclude) Line Command Function

Xn

Operands

Usage Notes

Example

334

The X (Exclude) line command is used to exclude aline or group of lines from being
displayed. Excluded lines display as arow of dashes with the number of excluded lines

indicated.

n. The number of consecutive linesto exclude. The default is 1. If the number specifiedis
greater than the number of available lines, all remaining lines are excluded.

Excluded lines display as arow of dashes with the number of excluded lines indicated.

Figure 121 and Figure 122 illustrate the X line command being used to exclude lines

332-336.

Figure121+« X (Exclude) Line Command Example

000331 MOVE ZIP-CODE TO HLD-ZIP.

X5 332 IF HLD-ZIP-PREFIX EQUAL CUR-PREFIX
000333 NEXT SENTENCE

000334 ELSE

000335 PERFORM P150-SUBTOT

000336 THRU P169-EXIT

000337 MOVE HLD-ZIP-PREFIX TO CUR-PREFIX

Figure122 « X (Exclude) Line Command Results

000331 MOVE ZIP-CODE TO HLD-ZIP.
--- - - - - - - - - - - -5 LINES NOT DISPLAYED
000337 MOVE HLD-ZIP-PREFIX TO CUR-PREFIX
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XX (Exclude Block) Line Command

XX

Function

Operands

Usage Notes

Example

The XX (Exclude Block) line command is used to exclude a block of lines from being
displayed. Excluded lines display as arow of dashes with the number of excluded lines

indicated.

None.

The XX (Exclude block) line command is entered in the line command area on the first

and last line of the block of lines to be excluded from being displayed.

Figure 123 and Figure 124 illustrate the XX line command being used to exclude a block

of fivelines.

Figure 123« XX (Exclude Block) Line Command Example

000331 MOVE ZIP-CODE TO HLD-ZIP.

XX0332 IF HLD-ZIP-PREFIX EQUAL CUR-PREFIX
000333 NEXT SENTENCE

000334 ELSE

000335 PERFORM P150-SUBTOT

XX0336 THRU P169-EXIT

000337 MOVE HLD-ZIP-PREFIX TO CUR-PREFIX

Figure 124 « XX (Exclude Block) Line Command Results

000331 MOVE ZIP-CODE TO HLD-ZIP.
--- - - - - - - - - - - - 5LINES NOT DISPLAYED
000337 MOVE HLD-ZIP-PREFIX TO CUR-PREFIX
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Zl (Zoom In) Line Command

A |

Function

Operands

Usage Notes

336

Tree View only

The ZI (Zoom in) line command is used to redisplay excluded source lines according to
the hierarchical levelsin the program. The ZI line command is used in conjunction with
the ZO (Zoom out) line command to show the structure of a program and provide a means
of stepping through each level or going directly into or out of a particular section of
source code.

None.

The ZI (Zoom in) line command is used to show the structure of a program.
PROCEDURE DIVISION hierarchy consists of section labels, paragraph labels, and
paragraph code. DATA DIVISION hierarchy consists of sections, FDs, 01, or 77 levels,
and all definitions within an 01 level.

If the ZI (Zoom in) line command is entered on an excluded block of lines, the highest
structure level within that block of lines displays. If there are multiple statements at that
level, they also display.

Note:

See"ZOOMIN/ZOOMOUT Commands' on page 324 for more information about
displaying and excluding source lines according to the hierarchical levels of the program.
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Z0O (Zoom Out) Line Command

Z0

Function

Operands

Usage Notes

Tree View only

The ZO (Zoom out) line command is used to redisplay a source lineinitsoriginal format
after aZoom line command is entered. The ZO (Zoom out) line command is used in
conjunction with the ZI (Zoom in) line command to show the structure of a program and
provide a means of stepping through each level or going directly into or out of a particular
section of source code. The ZI (Zoom in) and ZO (Zoom out) line commands are used to
display or exclude source lines according to the hierarchical levels of the program.

None.

The ZO (Zoom out) line command can only be entered on aline that displayed using the
Z1 (Zoom in) line command. See"ZOOMIN/ZOOMOUT Commands" on page 324 for
more information about displaying and excluding source lines according to the
hierarchical levels of the program.

The ZO (Zoom out) line command can also be used to remove lines that were displayed
in awindow on the screen, as the result of aZl (Zoom in) line command.
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1 1 Analyze

This chapter describes the analyze process and contains these sections:

Overview 339
Analyzing a COBOL Program 340
The Analyze Process 342
Automatic JCL Modifications 349
Analyze Summary Report 353
Analyze Options 355

Overview

A program must be analyzed before the ESW products can provide any information about
it. This chapter describes the methods used to analyze programs.

The analyze process gathers information about the program, including program
relationships, logic, data, and execution paths, and stores thisinformation in the AKR.
After the analyze information is placed in the AKR, it is available to ESW productsin
online and batch environments, where it is accessed to provide valuable information
about the design and operation of user systems.
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Analyzing a COBOL Program
_The analyze processis similar to aCOBOL compile. The process has these three primary
inputs:
- Source COBOL program (including copy books)
< JCL used to compile and link the COBOL program
=  Options and features that tailor the analyze steps

Analyze Input Descriptions

COBOL Source Program
The analyze process requires these basic program standards:

<  The COBOL language as specified in the IBM COBOL/370 Language Reference
Manual is accepted by the analyze job. It correctly processes any program that can
be compiled without warnings or errors by the IBM COBOL |1 compilers.

=  COBOL/370 programs that receive error (E), severe (S), or unrecoverable (U)
messages from the IBM compiler cannot be successfully analyzed.

This table contains the Program Analyzer resource estimates to process COBOL
programs of various sizes:

Source Virtual CPU Time AKR VIAUT2
. Memory XA Memory )
Lines Size Size MM:SS Blocks Cyls
1000 1060K 12100K 0:04 150
2000 1060K 12200K 0:10 300
5000 1060K 12500K 0:30 750
10000 1060K 12800K 1:00 1500 12
20000 1060K 14000K 2:00 3000 24
50000 1060K 16000K 5:00 6000 50

Thisinformation is the result of running Analyze under these criteria:

Version: Center R7.0
CPU Type: 3090-600 running MV S/ESA
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Disk Type: 3390
Analyze Parms: BUFMAXK=4096K
Compiler Parms: BUF=256K,SIZ=1024K

Compile/Link JCL

This JCL should be the complete JCL used to compile the program. Specifically, the JCL
should contain steps to fetch the source from the source manager (such as Librarian or
Panvalet), execute the preprocessor(s), invoke the compiler with the appropriate options
and COPY libraries, then, if applicable, invoke the linkage editor.

Analyze Features and Options

The analyze features indicate the type of analysis to be performed. An Encore analysis
provides the information required for code isolation and execution flow capabilities. A
SmartTest analysis provides the testing and debugging information required by
SmartTest. An Extended SmartTest analysis provides comprehensive program analyzing
capabilities in addition to the testing and debugging capabilities of a SmartTest analysis.
An Insight analysis provides logic and execution flow capabilities. A SmartDoc analysis
provides the information required for SmartDoc reports. A SmartDoc Extended analysis
provides data flow analysis.

Default options for the analyze process are established at installation time. Options that
are to be overridden are specified when submitting the analyze job.
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The Analyze Process

342

The analyze process consists of setting up and executing a batch job. There are three
methods used to invoke the analyze process. The method you used depends primarily on
the environment from where the analyze processis invoked, but may depend on the
access method containing the compile/link JCL. These are the three methods used to
invoke the analyze process:

Method Description

File- Andyze  Select File» Anayze action from the File pull-down, or type

Submit Pop-up  ANALYZE in any command input area, to display the Analyze Submit
pop-up. Type the required input and output information and submit
the job. See the online help for information about the File - Analyze
Submit pop-up.

| SPF From any |SPF screen, execute the VIASUBDS CLIST. To execute
this CLIST, type this command:

TSO VIASUBDS dsn parms
where:

dsn isaPDS member or sequential dataset containing the
compile JCL.

parms represents any of the available execution parameters
described in the VIASUBDS and VIASUB parameter tables.

ISPF/PDF Edit  Executethe VIASUB PDS edit macro. To execute this edit macro
type VIASUB parms, where parms represents any of the available
execution parameters described the VIASUBDS and VIASUB
parameter tables.

This table lists the methods for executing an analyze job and when to use each.

Compile JCL isFrom Method for Executing Analyze Job

PDS or sequential dataset Analyze Submit pop-up, VIASUBDSCLIST,
or VIASUB edit macro

Librarian, Panvalet, or other user source  VIASUB edit macro
manager when editing the JCL with
| SPF/PDF

Screen-driven submit facility that VIASUBDSCLIST
generates JCL
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Analyze Using ISPF

Y ou can use the VIASUBDS CLIST to submit the analyze job from any | SPF screen.
Thisisthe syntax for VIASUBDS:

TSO VIASUBDS input.jcl.dsn parms

where:

input. jcl.dsn isthe dataset containing the compile/link JCL. This dataset
must be a sequential dataset or amember of a PDS.

parms isone or more parameters that control the operation of VIASUBDS.
Typically, you enter the PANEL parameter to display the Analyze Submit
Parameters screen in order to enter any necessary parameters. The parameters are
saved in the |SPF profile and used as defaults for the next analyze submission. The
VIASUBDS and VIASUB Parameterstable contains alist of these parameters, with
default parameters underlined.

Note:

Using the VIASUBDS CLIST requiresthe ESW CLIST library to be available through
the standard SY SPROC allocations.

Analyze Using ISPF/PDF Edit

Y ou can use the VIASUB edit macro to submit the analyze job from the | SPF/PDF Edit
screen. Thisisthe syntax for VIASUB:

VIASUB parms

whereparms isone or more parameters that control the operation of VIASUB.
Typically, you enter the PANEL parameter to display the Analyze Submit Parameters
screen in order to enter any necessary parameters. The parameters are saved in the | SPF
profile and used as defaults for the next analyze submission. The VIASUBDS and
VIASUB Parameterstable contains alist of these parameters, with default parameters
underlined.
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Note:

Using the VIASUB edit macro requires the ESW CLIST library to be available through
the standard SY SPROC allocations.

AKR(XXXXX)

Indicates the AKR where the analyze job results are placed. The
specified name must conform to the standard TSO dataset naming
conventions.

AOPT (XXXXX)

Specifies the options to be supplied to the analyze job. The
COBOLII option is automatically added if the compiler you
specified in the input JCL is COBOL Il. When specifying more
than one analyze option, the options should be separated by
commas and enclosed in single quotes; for example,
AOPT('XMEM,RECUR,SUBSY S=D239'). See "Analyze
Options" on page 355 for information about each analyze option.

CMPL
NOCMPL

CMPL indicates that a COBOL compile and an analysisisto be
executed by the new JCL. NOCMPL indicates that the new JCL is
to bypass the compile step and only execute the analyze job. When
you specify NOCMPL, areturn code of 1000 (decimal) greater than
the analyze return codeis produced. This causesthe subsequent job
steps (e.g., alink edit) to be bypassed based on a successful
compilation. Y ou cannot specify NOCMPL if aSmartTest analysis
is being executed.

DSCHK
NODSCHK

DSCHK indicates that the datasets needed by the resulting JCL are
to be verified to ensure they exist. Specifically, the AKR and the
load library containing VIASMNTR are checked. When you
specify NODSCHK, the AKR and theload library need not exist at
thetime VIASUB or VIASUBDS is executed. NODSCHK is
useful when you are preparing the JCL for submission on another
system, or for delaying execution when an AKR does not yet exist.
Notice that the cataloged procedure libraries must exist and be
accessibleto VIASUBDS or VIASUB.

EDIT

EDIT specifies that the resulting JCL is not to be submitted for
batch processing. The PDF editor isinvoked for the resulting JCL.
Y ou can make any desired changes and submit the JCL by typing
SUBMIT. EDIT must be entered each timeit is needed. Notice that
the edits made to the JCL are not saved. To save the modified JCL
elsewhere, you must usethe CREATE command. The EDIT option
isignored if the Analyze Submit Parameters screen displays. Inthis
case, type E to edit the JCL.

INS|NOINS

INS specifies that an Insight analysisis to be performed.
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OUTPUT (xxxxx) Specifiesthat the resulting JCL is not to be submitted for batch

processing. The JCL iswritten to the specified dataset. The
specified name must conform to the standard TSO dataset naming
conventions. A dataset is created if it does not already exist.
OUTPUT must be entered each time it is needed.

PANEL PANEL indicates that the Analyze Submit Parameters screen isto
NOPANEL be displayed allowing you to enter parameters for the analyze job.
The Analyze Submit Parameters screen displaysevenif you specify
avalid AKR name as a parameter, or you can access it from the
| SPF profile when you specify PANEL.

PGM (XXXXX) Specifies aname to be used when storing the program in the AKR.
This name overrides the program name in the PROGRAM-1D
paragraph.

PROCONLY Indicatesthe JCL contains only acataloged procedure rather than a
complete job. PROCONLY suppresses the generation of the
VIAIN DD statement. Y ou must enter PROCONLY eachtimeitis
needed.

REUS REUS spfaci fiesthat when the program istested using SmartTest, it

NOREUS is dynamically loaded and tested with RUN NOMONITOR.

ENS | NOENS ENS specifies that an Encore analysisis to be performed.

SD | NOSD SD specifies that a SmartDoc analysisisto be performed.

SDR | NOSDR SDR specifies that SmartDoc reports are run.

SDX | NOSDX SDX specifies that a SmartDoc Extended analysisisto be
performed.

SQ |NOSQ SQ specifies that a SmartQuest analysis is to be performed.

ST |NOST ST specifiesthat a SmartTest analysisis to be performed.

STX |NOSTX STX specifiesthat an Extended SmartTest analysisisto be

performed. When you specify the INS and ST parameters, an
Extended SmartTest analysisis automatically performed.
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Analyze Submit Parameters Screen

Options

346

The Analyze Submit Parameters screen (Figure 125) displays when you specify the
PANEL parameter when executing VIASUBDS or VIASUB, or when you use the
NOPANEL option and an error condition is detected.

Figure 125+« Analyze Submit Parameters Screen

Command ===>

ASG-ESW - Prepare Program

E - Edit JCL S - Submit JCL D - Doc Options

Compile and link JCL (PDS or sequential):
"USER.TEST.CNTL(YOURJCL)"

Data set name

Analyze features (Y/N):

Understand: Y
Re-engineer:

AKR program name

Analyze options:

N Abend/Dump: N
AKR data set name "USER.TEST.AKR®"

Test: Y Extended Analysis: Y Document: N

(if overriding PROGRAM-1D)

Compile? (Y/N) . .

Link load module reusable? (Y/N) Y (Test only)

....... Y (Y if needed by features)

E - Edit JCL

Enables you to review or change the compile/analyze JCL, if
necessary. When you select the E option, the JCL to be edited is
generated from the JCL you specified when the VIASUBDS CLIST
or VIASUB edit macro was invoked, applying the rules outlined in
the Automatic JCL Modifications section. The generated JCL isthen
displayed on the Edit screen.

When you finish editing, type |SPF SUBMIT to submit the edited
JCL for execution. Optionally, you can save the edited JCL ina
partitioned dataset by using the ISPF CREATE command.
Otherwise, any changes made at this time are not saved.

S - Submit JCL

Submits the JCL to compile/analyze the specified program. The JCL
submitted is generated from the JCL you specified when the
VIASUBDS CLIST or VIASUB edit macro was invoked, applying
the rules outlined in the Automatic JCL M odifications section.

D - Doc Options

Displaysonly if SmartDoc isinstalled. Type D to display the
SmartDoc Options screen that is used to request an Extended
SmartDoc analysis and to specify what reports (if any) to generate.
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Analyze feature

Specifies the type of analysis. These are the valid analysis types:

Understand

Displaysonly if Insight isinstalled. This type of analysis provides
the logic and program execution flow capabilities of Insight. If
Insight is the only product installed, thisfield contains YES and
cannot be changed. The defaultisY.

Test

Displaysonly if SmartTestisinstalled. Y indicatesthat a SmartTest
compile/analysisisto be performed. Thistype of analysis provides
the testing and debugging information required by SmartTest. If
SmartTest isthe only product installed, thisfield contains YES and
cannot be changed. The default is Y.

Extended
Analysis

Displaysonly if SmartTest isinstaled. Thistype of analysis
provides comprehensive program analyzing capabilitiesin addition
to the testing and debugging capabilities of SmartTest. The default
isY.

Document

Displaysonly if SmartDoc isinstalled. Thistype of analysis
provides the report information generated by SmartDoc. If
SmartDoc isthe only product installed, thisfield contains YES and
cannot be changed. The default is N.

A SmartDoc Extended analysis is specified on the SmartDoc
Options screen.

Re-engineer

Displaysonly if Encoreisinstalled. Thistype of analysis provides
the logic and program execution flow capabilities of Encore. If
Encore is the only product installed, thisfield contains Y ES and
cannot be changed. The default is N.

Abend/Dump

Displays only if SmartQuest isinstalled. Thistype of analysislets
you analyze the source code to be used when diagnosing dumps.
The default isN.

AKR dataset name

Specifies the name of the AKR containing the analyzed program
information.
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AKR program
name

Specifies the alias name to be used by the analyze process to save
itsresultsin the AKR.

If you do not enter avalue in thisfield, the analyze job saves the
resultsin the AKR using the program name from the
PROGRAM-ID statement in the COBOL source.

If you enter an AKR program name, the analyzed program is saved
in the AKR as the entered name, and also as an dlias of the
PROGRAM-ID.

If aprogram contains ENTRY points, the analyzejob is also saved
in the AKR amember for each ENTRY point, with an aias of the
PROGRAM-ID.

Note:

Thisfield is only used for the AKR program name and does not
change the COBOL program name in the source.

Analyze options

Specifies the analyze options that are to be overridden. Default
options for the analyze job are established at installation time.
Analyze optionsthat can be entered in thisfield are described in the
Analyze Options appendix.

Compile?

A program does not need to be compiled if Insight, Encore, or
SmartDoc are the only features specified. The compile step can be
suppressed by typing N in thisfield. If you select SmartTest and/or
Extended analysis, thisfield isforced to avalueof Y.

Link load module

Tests a program under SmartTest that is dynamically loaded if it is

reusable? tested. It isnecessary to mark theload modul e asreusable so that the
Breakpoints are retained across calls. The default is Y
Display thispanel  Causes the | SPF profile to be updated to display this screen

by default in the
future?

whenever subsequent executions of VIASUBDS or VIASUB are
invoked. If you specify N, thisscreenisnot displayed on subsequent
executions of VIASUBDS or of VIASUB unless an error condition
is encountered.
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Automatic JCL Modifications

The analysis process automatically modifies the JCL based on the specified parameters
and analyze options. If problems arise, you can use this procedure as a checklist to
perform the analyze process manually until you determine and resolve the problem. You
can make changes to the JCL, the compile procedure, or to a copy of the compile
procedure.

To manually modify the JCL

1  Replace these PGM= parametersin the compile step(s):

PGM=IGY CRCTL PGM=VIACOBII
PGM=CPXUPTSM PGM=VIAOPT3
PGM=CAOTSMON PGM=VIAQOPTII

2  Add DD statements to the compile step(s) for these datasets:

//VIADCTOC DD SYSOUT=*
//VI1ADCRPT DD SYSOUT=*
//VIALOG DD SYSOUT=*
//VIAMRPT DD SYSOUT=*
//VIAPRINT DD SYSOUT=*
//V1AAKR DD DSN=[specified AKR name],DISP=SHR

3 If the SYSIN DD statement contains FREE=CL OSE, change it to FREE=END.

4 Ensurethat the ESW load libraries are available to the modified step by adding a
/ISTEPLIB DD statement specifying the ESW load libraries, or by concatenating
these libraries to an existing STEPLIB DD.

5 Ensure that the JOB and the modified STEP EXEC statements have a minimum of
REGION=4096K .

6  AddaVIAIN DD statement that designates the features and options to be used
during analysis. Thisisthe format:

//VIAIN DD *

* ANALYZE FEATURES:
INS,ST,STX,SD,SDX, SDR

/*
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Y ou can also preform this step manually by modifying the COBOL parameter
string to include the appropriate ESW parameter, for example:

VPARM=(vopt,vopt,vopt...)

where vopt can be:

EN An Encore analysis (no COBOL compile)

INS An Insight only analysis (no COBOL compile)

SD A SmartDoc analysis

SDR A SmartDoc report generation

SDX A SmartDoc Extended analysis

SQ A SmartQuest analysis

ST A SmartTest only analysis (no Extended analysis)

STX A SmartTest Extended analysis

[analyze parms] Vaid analyze parameters (using the standard analyze
options)

CMPL A COBOL compile (forcesa COBOL compile and an
analysis to be executed by the JCL)

NOCMPL Suppress the COBOL compile (JCL bypasses the compile

and executes only an analyze job)

(NO)SY SPRINT

Create separate compiler output file

(NO)VIADCOMP

Create SmartDoc intermediate compiler output file. The
intermediate compiler output fileis used to produce the
SmartDoc Compiler Output.

DPARM

SmartDoc run-time parameters.

Note:

If no ESW feature is specified (i.e., INS, ST, STX, SD, SDX, SDR, or ENS), al
processing is suppressed. This means the procedure executes a compile asit did

before.




11 Analyze

Figure 126 shows the compile/analyze JCL before submitting the analyze job.

Figure 126 « Compile/Analyze JCL Before Modifications

// ASG JOB (ASG), "PANVALET COMPILE*

/*ROUTE PRINT DEST

//* PANVALET EXTRACT

//*

//PANEXT EXEC PGM=PAN#1,REGION=256K

//PANDD1 DD DSN=ASG.COBOL.PANLIB,DISP=SHR

//PANDD2 DD DSN=&&COBIN,UNIT=SYSDA,SPACE=(CYL,(1,1)),

// DISP=(NEW,PASS) ,DCB=(RECFM=FB, LRECL=80,BLKS1ZE=3120)
//SYSPRINT DD SYSOUT=*

//SYSIN DD *

++WRITE WORK,VIASDDMO

/*

/7*

//* COBOL COMPILE

/7*

//COBCOMP EXEC PGM=IGYCRCTL ,REGION=1024K,COND=(8,LT,PANEXT),
// PARM="S1ZE=512K,BUF=128K,LANGLVL(2),L1B,DYNAM*
//STEPLIB DD DSN=SYS1.COBOL.COMPILER,DISP=SHR

//SYSIN DD DSN=&&COBIN,DISP=(OLD,DELETE)

//SYSLIB DD DSN=ASG.VIACOBII.COPYLIB,DISP=SHR

//SYSLIN DD DSN=&&LINKIN,UNIT=SYSDA,SPACE=(CYL, (1,1)),

1/ DISP=(NEW,PASS) ,DCB=(RECFM=FB, LRECL=80,BLKS1ZE=3120)
//SYSPRINT DD SYSOUT=*,DCB=(RECFM=FBA,LRECL=121,BLKSIZE=1573)
//SYSUTL DD UNIT=SYSDA,SPACE=(CYL, (1,1))

//SYSUT2 DD UNIT=SYSDA,SPACE=(CYL, (1,1))

//SYSUT3 DD UNIT=SYSDA,SPACE=(CYL, (1,1))

//5YSUT4 DD UNIT=SYSDA,SPACE=(CYL, (1,1))

//SYSUT5 DD UNIT=SYSDA,SPACE=(CYL, (1,1))

/7%

/7% LINK EDIT

/7%

//LINKED  EXEC PGM=IEWL,REGION=1024K,COND=(8,LT,COBCOMP)
//SYSLIB DD DSN=SYS1.VIACOBII.COBLIB,DISP=SHR

//SYSLMOD DD DSN=ASG.BAR.LOAD,DISP=0LD

//SYSPRINT DD SYSOUT=*,DCB=(RECFM=FBA,LRECL=121,BLKSIZE=1573)
//SYSUTL DD UNIT=SYSDA,SPACE=(CYL, (1,1))

//SYSLIN DD DSN=&LINKIN,DISP=(OLD,DELETE)

V74 DD *
NAME VIASDDMO(R)
/*

351



ASG-Insight Reference Guide

352

Figure 127 isan example of the compile JCL illustrated in the previousfigure, asit would
appear after the compile/analyze JCL is generated according to the rulesin this section.
Added or modified statements are tagged to the right with ASG NEW and ASG MOD.

Figure 127« Compile/Analyze JCL After Modifications

// ASG JOB (ASG), "PANVALET COMPILE*
/*ROUTE PRINT DEST

//
//*

//* THIS JCL HAS BEEN MODIFIED BY THE ASG ANALYZE
//* SUBMIT FACILITY, WHICH CONVERTS COMPILE JCL INTO
//* COMPILE AND ANALYZE JCL. NEW OR MODIFIED LINES
"ASG" IN COLUMNS 74 THROUGH 76.

//* CONTAIN

* o+ % ¢ F X

//*

//

//*

//*

//* PANVALET EXTRACT

//*

//PANEXT EXEC PGM=PAN#1,REGION=256K

//PANDD1 DD DSN=ASG.COBOL.PANLIB,DISP=SHR

//PANDD2 DD DSN=&&COBIN,UNIT=SYSDA,SPACE=(CYL,(1,1)),

// DISP=(NEW,PASS) ,DCB=(RECFM=FB, LRECL=80,BLKSI1ZE=3120)
//SYSPRINT DD SYSOUT=*

//SYSIN DD *

++WRITE WORK,VIASDDMO

/*

//*

//* COBOL COMPILE

//*

//COBCOMP EXEC PGM=VIACOBI I ,REGION=4096K,COND=(8,LT,PANEXT),
// PARM="S1ZE=512K,BUF=128K,LANGLVL(2),LIB,DYNAM*
//STEPLIB DD DSN=SYS1.COBOLII.COMPILER,DISP=SHR

// DD DSN=ASG.VIACENxx.LOADLIB,DISP=SHR

//SYSIN DD DSN=&&COBIN,DISP=(OLD,DELETE)

//SYSLIB DD DSN=ASG.COBOL.COPYLIB,DISP=SHR

//SYSLIN DD DSN=&&L INKIN,UNIT=SYSDA,SPACE=(CYL, (1,1)),

// DISP=(NEW,PASS) ,DCB=(RECFM=FB, LRECL=80,BLKSI1ZE=3120)
//SYSPRINT DD SYSOUT=*,DCB=(RECFM=FBA,LRECL=121,BLKS1ZE=1573)
//SYSUT1 DD UNIT=SYSDA,SPACE=(CYL, (1,1))

//SYSUT2 DD UNIT=SYSDA,SPACE=(CYL, (1,1))

//SYSUT3 DD UNIT=SYSDA,SPACE=(CYL, (1,1))

//SYSUT4 DD UNIT=SYSDA,SPACE=(CYL, (1,1))

//SYSUT5 DD UNIT=SYSDA,SPACE=(CYL,(1,1))

//VIADCTOC DD SYSOUT=*

//VIADCRPT DD SYSOUT=*

//VIALOG DD SYSOUT=*

//VIAMRPT DD SYSOUT=*

//VIAPRINT DD SYSOUT=*

//VIAAKR DD DSN=ASG.VIACENxx.AKR,DISP=SHR

//VIAIN DD *

* ANALYZE FEATURES
INS,ST,STX,SD,SDX, SDR,RNS

/*
//*

//* LINK EDIT

/7*
//LINKED
//SYSLIB
//SYSLMOD

EXEC PGM=IEWL ,REGION=1024K,COND=(8,LT,COBCOMP)

DD
DD

DSN=SYS1.VIACOBII .COBLIB,DISP=SHR
DSN=ASG.BAR.LOAD,DISP=0LD

ASG
ASG
ASG
ASG
ASG
ASG
ASG
ASG

ASG

ASG

ASG

ASG
ASG
ASG
ASG
ASG
ASG
ASG
ASG
ASG

NEW
NEW
NEW
NEW
NEW
NEW
NEW
NEW

MOD

NEW

MOD

NEW
NEW
NEW
NEW
NEW
NEW
NEW
NEW
NEW



//SYSPRINT DD SYSOUT=*,DCB=(RECFM=FBA,LRECL=121,BLKS1ZE=1573)

//SYSUT1 DD UNIT=SYSDA,SPACE=(CYL, (1,1))
//SYSLIN DD DSN=&LINKIN,DISP=(OLD,DELETE)

// DD *
NAME VIARDEMO(R)
/*

Analyze Summary Report

11 Analyze

Information about the analyzed program is placed in the AKR when the analyze job
completes. A summary report of the run-time statistics and diagnostic messages is also
produced. This report varies depending on whether you specified the SOURCE or

NOSOURCE option when the analyze job was submitted.

Figure 128 illustrates the Analyze Summary Report with the SOURCE option used. The

information shown on this summary is described below.

Figure 128« Analyze Summary Report I ncluding SmartDoc with Compile

(GQY)
00001 000100 IDENTIFICATION DIVISION. 00010000
00002 000200 PROGRAM-ID.  VIASDDMO. 00020000
00003 000300 AUTHOR. WRITTEN BY ASG IN LANG LEVEL 2. 00030000
000400* 00040000
00005 000500 ENVIRONMENT DIVISION. 00050000
00006 000600 INPUT-OUTPUT SECTION. 00060000
00007 000700 FILE-CONTROL. 00070000
00008 000800  SELECT INFILE1 ASSIGN TO UT-S-INFILEL. 00080000
00009 000900  SELECT INFILE2 ASSIGN TO UT-S-INFILE2. 00090000
00010 001000  SELECT INFILE3 ASSIGN TO UT-S-INFILE3. 00100000
*STATISTICS* SOURCE RECORDS = 466 DATA DIVISION STATEMENTS = 120
PROCEDURE

DIVISION STATEMENTS = 220
*OPTIONS IN EFFECT* SIZE = 1048576, BUF = 262144, LINECNT = 54, SPACE1,

FLAGW, SEQ

*OPTIONS IN EFFECT* SOURCE, DMAP, PMAP, NOCLIST, SUPMAP, NOXREF, NOSXREF,

LOAD, NODECK

*OPTIONS IN EFFECT* APOST, NOTRUNC, NOFLOW, NOTERM, NONUM, NOBATCH, NONAME,

COMPILE=0

*OPTIONS IN EFFECT* NOSTATE, RESIDENT, DYNAM, LIB, NOSYNTAX, NOOPTIMIZE,

NOSYMDMP

*OPTIONS IN EFFECT* NOTEST, VERB, ZWB, SYST, NOENDJOB, NOMIGR, NOLVL, DUMP,

NOADV

*OPTIONS IN EFFECT* NOLST, NOFDECK, NOCDECK, LCOL1, L120, NOFDECK, NOCDECK,

LCOL1

*OPTIONS IN EFFECT* L120, DUMP, NOADV, NOPRINT, NOCOUNT, NOVBSUM, NOVBREF,

LANGLVL(1)
®

ASG15341 PROGRAM VIASCOPR STARTED

ASG15191 PROGRAM VIASCOPR COMPLETED WITH RETURN CODE 0000
ASG15341 PROGRAM IGYCRCTL STARTED

ASG15191 PROGRAM IGYCRCTL COMPLETED WITH RETURN CODE 0000
ASG15341 PROGRAM VIASSYMB STARTED

ASG15191 PROGRAM VIASSYMB COMPLETED WITH RETURN CODE 0000
ASG15341 PROGRAM VIASANLZ STARTED
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ASG15191 PROGRAM VIASANLZ COMPLETED WITH RETURN CODE 0000

ASG15341 PROGRAM VIADBTCH STARTED

ASG15191 PROGRAM VIADBTCH COMPLETED WITH RETURN CODE 0000

ASG10251 THE PRODUCT LEVEL FOR ASG-CENTER-OS(XA) R4.0 1S 000.

ASG14351 ASG-CENTER-OS(XA) R4 .0 LVLOOO -SUMMARY REPORT- PROGRAM=V IASDDMO
ASG13991 OPTIONS IN EFFECT ARE: SOURCE, NODMAP, NOPMAP.

ASG13941 SUMMARY OF COBOL SYMBOLS EXTRACTED FROM VIASDDMO.

ASG13951 98 DATA NAME SYMBOLS PROCESSED.

ASG13961 33 PROCEDURE SYMBOLS PROCESSED.

ASG13971 131 TOTAL SYMBOLS.

ASG1398I 199 VERBS PROCESSED.

ASG14361 DIAGNOSTICS: O TOTAL - O WARNING, O ERROR, O SEVERE, O CATASTROPHE
ASG14371 ASG-CENTER-OS(XA) R4.0 LVLOOO - END OF SYMBOL EXTRACT ION FOR VIASDDMO

©
ASG-CENTER-OS(XA) R4.0 LVLOOO PROGRAM: VIASDDMO DD-MMM-YYYY HH:MM:SS
PAGE 1

®

LINE ERROR MESSAGE

ASG02371 131 SYMBOLS PROCESSED.
ASG02381 131 SYMBOLS MATCHED.
ASG02401 199 VERBS PROCESSED.
®
DIAGNOSTICS LINES: O TOTAL - O WARNINGS, O CONDITIONALS, O ERRORS, O DISASTERS
(@]
SOURCE LINES: 466 TOTAL - 120 DATA DIVISION STATEMENTS, 220 PROCEDURE
DIVISION STATEMENTS
©)
PARAMETERS PASSED: NOCOBOLII,LANGLVL(1),FEATURES=(I,S,X)
Q)]
OPTIONS IN EFFECT: BUFMAXK=2000K, FEATURES=(INSIGHT,SMARTTEST,EXTENDED),
FLAG(W) ,
LINECNT=60, NORECUR, NOSEQ, NOSOURCE, SPACE1, LANGLVL(1),

(O]

ENTRY POINTS: VIASDDMO
Q)

EXTERNAL CALLS:  VIASUB
()

END OF PROCESSING: DD-MMM-YYYY HH:MM:SS
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These are the analyze options highlighted in Figure 128 on page 353.

(A)

A complete listing of the program is produced and shows statement
numbers generated by the analyze job in the first six columns. These
numbers are referenced in diagnostic messages. These notations can also
appear on the source listing:

C Statement was inserted with a COPY statement.
** QOriginal source statement number is out of sequence.
|  Statement was inserted with an INSERT statement.

(B)

This portion of the Analyze Summary is the report from the ESW monitor
facility. The job steps that were executed by the monitor facility are listed
along with the return codes produced.

(®)

The Center (Analyze) release and product level is shown along with the
date and time the analysis was performed.

(D)

LINE and ERROR MESSAGE - Thisinformation is shown only if there
were error conditions encountered. If so, this arealists the line number
where the error occurred and the error message.

(E)

DIAGNOSTICS LINES - Indicates the total number of messages issued
with subtotals for each type.

(F)

SOURCE LINES - Indicates the number of source linesin the program.
The number of statementswithinthe DATA DIVISION and PROCEDURE
DIVISION are also shown. Each level number is counted as one statement
inthe DATA DIVISION. Each verb is counted as one statement in the
PROCEDURE DIVISION.

(G)

PARAMETERS PASSED - Lists al of the analyze options specified for
this analyze job.

(H)

OPTIONS IN EFFECT - Listsall optionsin effect, including default and
user-specified options.

(1)

ENTRY POINTS - Lists the entry pointsin this program.

Q)

EXTERNAL CALLS- Liststhe programs that this program CALLS.

(K)

END OF PROCESSING - Liststhe day, month, year, and time the analyze
job completed. This date and time is also reflected in the online AKR
statistics.
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The analyze job uses many of the same options as the IBM COBOL |1 compilers. These
compile-time options are available to control the output format and to describe COBOL
options. Default options are established when Insight isinstalled. To override the
installation options, type the desired options on the Analyze Submit pop-up. If you enter
an invalid option, the analyze job ignoresit. If you enter a valid option more than once,
the last one is processed.

Options that accept program names as parameters, with the exception of PROGRAM,
accept special characters to signify generic names. The asterisk (*) represents one or
more characters. The question mark (?) represents a single character. For example:

DBA* Accepts all programs that begin with DBA and end with any other
characters.

D?A* Accepts all programs that begin with D followed by any character,
followed by A, then followed by any other characters.

DBA??? Accepts all programs that begin with DBA and end with any three
characters.

This table summarizes the analyze options. In this summary, the abbreviations are shown
in uppercase (abbreviations comply with compiler standards). These defaults reflect the
information about the installation tape. The Analyze Summary Report printed at the end
of each analyze job lists the actual optionsin effect, and the options that were passed to it
(the override options).

BUF(nnnnnK) BUF isused only asan override. Insight dynamically

_ allocates the amount of main storage to buffers and
BUF=nnnnnK internal tables. If an override is necessary, the
minimum BUF value is 20K; the maximum BUF
value is 20000K.

COBOLII COBOLII and COB2R3 override the LANGLVL

COB2R3 option and processestheinput program as COBOL 1.

COBOL370

COBMVSVM

COBOS390

ENTCOB31

NOCOBOLII

DB2LIB=xXXXXXX . XXXXX . XX DB2LIB specifiesthe dataset name of theload library

XXXX that is used to invoke the DB2 pre-processor at your
site.
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DB2PL AN=XXXXXXXX

DB2PLAN specifies the ESW application plan that
was created at installation time by the VIASBIND
job. You can use DB2PLAN to override the default
plan name.

DY Ncall
NODY Ncall

The minimum abbreviationisDYN or NODY N.

DYNCALL specifies whether Insight functions use
the variable name in dynamic calls as the name of the
called program. If NODYNCALL is specified,
dynamic calls are not processed by the analyze and
information for themis not availableto ESW product
functions. The default isDYNCALL.

For example, the analyze process for this code
proceeds differently, depending on whether
DYNCALL is specified:

77 MYPROG PIC X(8).
CALL MYPROG USING PARM1, PARM2.

Inthisexample, if DYNCALL isineffect, theanalyze
process assumes that the program being called is
MY PROG, regardless of the data value that

MY PROG contains at run-time. The analyze process
looksup theanalysisresultsof MYPROG inthe AKR
to determine whether PARM 1 and PARM2 are used
or modified.

If NODYNCALL isin effect for this example, the
analyze process assumes that the program being
called could be anything, and treats both PARM 1 and
PARM2 as used and modified on the call statement.

Note:

The DYNCALL option isunrelated to the COBOL
compiler option DY NAM.
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FLAGW
fLAGE
FLAG(X)

FLAG specifiesthe types of messagesto belisted for
the analyze job. FLAGW indicates all warning and
diagnostic messages are listed. FLAGE indicates
diagnostic messages are listed; all other messages are
suppressed. FLAG(X) indicates all messages of the
specified level or above arelisted. These arethevalid
message levels:

- | - Informational

- W-Warning

- E - Error

- S- Severe

- U - Unrecoverable

Note:

Some informational messages are produced
regardless of the flag setting.

Input(x, X, - - -X)

I nput=x

NOInput(x, X, - - -X)
NOInput=x

INPUT liststhe CALLed programs that contain
INPUT statements. When commands that search for
INPUT are issued, statements that CALL these
programs are shown in the command results. The
specified programs are in addition to those specified
at installation time.

NOINPUT overrides the installation default list of
CALLed programs that contain INPUT statements.
The specified programs are del eted from the default
list.

10(X, X, - --X)
10=x
NOIO

10O liststhe CALLed programs that contain INPUT
and OUTPUT statements. When commands that
search for INPUT and OUTPUT are issued,
statementsthat CALL these programs are shown in
the command results. The specified programs arein
addition to those specified at installation time.

NOIO overrides the install ation default list of
CALLed programsthat containINPUT and OUTPUT
statements. The specified programs are deleted from
the default list.
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LANGLVL(1[2)

LANGLVL specifieswhether to usethe 1968 or 1974
American National Standard COBOL definitions
when analyzing source elements with meanings that
have changed. LANGLVL (1) indicates the 1968
standard isto be used; LANGLVL(2) indicates the
1974 standard (X 3.23-1974) isto be used. The default
iISLANGLVL(2).

lineCNT=60

LINECNT indicates the number of linesto be printed
on each page of the source listing. Thisvalue must be
110 99. The default value is 60.

MAIN

MAIN is used only as an override. The EXIT
PROGRAM statementsin COBOL programs are
treated as GOBACKs by the analyze job. Thisis
because the program is treated asa CALLed
subprogram. If the program is the main program,
using the MAIN option treatsthe EXIT program asa
fallthrough.

MBRERCNT=4000

Specifies the maximum number of analysis errors
allowed for amember during the analyze job. If this
number of errorsis exceeded, the analyze terminates
processing for that member. The number specified
must be between 1 and 4000. The default is set at
installation.

Output(X, X, - - -X)
Output=x

OUTPUT liststhe CALLed programs that contain
OUTPUT statements. When commands that search
for OUTPUT areissued, statementsthat CALL these
programs are shown in the command results. The
specified programs are in addition to those specified
at installation time.

NOOutput(x, X, - - -X)

NOOUTPUT overrides the installation default list of
CALLed programsthat contain OUTPUT statements.

NOOutput=x The specified programs are deleted from the default
list.
PROgram(XxXXxXXXXXXX) Analyzed programs are stored in the AKR and

PGM=XXXXXXXXXX

identified by the program name coded in the
PROGRAM-ID statement. PROGRAM is used to
override the name coded in the PROGRAM-1D
statement. The specified name can be from oneto ten
charactersin length.
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RECur
NORECur

RECUR specifieswhether the recursion report should
be included in the Analyze Summary Report. If you
specify RECUR and no recursion isfound, amessage
isissued that indicates no recursion was detected. If
RECUR is specified and recursion is found, a
messageisissued and the recursive codeis printed on
the report. The default is NORECUR.

RETurn(x,X, - - -X)
RETurn=x

RETURN overrides the installation list of programs
or entry pointsthat do not return when CALLed. You
override the system defaults by listing the desired
programs or entry points that are to return when
CALLed.

NORETurn(x, X, - -
NORETurn=x

NORETURN lists the additional programs or entry
pointsthat are not to return when CALL ed. When any
of these programs are CAL L ed by the program being
analyzed, they are treated as non-returning CALLS.
The specified programs are in addition to the system
defaults for programs that do not return when
CALLed.

SEQ
NOSEQ

SEQ specifieswhether the analyze job isto check the
source modul e statement number sequence. A
warning messageisprintedif the statementsarenotin
sequence. If the SOURCE option is specified, aflag
(**) is placed between the analyze job sequence
numbers and the source sequence numbers. The
default is SEQ.

SOUrce
NOSOUrce

SOURCE specifies whether the source programisto
be listed. The SOURCE option is specified if afull
program listing isdesired at analyze time. The default
isNOSOURCE.

SPACE1L[2]3

SPACE specifies the spacing for the source listing
that is generated when you use the SOURCE option.
SPACE2 causes one blank line to be placed between
every source line. SPACE3 causes two blank linesto
be placed between every sourceline. Singlespacing is
the default.

SQLID=nnnnnnnn

SQLID(nnnnnnnn, nnnnnnn

N, nNNNNNNn)

SQLID specifiesthe authorization ID or owner name
(amaximum of 8 characters) that is used by the
analyze process to qualify unqualified table and view
references in your program.
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Option Description

SUBSY S=xxxX SUBSY S specifies the name of the subsystem or
location that designates the DBM S where the tables
accessed by a specified program are stored. SUBSY S
overrides the name provided at installation time.

XLIVE XLIVEisused only asan override and should only be
used with programsthat contain 'live' exits. Live exits
areexitsfrom perform rangesthat areleft dangling by
imbedded PERFORMSs or GO TOs in the original
performed paragraph. If you do not use XLIVE, code
that isunprocessed because of thelive exit isignored.
If you use XLIVE, unprocessed code is saved.

Using XLIVE can significantly increase resource
usage.

XMEM XMEM isused only as an override. If aprogramis
extremely large (i.e., 30,000 source lines) and thereis
insufficient memory, increase the region space. If
thereis still insufficient memory, type XMEM. This
resultsin more disk 1/0 and additional CPU usage,
but less memory consumption.
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12 AKR Utilities

This chapter describes AKRs and contains these sections:

Introduction to AKR Management 363
AKR Structure 364
Online AKR Utilities 364
Batch AKR Utilities 365
Command Format 367
Command Syntax 367
Batch AKR Reports 377
Allocating and Expanding AKRs without |SPF 379

Introduction to AKR Management

The AKR istherepository for all information used by ESW family of components.
Analyzed programs are stored in the AKR. Y ou can define asingle AKR for use by all
ESW users, or define separate AKRs for use by departments, groups, or individual users.

ESW provides both online and batch utilities for managing the AKR. This chapter
describes the online AKR utilities (see "Online AKR Utilities' on page 364) and the
batch AKR utilities (see "Batch AKR Utilities' on page 365).

363



ASG-Insight Reference Guide

AKR Structure

The AKR isaBDAM or VSAM file organization. Y ou can define an AKR to be shared
by al users, or define multiple AKRs for use by departments, groups, or individuals.

Note:

See the ASG-Center Installation Guide for additional information about the Application
Knowledge Repository.

Online AKR Utilities

364

These are the online AKR utilities:

- File - AKR Utility pop-up that is used to rename or delete a program, or to display
the AKR Directory.

- File - AKR Directory pop-up that is used to view all programsin an AKR. This
pop-up can be used to rename or delete a group of programs. Statistics about the
AKR are aso shown on this pop-up.

- File - AKR Allocate/Expand pop-up that is used to allocate a new AKR or to
expand an existing AKR.

Note:

When you use the Allocate/Expand utility, the default AKR organization typeis applied.
For example, if your site'sdefault AKR type is sequential, any new AKR you alocateis
created as a sequential file, and any non-sequential AKR you expand is reorganized as a
sequential file.
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Batch AKR Utilities

The Batch AKR Utility is used to maintain the AKR without using ISPF. Thistable lists
the commands available in the batch utility:

Command Function

CONVERT Converts selected members from a previous ESW product
release level to the current release level.

COoPY Copies selected members from one AKR to another.
DELETE Deletes selected members from the AKR.
EXPORT Creates metrics and function point CDF files.

Note:

EXPORT is available only to Recap users.

HELP Prints the AKR Utility Help Report.

INIT Formats a previously-defined dataset into an AKR format.

MOVE Copies selected members from one AKR to another and deletes
them from the original AKR.

PRINT Prints AKR directory information or COBOL source listings for
selected AKR members.

PUNCH Produces afile that contains the AKR directory information or

the COBOL source code for selected AKR members.
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Job Control Statements

The Batch AKR Utility uses the JCL statements shown in Figure 129. The VIAAKRIN
and VIAAKROT DD statements describe AKRs that are used for AKR Utility
processing. The VIASY SIN DD control cards consist of the necessary Batch AKR
commands (see "Command Format" on page 367 for more information). See each
command description to determine the affected DD statements.

Figure 129« Batch AKR JCL Statements

//UTILITY EXEC PGM=VIASAKRU,REGION=3000K, PARM=""
//STEPLIB DD DISP=SHR,DSN=(ASG load library)
//VIAAKRIN DD  DISP=SHR,DSN=(Input AKR)
//VIAAKROT DD DISP=SHR,DSN=(Output AKR)
//VIAPRINT DD SYSOUT=A (Print file description)
//VIAPUNCH DD  SYSOUT=B (Punch file description)
//VIALOG DD  SYSOUT=A (Log file)

//VIASYSIN DD *

<control cards>

//

Control Cards

366

Commands are passed to the Batch AKR Utility with the control cards following the
VIASY SIN DD statement. Control cards must conform to these standards:

<  Command information must be contained in columns 1 through 72 of the control
card.

=  Only one command can be entered on each control card.

«  Only one control card may be used per command.

All control cards with command disposition and command summaries are printed to the
VIALOG AKR Utility Log file. Blank control cards are ignored.
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Command Format

Commands that use member names accept specia characters to signify generic names.
An asterisk (*) represents zero or more characters. A question mark (?) represents one
character. For example:

Example Description

DBA* Specifies all members that begin with DBA and end with any other
characters.
D?A* Specifies all members that begin with D followed by one character,

followed by an A, then followed by any other characters.

DBA??? Specifies all members that begin with DBA and end with any three
characters.

The LASTUSED parameter is used to provide the selection criteriafor several
commands. The specified number represents the number of days since the member was
last referenced online or the date the member was analyzed if it has not been referenced.

The REPLACE parameter is used to specify that members are to be replaced on the

output AKR. The NOREPLACE parameter is used to prevent members from being
replaced on the output AKR. NOREPLACE isthe default value.

Command Syntax

Each Batch AKR Utility command is described in this section. The descriptions include
the format and a brief explanation of the command parameters.

Item Description

ABBREViations Illustrates the command abbreviation, which isshownin uppercase
letters. Lowercase lettersin the command are optional .

lowercase Indicates user-supplied variable information.

UPPERCASE Indicates commands or keywords.

Bold Indicates operandsthat are available only if Insight isinstalled and
alnsight analysis has been run on the COBOL program being
tested.

Underline Specifies the default value of an operand.
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Item Description

| Separates synonymous commands or operands.

s Indicates that the command syntax is continued on the next line.

Indicates the command syntax is continued from the previous line.

9—
Indicates the end of the command syntax.
requi Indicates that the operand or keyword appearing on the main
—— required — bl .
command lineis required.
choicel —— Indicates that one operand is required.
hoice2 j
choice3

Contional] Indicates that an operand or keyword appearing below the main
optiona command lineis optional.

: Indicates that operands are optional.
I:chomel—

choice2—

— Indicates that more than one operand can be chosen.

I:choicel—
choice2—!

A — Indicates that operands can be concatenated by placing aplussign

(+) between them.
I:choicel—
choice2—
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Batch AKR Comments

\é
A

LcommentJ

Function
Includes a comment with the commands.

Operands
comment. Indicates user-supplied text.

Usage Notes
Blank control cards are ignored.

CONVERT Batch AKR Command

Y
A

Convert ~ —member
LASTUsed > nbrdays uOTINPIac_e;‘

LASTUsed < nbrdays INPlace
LASTUsed = nbrdays

LASTUsed <> nbrdays

Function

Converts selected members that were analyzed by a prior release of ESW productsto the
current release level.

Command Description

member Specifies a specific or generic name as described in "Command
Format" on page 367.

Operands

LASTUsed Selects members based on the number of days since they were last
used, as described in "Command Format" on page 367.

NOTINPlace Specifies that a member with the same name on the receiving AKR
should be replaced with the member from the sending AKR.

INPlace Specifies that amember isto be converted and kept withinthe AKR
named in the VIAAKRIN DD statement. This option should be used
with caution. Consult your systems programmer or ASG Customer
Support.

369



ASG-Insight Reference Guide

Usage Notes

Members are copied from the AKR specified in the VIAAKRIN DD statement to the
AKR specified in the VIAAKROT DD statement, as described in "Job Control
Statements' on page 366.

COPY Batch AKR Command

Copy —member <
LASTUsed > nbrdays HOREPIace:‘

LASTUsed < nbrdays REPlace
LASTUsed = nbrdays

LASTUsed <> nbrdays

Function
Copies selected members from one AKR to another.

Command Description

member Specifies a specific or generic name as described in "Command
Format" on page 367.

Operands

LASTUsed Selects members based on the number of days since they were
last used, as described in "Command Format" on page 367.

NOTINPlace Specifies that a member with the same name on the receiving
AKR should be replaced with the member from the sending
AKR.

REPlace Replaces members that have the same name on the receiving
AKR.

Usage Notes

Members are copied from the AKR specified in the VIAAKRIN DD statement to the
AKR specified in the VIAAKROT DD statement.

When you use the Allocate/Expand utility, the default AKR organization typeis applied.
For example, if your site's default AKR typeis sequential, any new AKR you allocate is
created as a sequential file, and any non-sequential AKR you expand is reorganized as a
sequential file.
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DELETE Batch AKR Command

Y
A

DELete —member
LASTUsed > nbrday
LASTUsed < nbrday
LASTUsed = nbrday
LASTUsed <> nbrday:
Function

Erases salected members from the AKR.

Operand Description

member Can be a specific or generic name as described in "Command
Format" on page 367.

Operands

LASTUsed Used to select members based on the number of days since they
were last used, as described in "Command Format" on page 367.

Usage Notes

Members are deleted from the AKR specified in the VIAAKRIN DD statement.

Y ou cannot delete members that begin with VIA by using this command. All ESW test
members begin with VIA. If these members must be deleted, use the online AKR Utility
function described in "Online AKR Utilities' on page 364.
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EXPORT Batch AKR Command

Y
A

EXPort —application
FPA

Function
Creates metrics and function point CDF files.

Operand Description

Operands

application Isaspecific or generic nameasdescribed in " Command Format”
on page 367.

FPA Generates only function point information. If FPA is not
specified, both metrics and function point information are
generated.

Usage Notes

EXPORT isavailable only for Recap users.

HELP Batch AKR Command

Y
A

HELP | 2

Function
Prints a description of the Batch AKR Utility and the commands that can be used.

Operands
None.

Usage Notes
A question mark (?) can be used as an alternate command.
The HEL P command has no operands.

The Help Report is printed to the SY SOUT specified in the VIAPRINT DD statement.
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INIT Batch AKR Command

INIT

Function

Operand

Usage Notes

DSname

A
A

(dsname)

Initializesanew AKR. Thisinternal command is used by the online AKR Utility
Allocation function. See "Online AKR Utilities* on page 364 for additional information.

DSname(dsname). Specifies the dataset name for the new AKR.

Y ou must create the AKR dataset before you initidize it. The AKR that isinitialized can
be described in the VIAAKRIN DD statement. The VIAAKRIN DD statement isignored
if you specify the DSNAME parameter.

MOVE Batch AKR Command

MOve —member .
LASTUsed > nbrdays mbce:‘
LASTUsed < nbrdays REPlace
LASTUsed = nbrdays
LASTUsed <> nbrdays
Function

Operands

Moves selected members from one AKR to another. Specified members are copied to the
receiving AKR and erased from the sending AKR.

Command Description

member Specifies a specific or generic name as described in "Command
Format" on page 367.

LASTUsed Selects members based on the number of days since they were
|ast used, as described in "Command Format" on page 367.
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Command Description

NOTINPlace Specifies that a member with the same name on the receiving
AKR should be replaced with the member from the sending
AKR.

REPlace Replaces members that have the same name on the receiving
AKR.

Usage Notes

Members are moved from the AKR specified in the VIAAKRIN DD statement to the
AKR specified in the VIAAKROT DD statement.

PRINT Batch AKR Command

\
A

PRint

DIRectory:
member LASTUsed > nbrdays

ber LASTUsed < nbrdays
— ] mem
PROgram LASTUsed = nbrdays
LASTUsed <> nbrdays

Function

Prints AKR directory information for the entire AKR, for a specified member, or the
source code for a specified member.

Operand Description

Blank If the PRINT batch AKR command is entered with no operand,
the AKR directory information is printed.

Operands

DIRectory Prints AKR directory information. Thisisthe default. If a
member is specified, the AKR directory information for that
member only is printed.

PROgram Prints the COBOL source for the specified AKR member. The
generated COBOL source listing contains expansions of all
COPYBOOKs and/or INCLUDEsS, as well as the results of any
source preprocessors such as CICS macro expansion.
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Operand Description

member Specifies a specific or generic name as described in "Command
Format" on page 367.

LASTUsed Used to select amember based on the number of dayssinceit was
last used, as described in "Command Format" on page 367.

Usage Notes

Directory information or COBOL source is extracted from the AKR specified in the
VIAAKRIN DD statement and is printed to the SY SOUT specifiedinthe VIAPRINT DD
statement.

See "AKR Utility Directory Report" on page 378 for more information.

PUNCH Batch AKR Command

PUNch

A
A

DIRectory-
member LASTUsed > nbrdays

member LASTUsed < nbrdays
L 1
PROgram LASTUsed = nbrdays
LASTUsed <> nbrdays

Function

Produces afile that contains AKR directory information for the entire AKR, a specified
member, or the source code for a specified member.

Operand Description

Blank If you enter the PRINT batch AKR command with no operand,
the AKR directory information is printed.

Operands.

DIRectory Prints AKR directory information. Thisis the default. If you
specify amember, the AKR directory information for that
member only is printed.

PROgram Prints the COBOL source for the specified AKR member. The
generated COBOL source listing contains expansions of all
COPYBOOKs and/or INCLUDEsS, as well as the results of any
source preprocessors such as CICS macro expansion.
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Usage Notes

376

Operand Description

member Can be a specific or generic name as described in "Command
Format" on page 367.

LASTUsed Used to select amember based on the number of dayssinceit was
last used, as described in "Command Format" on page 367.

Directory information or COBOL source is extracted from the AKR specified in the
VIAAKRIN DD statement and is written to the file specified in the VIAPUNCH DD
statement. Thefilethat is produced isin standard IBM IEBUPDTE Utility format. ADD
control cards are produced for each logical entity. The NAME parameter contains the
member name for COBOL source. The NAME parameter contains AKRDIRnnN for
directory information, where nn is a consecutively assigned number.

See the "Punch Directory Fil€" on page 378 for more information.

Thistable showsthe format of thefile produced by the PUNCH DIRECTORY command.

Description Length Format

Member name 10 Character
Number of source lines 6 Right justified
Days since last used 4 Right justified
Analyze date 9 DDMMMYYYY
Analyze job name 8 Character
Analyze CPU 4 Character
Analyze product level 8 Character

Last reference date 9 DDMMMYYYY
Last reference user ID 8 Character

Last reference CPU 4 Character
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Batch AKR Reports

Examples of the reports listed below are provided in this section.
< AKRUtility Log (see Figure 130).
< AKR Utility Directory Report (see Figure 131 on page 378).

«  File produced by the PUNCH DIRECTORY command (see Figure 132 on page
378).

AKR Utility Log

The VIALOG AKR Utility Log provides asummary of the commandsissued to the Batch
AKR Utility. Thislog contains:

- Comments

<  Commands

=  Completion messages

- Short summary of commands processed

The heading includes the ESW product level information, and the date and time the job

was executed. Comments are enclosed in a box comprised of asterisks. The second page
contains the log summary. Figure 130 illustrates the AKR Utility Log.

Figure 130+ AKR Utility Log

ASG-CENTER-0S Rx.x LVLnnn AKR UTILITY LOG DDMMMYYYY HH:MM:SS Page 1
00140000

* PRODUCE A REPORT CONTAINING DIRECTORY INFORMATION FOR ALL * 00150000

*  MEMBERS OF ASG.RENAISSA.AKR (VIAAKRIN) THAT HAVE * 00160000

*  NOT BEEN REFERENCED IN THE LAST 7 DAYS. * 00170000
00180000

* 00190000

PRINT DIRECTORY * LASTUSE > 7 00200000

ASG12891 8 DIRECTORY ENTRIES SUCCESSFULLY PRINTED.

00210000
00220000
* PRODUCE A FILE CONTAINING DIRECTORY INFORMATION FOR ALL * 00230000
*  MEMBERS OF ASG.RENAISSA.AKR (VIAAKRIN) THAT HAVE * 00240000
*  NOT BEEN REFERENCED IN THE LAST 7 DAYS. * 00250000
00260000
* 00270000
PUNCH DIRECTORY * LASTUSE > 7 00280000
ASG12901 8 DIRECTORY ENTRIES SUCCESSFULLY PUNCHED.
ASG13141 *** END OF VIASYSIN ***
ASG-CENTER-0S Rx.x LVLnnn AKR UTILITY LOG - SUMMARY DDMMMYYYY HH:MM:SS Page2
ASG13011 8 DIRECTORY ENTRIES PRINTED 0 FAILED.
ASG13021 8 DIRECTORY ENTRIES PUNCHED O FAILED.

ASG13151 *** END OF SUMMARY REPORT ***
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AKR Utility Directory Report

The AKR Utility Directory report lists the results of a PRINT DIRECTORY command
and iswritten to the VIAPRINT DD file. Thetitle line contains the ESW product level
information, title, date and time the job was executed. The report lists the AKR dataset
used, the command used to produce the report, and the directory information for the
selected members. Figure 131 illustrates the AKR Utility Directory Report.

Figure 131+ AKR Utility Directory Report

ASG-CENTER-0S Rx.x LVLnnn AKR UTILITY - DIRECTORY DDMMMYYYY HH:MM:SS Page 1

AKR: ASG.VIACENxx.AKR
Command: PRINT DIRECTORY * LASTUSE > 7

Member Last --—-——————————————- Analyzed ---—-——————————— —————- Last Referenced--
Name Lines Use Date Time Job CPU Level Date Time Job  CPU

ACTGO018 40 16 DDMMMYYYY HH:MM:SS VIASOFTA CPUA INO30000 DDMMMYYYY HH:MM:SS VIASOFT CPUA
PYRLOO85 17 16 DDMMMYYYY HH:MM:SS VIASOFTA CPUA INO30000 DDMMMYYYY HH:MM:SS VIASOFT CPUA
PYRLO105 17 8 DDMMMYYYY HH:MM:SS VIASOFTA CPUA INO30000
SROOO5A 493 8 DDMMMYYYY HH:MM:SS VIASOFTA CPUC INO30000
W550044 66 12 DDMMMYYYY HH:MM:SS VIASOFTA CPUC INO30000 DDMMMYYYY HH:MM:SS VIASOFT CPUA
XRSCLO70 1714 12 DDMMMYYYY HH:MM:SS VIASOFTA CPUA INO30000 DDMMMYYYY HH:MM:SS VIASOFT CPUA
XRSCL100 15 9 DDMMMYYYY HH:MM:SS VIASOFTA CPUC INO30000
XRSCL200 41 10 DDMMMYYYY HH:MM:SS VIASOFTA CPUC INO30000 DDMMMYYYY HH:MM:SS VIASOFT CPUA

*** End of Directory Report ***

Punch Directory File

378

The Punch Directory is written to the VIAPUNCH DD file when the PUNCH
DIRECTORY command is processed. Thefileisformatted in standard IBM IEBUPDTE
Utility format. Thefirst card, /ADD..., isan IEBUPDTE control card that indicates these
cards are to be added to a partitioned dataset specified in the NAME parameter. The cards
that follow arein the format described in the PUNCH DIRECTORY command

description. The last card isan IEBUPDTE control card that indicates the end of the
control cards. Seethe"PUNCH Batch AKR Command" on page 375 for the format of the
AKR Punch Directory File (described in "Punch Directory File" on page 378). Figure 132

illustrates the Punch Directory File.

Figure 132+« AKR Punch Directory File

./ ADD NAME=AKRDIR1,LIST=ALL

ACTG0018 40 16DDMMMYYYYSRENFKKACPUAINO30000DDMMMYYYYVIASOFT CPUA
PYRLO085 17 16DDMMMYYYYSRENFKKACPUAINO30000DDMMMYYYYVIASOFT CPUA
PYRLO105 17 8DDMMMYYYYSRENDEMACPUAINO30000

SRO005A 493 8DDMMMYYYYSRENJDRACPUC INO30000

W55004 66 12DDMMMYYYYSRENFKKACPUCINO30000DDMMMYYYYVIASOFT CPUA
XRSCLO70 1714 12DDMMMYYYYSRENDEMACPUAINO30000DDMMMYYYYVIASOFT CPUA
XRSCL100 15 9DDMMMYYYYSRENFKKZCPUCINO30000

XRSCL200 41  10DDMMMYYYYVIASOFTZCPUCINO30000DDMMMYYYYVIASOFT CPUA
./ ENDUP
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Allocating and Expanding AKRs without ISPF

The Batch AKR Utility can allocate and expand VSAM AKRs without using | SPF.
Existing Systems Workbench providesthe VIASAKRA JCL to allocate an AKR, and the
VIASAKRX JCL to expand an AKR. Figure 133 is an example of the VIASAKRA JCL
and Figure 134 on page 380 is an example of the VIASAKRX JCL.

Figure 133« VIASAKRA JCL for aVSAM AKR

//ASG JOB (), "ALLOC/INIT AKR"
/*ROUTE PRINT XXXXXXX . XXXXXX
/7*
/7*
//*  * ASG, INC. ASG-CENTER RX.x MMM, YYYY *
//* * *
//* * JCL PROCEDURE TO ALLOCATE AND INITIALIZE AN ASG *
//* * APPLICATION KNOWLEDGE REPOSITORY (AKR) *
/7*
/7*
//VIASIDAP PROC SYSOUT="*", PRINTED OUTPUT MESSAGE CLASS
// VIASOFT="ASG",  HIGH LEVEL NODE FOR ASG DATA SETS
// CENTER="VIACENxx" MIDDLE NODE FOR ASG DATA SETS
/7*
/7*
//* * DEFINE A NEW ASG AKR FILE *
/7*
/7*
//DEFAKR EXEC PGM=1DCAMS,REGION=512K
//SYSPRINT DD SYSOUT=&SYSOUT
//SYSOUT DD SYSOUT=&SYSOUT
//SYSIN DD DDNAME=SYSIN

/7*
/7*
//* * INITIALIZE THE NEWLY ALLOCATED AKR FILE *
/7*
/7*
//INITAKR EXEC PGM=V IASAKRU , REGI0N=2048K , COND=(0,LT,DEFAKR)
//STEPLIB DD DSN=&ASG..&CENTER..LOADLIB,DISP=SHR
//VIASYSIN DD DDNAME=SYSIN

//VIALOG DD SYSOUT=&SYSOUT

//SYSUDUMP DD SYSOUT=&SYSOUT

/7*
/7*
//* * DELETE NEW AKR (ONLY IF INITAKR FAILS) *
/7*
/7*
//DELETE EXEC PGM=IDCAMS,REGION=512K,

// COND=(EVEN, (0,LT,DEFAKR), (0,EQ, INITAKR))
//SYSPRINT DD SYSOUT=&SYSOUT

//SYSOUT DD SYSOUT=&SYSOUT

//SYSIN DD DDNAME=SYSIN

/7*

// PEND

//*

//VIASAKRA EXEC VIASIDAP
/7*

//DEFAKR.SYSIN DD *
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DEFINE CLUSTER -

(NAME(XX) - XX AKR NAME HERE **
XX(XX) - XX ALLOC UNITS AND QUANTITY HERE **
VOLUME(SRT801) -
CONTROL INTERVALS I ZE(4096) -
NUMBERED -
RECORDS IZE (4089 4089) -
RECOVERY -
ERASE -
UNIQUE -
SHAREOPTIONS(3 3)) -
DATA -
(NAME(XX.DATA)) XX AKR NAME HERE **
/7%
//7INITAKR.VIASYSIN DD *
INIT DSNAME(XX) XX AKR NAME HERE **
/7%
//DELETE.SYSIN DD *
DELETE XX XX AKR NAME HERE **
/7%

To allocate an AKR, replace XX inthe NAME(XX), NAME(XX.DATA), and the
DSNAME(XX) parameters with the name of the AKR to be allocated. Then replace
XX(XX) with the alocation units values and quantities for your site.

Figure 134« VIASAKRX JCL for aVSAM AKR

//ASG JOB ( ), "EXPAND AKR*®

//* INSERT "/*ROUTE PRINT NODE.USER®" HERE IF NEEDED.
//*
//*
//* * ASG, INC. ASG-CENTER Rx.x MMM, YYYY *
//* * *

//* * JCL PROCEDURE TO EXPAND AN EXISTING ASG *
//* * APPLICATION KNOWLEDGE REPOSITORY (AKR) . *
//*
//*
//VIASAKXP PROC SYSOUT="*", PRINTED OUTPUT MESSAGE CLASS
// VIASOFT="ASG", HIGH LEVEL NODE FOR ASG DATA SETS
// CENTER="VIACENxx" MIDDLE NODE FOR ASG DATA SETS
/7*
//*
//* * DEFINE A NEW DATA SET *
/7*
//7*
//DEFAKR EXEC PGM=I1DCAMS,REGION=512K
//SYSPRINT DD SYSOUT=&SYSOUT
//SYSOUT DD SYSOUT=&SYSOUT
//SYSIN DD DDNAME=SYSIN

/7*
//*
//7* * INITIALIZE NEW DATA SET AS ASG AKR *
/7*
//*
//INITAKR EXEC PGM=VIASAKRU,REGION=2048K,COND=(0,LT)
//STEPLIB DD DSN=&ASG. .&CENTER. .LOADLIB,DISP=SHR
//VIASYSIN DD DDNAME=SYSIN

//VIALOG DD SYSOUT=&SYSOUT

//SYSUDUMP DD SYSOUT=&SYSOUT

//7*




/7*
//* * COPY OLD AKR TO NEW AKR *
/7*
/7*
//REPRO EXEC PGM=1DCAMS,REGION=512K,COND=(0,LT)
//SYSPRINT DD SYSOUT=&SYSOUT

//SYSOUT DD SYSOUT=&SYSOUT

//SYSIN DD DDNAME=SYSIN

/7*
/7*
//* * UPDATE INTERNAL SIZE OF ASG AKR *
/7*
/7*
//RESIZE EXEC PGM=VIASAKRU,REGION=2048K,COND=(0,LT)
//STEPLIB DD DSN=&ASG. .&CENTER. .LOADLIB,DISP=SHR
//VIASYSIN DD DDNAME=SYSIN

//VIALOG DD SYSOUT=&SYSOUT

//SYSUDUMP DD SYSOUT=&SYSOUT

/7*
/7*
//* * DELETE OLD AKR AND RENAME NEW AKR TO  *
/7 * OLD AKR NAME *
/7*
/7*
//RENAME EXEC PGM=1DCAMS ,REGION=512K,COND=(0,LT)
//SYSPRINT DD SYSOUT=&SYSOUT

//SYSOUT DD SYSOUT=&SYSOUT

//SYSIN DD DDNAME=SYSIN

//*
//7*
//* * RUN THIS STEP ONLY IF ALL ABOVE STEPS *
//* *  RUN SUCCESSFULLY *
/7*
/7*
//TESTCODE EXEC PGM=1EFBR14,COND=(0,LT)
//SYSIN DD DDNAME=SYSIN

/7*
//*
//* * DELETE OLD AKR AND RENAME NEW AKR TO  *
//* * OLD AKR NAME *
//*
/7*
//RENAME EXEC PGM=IDCAMS,REGION=512K,COND=(0,LT)
//SYSPRINT DD SYSOUT=&SYSOUT

//SYSOUT DD SYSOUT=&SYSOUT

//SYSIN DD DDNAME=SYSIN

//*
/7*
//* * RUN THIS STEP ONLY IF ALL ABOVE STEPS *
//* *  RUN SUCCESSFULLY *
/7*
/7*
//TESTCODE EXEC PGM=1EFBR14,COND=(0,LT)
//SYSIN DD DDNAME=SYSIN

/7*

12 AKR Utilities
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/7%

//* * DELETE NEW AKR ONLY IF EXPAND IS NOT  *

//* *  SUCCESSFUL *

/7%

/7%

//DELETE EXEC PGM=1DCAMS,REGION=512K,

V74 COND=(EVEN, (0,LT,DEFAKR), (0,EQ, TESTCODE))

//SYSPRINT DD SYSOUT=&SYSOUT
//SYSOUT DD SYSOUT=&SYSOUT
//SYSIN DD DDNAME=SYSIN

//*

// PEND

/7*

//VIASAKRX EXEC VIASAKXP
/7*

//DEFAKR.SYSIN DD *
DEFINE CLUSTER -

(NAME (ASG . VIACENXX . AKR . EX) /* AKR NAME */ -
RECORDS(6000)  /* NEW ALLOC UNITS AND QUANTITY */ -
VOLUME (XXXXXX) /* AKR VOLSER */ -
CONTROL INTERVALS I1ZE(4096) -
NUMBERED -
RECORDS 1 ZE (4089 4089) -
RECOVERY -
UNIQUE -
SHAREOPTIONS(3 3)) -
DATA -
(NAME (ASG . VIACENXX . AKR . EX_DATA)) /* AKR NAME **
/7%
//INITAKR_VIASYSIN DD *
INIT DSNAME (ASG . VIACENXX . AKR .EX) /* AKR NAME **
/17*
/7*
//REPRO.SYSIN DD *
REPRO INDATASET(ASG.VIACENXx . AKR) /* AKR NAME */ -
OUTDATASET(ASG. VIACENXX . AKR .EX) /* AKR NAME */ -
REPLACE
/17*
/77*
//RESIZE .VIASYSIN DD *
RES1ZE DSNAME(ASG . VIACENXX . AKR .EX) /* AKR NAME **
/7*
/7%
//RENAME .SYSIN DD *
DELETE ASG.VIACENXX.AKR /** AKR NAME HERE **/
ALTER  ASG.VIACENXX.AKR.EX /* AKR NAME */ -
NEWNAME (ASG . VIACENXX . AKR) /* AKR NAME */
ALTER ASG.VIACENXX.AKR._EX.DATA /* AKR NAME */ -
NEWNAME (ASG . VIACENXX . AKR . DATA) /% AKR NAME */
/17*
/77*
//DELETE.SYSIN DD *
DELETE ASG.VIACENXX.AKR.EX /* AKR NAME HERE */
/7*
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To expand an AKR

1 Replace XX inthe NAME(XX.EX), NAME(XX.EX.DATA), DSNAME(XX.EX),
INDATASET (XX), and the OUTDATASET(XX.EX) parameters with the name of
the AKR to be expanded.

2 Replace XX(XX) with the alocation units values and quantities for your site.

Torename an AKR

1 Replace the XX in the DELETE statement with the AKR to be renamed.

2 Typethe new AKR namein the NEWNAME(XX) parameter.
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13 Paragraph Control Transfer Methods

The Paragraph Cross Reference pop-up shows how control istransferred to or from the
target paragraphs. Thistable lists how control is transferred.

Abbreviations

COBOL Transfer M ethods

ALTERED GOTO ALTERED, AG
CALL INTERNAL CLL INT, CI
CALL RETURN CLL RTN, CR
FALLTHRU FALL, F
GOTO G

GOTO DEPENDING GODEP, GD
PERFORM PERF, P
PROGRAM ENTRY ENTRY
PROGRAM EXIT EXIT

RETURN RET, R
UNKNOWN UNKN, ?

USE BEFORE RPT USE REPORT, U
USE FOR DEBUG USE DEBUG, U

USE ON ERROR

USE ERROR, U
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Abbreviations

CICSHandle Strings

ABEND ABND, ABN
ANYKEY ANYK, AK
CBIDERR CBIDE, CB
CCERROR CCERR, CC
CLEAR CLR, CL
CLRPARTN CLRP, CLP
DISABLED DISA, DI
DSIDERR DSIDE, DS
DSSTAT DSST, DT
DUPKEY DUPK, DK
DUPREC DUPR, DR
ENDDATA ENDD, ED
ENDFILE ENDF, EF
ENDINPT ENDI, El
ENQBUSY ENQB, EB
ENTER ENT, ET
ENVDEFERR ENVDE, EV
EOC EC

EODS ES

EOF EF

ERROR ERR, ER
EXPIRED EXPIR, EX
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M ethod Abbreviations

FUNCERR FUNCE, FE
IGREQCD IGQCD, ICD
IGREQID IGQID, ID
ILLOGIC ILLOG, IL
INBFMH INBF, IB
INVERRTERM INVERRT, IT
INVLDC INVL, ILD
INVMPSZ INVM, IM
INVPARTN INVP, IP
INVPARTNSET INVPART, IS
INVREQ INVR, IR
INVTSREQ INVTS, IT
IOERR IOE, IE
ISCINVREQ ISCIR, IR
ITEMERR ITEME, ITE
JDERR JDE, JD
LENGERR LENGE, LE
LIGHTPEN LPEN, LPN
MAPERROR MAPE, MPE
MAPFAIL MAPF, MPF
NAMEERROR NAMEE, NME
NOJBUFSP NOJIBSP, NJB

NONVAL NONV, NV
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M ethod Abbreviations

NOPASSBKRD NOPASSB, NPB
NOPASSBKWR NOPASSBW, NPW
NOSPACE NOSA, NSA
NOSPOOL NOSP, NSP
NOSTART NOST, NST
NOSTG NSTG, NTG
NOTALLOC NALLC, NAL
NOTAUTH NAUTH, NAH
NOTFND NFND, NFD
NOTOPEN NOPEN, NOP
OPENERR OPENE, OPE
OVERFLOW OVRFLW, OVF
OPERID OPEI, OP|

PA1 Al 1

PA2 A2, 2

PA3 A3, 3
PARTNFAIL PARTNF, PNF
PF1 F1

PF2 F2

PF3 F3

PF4 F4

PF5 F5

PF6 F6
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M ethod Abbreviations

PF7 F7
PF8 F8

PF9 F9

PF10 F10

PF11 F11

PF12 F12

PF13 F13

PF14 F14

PF15 F15

PF16 F16

PF17 F17

PF18 F18

PF19 F19

PF20 F20

PF21 F21

PF22 F22

PF23 F23

PF24 F24
PGMIDERR PGMIDE, PDE
QBUSY QBSY, QB
QIDERR QIDE, QID
QZERO QZRO, QZ
RDATT RDAT, RDT
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M ethod Abbreviations

RETPAGE RETP, RTP
ROLLEDBACK ROBACK, RBK
RTEFAIL RTEF, RTF
RTESOME RTES, RTS
SELNERR SELNE, SNE
SESSBUSY SESSB, SSB
SESSIONERR SESSIONE, SSE
SIGNAL SIGNL, SGL
SUPPRESSED SUPPRESS, SPS
SYSBUSY SYSB, SYB
SYSIDERR SYSIDE, SID
TERMERR TERME, TME
TERMIDERR TERMIDE, TID
TRANSIDERR TRANSIDE, TS
TRIGGER TRIG, TRG
TSIOERR TSIOE, TIO
UNEXPIN UNEXP, UNP
USERIDERR USERIDE, UID
WRBRK WBRK, WBK
WRONGSTAT WRONGS, WST
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Abbreviations

SQL WHENEVER Statements

SQLCONTINUE SQLCONT, SQC
SQLWARNING SQLWARN, SQW
SQLERROR SQLE, SQE
SQLNOTFOUND SQLNF, SON
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14 Help Facility

This chapter describes Insight Help options and contains these sections:

Help Navigational Commands 395
Screen and Pop-up Help 396
Command Help 397
General Information 399
Specific Information 399
Help Abends 400
Help Messages 401

Alliance provides a comprehensive and context sensitive Help facility, including an
online Help Tutorial, to answer most questions online. The Help Tutorial contains help
information on topics such as pull-downs, screens, pop-ups, commands, messages and
abends. The Help Tutorial aso includes a Table of Contents that lists general information
topics, and a comprehensive Index for viewing specific information.
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Y ou can access online help using these methods:

=  Select Help on the action bar to display the help pull-down and press Enter.

- Press PFO1/PF13 on any Insight screen.

e  TypeHELP.

=  Typeaquestion mark (?) in the command input area on any screen or pop-up and

press Enter.

Thistable lists the Insight online help information, and the means of accessing them.

Screen and pop-up

Request help for the current screen or pop-up by selecting the

help Current screen action on the Help pull-down, by typing HELP,
or by pressing PF01/13. No messages can appear on the screen
or pop-up at the same time as when you' re requesting help.

Command help Request help for acommand by typing the command in the

command input area and pressing PF01/13, typing HELP
COMMANDS, typing HEL P plusthe command name, sel ecting
All Commands on the Help pull-down, or by selecting Help »
specific Command.

General information

Request general help information by selecting the Help » Table
of contents or by typing TOC from within the Help Tutorial.

Specific information

Request help for specific topics by selecting Help » Index,
selecting option 6 on the Help Table of Contents or by typing
INDEX from within the Help Tutoria. View help for a specific
topic by selecting the appropriate index entry.

Abends

Request help for ESW user abends by selecting the Common
abends action on the Help pull-down or by typing HELP
ABENDS. The Help Tutorial Abends screen displays. Select
topic 2 on this screen to display the ESW Abend Codes screen,
that lists all the ESW user abends, and explanations for each
abend.

Messages

Display help for a current message by selecting the current
message action on the Help pull-down. Request help for a short
message, displayed in the upper right corner of the screen, by
typing HELP or pressing PF01/13. The corresponding long
message displays. Display help for a specific message by
selecting Help » Specific message, or by typing HELP msg#.
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Help Navigational Commands

All online help topics listed in the previous table are contained in the Help Tutoria. To
reach an online help topic from anywhere within the Help Tutorial, go through the Help
Table of Contents or Index. Insight provides commands for navigating the Help Tutorial.
These commands are listed below.

Command Purpose

BACK Redisplays the previous Help Tutorial screen.

END Exitsthe Help Tutorial.

ENTER key Displays the next screen in a continuation series.
INDEX Displays the first screen of the Help Index.

SKIP Goes directly to the next subject.

TOC Displays the Help Table of Contents.

UP Displays the next higher-level subject.

Alpha character On an Index screen, entering an a phabetic character

displays the Index screen corresponding to that character.
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Screen and Pop-up Help
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The Help Tutorial for each screen and pop-up describes all the options available on that
screen or pop-up, lists descriptions of al the fields, and notes any special processing

considerations.

To request Help for the current screen or pop-up, follow this step:

» Select Help » Current screen, type HELP or HELP SCREEN, or press PF1/13 with no
messages appearing on the screen. Figure 135 illustrates the Help Tutorial for the

Options - Product Allocations pop-up.

Figure 135+ Screen and Pop-up Help Example

ASG-Insight RX.X ----- Options - Product Allocations -------—-—-————————- HELP
===>

The Options - Product Allocations pop-up is used to specify the allocation
parameters for the Log, List, Punch, and Work files. This pop-up is
displayed by selecting the Allocation... action on the Options pull-down, or
by entering the ALLOCDEF command on any screen.

Note: Management Class, Storage Class, and Data Class provide various
parameters for newly allocated data sets. These parameters apply only
if you have SMS active at your site. Your system administrator
determines the valid entries for these parameters.

The Storage Class and Volume serial parameters are mutually exclusive.
Field Descriptions
Log File Specify either the Management Class and Storage Class or the
Generic unit and volume serial number for the Log file
that is allocated upon entry into ASG-Insight. The Log file
is used for error messages and log commands. File characteristics
are specified on the Options - Log/List/Punch Definition pop-up.

(continued)
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Command Help

To request Help for a specific command, select one of these actions:

=  Select Help » Specific and press Enter.

<  Typethe command in the command input area and press Enter.

- Press PF1/13.

=  TypeHELP followed by the desired command name and press Enter.

A message displays describing the command. Press PF1/13 to display the Help
Tutorial screen for that command.

The Help Tutorial for each command displays the command syntax diagram, and gives a
description of each operand in the command.

To display alist of adl Insight primary commands, type UP on acommand help screen.
For help on all Insight commands, follow this step:
» Select Help P All and press Enter.

Or

TypeHELP COMMANDS and press Enter.

The All commands action displays acomplete list of all Insight commands.

The HELP COMMANDS command displays a message that lists most of the primary
commands. After this message displays, press PF1/13 to display thelist of al Insight
commands. From thislist, select the appropriate number to display information about a
particular command.
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Figure 136 illustrates the Help Tutorial screen for the RECALL command.

Figure 136 « Command Help Example

ASG-Insight RX_X ——————————mm—moem RECALL  ————mmmmmmmmmmm e HELP

=—==>

The RECALL command displays the previous command or message. The last twenty
commands that have been executed and the last twenty messages that have been
displayed are stacked. RECALL can be entered repeatedly to display any of the
stacked commands or messages. Once the desired command displays, it can be
executed again by pressing ENTER or changed prior to execution.

The RECALL command syntax is:

RECall
—————————————————————————————————————————————————————————————————————— ><
| -COMmand | CMD-| | -NEXT-]
| -MESsage | MSG-| | -PREV-]
J-POPUp—====—— e e e |

Minimum Abbreviations are in CAPS

Default operands are highlighted

LEGEND: ---required------————————————— ><
|-optional-|

The following topic will be presented only if explicitly selected by number:

1 - Operand Descriptions

For some commands, (on the Source View screen only), pressing PF1/13 after the long
message displays causes NOTES to display with specific examples for using the
command. After the NOTES are displayed, pressing PF1/13 again displays the Help
Tutorial for that command. The Help NOTES displays for those commands where
specific examples are helpful.

Figure 137 illustrates the Help NOTES for the RECALL command.

Figure 137+ Help NOTES Example

File View Search Logic Task List Options Help

Source View Program: V

Command ===> Scroll ===> CSR
ASG45411 RECALL REDISPLAYS THE PREVIOUS COMMAND OR MESSAGE.

=NOTE +-----———=——= Examples ------- RECALL ------ Descriptions ----------- +
=NOTE | RECALL | Recalls the last command that was |
=NOTE | ] entered in the primary command |
=NOTE | | area. |
=NOTE | REC MSG | Recalls the last message that was |
=NOTE | ] displayed in the message area. |
=NOTE | RECALL NEXT ] Once recalling is started, NEXT |
=NOTE | | may be used to reverse its |
=NOTE | | direction. |
=NOTE == e e e e e e e T +

F

000001 IDENTIFICATION DIVISION.

000002 PROGRAM-ID. VIAIDEMO.

000003 AUTHOR. WRITTEN BY ASG AT LANGLVL 2.
000004 ENVIRONMENT DIVISION.

000005 CONFIGURATION SECTION.

000006 SOURCE-COMPUTER. 1BM-370.

000007 OBJECT-COMPUTER. IBM-370.

000008 INPUT-OUTPUT SECTION.

000009 FILE-CONTROL.

000010 SELECT MASTERIN ASSIGN TO S-MASTERIN.
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General Information

To request general help information, follow this step:

» Select Help P Table of contents or type TOC on any Help Tutorial screen and press
Enter. The Help Table of Contents, shown in Figure 138, displays.

Figure 138« Help Table of Contents

ASG-Insight RX.X --—----- Help Table of Contents --------—--—-—-————————— HELP
===>

The topics below represent general categories of information about ASG-Insight.
To get help for a pull-down, select the Action Bar topic. This Help Table of
Contents may be redisplayed from any Help screen by entering the TOC command.
The following topics will be presented only if explicitly selected by number:

1 Overview of ASG-Insight

2 Introduction to CUA

3 The Action Bar

4 Customer Support

5 Release x.x Summary of Revisions

6 Index for ASG-Insight Help

Specific Information

To request Help for specific topics, choose one of these actions:

=  Select Help » Index and press Enter.

- Select option 6 on the Help Table of Contents and press Enter.
<  Type INDEX from within the Help Tutoria and press Enter.

Help for a specific topic can then be viewed by selecting the appropriate Index entry.

On any Index screen, enter an alphabetic character to display the Index screen
corresponding to that character.
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Figure 139 illustrates a Help Index screen.

Figure 139 « Help Index Example

ASG-Insight RX.X —-——————————— INDEX A = C —mm oo HELP
===>
To select a topic, enter the two- or three-character identifier.
Al - Action Bar B1 - BRANCH Command
A2 - AKR B2 - Branch Previous Options
A3 - AKR Program Selection B3 - Buf, Analyze Option
A4 - ALLOCDEF Command B4 - BYPASS PERFORMED CODE,
A5 - ANALYZE Command Decision Option
A6 - Analyze Options
A7 - At End, Decision Option Cl - CALL Command
A8 - Automated Task - Debug a C2 - CANCEL Command
Program Abend C3 - COBOL Language Subset
A9 - Automated Task - Modify a C4 - COBOL 11, Analyze Option
Computation C5 - Commands
A10 - Automated Task - Modify Program C6 - COPY Command
Output C7 - CUA, Introduction
All - Automated Task - Result Options C8 - CURRENT Command
C9 - Current cursor location
Another index page can be displayed by entering its letter.

Help Abends

To request Help for user abends, choose one of these options:
=  Select Help » Common abends and press Enter.
e  TypeHELP ABENDS and press Enter.
<  Type ABENDS in the command input area and press PF1/13.
The ABENDS screen displays. Select topic 2 on this screen to display the ASG

Abend Codes screen, that lists all the user abend messages, and explanations for
each message.
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Figure 140 illustrates the ASG Abend Codes screen.

Figure 140« ASG Abend Code Screen

965

968

970

972

974

X"3C5"

X"3C8"

X"3CA"

X"3CC"

X"3CE"

ASG-Insight RX.X —-————————————-

===>

Abend codes in the range 900 - 999 (X"384 - X"3E7") bypass ASG error
recovery, causing the abend to be handled by ISPF or by the system. If the
problem cannot be resolved, call Customer Support.

Unable to intercept program.

An internal error occurred during initialization.

A package load module was called directly.

The ASG Edit Monitor encountered a severe error.

An invalid VIASPRMS module was found. The current product
expects a level of CEO30 or greater. Enter HELP 4988 for more

information.

ASG ABEND CODES ————————mmmmoeee HELP

(continued)

Help Messages

Insight messages are displayed in the long message area. Thisisthe format for help
messages.

where:

ASGnnnnx text

nnnn is the message number.
X is one of the severity levels listed below.

text isthelong or short message text.

Level Type Description

I Informational  Specifies that no required action.

W Warning Specifies that an error condition exists that is not critical
E Error Specifies that a critical error condition exists
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D Disaster Specifies that a serious error condition exists; the product is
unable to continue

T Termination Specifies that the product terminated with the specified error.

Short messages are displayed when available. Long messages are displayed if a short
message does not exist or when help isrequested immediately following adisplayed short

message.

To display Help for a specific message, follow this step:

» Select Help » Current message or Help » Specific message and press Enter.
Or

Type HELP followed by the message number and press Enter.

The Help Explanation and Action screen for that message displays. Figure 141 illustrates
the Help Explanation and Action screen.

Figure 141« Help Explanation and Action Screen

ASG-Insight - Rx.x --- HELP EXPLANATION AND ACTION PANEL -------————————- HELP
===> SCROLL ===> CSR

ASGO650 END OF PROGRAM; USE BRANCH BACKUP TO FOLLOW OTHER BRANCHES.

EXPLANATION:
This is a warning message indicating that branch has reached the
physical end of the program.

ACTION:
IT you wish to branch to other paths, use BRANCH BACKUP to reach
the desired decision point and then use BRANCH to follow another
path.

BOTTOM OF DATA

Printing Messages
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Y ou can either print all Insight messages or arange of messages using the VIASMPRT
program. The VIASMPRT program produces alisting of the specified messages that
includes:

- M essage number

-  Short message (if available)
- L ong message

- Explanation of the message
< Adction (if any)
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JCL to execute the VIASMPRT program isin ASG.VIACENxX.CNTL(VIASMPRT).
The entire message fileis printed unless a you specify arange in the PRM parameter. For
example: this command prints messages 300 through 499.

PRM="START=300, END=499"

To print all messages, specify the ALL keyword in the PRM parameter.

The default value for START is 1; the default value for END is 5000. If you enter only

the START value, messages print starting at the message number you specified and

ending with 5000. If you enter only the END value, messages start printing with 1 and
end with the message number you specified.

The NOTES keyword specifies that any notes associated with a message are printed. The
default isNONOTES. Typically, notes are provided to illustrate Center primary

commands.

Figure 142 and Figure 143 on page 404 illustrate the VIASMPRT JCL and the output

from the job.

Figure142« VIASMPRT JCL

//ASG JOB ( ),"ASG-CENTER VIASMPRT*®

/7* INSERT "/*ROUTE PRINTNODE.USER®" HERE IF NEEDED.

//*

/7*

//*  * ASG, INC. ASG-CENTER Rx.Xx DEC, 2001 *
//* * *
/7 * UTILITY TO PRINT ASG MESSAGES *
//* * *
//*

/7*

//VIASMPRT PROC VIASOFT="ASG", HIGH LEVEL NODE OF ASG DATA SETS
// CENTER="VIACENxx", MIDDLE NODE OF ASG DATA SETS

// SYSOUT="*", PRINT OUTPUT MESSAGE CLASS

// PRM=""* PARM FOR MESSAGES TO BE PRINTED
//*

/7*

//* * *
//** MESSAGE PRINT UTILITY *
//* * *
//* * THIS PROGRAM WILL PRINT ALL OF THE MESSAGES IN THE ASG *
//* * MESSAGE FILE AND THE HELP TEXT ASSOCIATED WITH EACH *
//* * MESSAGE 1T WILL PRINT THE ENTIRE FILE BY DEFAULT. YOU MAY *
//* * SELECT A GIVEN RANGE OF MESSAGES BY SPECIFYING THE OPTION- *
//* * AL PARAMETER KEYWORDS: START AND END. FOR EXAMPLE: *
/7 * PRM="START=300,END=499" *
//* * WILL PRINT MESSAGES NUMBER 300 THROUGH 499, INCLUSIVE. *
//* * THE DEFAULT VALUES FOR START AND END ARE 1 AND 99999 *
//* * RESPECTIVELY. CONSEQUENTLY THE PRM VALUE "END=300" WILL *
//* * PRINT MESSAGES 1 THROUGH 300, AND THE PRM VALUE *
//* * F"START=4000" WILL PRINT MESSAGES 4000 THROUGH 99999. *
//* * *
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//* > AN OPTIONAL KEYWORD, NOTES, WILL ALSO PRINT ANY NOTES *
//* * ASSOCIATED WITH A MESSAGE. *
//* * *
//* * ADDITIONALLY, THE KEYWORD “ALL® WILL EXPLICITLY PRINT ALL *
//* * MESSAGES. *
/7*

/7*

//7*

//VIAMPRT EXEC PGM=VIASMPRT,REGION=4096K,

// PARM="&PRM"

//STEPLIB DD DSN=&ASG..&CENTER..LOADLIB,DISP=SHR
//VIAMSGS DD DSN=&ASG..&CENTER..VIAMSGS,DISP=SHR
//SYSPRINT DD SYSOUT=&SYSOUT
//VIAPRINT DD SYSOUT=&SYSOUT
//VIALOG DD SYSOUT=&SYSOUT
//SYSUDUMP DD  SYSOUT=&SYSOUT

/7*

// PEND

/7*

//VIASMPRT EXEC VIASMPRT PRINT MESSAGES
/7*

Figure 143+ VIASMPRT Output

//ASG JOB ( ),"ASG-CENTER VIASMPRT*

/7* INSERT "/*ROUTE PRINTNODE.USER®" HERE IF NEEDED.

//*

//*

//*  * ASG, INC. ASG-CENTER R6.0 DEC, 2001 *
//* * *
/7 * UTILITY TO PRINT ASG MESSAGES *
//* * *
//*

//*

//VIASMPRT PROC VIASOFT="ASG", HIGH LEVEL NODE OF ASG DATA SETS

// CENTER="VIACENxx", MIDDLE NODE OF ASG DATA SETS

// SYSOUT="*", PRINT OUTPUT MESSAGE CLASS

// PRM="" PARM FOR MESSAGES TO BE PRINTED
//*

/7*

//* * *
//** MESSAGE PRINT UTILITY *
//* * *
//* * THIS PROGRAM WILL PRINT ALL OF THE MESSAGES IN THE ASG *
//* * MESSAGE FILE AND THE HELP TEXT ASSOCIATED WITH EACH *
//* * MESSAGE IT WILL PRINT THE ENTIRE FILE BY DEFAULT. YOU MAY *
//* * SELECT A GIVEN RANGE OF MESSAGES BY SPECIFYING THE OPTION- *
//* * AL PARAMETER KEYWORDS: START AND END. FOR EXAMPLE: *
/7 * PRM="START=300,END=499" *
//* * WILL PRINT MESSAGES NUMBER 300 THROUGH 499, INCLUSIVE. *
//* * THE DEFAULT VALUES FOR START AND END ARE 1 AND 99999 *
//* * RESPECTIVELY. CONSEQUENTLY THE PRM VALUE "END=300" WILL *
//* * PRINT MESSAGES 1 THROUGH 300, AND THE PRM VALUE *
//* * F"START=4000" WILL PRINT MESSAGES 4000 THROUGH 99999. *
//* * *
//* * AN OPTIONAL KEYWORD, NOTES, WILL ALSO PRINT ANY NOTES *
//* * ASSOCIATED WITH A MESSAGE. *
//* * *
//* * ADDITIONALLY, THE KEYWORD “ALL® WILL EXPLICITLY PRINT ALL *
//* * MESSAGES. *
/7*

/7*
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/7*

//VIAMPRT EXEC PGM=VIASMPRT,REGION=4096K,

// PARM="&PRM"

//STEPLIB DD DSN=&ASG..&CENTER..LOADLIB,DISP=SHR
//VIANSGS DD DSN=&ASG. .&CENTER..VIAMSGS,DISP=SHR
//SYSPRINT DD SYSOUT=&SYSOUT

//VIAPRINT DD SYSOUT=&SYSOUT

//VI1ALOG DD SYSOUT=&SYSOUT

//SYSUDUMP DD  SYSOUT=&SYSOUT

/7*

// PEND

/7*

//VIASMPRT EXEC VIASMPRT PRINT MESSAGES
/7*

Help Facility
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Glossary

action bar

Theline of keywords at the top of a screen. Each keyword represents a category of
actions that may be performed on that screen. An action is selected by moving the cursor
to the desired keyword and pressing Enter. See the ASG-Insight User’s Guide for
additional information.

AKR
See "Application Knowledge Repository" on page 408 .

AKR utility log
Provides a summary of the commands issued to the Batch AKR Utility. See"AKR
Utilities" on page 363 for more information.

alias of

A field on a pop-up listing entriesin the AKR. If the analyzed program contains an
ENTRY point, Alias Of isthe name of the program that contains the ENTRY point. If the
name in the PROGRAM-ID statement was overridden at the time the analyze job was
submitted, Alias Of is the name that was entered in the AKR program name field on the
File - Analyze Submit pop-up.

analyze

The analyze process gathers information about the program, including program
relationships, logic, data and execution paths, and stores this information in the AKR.
After the analyze information is placed in the AKR, it is available to ESW productsin
online and batch environments, where it is accessed to provide valuable information
about the design and operation of user systems. See "Analyze" on page 339 for more
information.

analyze options
Run-time options that control analyze processing. Most are similar to the COBOL
compiler options. Default settings are established at installation time and can be

overridden by editing the Analyzer JCL or by using the Analyze screens. "Analyze" on
page 339 contains a complete description of each Analyze option.

Analyze Summary report

A summary of the run-time statistics and diagnostic messages that are produced when an
Analyze job completes.
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Application Knowledge Repository
A BDAM or VSAM file organization that contains all of the analysis information
produced by the Analyze job. See "AKR Utilities" on page 363 for more information.

Batch AKR command
Control cardsinput in the VIASY SIN DD dataset of the Batch AKR Utility. See "AKR
Utilities" on page 363 for more information.

Batch AKR utility
Used to maintain the AKR. See "AKR Utilities' on page 363 for more information.

COBOL subset
COBOL verbs of asimilar nature that are grouped together. For example, READ,
WRITE, OPEN, CLOSE are grouped into the O subset.

command
Instructions issued by you to Insight. There are three types of commands: primary
commands, line commands, and batch AKR utility commands.

command input area
Thefield on Insight screens where primary commands are entered, indicated by ===> on
the fourth line of a screen, or the second line of a pop-up.

control flow
Describes how execution can transfer from one COBOL statement to another.

cursor position
The current location of the cursor on the screen, used as a starting point for certain
commands.

cursor substitution character

A token substitution character that may be used in some primary commands. The Cursor
character is set on the Options - Product Parameters pop-up. See the online help for more
information.

data flow
Describes the path of executable statements leading to how the value of datanames are
tested, used, and changed.

dataname

The standard COBOL term for fields defined in the DATA DIVISION of a COBOL
program. Variable names, files, groups, array elements, and fully-qualified datanames.
Multiple datanames can be searched for at once using plus sign (+). For example:

FX ZIP-CODE + HLD-ZIP.
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data usage

Defines how adataitem isused. A dataitem can be used in one of four ways: 1 USE -
when the value is used or tested, 2 MOD - when the valueis set or changed (modified), 3
DEF - indicates the statements in the DATA DIVISION where it is defined, 4 REF -
means any one of the above.

DBC
See Double Byte Character Set (DBCS).

decision options
Choices listed on the Trace Decision Menu. Decision options represent the branches in
the path that the TRACE command is following.

decision point

A statement that causes a branch in the execution path of the program. It could be a
PERFORM, conditional statement, exception condition, input statement, GO TO or
LABEL.

Double Byte Character Set (DBCS)

A character set that uses two bytes to represent each character. Various Double Byte
Character Sets are used with languages such as Chinese and Japanese that cannot be
represented with single byte codes.

equate
A substitution name for a character string. See the "EQUATE Command" on page 201 or
the Options - Scratchpad Equate pop-up for more information.

help

Insight Help has three levels of help: Long messages, NOTES, and tutorial screens.
Specific command information is available by entering the command and pressing
PF01/13. The Help facility can aso be accessed from the Help pull-down or any Insight
screen. See "Help" on page 171 and "Help Facility" on page 393 for more information.

label name

Any paragraph or section name of the PROCEDURE DIVISION, aswell asthe literals
PROCEDURE and PROC. Label name specifies all transfers of control to a paragraph or
section.

line commands
Commands that affect specific lines or blocks of lines, entered in the line command area
(columns 1 through 6).

list file

A filethat is allocated the first time the LPRINT command is executed. Thisfileis used
for LPRINT output. See "LPRINT Command" on page 251 or the online help for the
Options - Log/List/Punch Definition pop-up for more information.
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live exit
An abnormality in program control caused by out of perform range GO TO and
overlapping perform ranges.

log file

Thefilethat is allocated by Insight and used for error messages and log commands. See
the online help for the Options - Log/List/Punch Definition pop-up for more information.
There is a separate log file created by the Batch AKR Utility. See "AKR Utility Log" on

page 377.

long message

A diagnostic or error message that displays on line five of a screen or line three of a
pop-up. A long message is sometimes preceded by a short message that displaysin the
upper right corner of the screen. If the short message does not provide enough
information, press PF01/13 to display the long message.

member
A member in a PDS or source manager such as Panvalet or Librarian. This can be the
alias name found in the AKR.

network

Theresult of a FLOW command. It consists of al possible executable statements that
reach from the starting point of the command to al possible targets. The next FLOW
command replaces the previous network with the new results.

online help
See "help” on page 409.

paragraph name
Any PROCEDURE DIVISION paragraph or section name, and the PROCEDURE and
PROC literals. Paragraph name includes the entire paragraph or section.

path

Any group of executable statements that describe possible execution flows of the
COBOL program. FLOW creates paths called NETWORK and TRACE creates a path
caled aTRACK.

perform range
A perform range consists of the source code contained in a PERFORM statement, and
includes all code that is or could be executed as aresult of GO TOs, PERFORMS, etc.
within that range.

pop-up

A window that displays as the result of selecting an item on a pull-down or pop-up, or as
the result of entering certain commands. It is superimposed on the screen to alow entry
of information for the requested action. See the ASG-Insight User’s Guide for additional
information.
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primary command
An instruction entered in the command input area of the screen.

program
The program source member name, the name specified in the IDENTIFICATION
DIVISION of aCOBOL program, or the CSECT name of a program that is not COBOL.

pull-down

Thelist that displayswhen an action is selected on the action bar. On a pull-down, actions
followed by ... displays a pop-up when selected. Actions not followed by ... immediately
activate internal commands. See the ASG-Insight User’s Guide for additional
information.

punch file

A filethat is allocated the first time the LPUNCH command is executed. Thisfileis used
for LPUNCH output. See"LPUNCH Command" on page 258 the online help for the
Options - Log/List/Punch Definition pop-up for more information.

recursion
A perform range or paragraph that performsitself.

SBCS
See "Single Byte Character Set" on page 412.

screen
A full-width display of information containing an action bar as the first line. See the
ASG-Insight User’s Guide for additional information.

screen subset
Lines acted upon by an interactive command that has caused them to bein one of these
screen display set types:

<  Highlighted | HI

<  Excluded | X

- NONHighlighted | NHI

- NONExcluded | NX

script file

A dataset containing primary commands entered during a Source View session. The
commands are captured automatically when the SET SCRIPT ON or SET SCRIPT
RESULT command isissued. See"SET Command" on page 311 for additional
information.
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short message

A diagnostic or error message that displaysin the upper right corner of a screen. A short
message is sometimes followed by along message that displays on line five of ascreen or
line three of a pop-up. If the short message does not provide enough information, press
PF01/13 to display the long message.

Single Byte Character Set

A character set that uses one byte to represent each character. Single Byte Character Sets
are used with languages such as English where the characters can be represented with a
one-byte code.

SMS
See Storage M anagement Subsystem.

Storage Management Subsystem

An operating environment that hel ps automate and centralize the management of storage.
To manage storage, SM S provides the storage administrator with control over data class,
storage class, management class, storage group, and ACS routine definitions.

subset
A COBOL subset, screen subset, or tagged lines subset. See the ASG-Insight User’s
Guide for additiona information.

tagged lines subsets
Information shown in columns 73 through 80 as the result of a FLOW or TRACE
command. Tags can be used as subsets in commands that accept subsets as targets.

target
The object of an Insight primary command.

track

The result of a TRACE command. Track is the set of lines captured while moving
through program logic selecting the branch options. See "TRACE Command" on
page 315 for more information.

VIASUB
An edit macro included with the Insight product that is used to submit an Analyze job.

VIASUBDS
A CLIST included with the Insight product that is used to submit an Analyze job.

work file
A filethat is allocated upon entry into Insight. See the Options - Product Allocations
pop-up for more information.
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Symbols
$SSEGMENTS program name 19
& (Retain) command 182, 186

A
Abend Codes screen 401
action bar 1
AKR
dlocate 15, 20
alocate without ISPF 379

analyzed program information 353

available spacein 18
delete a program from 18
expand 15, 20
expand without |SPF 379
list programsin 17
management 363
metrics member 19
profile member 19
rename aprogramin 15,18
VIASAKRA JCL example 380
VIASAKRX JCL example 383
AKR library 8
AKR parameter 346
AKR Program Selection pop-up
description 7
field descriptions 8
SELECT command 310
VIEW command 323
AKR Utility Log
description 377
example 378
alarm 151
Alliance
accessing from ESW screen xv
description xii
linking xv
ALLOCDEF command 187
analysistypes 19

anayze
features 341
methods 342
options 341, 356
parameters 346
process 342
requirements 340
using ISPF 343
using | SPF/PDF Edit 343
VIAIN DD statement 349
VIASUB edit macro 13, 343, 348
VIASUBDS CLIST 342-343, 348
ANALY ZE command 188
analyze process, primary inputs 340
Analyze Submit Parameters screen
description 346
example 346
field descriptions 347
option descriptions 346
Analyze Submit pop-up 356
Analyze Summary report 353
AOPT parameter 346
AutoChange
accessing from ESW screen xv
description xii
Automated Task - Debug a Program Abend
pop-up
description 134
example 134
field description 134
Automated Task - Modify a Computation
pop-up
example 129
field description 129
Automated Task - Modify Program Output
pop-up
example 123
field description 123
Automated Task - Result Options pop-up
example 137
field description 137
automatic JCL modifications 349
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B

Batch AKR Utility

AKR Utility Log 377
command format 367
command syntax 367
comments 369

control cards 366
CONVERT command 369
DELETE command 371
EXPORT command 372
HELP command 372

INIT command 373

JCL 366

MOVE command 373
PRINT command 374

print directory example 378
print directory report 378
PUNCH command 375
punch directory 378

punch directory example 379
Utility Log 377

BRANCH command

description 189
on Tree View screen 34

Branch Previous Options pop-up

BRANCH command 190
example 95
field descriptions 95

branching logic 190
Bridge

C

accessing from ESW screen xv

description xii

CALL command 192

CANCEL command 193

Center, description Xii

character string 201, 249

CLIST, VIASUBDS 342-343, 348
CMPL parameter 346

COB2R3 analyze option 356
COBOL intelligent search 216
COBOLII analyze option 356
command
& (Retain) 182, 186
ALLOCDEF 187
ANALYZE 188
BRANCH 34,189
CALL 192
CANCEL 193
COPY 194
CURRENT 197
DELETE 198

END 34, 151, 200
EQUATE 201
EXCLUDE 203
EXECUTE 209
FIND 212, 293
FINDXTND 203, 216
FLOW 228
GOBACK 151,234
HELP 235

HIGH 236, 294
JUMP 34,243
KEYS 180, 244
LEVELS 34, 246
LIST 247

LOCATE 7,249
LPRINT 154, 251
LPUNCH 154
MARK 265
MERGE 268
PARMDEF 271
PREF 272

primary 210
PRINTLOG 275
PRINTLST 276
PROCESS 277
processing 180
PRODLVL 281
PROGRAM 151, 282
QUALIFY 283
RECALL 180-181, 284
recalling 181, 284
REDO 182, 287
REFRESH 288
RENAME 289
REPEAT 181, 290
repeating 181, 290
RESET 34,291
Retain 186
RETURN 151, 292
RFIND 182, 293
RHIGH 182, 294
RPREF 182, 295
RSCROLL 182, 296-297
RTRACE 182, 298
RTREEVW 301
SAVE 151, 202, 302
SCROLL 303
SELECT 310
sequence 180

SET 311
SOURCEVIEW 312
STRUCTURE-VIEW 313
TRACE 287, 315
TREEVIEW 321



VIEW 323
ZOOMIN 35
ZOOMOUT 35
command input area 180, 290
commands
diagram syntax 183
line 180, 291, 325
on Tree View screen 36
primary 180
comment lines 232
compiler directives 232
COND Tree View tag 33
control, transfer of 385
conventions page Xix
COPY command 194
CUA overview 1
CURRENT command 197
cursor position 182, 231
cursor substitution character 183
customer support 176

D
dataname 201
DB2LIB anayze option 356
DB2PLAN analyze option 357
Debug Abend Task - Line Number Entry
pop-up
example 135
field descriptions 135
Debug Abend Task - Statement Selection
pop-up
description 135
example 136
field descriptions 136
decision options 287
decision point 287, 319
DELETE command 198
DSCHK parameter 346
dynamically called programs
inanalyze job 357
DYNCALL anayze option 357

E
edit macro, VIASUB 343, 348
EDIT parameter 346
Encore
accessing from ESW screen xv
description xiii
END command 151
description 200
on Tree View screen 34
enhancement tasks, automating 121
EQUATE command 201

equates
list 142
saving 151, 302
Estimate
accessing from ESW screen xv
description xiii
ESW
description xi
invoking products xiv
product integration xv
EXCLUDE command 203
excluded lines 291, 331, 334-335
EXECUTE command 209
execution paths 228

F
F (First) line command
description 327
on Tree View screen 36
features, overview 2
File - AKR Allocate/Expand pop-up
description 20
example 21
field descriptions 21
online utilities 364
option descriptions 21
File - AKR Directory pop-up
description 17
example 17
field descriptions 17
online utilities 364
File - AKR Utility pop-up
description 15
example 15
field descriptions 16
online utilities 364
File - Analyze Submit pop-up
description 12
example 12
field descriptions 13
option descriptions 12
File - Close Program Request pop-up
description 10
example 10
field description 10
File - Execute Script pop-up
example 24
field descriptions 24
File - Open Program Request pop-up
description 5
example 6

Index
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File - Save Program Request pop-up
description 11
example 11
field description 11
File - SmartEdit Request pop-up
example 23
field descriptions 23
File pull-down
actions 4
example 4
FIND command 212, 293
FINDXTND command 203, 216
FLAG(x) analyze option 358
FLAGE analyze option 358
FLAGW analyze option 358
FLOW command 228

G
GOBACK command 151, 234

H
H (highlight) line command 242, 328
help
for acommand 174
for abends 400
for commands 397
for general information 399
for messages 401
for pop-ups 396
for screens 396
for specific information 399
how to obtain 395
index 399
navigational commands 396
NOTES 398
online 393
printing messages 402
product release information 175
table of contents 399
topics 395
Help - About pop-up
description 175
example 175
field descriptions 176
Help - Specific ASG Command pop-up
description 174
example 174
field descriptions 174
Help - Specific ASG Message Number
pop-up
example 175
field descriptions 175
HELP command 235

help explanation and action panel 402
Help pull-down
action descriptions 172
description 172
example 172
help tutorial 395
HH (Highlight block) line command
description 329
HH (highlight block) line command 242
HIGH command 236, 294
highlighted set, adding lines 242
highlighting 328-329

|
IN-Clause Option pop-up
description 97
example 97
field descriptions 97
information tags 100, 319
INPUT analyze option 358
INS parameter 346
Insight
accessing from ESW screen xv
description xiii
facilities 1
introduction 1
using analysis functions xv
IO analyze option 358

J
J (Jump) line command
description 330
on Tree View screen 36
JCL, automatic modifications 349
JUMP command
description 243
on Tree View screen 34

K
KEY S command 180, 244

L
L (Last) line command
description 331
on Tree View screen 36
label line command 330
LANGLVL analyze option 359
LEARN Mode - Generated Command
pop-up
description 312
displaying 160
example 312



LEVELS command
description 246
on Tree View screen 34
line command
block format 326
F (First) 36, 327
H (Highlight) 242, 328
HH (Highlight block) 242, 329
J(Jump) 36, 330
L (Last) 36,331
Label 330
on Tree View screen 36
S (Show) 36, 332
singleformat 325
SS (Show block) 36, 333
X (Exclude) 36, 334
XX (Exclude block) 36, 335
Z1 (zoomin) 36, 324, 336
Z0O (zoom out) 36, 324, 337
LINECNT analyze option 359
List - CALL Statements pop-up
example 141
field descriptions 141
List - COBOL Subset Names pop-up
description 147
example 147
field descriptions 147
List - Equates pop-up
description 142
example 142
field descriptions 142
List - Perform Range Names pop-up
description 145
example 145
field descriptions 145
List - Program/Subprogram Names pop-up
example 146
field descriptions 146
List - User Marks pop-up
description 143
example 144
field descriptions 144
LIST command 247
list file 153, 251, 275-276
List Menu pop-up
description 248
example 248
List pull-down
description 140
example 140
LOCATE command 7, 249
log file 153, 275-276

Index

Logic Order Search - COBOL Subset Name
pop-up
description 107
example 107
field descriptions 107

Logic Order Search - Data Name pop-up
example 103
field descriptions 103

Logic Order Search - Label Name pop-up
description 105
example 105
field descriptions 105

Logic Order Search - Line Number Range
pop-up
example 116
field descriptions 116

Logic Order Search - Perform Range Name
pop-up
example 110
field descriptions 110

Logic Order Search - Subprogram Name
pop-up
description 114
example 114
field descriptions 114

Logic Order Search - Trace IN-Clause
Option pop-up
example 119
field descriptions 119

Logic Order Search - User Mark Name
pop-up
description 112
example 112
field descriptions 112

Logic pull-down
action descriptions 101
description 101
example 101

logical program unit 33

LPRINT command 154, 251

LPUNCH command 154

M
MAIN analyze option 359
mai ntenance tasks, automating 121
MARK command 265
mark name, deleting 198
marks

creating 164

deleting 168

list 143

renaming 170

saving 302
MERGE command 268
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messages
long 291, 402
recalling 284
short 291, 402
Modify Computation Task - Data Name
Entry pop-up
description 130
example 130
field description 130
Modify Computation Task - Data Name
Selection pop-up
description 131
example 131
field descriptions 131
Modify Computation Task - Statement
Selection pop-up
example 133
field descriptions 133
Modify Output Task - Data Name Selection
pop-up
description 127
example 128
field descriptions 128
Modify Output Task - Output Selection
pop-up
description 124
example 124
field descriptions 124
Modify Output Task - Statement Selection
pop-up
description 126
example 126
field descriptions 126

N

NETWORK 100, 228

NOCMPL parameter 346
NOCOBOLII analyze option 356
NODSCHK parameter 346
NODYNCALL anayze option 357
NOINPUT analyze option 358
NOINS parameter 346

NOIO analyze option 358
NOOUTPUT analyze option 359
NOPANEL parameter 346
NORECUR analyze option 360
NORETURN analyze option 360
NOREUS parameter 346
NORNS parameter 346

NOSD parameter 346

NOSDR parameter 346

NOSDX parameter 346

NOSEQ analyze option 360
NOSOURCE analyze option 360

NOST parameter 346
NOSTX parameter 346
NOTESin help 398

o]
Options - Allocation Definition pop-up 154
Options - COPY /Include Libraries pop-up

description 138

field description 138
Options - Log/List/Punch Definition pop-up

displaying 251

example 155

field descriptions 155

option descriptions 155
Options - PF Key Definition pop-up

example 158

field descriptions 158

KEY S command 244
Options - Processing Modes pop-up

description 160

example 160

field descriptions 160
Options - Product Allocations pop-up

ALLOCDEF command 187

description 152

displaying 187

example 153

field descriptions 153
Options - Product Parameters pop-up

example 151

field descriptions 151
Options - Scratchpad Copy pop-up

description 166

example 166

field descriptions 166
Options - Scratchpad Delete pop-up

description 168

example 168

field description 168
Options - Scratchpad Equate pop-up

example 163

field descriptions 163
Options - Scratchpad Mark pop-up

description 164

example 164

field descriptions 164
Options - Scratchpad Merge pop-up

field descriptions 169
Options - Scratchpad pop-up

description 161

example 161

field description 161



Options - Scratchpad Rename pop-up
description 170
example 170
field descriptions 170
Options - Script File Allocations pop-up
description 157
example 157
fields 157
Options - Set Processing Modes pop-up 311
Options pull-down
action descriptions 150
example 150
OUTPUT analyze option 359
output names, selecting 124
OUTPUT parameter 346

P
PANEL parameter 346
PARMDEF command 271
perform ranges, listing 145
Perform Structure View screen
description 40
displaying 313
STRUCTURE-VIEW command 313
PF keys 180, 244
PGM EXIT Tree View tag 33
PGM parameter 346
pop-up
AKR Program Selection 7, 310, 323
Analyze Submit 356
Automated Task - Debug a Program
Abend 134
Branch Previous Options 93, 190
Debug Abend Task - Statement
Selection 135
definition 1
File - AKR Allocate/Expand 20, 364
File- AKR Directory 364
File - AKR Directory pop-up 17
File- AKR Utility 15, 364
File- Analyze Submit 12
File - Close Program Request 10
File - Open Program Request 5
File - Save Program Request 11
Help - About 175
Help - Specific ASG Command 174
IN-Clause Option 97
LEARN Mode - Generated
Command 160, 312
List - COBOL Subset Names 147
List - Equates 142
List - Perform Range Names 145
List - Program/Subprogram
Names 146

Index

List - User Marks 143

List Menu 248

Logic Order Search - COBOL Subset
Name 107

Logic Order Search - Label
Name 105

Logic Order Search - Subprogram
Name 114

Logic Order Search - User Mark
Name 112

Modify Computation Task - Data
Name Entry 130

Modify Computation Task - Data
Name Selection 131

Modify output Task - Data Name
Selection 127

Modify Output Task - Output
Selection 124

Modify Output Task - Statement
Selection 126

Options - Allocation Definition 154

Options - COPY/Include
Libraries 138

Options - PF Key Definition 244

Options - Processing Modes 160

Options - Product Allocations 152,
187

Options - Scratchpad 161

Options - Scratchpad Copy 166

Options - Scratchpad Delete 168

Options - Scratchpad Mark 164

Options - Scratchpad Rename 170

Options - Script File Allocations 157

Program Summary - Copy
Members 51

Program Summary - Data 50

Program Summary - Files 48

Program Summary - Preprocessor
Statements 55

Script File Allocations 157

Search - Any/Unknown Type 91

Search - Branch Request 93

Search - COBOL Subset Name 78

Search - Data Name 66

Search - Label Name 70

Search - Paragraph Name 72

Search - Pattern String 75

Search - Perform Range Name 81

Search - Program Name 84

Search - User Mark Name 86

Selection List 96, 118

Trace Decision Options 298-299, 310

View - Exclude Request 59

View - Levels Request 57
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View - Paragraph Cross Reference 45
View - Paragraph Cross-Reference
Request 42
View - Program Summary 47
View - Structure View Request 37
View - Tree View Request 30
PREF command 272
prefix area 325
printing messages 402
PRINTLOG command 275
PRINTLST command 276
PROCEDURE DIVISION label 189
PROCESS command 277
PROCONLY parameter 346
PRODLVL command 281
product integration xv
product level 281
program
list 146
structure 324
VIASMPRT 403
PROGRAM analyze option 359
PROGRAM command 151, 282
Program Summary - Control Flow pop-up
example 54
field descriptions 54
Program Summary - Copy Members pop-up
description 51
example 51
field descriptions 52
Program Summary - Data pop-up
example 50
field descriptions 50
Program Summary - Files pop-up
example 48
field descriptions 48
Program Summary - Preprocessor
Statements pop-up
description 55
example 56
Program Summary - Sections/Paragraphs
pop-up
example 53
field descriptions 53
program view 298
pull-down
File 4
Help 172
List 140
Logic 101
Search 65
Task 122
View 27
punch file 153, 258, 275-276

Q
QUALIFY command 283

R
RECALL command 180-181, 284
Recap
accessing from ESW screen xv
description xiii
RECUR analyze option 360
RECUR Tree View tag 33
REDO command 182, 287
REFRESH command 288
release level 281
RENAME command 289
REP Tree View tag 34
REPEAT command 181, 290
REPEATED Tree View tag 34
requesting help 395
RESET command
description 291
on Tree View screen 34
Retain (&) command 186
RETURN analyze option 360
RETURN command 151, 292
REUS parameter 346
RFIND command 182, 293
RHIGH command 182, 294
RNS parameter 346
RPREF command 182, 295
RSCROLL command 182, 296-297
RTRACE command 182, 298
RTREEVW command 301

S

S (Show) line command
description 332
on Tree View screen 36

SAVE command 151, 202, 302

save equates 151

screen
Abend Codes 401
Analyze Submit Parameters 346
help explanation and action panel 402
Perform Structure View 40, 313
TreeView 32, 301

script file comments 211

SCROLL command 303

SD parameter 346

SDR parameter 346

SDX parameter 346



Search - Any/Unknown Type pop-up

description 91

example 91

field descriptions 91
Search - Branch Request pop-up

description 93

example 93

field descriptions 93
Search - COBOL Subset Name pop-up

description 78

example 78

field descriptions 79
Search - Data Name pop-up

description 66

example 67

field descriptions 67
Search - Label Name pop-up

description 70

example 70

field descriptions 70
Search - Line Range pop-up

example 88

field descriptions 89
Search - Paragraph Name pop-up

description 72

field descriptions 73
Search - Pattern String pop-up

description 75

example 75

field descriptions 75
Search - Perform Range Name pop-up

description 81

field descriptions 82
Search - Program Name pop-up

description 84

example 84

field descriptions 84
Search - User Mark Name pop-up

description 86

example 86

field descriptions 87
Search pull-down

action descriptions 65

description 65
SELECT command 310
Selection List pop-up

description 96, 118

example 118
SEQ analyze option 360
SET command 311

Index

sets
copy 143
delete 143
merge 143
rename 143
SmartDoc
accessing from ESW screen xv
description xiii
SmartEdit
accessing from ESW screen xv
description xiv
enter from Task 122
SmartQuest
accessing from ESW screen xv
description xiv
SmartTest
accessing from ESW screen xv
description xiv
SOURCE analyze option 360
Source Manager, specifying 138
SOURCE Tree View tag 34
SOURCEVIEW command
description 312
SPACE analyze option 360
SQLID analyze option 360
SRC Tree View tag
description 34
SS (Show block) line command
description 333
on Tree View screen 36
ST parameter 346
stopping point 319
STRUCTURE-VIEW command
description 313
STX parameter 346
SUBNET 228
subprogram, internal 146
Subsets, list 147
SUBSY S analyze option 361
support, customer 176

-
tags
information 100
Tree View generated 33
Task pull-down
action descriptions 122
description 122
example 122
To 146
TRACE command 287, 315

421



ASG-Insight Reference Guide

422

Trace Decision Options pop-up
description 299
example 299
field descriptions 299
RTRACE command 298
SELECT command 310

TRACK 319

transfer of control 385

Tree View commands 34

Tree View generated tags 33

Tree View screen
command 301
description 32
example 33
primary commands 34
tags 33

Tree View tag 33

TREEVIEW command 321

\Y
VIAIN DD statement 349
VIASAKRA JCL 379
VIASAKRX JCL 379
VIASMPRT program 402
VIASUB edit macro 13, 343, 346, 348
VIASUBDS CLIST 342-343, 346, 348
View - Exclude Request pop-up
description 59
field descriptions 60
View - Levels Request pop-up
description 57
field description 57
View - Paragraph Cross Reference
pop-up 295
description 45
example 46
field descriptions 46

View - Paragraph Cross-Reference Request

pop-up
description 42
example 42
field descriptions 42
View - Program Summary pop-up
description 47
example 47
field description 47
View - Reset Request pop-up
example 58
field descriptions 58
View - Structure View Request 37
View - Structure View Reguest pop-up
field descriptions 38

View - Tree View Request pop-up
description 30
field descriptions 31
VIEW command 323
View pull-down
action descriptions 27

description 27
example 27

X

X (exclude) line command
description 334

on Tree View screen 36
XLIVE analyze option 361
XMEM analyze option 361
XX (exclude block) line command

description 335

on Tree View screen 36

Z

Zl (zoom in) line command
description 336
on Tree View screen 36
syntax 324

Z0 (zoom out) line command
description 337
on Tree View screen 36
syntax 324

ZOOMIN command, on Tree View
screen 35

ZOOMOUT command, on Tree View
screen 35
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